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Human civilization achieved the highest peak

with the development of computer known as
“Computer era”. Literate are those who have
the knowledge in using the computerwhereas
others are considered illiterate inspite of the
other degrees obtained. The growth of the
nation at present lies in the hands of the youth,
hence the content of this book is prepared in
such a way so as to attain utmost knowledge
considering the future needs of the youth. ®
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@ LEARNING OBJECTIVES

Students will be able to learn about the concepts, techniques, and processes used

throughout the multimedia environment

01

CHAPTER

e Gain an ability to understand multimedia tools.

e Import graphics, create objects using various tools, add effects to objects

e To know various multimedia file formats for sound and video

e To understand the Multimedia production method and their team activities.

B8 Introduction to
Multimedia

Multimedia allows the users to combine
and change data from various sources like
image, text, graphics, video, audio and
video to a single platform. Multimedia has
become the latest enriching experience
in the field of information sector. The
fast growing of multimedia technology
over the last decade has brought a lot of
changes to computing, entertainment and
education.

The phenomenal growth of
multimedia technologies and applications
has presented the computerized field
with great challenges and opportunities.
Multimedia is becoming more popular
among the user in the terms of its uses

and applications. Multimedia application

‘ ‘ X1l CompApp_English version CHAPTER 01.indd 1

plays vital role in terms of presenting

information to the users.

Figure: 1.1 Introduction to Multimedia

Multimedia Definition

The word multimedia consists of two

words “multi” and “media” which means
that multiple forms of media are combined
to gather and provide services like storage,
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communication, presentation and Input/
output interactions of text, video, image,
graphics and audio.

The term multimedia comprises of
two words, “multi” and “medium”. Multi
refers to many i.e. at least two. Media is the
plural of medium. Therefore multimedia is
an integration of many types of media like
text, graphics, images, audio, animation,
video etc on a single medium in the same
information unit.

%] Components of
Multimedia

Multimedia has five major components
like text,
animation. They are explained in detail

images, sound, video and

below:

DYNAMIC [ .d'
ELEMENTS ¢
AUDIO
STATIC
ELEMENTS

GRAPHICS

Figure: 1.2 Components of Multimedia

1.3.1 Text

Text is the component of
multimedia and is the most common way
of communicating information to other

basic

person. Even though multimedia includes
images, video, audio and graphics, Text is
the basic component used in multimedia.
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Figure: 1.3 Text

Chapter 1 Multimedia and Desktop Publishing
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Static Text

Static text, the text which will remain
static as a heading or in a line, or in a
paragraph. The words are given along
with the images to explain about the

images. In static text the words will either
give information or support an image or
an video.

Figure: 1.4 Static Text

Hypertext

A hypertext is a system which consists of
nodes, the text and the links between the
nodes, which defines the path the user
need to follow for the text access in non-
sequential ways. The author of the working
system created this structure. The user is
permitted to define their own paths in
more sophisticated hypertext systems.
The user is provided with the flexibility
and choice to navigate in hypertext. In a
multimedia product, text is used to convey
the information and must be placed at
appropriate position in order to obtain the
well-formatted sentences and paragraphs.
The readability of the text depends on the
spacing and punctuation. The message
communication is more appropriate with
improved Fonts and styles.
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Figure: 1.5 Hyper Text

1.3.2 Image

Images acts as an vital component in
multimedia. These images are generated
by the computer in two ways, as bitmap or
raster images and as vector images.

Raster or Bitmap Images

The common and comprehensive form of
storing images in a computer is raster or
bitmap image. Bitmap is a simple matrix
of the tiny dots called pixel that forms a
raster or bitmap image. Each pixel consists
of two or more colors. Based on how
much data, in bits is used to determine
the number of colors, the color depth
is determined. Eg. one bit is two colors,
four bits means sixteen colors, eight bits
indicates 256 colors, and so on.

Vector Images

Drawing elements or objects such as lines,
rectangles, circles and so on to create an
images are based on Vector images. The
advantage of vector image is relatively
small amount of data is required to
represent the image and thereby only less
memory is needed to store. Compression
techniques are used to reduce the file
size of images that is useful for storing
large number of images and speeding

‘ ‘ X1l CompApp_English version CHAPTER 01.indd 3

transmission for networked application.
various Compression formats used for
this purpose are GIF, TIFF and JPEG.

Figure: 1.6 Images

1.3.3 Animation

Animation is the process of displaying
still images so quickly so that they give
the impression of continuous movement.
In animation the screen object is a vector
image. Using numerical transformations
the movement of that image along its paths
is calculated for their defining coordinates.
Theleast frame rate of atleast 16 frames per
second gives the impression of smoothness
and for natural looking it should be at
least 25 frames per second. Animations
may be in two or three dimensional. A two
dimensional animation, brings an image
alive, that occur on the flat X and Y axis

Chapter 1 Multimedia and Desktop Publishing
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of the screen. while in three dimensional
animation it occurs along the three axis
X, Y and Z. Animation tools are very
powerful and effective. The two basic
types of animations are Path animation
and Frame animation.

Path Animation

Path animation involves moving an object
on a screen that has a constant background
e.g. a cartoon character may move across

the screen regardless of any change in the
background or the character.

Figure: 1.7 Animation

Frame Animation

In frame animations, multiple objects are
allowed to travel simultaneously and the
background or the objects also changes.

1.3.4 Sound

Sound is a meaningful speech in any
language and is the most serious element
in multimedia, providing the pleasure of
music, special effects and so on. Decibels is
the measurement of volume, the pressure
level of sound.

)
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Figure: 1.8 Sound

Chapter 1 Multimedia and Desktop Publishing
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Musical Instrument Digital

Identifier (MIDI)

Musical Instrument Digital Identifier
(MIDI) is a standard communication tool
developed for computers and electronic
instruments. This tool is flexible and easy
for composing the projects in multimedia.
Tools for synthesizing the sound and
software for sequencing are necessary for
MIDI.

Digital Audio

Sampled sound is a Digitized sound.
A sample of sound is taken and stored
every n™ fraction of a second as digital
information in bits and bytes. The quality
of this recording depends on the sampling
rate. sampling rate is defined as how often
the samples are taken and how many
numbers are used to represent the value
of each sample (bit depth, resolution and
sample size). The finer the quality of the
captured sound and the resolution is
achieved while played back, when more
often the sample is taken and the more
data is stored about that sample.

1.3.5 Video

Video is defined as the display of recorded
event, scene etc. The powerful way
to convey information in multimedia
applications are embedding of video. The
video can be categorized in two types as
Analog video and Digital video.

Analog Video

In Analog video, the video data’s are
stored in any non-computer media like
video tape, laser disc, film etc. It is divided
further in two types as Composite and
Component Analog Video. Composite
Analog Video hasall the video components
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like brightness, color, and synchronization
combined into one signal. Thus the
quality of the composite video resulted
in color blending, low clarity and high
generational loss.

Digital Video

Digitalvideoisanelectronicrepresentation
of moving visual images in the form of
encoded digital data. This is in contrast to
analog video where images are displayed
in rapid succession.

WY File Formats for
Multimedia

The following is an outline of current
tile formats used for the production and
delivery of multimedia data.

1.4.1 Text Formats

RTF

Rich Text Format is the primary file format
introduced in 1987 by Microsoft with the
specification of their published products
and for cross-platform documents

interchange.

Plain text

Plain text files can be opened, read, and
edited with most text editors. commonly
used are Notepad (Windows), Gedit or
nano (Unix, Linux), TextEdit (Mac OS X)
and so on. Plain text is the original and
popular way of conveying an e-mail.

1.4.2 Image Formats
TIFF (Tagged Image File Format)

This format is common in desktop
publishing world (high quality output),
and is supported by almost all software
packages. Recent versions of TIFF allows

‘ ‘ XII CompApp_English version CHAPTER 01.indd 5

image compression, and the format is
comfortable for moving large files between
computers.

BMP (Bitmap)

Initially this format is in use with Windows
3.1.Itis quite large and uncompressed and
hence BMP is used for the high-resolution
or large images.

DIB (Device Independent Bitmap)

A device independent bitmap contains a
colour table. The colour describes how
pixel values corresponds to RGB colour
values, which describes colors that are
produced by emitting light.

GIF (Graphics Interchange Format)

GIF is a compressed image format.
Most of the computer color images and
backgrounds are GIF files. This file format
is best suitable for graphics that uses only
limited colors, and it is the most popular
format used for online color photos.
13-bit Color look up table is used by the
GIF format to identify its color values.
This format is supported widely.

JPEG (Joint Photographic

Experts Group)

JPEG is a commonly used method of
lossy compression for digital images. The
degree of compression can be adjusted
and it works good with photographs,
naturalistic artwork, and similar material
but functions less on lettering, live
drawings or simple cartoons.

TGA (Tagra)
It is the first popular format for high-
resolution images. TGA files are common

in animation video industry.

Chapter 1 Multimedia and Desktop Publishing

1/5/2022 1:16:33 PM‘ ‘



@

www.tntextbooks.in

PNG (Portable Network Graphics)

An extensible file format for the less loss,
portable and well compressed storage of
raster images. PNG acts as replacement for
GIF and also replaces multiple common
uses of TIFE. PNG works good with online
viewing applications like worldwide web.
so it is fully streameable with a best display

option.
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Figure: 1.9 Image file Formats

1.4.3 Digital Audio File Formats

WAV (Waveform Audio File Format)

It is the most popular audio file format in
windows for storing uncompressed sound
files. In order to attain the reduced file
size it can also be converted to other file
formats like MP3.

MP3 (MPEG Layer-3 Format)

MPEG Layer-3 format is the most popular
format for storing and downloading music.
The MP3 files are roughly compressed to
one-tenth the size of an equivalent WAYV file.

OGG

A free, open source container format that
is designed for obtaining better streaming
and evolving at high end quality digital
multimedia. It can be compared to MP3
files in terms of quality.

Chapter 1 Multimedia and Desktop Publishing

‘ ‘ X1l CompApp_English version CHAPTER 01.indd 6

AIFF (Audio Interchange File
Format)

It is an audio file format developed by
Apple Inc. used for storing sound data for
personal computers and other electronic
audio devices.

WMA (Windows Media Audio)

It is a popular windows media audio
format owned by Microsoft. WMA is a
tile extension used with windows media

player.
RA (Real Audio Format)

Real Audio format is designed for

streaming audio over the Internet. The

digital audio resources are usually stored
as a computer file in computer’s hard drive
or CD/DVD. Besides the variety of audio
file formats available, the most common
formats are wave files (WAV) and MPEG
Layer-3 files (MP3), WMA and RA.

Figure: 1.10 Digital Audio File Formats

1.4.4 Digital Video File Formats

AVI (Audio/Video Interleave)

AVT is the video file format for Windows.
Here sound and picture elements are

stored in alternate interleaved chunks in
the file.
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MPEG (Moving Picture Experts
Group)

MPEG sastandard for generating digital
video and audio compression under the
International Standards Organization
(ISO) by the group of people. The group
has developed MPEG-1, the standard
on which Video CD and MP3 are
based, MPEG-2, the that
supports products as Digital Television
set top boxes and DVD, MPEG-4, the
standard for multimedia and mobile
web.MPEG-7, the standard for search of
audio and visual content. Research on
MPEG-21 “Multimedia Framework”
has started in 2000. Simply MPEG is the
standards for digital video and audio
compression.

standard

%%%a%

MPEG-1 NTSC

MP4 Yideo(MC) HTMLS

?1??%

SECAM

MPEG-1 PAL  MPEG-1 SECAM  MPEG-Z NTSC MPEG-2 PAL MPEG-2 SECAR

Figure: 1.11 Digital Video File Formats

Multimedia Production

1.5.1 Steps in Multimedia
Production

Adequate time and efficient planning
is required for multimedia production.
This that the project will
proceed smoothly and ensures that the

assures
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information reaches the target audience.
Following are the phases for development
of complex multimedia projects.

1. Conceptual Analysis and Planning

The process of multimedia making
begins with a conceptual ignition
point. Conceptual analysis identifies
a appropriate theme, budget and
content availability on that selected
Additional
copyright issues also are considered
in this phase.

theme. criteria like

2. Project design

Once the
objectives, goals, and activities are

theme is finalized
drawn for the multimedia project.
General
as goals.

statements are termed
The specific statements
in the project is known as the
objectives. Activities are series of
actions performed to implement an
objective. These activities contribute

to the Project design phase.
3. Pre-production

Based on the planning and design, it
is necessary to develop the project.
The following are the steps involved
in pre-production:

4. Budgeting

Budgeting for each phases like

consultants, hardware, software,

travel, communication and
publishing is estimated for all the

multimedia projects.
5. Multimedia Production Team

The production team for a high-
end multimedia project requires a
team effort. The team comprises
of members playing various roles
and responsibilities like Script

Chapter 1 Multimedia and Desktop Publishing
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writer, Production manager, Editor,
Graphics  Architect, Multimedia
Architect and Web Master.

. Hardware/Software Selection

All multimedia Application requires
appropriate tools to develop and
playback the application. Hardware
includes the selection of fastest
CPU, RAM and huge monitors,
sufficient disc for storing the
records. Selection of the suitable
software and file formats depends
on the funds available for the project
being developed.

Defining the Content

Content is the “stuft” provided by
content specialist to the multimedia
architect with which the application is
developed, who prepares the narration,
bullets, charts and tables etc.

Conceptual Analysis and
Planning

Project Design

Pre Production

Budgeting

Multimedia Production Team

Hardware/Software Selection

8. Preparing the structure

A detailed structure must have
information about all the steps
along with the timeline of the future
action. This structure defines the
activities, responsible person for
each activity and the start/end time
for each activity.

. Production

In the multimedia application,
after the pre-production activities,
the production phase starts. This
phase includes the activities like
background  music  selection,
sound recording and so on. Text is
incorporated using OCR software,
Pictures shot by digital camera,
Video clips are shot, edited and
compressed. A pilot project is ready

by this time.

Defining the Content

Preparing the Structure

Production

Testing

Documentation & Delivering the
Multimedia Product

Conceptual Analysis and

Planning

Figure 1.12 Steps in Multimedia Production

Chapter 1 Multimedia and Desktop Publishing
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10. Testing

11.

The complete testing of the pilot
product is done before the mass
production to ensure that everything
is in place, thereby avoiding the failure
after launch. Ifitsan web based product,
its functioning is tested with different
browsers like Internet Explorer,
Chrome, Mozilla and Netscape
Navigator. After the testing process is
over, the product is incorporated with
valid suggested changes.

Documentation

User documentation is a mandatory
feature of all multimedia projects.
The documentation has all the
valuable  information’s  starting
from the system requirement till
the completion of testing. Contact
details, e-mail address and phone
numbers are provided for technical
support and sending suggestions
and comments.

12.Delivering the Multimedia Product

Multimedia applications are
best delivered on CD/DVD or in
the website . In reality various
challenges are faced while delivering
through internet, like bandwidth
problems, huge number of plug-
ins required to play audio and
video and long downloading time.
Finally, a multimedia application
is delivered in a more effective way
by the integration of two mediums
CD-ROM/DVD and Internet.

1.5.2 Multimedia Production

Team

Managing team members in a way to get
maximum outcome with high degree of

‘ ‘ XII CompApp_English version CHAPTER 01.indd 9

efficiency is mandatory in multimedia
production. The fine quality high-end
multimedia  production  application
requires a specialized team comprising of
the following members:

1. Production Manager

In a multimedia production, the role
of production manager is to define,
and coordinate, the production of
the multimedia project in time and
with full quality. The production
manager should be an expertise in
the technology, good at proposal
writing, good communication skills
and budget management skills. Also
must have experience in human
resource management and act as an
efficient team leader.

2. Content Specialist

Content specialist is responsible ®
for  performing all research

activities concerned with the

proposed  application’s  content.

Program content refers to projects

information, graphics, data or facts

presented through the multimedia

production.

3. Script Writer

Video and film scripts represents
a linear sequence of events. The
script writer visualizes the concepts
in three dimensional environment
and if needed uses the virtual reality
integration into the program.

4. Text Editor

The content of a multimedia
production always must flow
logically and the text should
always be structured and correct

Chapter 1 Multimedia and Desktop Publishing @I

1/5/2022 1:16:34 PM‘ ‘



@

www.tntextbooks.in

K.Til
Content specialist
@

Computer graphic artist

j.[
Production manager

M

Multimedia architect

K s

Text editor

Script writer

A

Audio and video specialist

o

Web master
computer programmer

Figure: 1.13 Multimedia Production Team

grammatically. Text and narration is
an integrated part of the application.

5. Multimedia Architect

The multimedia architect integrates
all the multimedia building blocks
like graphics, text, audio, music,
video, photos and animation by
using an authoring software.

. Computer Graphic Artist

The role of Computer Graphic Artist
is to deal with the graphic elements
of the programs like backgrounds,
bullets, buttons, pictures editing,
3-D objects, animation, and logos
etc.

7. Audio and Video Specialist

The roles of these specialists are
needed for dealing with narration
and digitized videos to be added in
a multimedia presentation. They are
responsible for recording, editing
sound effects and digitizing.

8. Computer Programmer

The computer programmer writes
the lines of code or scripts in the
appropriate language. These scripts
usually develops special functions
like developing the software to give

Chapter 1 Multimedia and Desktop Publishing
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the size and shape of video windows,
controlling peripherals and so on.

9. Web Master

The
master is to create and maintain an

responsibility of the web
Internet web page. They convert a
multimedia presentation into a web
page.
is a joint effort of the entire team.

Final multimedia product

Initially, the production manager
identifies the project content, while
the web master provides access to
a wide range of community through

web-services.

Multimedia on Internet

Major applications have been developed
with the integration of internet and
multimedia like maps, media rich blogs
etc. A comprehensive study on use of
internet and multimedia in USA says that
an estimated 55 million consumers use
Internet radio and video services each
month. Image is the most widely used
multimedia resource on internet. Social
networking sites like Facebook, Whatsapp,
Twitter etc. also enables multimedia rich
contents to be exchanged online.
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Figure: 1.14 Multimedia on Internet

Applications of
Multimedia

Multimedia is the most fast growing area
in the field of information technology. A
Multimedia is an application which is a
collection of multiple media sources like
text, images, sound/audio, animation and
video on a single platform. Predominantly,
Entertainment and Education are the fields
where multimedia is used in majority.

1. Education

Multimedia plays an vital role in
offering an excellent alternative
method to traditional teaching by
allowing the students to explore
and learn various concepts through
animation. Students, teachers and
the parents enjoy this multimedia
mode of learning and multimedia
learning  materials. Multimedia
based teaching and learning system
named as MODULO at GMU in
Germany developed is a web-
based environment that aims to
provide students with flexible and
decentralized learning environment

‘ ‘ X1l CompApp_English version CHAPTER 01.indd 11

based on  their educational

background.

In India, multimedia is used
in different ways for teaching and
learning like e-learning, distance
learning, virtual learning and so
on. EDUSAT (Education Satellite)
is launched in India for serving the
educational sector of the country for
emulating virtual classroom in an
effective manner.

. Entertainment

The remarkable advancement in the
entertainment industry is due to the
Multimedia Technology mainly. This
technology is needed in all mode of
entertainment like radio, TV, online
gaming, video on demand etc.

Video on demand or movies
on demand is a service that
provides movies to television sets
on an individual basis at homes.
Movies are stored in a central
server and transmitted through
a communication network. A
set-top box connected to the
communication network converts

Chapter 1 Multimedia and Desktop Publishing
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the digital information to analog
signals and inputs it to the television
set.

3. Business Systems

Business applications for multimedia
presentations, training,
internet protocols and so on. The
marketing and advertising agencies

include

are using animation techniques for
sales promotion. High resolution
projectors are common  for
multimedia presentations on the
road. Cell phones and personal
digital assistants with Bluetooth and
Wi-Fi communication technology
makes multimedia communication

for business more efficiently.
4. Medical Services

Medical
drastically with the development

services are  grown
of multimedia. Medical Students
practices
simulation prior to actual surgery.
Tiny digital cameras are inserted
in human body and it displays the
inner site of the body through which
the medical practitioners can see

surgery methods via

the internal parts without actually
dissecting it.
5. Public Places

Multimedia is available in many
public places like trade shows,
libraries, railway stations, museums,
banks, hotels

in the form of

malls, airports,
and exhibitions
kiosks. It helps the customers by
providing information to them. The
information presented in kiosk are
enriched with animation, video, still

pictures, graphics, diagrams, maps,

Chapter 1 Multimedia and Desktop Publishing
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audio and text. Banks uses kiosks in
the form of ATM machines.

6. Multimedia Conferencing

Multimedia conferencing or video-
system that
performs face-to-face interactions
among participating users, located
far from each other, as if they were

conferencing is a

sitting and discussing in a single
room.

Libraries, Information
Centers and Archives

The primary function of library is

to organize, collect, preserve, and

disseminate  information to  users.
Several
are in use for handling the information
more effectively. Multimedia technology
is adopted by the libraries in various

functions like multimedia kiosks, user

techniques and technologies

orientation programs etc. Following is the
brief account of multimedia technology
applications in libraries.

1. Multimedia Kiosk

Kiosk is a free-standing furnished
equipped multimedia computer that
allow users to retrieve information
via a touch screen. It is commonly
used in airports and other public
locations to provide directions and
few mandatory information’s. In an
library, Kiosk is usually located near
the entrance of the library, used for
displaying announcements, reading
lists, comments and suggestions
from library wusers and
information’s about operations and

other

programs of the library.

1/5/2022 1:16:34 PM‘ ‘
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2. Webcasting and Video parent organization. Introduction
Conferencing of CD/DVD and their writers
The live telecast of real time programs has solved few of the problems of
through internet is known as libraries in storing or achieving
Webcasting. Video conferencing is the materials. Multimedia tools
the process of conducting conference along with CD-writers is made
between more than two participants possible to publish information
at different sites by using computer from different sources in a most
networks to transmit audio and video easy to use and acceptable form to
data. library users.

3. User Orientation Program 5. Digital Multimedia Libraries

The role of multimedia plays an Information’s are available in

vital role in training the librarians digital formats that include digital

in schools, colleges and universities books, scanned images, graphics
and digitized audio-visual clips etc.
Initially digital library projects were

based only on textual data but now

due to its interactivity. Hence, it is
used in depth subject training to
their faculties.

4. In-houseProductionof Multimedia it is an integration of various media
Resources and E-publishing elements like images, audio and
Many libraries produce multimedia video recordings.

resources in-house, to serve the

POINTS TO REMEMBER

e Multimedia allows the users to combine and change data from various sources like image,
text, graphics, video, audio and video to a single platform.

e Multimedia has five major components like text, images, sound, video and animation.
e Static text, the text or the words will remain static as a heading or in a line, or in a paragraph.

e A hypertext is a system which consists of nodes, the text and the links between the nodes,
which defines the paths the user need to follow for the text access in non-sequential ways.

e Images acts as an vital component in multimedia. These images are generated by the
computer in two ways, as bitmap or raster images and as vector images.

e Animation is the process displaying still images so quickly so that they give the impression
of continuous movement. In animation the screen object is a vector image in animation.

e Sound is a meaningful speech in any language and is the most serious element in multimedia,
providing the pleasure of music, special effects and so on.

e Musical Instrument Digital Identifier (MIDI) is a standard communication tool developed
for computers and electronic instruments.

e Video can be categorized in two types as Analog video and Digital video.

Chapter 1 Multimedia and Desktop Publishing  @GENEE
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Multimedia

Multimedia allows the users to combine and
change data from various sources like image,
text, graphics, video, audio and video to a single
platform.

Raster or Bitmap Images

The common and comprehensive form of storing
images in a computer is raster or bitmap image.

Vector Images

It relatively requires small amount of data to
represent the image and thereby only less memory
is needed to store.

Animation

Animation is the process of displaying still
images quickly so that they give the impression of
continuous movement. In animation the screen
object is a vector image.

Path Animation

Path animation involves moving an object on
a screen that has a constant background e.g. a
cartoon character may move across the screen
regardless of any change in the background or the
character.

Musical Instrument Digital
Identifier (MIDI)

Musical Instrument Digital Identifier (MIDI) is
a standard communication tool developed for
computers and electronic instruments.

Chapter 1 Multimedia and Desktop Publishing
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Where?

Write n

Write &%

When?

. EVALUATION i
=

1
A 1
Part - I 3. Sound - MPEG
Choose the correct answer W Video _ RTF
_______ refers to any type of a)l,2,3,4 b)2,3,4,1
application that involves more than )4,1,2,3 d)3,4,1,2

one type of media such as text,
graphics video animation and sound.

a) an executable file
b) desktop publishing
¢) multimedia

d) hypertext

. One of the disadvantages of the
multimedia is its __.

a) cost

b) adaptability

¢) usability

d) relativity

. Expand JPEG

a) joint photo experts gross

b) joint photographic experts group

c) joint processor experts group

. Find the odd one on the following

which is not an image format.
a) TIFF b) BMP
¢) RTF d) JPEG

___ is the process of displaying still
images with continuous movement.

a) Text formats
b) Sound
¢) MP3

d) Animation

. The live telecasting of real time

program through Internet is known
as

a) web casting
b) web hosting
c) data manipulation

d) none of the above

d) joint photographic expression
group . GIFuse color look up table
. You need hardware, software and __ a) 8 bit
to make multimedia. b) 13 bit
a) network c) 8 MB
b) compact disk drive d) 13 MB

c) good idea

d) programming knowledge

10.RTF file format was introduced by

. Match the following by choosing the a) TCS
right one. b) Microsoft
1. Text = TGA C) Apple
2. Image = MIDI d) IBM
Chapter 1 Multimedia and Desktop Publishing @
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Part - I1
Short Answers
1. Define Multimedia and their
features.
2. List out Multimedia Components.
3. Classify the TEXT component in
multimedia.
4. Classity the IMAGE component in
multimedia.
5. Define Animation and their features.
6. List out image file formats.
7. List out audio file formats.
8. List out video file formats.
9. Define Multimedia Production.

10.List out Multimedia Production

team members.

Part - II1
Explain in Brief Answer

1. Briefly explain about Multimedia
Components.
Chapter 1 Multimedia and Desktop Publishing
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Describe the features and techniques
of animation.

Write roles and responsibilities of
Production team members.

. Describe the various file formats in

multimedia .

Explain animation industry and
their scope.

Part - IV
Explain in detail

1.

Explain in detail Process of

Multimedia.

Explain in detail Techniques of
Animation.

Explore the opportunities Animation
filed movie industry.

Explain in detail about production
team Roles and Responsibilities.

Explain about different file formats
in multimedia files.
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CHAPTER

After the completion of this chapter, the student

learns about what Desktop publishing is.
creates documents using PageMaker
creates Text Blocks

changes a Text block size

2.1 Desktop Publishing

We hear and see the term ‘Desktop
publishing’ a lot these days. What
exactly is it? What does it mean? Desktop
publishing (abbreviated DTP) is the
creation of page layouts for documents
using DTP software.

Today, there are several Desktop
Publishing (DTP) software available in
the market. Some of the popular DTP
software are Adobe PageMaker, Adobe
InDesign, QuarkXPress, etc.

. - [
| !:! 7o oy 21 2ona7sag 70

Adobe PageMaker*7.0

Adobe InDesign

2020

inserts text from other software like MS-Word in the PageMaker document

uses frames to hold text in place of using text blocks and so many

2.2 Introduction to Adobe
PageMaker

Adobe PageMaker is a page layout software.
It is used to design and produce documents
that can be printed. You can create anything
from a simple business card to a large book.

Page layout software includes
tools that allow you to easily position
text and graphics on document pages.
For example, using PageMaker, you can
create a newsletter that includes articles

and pictures on each page. You can place

Figure 2.1 Various page layout softwares

‘ ‘ X1l CompApp_English version CHAPTER 02.indd 17
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pictures and text next to each other, on top of each other, or beside each other—wherever
you want them to go. Figure 2.1 shows various page layout softwares

2.3 Opening PageMaker

In the Windows 7 operating system, we can open Adobe PageMaker using the command
sequence Start—All Programs — Adobe — Pagemaker 7.0 - Adobe PageMaker 7.0.

The Adobe PageMaker window will be opened as shown in Figure 2.2

it Adobe PageMaker 7.0
File Edit Layout Type Element Utlites View Window Help

Dis[EA[ES[allAl T ol ariEl=E R e =] o] [He (Bl S[T[@ S E] 2
les N Calors™ »
EdEs=] T [100% ~]
k|T (<] (Hene) -
B, [ tPaper)
FE W (51ack) ]
Olm= M (Registration]
o|le [ &1 [ [}
ol® [ cyan =@
I Do o
Magenta EO -~
[
»
Type: IAI Types _‘ﬂ
@ Categony: IAni'naIs & Insects _:i @

i o —

Figure 2.2 Adobe PageMaker window

2.4 Creating a New Document

To create a new document,
1. Choose File > New in the menu bar. (or) Press Ctrl + N in the keyboard. Now
Document Setup dialog box appears.(Figure 2.3)

2. Enter the appropriate settings for your new document in the Document Setup dialog
box.

3. Click on OK.

T cChapter2 An Introduction to Adobe Pagemaker
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Document Setup 0K
Page size: lLeIter EI Cancel
Dimensions: [8.5 % |11 inches
Numbers...

Orientation: @ Tal  Wide

Options: [v Double-sided [~ Adust layout
[V Facingpages | Restart page numbering

Number of pages: |[| Start page #: I]
Margins
Inside: |1 inches Qutside: [0.75 inches

Top: |0.75 inches Bottom: |0.75 inches

T arget output resolution: |3DD VI dpi

Compose to printer: IMicmsofl XPS Document Writer on >ZI

Figure 2.3 Creating a New Document

Now a new document
called Untitled - 1 opens
on the screen as shown in
Figure 2.4.

A document page
is displayed within a dark
border. The area outside of
the dark border is referred to
as the pasteboard. Anything
that is placed completely
in the pasteboard is not
visible when you print the
document. You can use the
pasteboard to temporarily hold
elements while designing your
document.

Tool B
Title Bar 001 bar
£ Adobe PageMaker 7.0 - [Untitled-1] i =10 x|
Menu Bar <[ fie edt Layout Type Bement Utiites View Window Help =18 x|
CERBR AL TR D Bl EREeEeE sl ®
Ruler <, ot a b o A o A T TV, o e, O L R O B, |
-
= [x[T
Tool Box < o
EINE
2 [O=
El =
3 E18] — Black
i3 AN Border
E
:
E Pasteboard = 5
E (The pasteboard PageMaker Page =
L3 stores items for Q
3 later use.) o:
= o
3 =4
3
%
3 ' <1— Margins
11
3 (Margins appear as
12 dotted or pink lines.)
a6 o J of
Pages Horizontal scroll bar

Figure 2.4 Workspace
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The main components of the PageMaker window are Title bar, Menu bar, Toolbar, Ruler,
Scroll bars and Text area. Let us have a look at these components.

Title bar

£\ Adobe PageMaker 7.0 - [Untitled-1] _ -|I:I|ﬁ]

Figure 2.5 Title bar

It is the topmost part of the window. It shows the name of the software and the name of
the document at the left, and the control buttons (Minimize, Maximize and Close) at the
right.

In Figure 2.5 we can see the name of the software (Adobe PageMaker 7.0) at the left.
It is followed by the default name of the document(Untitled-1) which can be changed
when we save the document with a user-supplied name.

We know that on clicking the Minimize button the document window is minimised
to a small icon and kept in the task bar, Maximise button is used for maximising the
current document window to fit the whole screen area, and the Close button closes the
software itself.

Menu bar

® [i] Fle Edit Layout Type Element Utiites View Window Help ®
Figure 2.6 Menu bar

It contains the following menus File, Edit, Layout, Type, Element, Utilities, View,
Window, Help. When you click on a menu item, a pulldown menu appears. There may be
sub-menus under certain options in the pull-down menus. Refer Figure 2.6

Toolbar

If you place the mouse pointer on a button in the Toolbar, a short text will appear with its
description called “Tool Tip’. Refer Figure 2.7

Dle[R[@[aAlx[<[¥ma eE[EER R[] HR RO R[®[C[R[&]?

Figure 2.7 Toolbar

Toolbox

The Figure 2.8 shows the PageMaker toolbox.

To move the toolbox, drag the toolbox by its title bar. Select a tool from the default
toolbox by clicking it.

If the toolbox is not available on the screen, you can perform these steps to show the
toolbox.

IEID Chapter2 An Introduction to Adobe Pagemaker
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Pointer Tool

Rotating Tool

Line Tool

Text Tool

g}

=]
)
H
L

— Cropping Tool

Constrained Line Tool

Rectangle Tool

Rectangle Frame Tool

Ellipse Tool

Polygon Tool

Ellipse Frame Tool

Hand Tool

—]

—— Polygon Frame Tool

-|— Zoom Tool

SZ\olo(0|l/):
PIRIR|H| T

Figure 2.8 Toolbox

1. Click on Window. The Window menu will appear.
2. Click on Show tools.

toolbox, you can perform these steps to hide the toolbox.
1. Click on Window. The Window menu will appear.
2. Click on Hide tools to hide the toolbox.

The Keyboard shortcuts and Toolbox usages are shown in Table 2.1 & Table 2.2

The toolbox appears in front of your document window. If you want to hide the

O 0 N N Uk W N~

— =
= | =

2
Z
e

Tools

Pointer Tool

Rotating Tool

Line Tool

Rectangle Tool

Ellipse Tool

Polygon Tool

Hand Tool

Text Tool

Cropping Tool
Constrained Line Tool

Rectangle Frame Tool

Keyboard Short Cut
F9
Shift + F2
Shift + F3
Shift + F4
Shift + F5
Shift + F6
Shift + Alt + Drag Left mouse button
Shift + Alt + F1
Shift + Alt + F2
Shift + Alt + F3
Shift + Alt + F4
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Pointer Tool

|=

Used to select, move, and resize text objects

and graphics.
Text tool T I‘ Used to type, select, and edit text.
d'\y. .
Rotating tool e Used to select and rotate objects.
Cropping tool Used to trim imported graphics.
Line tool Used to draw straight lines in any direction.

Constrained line
tool

Used to draw vertical or horizontal lines.

Rectangle tool

Used to draw squares and rectangles.

Rectangle frame
tool

R [o] T[]

Used to create rectangular placeholders for
text and graphics.

Ellipse tool

Used to draw circles and ellipses.

Ellipse frame tool

Used to create elliptical placeholders for
text and graphics.

Polygon tool

Used to draw polygons.

Polygon frame tool

Used to create polygonal placeholders for

121 | [Z] | |2]|[o]|[® | [0

[
ik
+
o
+
+
+
+
+
+
+
+
M
@

text and graphics.

Hand tool Used to scroll the page (an alternative to
the scroll bar)

Taina ol Used to magnify or reduce an area of the

page.

Chapter 2 An Introduction to Adobe Pagemaker
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Scroll bars

Scrolling is the process of moving up
and down or left and right through
the document window. There are two
scrollbars namely Vertical and Horizontal
scroll bars for scrolling the document
vertically or horizontally.

Rulers

There are two ruler bars. One is at the top
and the other is at the left side.

To show the ruler
1. Click on View. The View menu will
appear.

2. Click on Show Rulers. Rulers appear
along the top and left sides of the
document window.

To hide the ruler
1. Click on View. The View menu will
appear.

2. Click on Hide Rulers to hide the
rulers.

2.5 Entering Text in the
Document

In PageMaker the text can be typed
inside a text block. So, you must use the
Text tool to create the text blocks. After
creating a Text block, you can type the
text directly into the text block. As the
characters are typed, the flashing vertical
bar called the insertion point or I-beam
which moves to the right. When the text
being typed reaches the end of the text
block, PageMaker will automatically wrap
the text to the next line. The Enter key
must not be pressed at the end of the each
line in text block. The Enter key should be
pressed only at the end of a paragraph or
when a blank line is to be inserted.

‘ ‘ X1l CompApp_English version CHAPTER 02.indd 23

2.6 Editing Text in the
Document

Editing means making changes to the text.
When you edit a document, you revise the
text. Editing may be inserting and deleting
words and phrases, correcting errors,
and moving and copying text to different
places in the document.

2.6.1 Selecting Text

Text can be selected using the mouse or
the keyboard.

Selecting Text using the mouse
To select text using a mouse, follow these
steps :
1. Place the Insertion point to the left
of the first character to be selected.

2. Press the left mouse button and drag
the mouse to a position where you
want to stop selecting.

3. Release the mouse button.

4. The selected text gets highlighted.

Double-click with I-beam

A Word

A Paragraph  Triple-click with I-beam

Selecting Text using the Keyboard
To select text using a keyboard, follow
these steps :

1. Place the Insertion point to the left of
the first character you wish to select.

2. The Shift key is pressed down and
the movement keys are used to
highlight the required text.

3. When the Shift key is released, the
text is selected.

Chapter 2 An Introduction to Adobe Pagemaker
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One character to the left Shift + «
One character to the right Shift + —
One line up Shift + T
One line down Shift +
To the end of the current Shift +End
line

To the beginning of the Shift +
current line Home
Entire Document Ctrl + A

2.6.2 Deleting Text

You can easily delete a character, or word,
or block of text.

To delete a character, do the following :
1. Position the insertion point to the
left of the character to be deleted.

2. Press Delete key on the keyboard.
(or)

3. Position the insertion point to the
right of the character to be deleted.

4. Press Backspace
keyboard.

key on the

To delete a block of text, do the following :
1. Select the text to be deleted.

2. Press Delete or Backspace in
the keyboard (or) Edit > Clear
command.

2.6.3 Undo Command

The Undo command is used to reverse the
action of the last command. To reverse
the last command, click on Edit>Undo in
the menu bar (or) press Ctrl + Z in the
keyboard.

Chapter 2 An Introduction to Adobe Pagemaker
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2.6.4 Copying and Moving Text

The Copy and Paste commands of
PageMaker can be used to copy text from
one location in a document and paste it
at another location. The Copy command
creates a duplicate of the selected text,
leaving the original text unchanged. The
Paste command pastes the copied text at the
position where the insertion point is placed.

The Cut and Paste commands can
be used to move text from one position
in a document to the other. The Cut
command deletes the selected text from
its original position. The Paste command
then places this text at the position where
the insertion point is placed.

Moving the Text

The selected text can be easily cut and
pasted in the required location.

To cut and paste text .

1. Select the text to be moved.

2. Choose Edit > Cut in the menu bar.
(or) Press Ctrl + X in the keyboard
(or) Click the right mouse button and
choose cut from the pop-up menu.

3. Insertion point is moved to the place
where the text is to be pasted.

4. Choose Edit > Paste in the menu bar.
(or) Press Ctrl + V in the keyboard.
(or) Click the right mouse button and
choose Paste from the pop-up menu.

The text can also be moved in this
way to another location.

The following keyboard shortcuts
can be used to move text

Ctrl + X > to Cut
Ctrl + V > to Paste
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Copying the Text

The selected text can be easily copied and
pasted in the required location.

To copy and paste text .
1. Select the text to be coped.

2. Choose Edit > Copy in the menu bar
(or) Press Ctrl + C in the keyboard
(or) Click the right mouse button
and choose Copy from the pop-up
menu.

3. Insertion point is moved to the place
where the text is to be pasted.

4. Choose Edit > Paste in the menu bar
(or) Press Ctrl + V in the keyboard
(or) Click the right mouse button
and choose Paste from the pop-up
menu.

The text can also be copied in this way to
another location.

Keyboard shortcuts for copy and paste:

Ctrl + C > to Copy
Ctrl + V > to Paste

2.7 Text Block

A text block contains the text you type,
paste, or import. You can’t see the borders
of a text block until you select it with the
pointer tool.

You can create text blocks in two ways:
1. Click or drag the text tool on the page
or pasteboard, and then type.
2. Click a loaded text icon in an empty
column or page.

2.7.1 Creating a Text Block with
the Text tool
To create a text block with the text tool:
1. Select the text tool (T) from the

toolbox. The pointer turns into an
I-beam. Refer Figure 2.9

i\ Adobe PageMaker 7.0 - [Untitled-1] |

(i) Fle Edit Layout Type Element Utiites View Window Help

Figure 2.9 Text creation using text tool
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2. On an empty area of the page or pasteboard, do one of the following:

Click the I-beam where you want to insert text. (Refer Figure 2.10) This creates a text
block to the width of the column or page. By default, the insertion point jumps to the
left side of the text block.

it Adobe PageMaker 7.0 - [Untitled-1] =10 x|

[E]) File Edit Layout Type Element Utiites View Window Help =8| x|

NMEFIENINEEEEOAEEEE

BEd

O 3

Computer is an

Z|olo]of/|[2]>

=4
«3 EED electronic device.
& P . a
S Ql
Figure 2.10
@ 3. Type the text you want. @

Unlike with a text frame, you do not see the borders of a text block until you click the
text with the pointer tool. Refer 2.11

X Adobe PageMaker 7.0 - [Untitled-1] =10 x|

[E] File Edit Layout Type Element Utiities View Window Help =8| x|

[D[S[R[S[a[A[A]~ [[ml[1 [[E[EE
..,!,.“., ...-. 5

Figure 2.11 Text borders
IETD Chapter2 An Introduction to Adobe Pagemaker
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2.7.2 Moving a Text Block

To move a block without changing its shape, place the cursor anywhere inside the block,
and click and drag it to the required position. Refer 2.12

i\ Adobe PageMaker 7.0 - [Untitled-1]

(i) Fle Edit Layout Type Element Utiites View Window Help

N
N
O
O
O

7

Figure 2.12 Moving a text block

2.7.3 Resizing a Text Block

When you select a text block with the Pointer tool, the block’s boundaries become
visible. Two handles are seen above and below the text block. These handles are called
Windowshades. There is a dark square on both ends of the handle. These are used to
change the size of the text block. Refer Figure 2.13 to Figure 2.15

|

n
i
]

Figure 2.13 Resizing text block-Step 1

Chapter 2 An Introduction to Adobe Pagemaker
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To resize a Text block

1. Click on the Pointer tool.
2. Click either the left or right corner handle on the bottom of the text block and drag.

When you release the mouse button, the text in the text block will reflow to fit the
new size of the text block.

i Adobe PageMaker 7.0 - [Untitled-1] ' -10| x|

[(f) Fle Edit Layout Type Element Utlites View Window Help =8| x|

|D|@|H|@Iﬂ"A|A‘| A'l?lﬂ"ﬂl”liglfglﬁl
i 4 RS, . RN, RO VOO, RO ROV VT O

Zl[]|8|K| T

Il

Figure 2.14 Resizing text block-Step 2

3. Ared triangle in the bottom windowshade means there is more text in the text block
than is visible on the page. Drag the windowshade handle down to show more text.

i\ Adobe PageMaker 7.0 - [Untitled-1]
[E] File Edit Layout Type Element Utiites View Window Help

PO E | EE[EE g
2 3 q 5

Figure 2.15 Resizing text block-Step 3
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2.7.4 Splitting a Text Block into two
To split a text block into two

1. Place the cursor on the bottom handle, click and drag upwards.
When you release the bottom handle will contain a red triangle. Refer Figure 2.17-18

S0l Al | |0 1 vo| 2 sl o] | @0 o | 812 | B @ @ © [

b 7

Figure 2.16 Splitting a Text block-Step 1

2. Click once on this, and the cursor changes to a loaded text icon.

7| S| s Al A x|V B 1] b= E|E B0 B =] 9| M) | B & B|[®]
3 2 1 0 1 2 3 q : 5 £ 7| 3 9 10
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]
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2|8 |

g

Figure 2.17 Splitting a Text block-Step 2
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3. Position this where the second part of the text is to be, and click.

@) File Edit Layout Type Element Utiities View Window Help

D|$|E|$|M|IA|A‘IA Iylnjlquwl -|«== »F.I REBEERE

|,I.|.I.|.2|.r.I.l.‘I‘l.I.lF'I-ILIl

“II“II“IIlIE”,I.lil.l.l.l.l.{.|.|.|.|.I.

Figure 2.18 Splitting a Text block-Step 3

2.7.5 Rejoining split blocks
To rejoin the two text blocks
1. Place the cursor on the bottom handle of the second text block, click and drag the bottom
handle up to the top.

2. Then place the cursor on the bottom handle of the first text block, and click and drag
the bottom handle down if necessary.

2.7.6 Placing (Importing) Text

You can insert text from other software program like MS-Word in to a PageMaker
document. Refer Figure 2.19 to Figure 2.22

1. Choose File > Place. The Place dialog box will appear.

(@) Fle Edit Layout Type Element Utiities View Window Help
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Links Manager... Sh~D

Figure 2.19 Importing Text
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2. Locate the document that contains the text you want to place and select it.

x
Look'n:l | My Documents :I - d"'
Name = Ivl Date modified I;lType -
.. Adobe 12/3/2018 6:52 AM File folde
.. Corel 12/3/2018 1:11PM File folde___
.. Custom Office Templates 12/2/2018 9:53PM File folde
1. CyberLink 12/3/2018 8:50 AM File folde
. My Palettes 12/3/2018 12:45... File folde
., Serif 12/3/2018 2:28 PM File folde »
4 I »
File name: [I Open l
Files of type:  |Importable Files ~| Cancel
Kind: WS source...
Size: Last modified: Place URL. ..
® ~ Place ~ Dptions ®
¥ As new item I~ Show filter preferences ¥ Corvert quotes
€ Replacing entire story ¥ | Betain format I” Beadtags
€ Inserting text ¥ Betain cropping Data

Figure 2.20 Document selection during import

3. Click on Open in the Place dialog box. Manual text flow

The po.iilter changes to the loaded text e DPosition theloaded texticon ata corner
icon (|25 ). of the area where you want to place
4. Make a text block to place the text. text, hold down the mouse button, and
(Or) Click in the page to place the drag to define the text block. Release
text. The text will be placed in the the mouse button.
page. e Text flows into the defined area. If
If the text to be placed is too big to fit there is more text than that fits in the
on one page, PageMaker allows you text block you defined, a red triangle
to place it on several pages. This can appears in the bottom windowshade
be done manually or automatically. handle.
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i Adobe PageMaker 7.0 - [Untitled-1]

[(f] Fle Edit Layout Type Element Utiites View Window Help
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Figure 2.21 Load Text

e Click once on this and the loaded text icon reappears. Now generate a new text block

® and click. Repeat this process until there is no more text to place. ®
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Figure 2.22 Continue loading text
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Similarly if you want to place the
text in a page, position the loaded text
icon at the top of the page and click. Text
flows into the page. If there is more text
than fits in the page, a red triangle appears
in the bottom windowshade handle.

Click once on this and the loaded
text icon reappears. Now generate a new
page (or pages) by selecting Layout >
Insert Pages in the menu bar. Place the
loaded text icon at the top of the next page
and click. Repeat this process until there
is no more text to place.

Automatic text flow

Before importing the text, first select
Layout > Autoflow in the menu bar.
Then you should import the text. Now
the loaded text icon looks different - it

contains a squiggly arrow(m ).
Place the loaded text icon at the top
of the page and click. Now the text will

automatically flow on to the succeeding
pages, creating new ones, if necessary.

2.8 Understanding story

APageMakerstoryissimilartoanewspaper
article. The front page of a newspaper
may contain several independent articles,
some of which continue on other pages. In
PageMaker, several stories may appear on
the same publication page and continue
elsewhere in the publication.

2.9 Threading text blocks

All text in PageMaker resides inside
containers called text blocks.

A Text block can be connected to
other text block so that the text in one text
block can flow into another text block.

‘ ‘ XIl CompApp_English version CHAPTER 02.indd 33

Text blocks that are connected in this way
are threaded. The process of connecting
text among Text blocks is called threading
text. Text that flows through one or more
threaded blocks is called a story.

Once you have a loaded text icon,
you can use one of three text-flow options
to place text in text blocks.

To cancel a loaded text icon, click the
pointer tool in the toolbox, now the text is
deleted.

A threaded text block can be
identified by a plus sign in its top and/or
bottom handles. Refer Figure 2.23-Fig 2.25

Unthreaded textiswhereatextblock
stands alone, without being connected
to any other block. These blocks have
nothing in their top and bottom handles.

|

:-: SEIIIIIIIIITIIIIIIITIiniiiCcaiiiiic :: SEIIIIIITISIEIIIIIEIIISIIIININICIIININ :

Figure 2.23 Unthreaded text

U

Figure 2.24 Threaded text-1
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Figure 2.25 Threaded text-2

2.9.1 To unthread a threaded
block

Method - 1:

Select the block that you wish to unthread
with the pointer tool. Click on Edit > Cut
in the menu bar.(the block disappear). Now
click on the Edit > Paste in the menu bar. The
block will reappear in the same position, but
it is now an unthreaded block.

BEWARE: if the block is in the
middle of a story, say the second
of the three, the first block is now
threaded directly to the third.

Chapter 2 An Introduction to Adobe Pagemaker
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Method - 2:

Select the block that you wish to unthread
with the pointer tool. Then choose the
Text tool and select all the text in the
block. Then click on Edit > Cut in the
menu bar.(the block disappear). Now
click the insertion point within an existing
threaded block. Then click on Edit > Paste
in the menu bar. The text will be added in
this block.

2.10 Placing Text in a Frame

You can also use frames to hold text in
place of using text blocks. Refer Figure 2.26
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To place text in a Frame

. Locate the document that contains

the text you want to place, select it.

1. Click on any one Frame tool from
the Toolbox. . Click on Open.

2. Draw a frame with one of PageMaker’s . Click inside the frame to place the
Frame tools (Rectangle frame tool or text in it.
Ellipse Frame Tool or Polygon frame , ,
Tool). Make sure the object remains The text will be placed in the frame.
selected.

3. Click on File > Place. The Place
dialog box will appears.

L Pt o W N 0 N R S e A N | LR e Mk el e S il | i T P OB Sl PN T e A T P ol N § ) P

E Untitled-3 |

10

11

], 4 3 2 0 1

g 6| 2 8 9 10 1

the most powerful
weapon which you can
use to change the world -
Mandela.

Nelson

Education is not
for ife; education islife
itself - John Dewey.

preparation

4
ol
—~—

Figure 2.26 Place text in a Frame

~ @ In PageMaker, text and graphics that you draw or import are called objects.

® An object can be on a page or on the pasteboard.

® Text can be contained either in text blocks or text frames.
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2.10.1 Linking Frames containing

Text

A single frame may not be large enough to

hold an entire story when you are using a

large amount of text, you can link frames
together so that an entire story is visible.

To link Frames containing text

X Adobe PageMaker 7.0 - [Untitled-1]
[i) Fie Edt Layout Type Element Utiites View Window Help

. Draw a second frame with the

Frame tool of your choice.

2. Click the first frame to select it.
. Click on the red triangle to load the

text icon.

. Click the second frame. PageMaker

flows the text into the second frame.
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Figure 2.27 To link Frames containing text

2.10.2 Converting text in a Text block to a Frame

After created text in a text block, if you

want to convert it to a frame. You can do
this by using these steps.

1.

Draw the frame of your choice using
one of the PageMaker’s Frame tool.

Select the text block you want to
insert in the frame.

Chapter 2 An Introduction to Adobe Pagemaker
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3. Click the frame while pressing the

Shift key. Now both elements will be
selected.

. Choose Element > Frame > Attach

Content on the Menu bar.

5. Now the text appears in the frame.

Refer Figure 2.28
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Figure 2.28 Converting text in a Text block to a Frame

2.10.3 Separating Text from the
Frame

Once text has been attached to a frame or
flowed inside it, you can separate the text
and frame.

To separate text from a frame

Click the frame with the Pointer tool.

2. Choose Element > Frame > Delete
Content in the menu bar. The text
will not appear in the frame.

2.11 Saving, Closing and
Opening Documents

The below section explains about various
operations with the documents.

2.11.1 Saving a Document

You can save your document for future
use. Saving a document allows you to
review later and edit the document. Saved
file can be used on other computer also.

To save a document for a first time
following steps are used:

1. (a) Choose File > Save in the menu
bar. (or)
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(b) Click on the Save icon(ﬂl) in
the Tool bar. (or)

Press Ctrl + S in the Keyboard.

(c) A Save Publication dialog box as

shown in the Figure 2.29 appears on ®
the screen.
£ save Publication: Untitled-2 ] x|
Saveh:lg My Documents _vj@@ﬁ.
Neme = | -| pate modified |~ -
1. Adobe 12/3/2018 6:52 AM  File folde
| Corel 12/3/2018 1:11PM  File folde
| Custom Office Templates 12/2/2018 9:53PM  File folde
1. CyberLink 12/3/20188:50 AM  File folde
|| My Palettes 12/3/2018 12:45... File folde
. Serif 12/3/2018 2:28PM  File folde »
< | 3|
Save as type: |Publication | Cancel I
Copy:
% No additional files

" Files required for remote printing
€ Al finked fles

Figure 2.29 Saving a Document

2. The file name is given in the File
name list box.

3. Then click on the Save button to
save the document. The document
is now saved and a file name appears
in the title bar.

Chapter 2 An Introduction to Adobe Pagemaker
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Once a file is saved under a name,
to save it again the name need not be
entered again. The file can be saved simply
by selecting the File > Save command or
by clicking the Save button (or) clicking
Ctrl + S in the keyboard.

2.11.2 Saving a Document
with a new name or in a
different location
You can save a document with a new
name or in a different location using
Save As command. Save As command
creates a new copy of the document. So,
two versions of the document exist. The

versions are completely separate, and the
work you do on one document has no
effect on the other.

To save a document with a new
name or in a different location:

1. Choose File > Save As in the menu
bar. (or) Press Shift + Ctrl + S in the
keyboard.

Now Save Publication dialog box
will appear. Refer Figure 2.30

2. Type a new name or specify a new
location.

3. Click the Save button.

New. ., N i Save Publication: Untitled-1 3 |
e " Savein: [ 7 My Documert -« @k B
Recent Publications y in: | |£| My Documents =~
o Name = leDaten!o:iﬁad |v|T'rpe ‘l
Cloge W ?
i e Adobe 12/3/2018 6:52 AM  File folde
| ., Corel 12/3/2018 1:11PM File folde
T o —— e
| Cyberlink 12/3/2018 8:50 AM  File folde
Place, ., > My Palettes 12/3/2018 12:45... File folde
| Serif 12/3/2018 2:28PM File folde &
Acquire 4 4 l S I l’J
Export. .. »
Links Manager...  Sh*D i — ] Save I

Document Setup, ., Sh7P
Printer Styles 3

Save as type: IPubﬁcation

j Cancel |

" No additional files

" Files required for remote printing
€ Alllinked fles

Print... ~p Copy:
Preferences, .. L

Send mall...

Exit ~Q

Figure 2.30 Saving a Document with a new name or in a different location

2.12 Closing a Document

After a document is saved, it is not closed. It
remains open so that the user can continue
working. When the work is finished, the
user should save and close the document.

After saving, the document can be
closed using the File > Close command in
the menu bar (or) Ctrl +W in the keyboard.

Chapter 2 An Introduction to Adobe Pagemaker
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2.13 Opening an existing
Document

To open a document that has been saved
and closed the following steps are used:

1. (a) Choose File > Open in the menu
bar (or)

Click on the Open icon (E‘) in the
Tool bar (or)
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Press Ctrl + O in the Keyboard.
A Open Publication dialog box as

combination is joined with a plus sign, the
tirst key must be pressed and held down
and the second key is to be pressed.

shown in the figure 2.31 appears on

x Move Press
Lookh:‘ F| My Documents :I = B kB
N & (+| Date modified |~ = One character to the Left Arrow
. Adobe 12/3/2018 6:52 AM  File folde left
. Corel 12/3/2018 1:11PM  File folde
, Custom Office Templates 12/2/2018 9:53PM  File folde
| Cybertink 12/3/2018 8:50 AM il folde One character to the Right Arrow
. My Palettes 12/3/2018 12:45... File folde . ht
| Serif 12/3/2018 2:28PM  Fie folde rg
4| | >
mereme: (o] One word to the left Ctrl + Left Arrow
Fles of type: - Cancel . .
o I iz NG One word to the right ~ Ctrl + Right Arrow
Open a3
(“ il gL Up one line Up Arrow

Figure 2.31 Opening an existing Document

2. The file name is given in the File

Down one line

Down Arrow

list b To the end of a line End
name list box.
The name of the file to be opened EO the beginning ofa  Home
can be chosen from the list, which is e
® displayed. Up one paragraph Ctrl + Up Arrow @
3. Then click on the Open button. Down one paragraph  Ctrl + Down
Now the required file is opened. Arrow

2.14 Moving Around the
Document

We can move the insertion point to
anywhere in the document by using the
mouse or the Keyboard.

To move the insertion point with
the mouse, the mouse pointer is moved to
the required spot and the mouse button is
clicked. The insertion point jumps to that
spot. It is to note that mouse pointer is
different from the insertion point.

To move the insertion point with
the keyboard the arrow keys and other key
combination can be used.

The below Table 1.1 lists the
common movement keys. If the key

‘ ‘ X1l CompApp_English version CHAPTER 02.indd 39

2.15 Scrolling the Document

In PageMaker, there are two sets of scroll
bars; one for up and down movement and
the other for the left and right movement
of the document.

PageMaker’s scroll bars work differently
than those in a word processor. Note that
they are set to the center of each bar. Also,
they scroll only the page you are currently
on. Use the scroll bar on the right side to
move up and down. Use the scroll bar at
the bottom to move left and right.

The scrolling procedure is as follows:

1. To scroll left and right the left and

right arrow respectively should be
clicked.

Chapter 2 An Introduction to Adobe Pagemaker
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2. To scroll up and down the up and
down arrow respectively should be
clicked.

3. To scroll a relative distance in the
document the scroll box should be
drawn up or down.

2.16 Magnifying and
reducing with the zoom
tool

Use the zoom tool to magnify or reduce
the display of any area in your publication.
You can also double-click the zoom tool
to jump to Actual Size, or press Alt as
you double-click the tool to go to Fit in
Window view. Refer Figure 2.32

To magnify or reduce with the zoom
tool:

1. Select the zoom tool.

The pointer becomes a magnifying
glass with a plus sign in its center,
indicating that the zoom tool will
magnify your view of the image.
(The magnifying glass shows a
minus sign in its center when in
reduction mode.) To toggle between
magnification and reduction, press
the Ctrl key.

2. Position the magnifying glass at
the center of the area you want to
magnify or reduce, and then click to
zoom in or out.

Continue until  the
publication is at the magnification
level you want. When the publication
has  reached  its

clicking

maximum
magnification or reduction level,
the center of the magnifying glass
appears blank.

Chapter 2 An Introduction to Adobe Pagemaker
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To magnify part of a page by
dragging:
1. Select the zoom tool.

2. Drag to draw a marquee around the
area you want to magnify.
To zoom in or out while using
another tool:

Press Ctrl+Spacebar to zoom in. Press
Ctrl+Alt+Spacebar to zoom out.
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Figure 2.32 To magnify or reduce with the zoom
tool

2.17 Formatting a Document

Formatting is the process of changing
the general arrangement of text, i.e.,
improving the appearance of the text by
using various fonts, font colors, and font
styles. A font is a set of letters, numbers or
symbols in a certain style. Each font looks
different from other fonts.
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2.17.1 Character Formatting
using Character
Specifications Dialog Box

Character formatting means displaying

text in a certain way. Character formatting

consists of text properties - bold, italic,
underline, font type, font size, font color,

etc. Refer Figure 2.33, 2.34 and 2.35

The steps to character

apply
formatting to text are as follows :

1. Select the text to be formatted.

2. Choose Type > Character in menu
bar (or) Press Ctrl + T on the
keyboard.

The Character Specifications dialog
box appears.

x|
Font: Times New Roman OK
Size: [12 =] points  Posiion: [Nomal  ¥| Cancel
Leadng |40 ¥ points Case:  [Nomal  ¥| ‘U—m—m—
Horiz scale: |Nomal w| % Track: Notrack ~ —_
Color.  [Black ~| Lneend: [Break v
Tint [100 ~Jx
Type style: [V Normal I~ Italic ™ Reverse

I~ Bold I~ Undefine I~ Stikethru

3. Make the appropriate changes in the
dialog box.

e Click the drop-down menu
arrow of the Font box and
select the desired font.

e Click the drop-down menu
arrow of the Font Size box and
select the font size.

e Click the drop-down menu
arrow of the Font Color box
and select the desired color.

e Click the Bold, Italic, or
Underline buttons to make the
text bold, italic, or underlined
respectively.

4. Click on OK.

Figure 2.33 Character Formatting using Character Specifications Dialog Box

2.17.2 Character Formatting
using the Control Palette

The Control Palette is especially useful

when you are doing lot of formatting.

Its features change based on the
object that is selected on your layout.

If the Control palette is not showing then
use the following steps:
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1. Click on Window > Show Control
Palette sequence in the menu bar.

(or)
2. Press Ctrl + “ in the keyboard.

Now the Control Palette appears on
the window.

Chapter 2 An Introduction to Adobe Pagemaker
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To modify character attributes using the Character Control Palette:
1. Select the text you want to modify.
2. Make the appropriate changes in the Control palette. Refer Figure 2.34

Font Font Size Tracking

A A A

Times New Roman |v |[EEIT 12~ || 2¢ [No Track _|v |[F]%
NBZ[U]RECICI2[F] MRk [14.4 | [v|E6] X [100%, |~ |EE14 (0 in

s

\/ \ 4 \ /
/ / Small Caps Leading  Horizontal Baseline

i Scale Shift
ltalic  ynderline

Bold

Figure 2.34 Character Control Palette
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Font:
) . / Alrial Black ®
3 1 Bold
3 /TamFl Nadu—
: -, |
2 | / Underlined
E i
Font Size
2

¥ Adobe PageMaker 7.0 - [Untitled-1] ) =101 x|
@mmtumrmeammtmmmmmb _[_|_|
FEFED| IﬁlaﬂnlAlA-la |»|.v|uu« SiE -izafzsﬂlmln;l-l--l@?lm BIED B
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Figure 2.35 Modify character attributes using the Character Control Palette
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2.17.3 Changing Text Colour

You can change the colour of the text.
Your design may look beautiful if you
choose a text colour other than black.

To colour characters

1. Select the text you want to colour.
2. Choose Window > Show Colors
in Menu bar. The Colors palette
appears. Refer Figure 2.36
Click the colour you want to apply
to the selected text.
The characters change to the
colour you selected in the palette.
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Figure 2.36 Colors palette

2.18 Drawing

There are so many drawing tools in
PageMaker. Line tool, Rectangle tool,
Ellipse tool and Polygon tool are four
main drawing tools.

2.18.1 Drawing Lines

The
first one creates a straight line at any

PageMaker has two Line tools.

orientation. The second is a constrained

‘ ‘ X1l CompApp_English version CHAPTER 02.indd 43

Line tool that draws only at increments of
45 degrees. You can change the property
of tools by double-clicking on them. Refer
Figure 2.37 to Figure 2.40

To draw a line

1. Select the Line tool from the toolbox.
The cursor changes to a crosshair.

2. Click and drag on the screen to draw
your line. As you drag, a line appears.

Chapter 2 An Introduction to Adobe Pagemaker
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3. Release the mouse button and the
line will be drawn and selected, with
sizing handles on either end.

Resize the line by clicking and
dragging the handles, if necessary.

e £ot Lot e Sorent Uit Vew Wndow b I8|
FMEFBONEEEGE GEEEERRE
NI o0l s a8 G T I R
:
= (A [T

BIL!

\ =

] ]

OlD

o
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Sk EFEE TR

Figure 2.37 Drawing Lines

To draw a Dotted line

1. Double click the Line tool from the
toolbox. A Custom Stroke dialogue
box appears.

]
Stroke style: Il ] '[ | oK I
Stroke weight: |15 points Cancel I

¥ Transparent background

I Reverse

Figure 2.38 Custom Stroke

2. Select the required Stroke style in
the drop-down list box.

Custom Stroke x|

Stroke style:

——— | 0K

Stroke weight: L Cancel
I\-l' TIWP&BVJ IIIIIIIII&

RPN PSN Y ¥

[~ Reverse

Figure 2.39 Stroke style

Chapter 2 An Introduction to Adobe Pagemaker

‘ ‘ X1l CompApp_English version CHAPTER 02.indd 44

3. Then click OK button. Now the
cursor changes to a crosshair.

4. Click and drag on the screen to draw
your dotted line. As you drag, the
line appears.

5. Release the mouse button and the
line will be drawn and selected, with
sizing handles on either end.

Resize the line by clicking and
dragging the handles, if necessary.

[ Fi= Edt iyt Type Sement Ubibes View Window Hep e
[CERIEB[ALX < ZBl[aE e Bl | Ha R e[le[el
11 T PP T N ) . REYOTIC T IO, P o oo ey WL NG, e e 0|
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e ’,
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[6 3 o‘
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3 ’o.

3 L]

fa =

Figure 2.40 Dotted line

2.18.2 Drawing Rectangles or
Ellipses

You can also draw rectangles and ellipses

shapes by using the same technique as used

in line drawing. Refer Figure 2.41 and 2.42

1. To draw a rectangle or ellipse:
Click on the Rectangle or Ellipse
tool from the toolbox.
The cursor changes to a crosshair.
2. Click and drag anywhere on the
screen. As you drag, a rectangle or
ellipse appears.

3. Release the mouse button when the
rectangle or ellipse is of the desired
size.

Press the Shift key while you’re
drawing to constrain the shape to a
square or circle.
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Figure 2.41 Draw a Rectangle or Ellipse

Drawing a Rounded Corner
Rectangle

To draw a rounded-corner rectangle:

1.

Double-click the Rectangle tool in
the toolbox.

The Rounded Corners dialog box
appears.

. Choose a corner setting from the

preset shapes.

. Click on OK. The cursor changes to

a crosshair.

Click and drag anywhere on the
screen.

Release the mouse button when the
rectangle is the desired size.

Press the Shift key as you draw to
constrain the shape to a rounded-
corner square.

BEREEE

Figure 2.42 Draw a Rounded Corner Rectangle
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2.18.3 Drawing Polygon
To draw a Polygon
1. Click on the Polygon tool from the
toolbox.

The cursor changes to a crosshair.

2. Click and drag anywhere on the
screen. As you drag, a Polygon
appears.

3. Release the mouse button when the
Polygon is of the desired size. Refer
Figure 2.43

cEd

IZ|[©[0[0]~]

B EEE D

Figure 2.43 draw a Polygon

Chapter 2 An Introduction to Adobe Pagemaker
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2.18.4 Drawing a Star using
Polygon tool

To draw a Star
1. Click on the Polygon tool from the
toolbox.

The cursor changes to a crosshair.

2. Click and drag anywhere on the
screen. As you drag, a Polygon
appears.

3. Release the mouse button when the
Polygon is of the desired size.

4. Choose Element > Polygon Settings
in the menu bar.

Now Polygon Settings dialogue box
appears.

5. Type 5 in the Number of sides text
box.

6. Type 50% in Star inset textbox.

Click OK. Now the required star
appears on the screen. Refer
Figure 2.44 - 2.46

layout Type | Element Utiities View Window Help

Align Objects,,,  ShPE
Text Wrap... Alt"E
Group G
|| Ungroup ShoG
Lock Position 3, &
Unlock AlesL
Mask ~6
Unmask sh”6
Image » -
Polygon Settings...
Rounded Corners,..
Linl TofA

Figure 2.44 Drawing a Star using Polygon tool
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Numberof sides: |5 [~ Preview——— | 0K
Kij | 2 Cancel

Star inset [50 %

T

Figure 2.45 Polygon tool setting

L/_"JWWIQI
>

Figure 2.46 Polygon

ﬁ]‘ Star Inset percentage bends the
?

polygon lines inwards to form a
star-shaped object.

Drawing a star with given number of
sides and required inset

1. The value of ‘Star inset’ is 50%
The number of sides is 15

The result of the star shape is shown

Figure 2.47.
+

Figure 2.47 Drawing a star-1
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2. The value of ‘Star inset’ is 25%
The number of sides is 25

The result of the star shape is shown
Figure 2.48.

P

Figure 2.48 Drawing a star-2

3. The value of ‘Star inset’ is 35%
The number of sides is 70

The result of the star shape is shown
Figure 2.49.

Figure 2.49 Drawing a star-3

2.18.5 Filling Shapes with
Colors and Patterns

Filling Rectangle with colour
1. Draw a rectangle using Rectangle tool.
2. Select the rectangle.

3. Choose Window > Show colors in
the menu bar. (or) Press Ctrl + ]

Now Colors palette appears.

4. Click on the required colour from
the Colors Palette.

5. The rectangle will be filled with the
colour. Refer Figure 2.50 and 2.51
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geMaker 7.0 - [Untitled-1]
Layout Type Element Utilities \ﬂew]\mﬂow Help
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Hide Tools

Hide Control Palette ~ ~'

MI
Show Styles ~B

Show Layers ~8
Show Master Pages Sh”8
———  Show Hyperlinks g
Plug-in Palettes >
0 v Untitled-1

Figure 2.50 Show colors
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Figure 2.51 Filling Shapes with Colors and
Patterns

2.19 Working with pages

The main purpose of PageMaker is
composing pages. You can insert new
pages into a document, remove existing
pages, move between pages, and sort pages

in a large document.

2.19.1 Going to a
specific Page
PageMaker provides several methods

for navigating through the pages in
your publication.

Chapter 2 An Introduction to Adobe Pagemaker
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Method 1:

You can move from one page to another
by using the Page up and Page down keys
on your keyboard. This is probably the
navigation methods you will use most often.

Method 2:

You can move from one page to another
by using the page icons at the left bottom
of the screen. Click on the page icon that
corresponds to the page that you want to
view. The page is displayed.

Method 3:

Using the Go to Page dialog box. Refer
Figure 2.52 and 2.53

To go to a specific page in a document
1. Choose Layout > Go to Page in the
menu bar (or) Press Alt + Ctrl + G
in the keyboard. Now the Go to Page
dialog box appears.

Edit | Layout Type Element Utlites View Wi

w
Ju

Jl 3

B) GoBack  ~PgUp
[y T GoForward ~Pabn
|  Column Guides...
=r—  (Coov.Master.Guides ‘

Figure 2.52 Go to page

2. In the dialogue box, type the page
number that you want to view.

X
Goto: (¢ Page number I
" Master page IDocument Master ;I Cancel I

Figure 2.53 Type page number
3. Then click on OK. The required page
is displayed on the screen.

Chapter 2 An Introduction to Adobe Pagemaker
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2.19.2

You can add more pages toadocument. You
can insert pages before, after, or between
the pages you’re currently viewing. When
you insert pages, PageMaker automatically
renumbers the pages in your publication.
Refer Figure 2.54 and 2.55

Inserting Pages

To insert pages

1. Go to the page immediately before
the page you want to insert.

2. Choose Layout > Insert Pages in the
menu bar. The Insert Pages dialog
box appears.

i) Adobe Pag_el—iaker 7.0 - [Untitled-1]
[E) File Edit | Layout Type Element Utiities View Window Help

[D[S[E gorse ats FTo] q [pi=[e =] D[m[B] e[
‘ll]r|2|l||I?lI||I|4|I||IS|I|.|ISE|I||I?|I||I

il

Remove Pages...
Sort Pages...
Go Back “Pglp

GoForwerd  ~Paln

Column Guides. ..

Copy Master Guides

v Autofiow

Figure 2.54 Insert Page

T T A AT T A

3. Type the number of pages you want
to insert.

4. To insert pages after the current
page, choose ‘after’ from the pop-up
menu.

5. Click on Insert button.

x
Insert I pagels) Iafler 'I the current page.

Master page:

INone El

[~ Set left and right pages separately

coce | [t ]

Figure 2.55 Insert page settings

6. The new pages are inserted in your
publication.
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2.19.3 Removing Pages

You can remove the unused pages from your
document using Remove Pages dialog box.

1. Choose Layout > Remove Pages in
the menu bar. The Remove Pages
dialog box appears. Refer Figure 2.56
and 2.57

i ¥ Adobe PageMaker 7.0 - [Untitled-1]

File Edit | Layout Type Element Utii

Dl L2 o ™
o
2
Sort Pages...
1
Go Back “Pglp
LU Go Forward ~Pabn

Y

Column Guides...
Copy Master Guides

5]

v Autoflow

L

Lotabetelote ottt et gl

Figure 2.56 Remove pages

2. Type the page range you want to
remove.

Remove pages

Remove pagels)
through: |1

X|

0K

Cancel

Figure 2.57 Remove pages settings

3. Click on OK button.

2.20

Any text or object that you place on
the master page will appear on all the

Master Pages

document pages to which the master is
applied. It shortens the amount of time
because you don’t have to create the
same objects repeatedly on subsequent

pages.

‘ ‘ X1l CompApp_English version CHAPTER 02.indd 49

Master Pages commonly contain
repeating logos, page numbers, headers,
and footers. They also contain nonprinting
layout guides, such as column guides,
ruler guides, and margin guides.

A master item cannot be selected
on a document page.

You can create, modify, and delete
objects on master pages just like any other
objects, but you must do so from the
master pages themselves.

At the lower left corner of a
document (publication) window you can
find an icon which represents the master
pages. The letters L and R (L denotes left
and R denotes right) mark the master
page icon for facing pages. A single-sided
publication icon is marked by an R alone.
Refer Figure 2.58

= ®
g =
5=
=

= Master  Pages

= Icon —
15|
AN .

ik gl

Figure 2.58 Master Pages
2.20.1 Inserting Page Numbers

in Master Pages
To make page numbers appear on
every page
1. Click on Master Pages icon.
2. Then click on Text Tool. Now the
cursor changes to I - beam.
3. Then Click on the left Master page

where you want to put the page
number.

Chapter 2 An Introduction to Adobe Pagemaker

1/5/2022 1:19:43 PM‘ ‘



B [ ® H .  EEEm

- www.thtextbooks.in

4. Press Ctrl + Alt + P.

5. The page number displays as ‘LM’ on the left master page.

6. Similarly click on the right Master page where you want to put the page number.

7. Press Ctrl + Alt + P.

8. The page number displays as ‘RM’ on the right master page, but will appear correctly

on the actual pages. Refer Figure 2.59

o adobe Pagedaker 2.0 - [Untitled-1] =iofx o ndobe Pagedaker 1.0 - [Untited-1] =ojz
[ Fie B Lot Type Benent Uitis Von Wecox e =IE(x| [Elﬁ:afru,wtmmummmkb =IE1x|
El[f 1A AT T8 I‘laiﬁtﬁiiﬁnlaj_liw'lﬂj_ﬁilgﬂq-:” ID sluS[AT Al 1Tl v M e R4 ]B: :EN:WT@EQE@JQL

’5 . 5_ J
IHE £ ot L|ﬂ Ll 4 i L|j
@ Figure 2.59 Inserting Page Numbers in Master Pages @
2.20.2 Hiding Master Items 2.20.3 Showing Master Page

Palette
Master Pages palette organize all the
command you will need to work with
Master Pages. Refer Figure 2.61 and 2.62
To show Master Page Palette
1. Choose Windows> Show Master
Pages in the menu bar. The Master

To make the master items invisible on a
particular page, switch to the appropriate
page, then choose View > Display Master
items (which is usually ticked). Refer Fig 2.60

nent Utilities | View Window Help

A v Display Master [tems
| | v Display Non-Printing Ita‘ns

Pages Palette appears.

:
| Bl

Zoom In ek
Foom Okt e tlities View I Window Help
Actual Size ~1 | Arrange Icons =5
v Fitin Window 0 ] 2 Tile
Entire Pasteboard sh~0 “-'L“L'“-l'-“h-"-l"*h“ Cascade
Zoom To 2 Hide Tools
Show Control Palette
Hide Rulers AR .
Snap to Rulers Alt"R. Show Colors i |
Zero Lock Show Styles s g
Show Layers "‘8
s Guides_ K Show Master Pages Sh*
¥ Snap to Guides Sh7; Show Hyperlinks ~g h I
Figure 2.60 Hiding master page items Figure 2.61 Master page palette
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Applying Master Page

ENERY

Master Pages tab  Master Pages List

[Document Master]

d_ﬂiﬂ

Pop-up Menu

Applying Master Page Bl | T |/

New Master Page Delete
Pages icon Icon

Figure 2.62 Master page

2.20.4 Creating Master Pages

By default, all Pagemaker documents have
a Master Page already created ‘Document
Master’. But sometimes you will require

more than one Master Page.

You can set up multiple master pages
for any publication, each page containing
a specific combination of headers, footers,
page numbers, frames, and other elements

that you want to use over and over.

‘ ‘ XIl CompApp_English version CHAPTER 02.indd 51

When you create a new Master

Page, you will be asked to name the new
Master page and set its margins and
column guides.

To create a new Master Page

1. Click the New Master Page icon in
the Master Pages palette. The New
Master Page dialog box appears.

2. Enter the name of the new master
page in the Name field.

3. Make the appropriate changes in the
Margins and Column Guides fields.

4. Click on OK. A new Master Page
appears in the Master Pages palette.
Refer Figure 2.63 and 2.64

New ste Pge
[None] Delete "one
[Docurnant Master] Ouplcate None
Master Page Options,,
Save Page as...
| Applying Master Page | | i |é Prompt on Apply
Adjust Layout

Figure 2.63 Create master pages

x|

" One page

Name: [ ¢ Two page
— Margins

Inside: |T inches
Top: Ill 75 inches

Outside: |2.75  inches

Bottom: IU-75 inches

— Column Guides——
Columns: |1 I‘I
Space between: [0.1 67 inches 0.167 inches

Cancel |[ oKk |

Figure 2.64 Master page setting

Chapter 2 An Introduction to Adobe Pagemaker

1/5/2022 1:19:44 PM‘ ‘



____IEEEN ®

www.tntextbooks.in

2.21 Print a document

1.

Choose File > Print in the menu bar
(or) Press Ctrl + P in the keyboard.
The Print Document dialog box
appears.

. Choose the settings in the Print

Document dialog box as

e Select the printer from the
Printer drop-down list box.

e Choose the pages to be printed
in the Pages group box by
selecting one of the following
available options :

All: This option prints the whole

document.

Ranges: This option prints individual

pages by the page number or a range
of pages.

You can use commas to separate the
page numbers

(e.g., 5,7,19).

Use a hyphen to print page
ranges(e.g., 10-17; this will print all
pages from page numbers 10 to 17).
To print from a particular page to
the end of the document, enter the
starting page number followed by a
hyphen (e.g., 5 - ).

You may also combine individual
page numbers and a range of pages
(e.g., 5,9, 15-26).

Print:  You can also print only odd-
numbered or even-numbered pages.
Select the Odd pages or Even pages
option from the Print drop-down
list box. Refer Figure 2.65

Print Document R '|
Printer: |Hicmsolt XPS Document Writer on XPSPort: :I Print
[~ Collate —
anc
[~ Reverse
Copies: |1 [ [Proot
S P gos I Document
= Al Print: |Both Pages LI Setup...
" Ranges: |1 I~ Reader's spreads Options
[~ Ignore "Non-Printing" setting I~ Print blank pages Color
~ Book Orientation Feat
ealures
[~ Prnt all publications in book Ig -
I” Use paper settings of each publication w Resot

Figure 2.65 Print Document setting
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e Type the number of copies you If the Collate option is selected,
want in the Copies text box. PageMaker will print a complete set
e You can choose whether to of pages 1 to 5, then a second set,
collate the pages or not. Suppose and so on.
you want to print 4 copies of a 5 4. After choosing from the options in
pages document. the Print Document dialog box,
If the Collate option is not selected. click Print  button to print the
PageMaker will first print 4 copies of document. Make sure the printer is
page 1, then 4 copies of page 2, and switched on.
O on.

POINTS TO REMEMBER

e Desktop publishing (abbreviated DTP) is the creation of page layouts for documents

using DTP software.

Some of the popular DTP software are Adobe PageMaker, Adobe InDesign,
QuarkXPress, etc.

Adobe PageMaker is a page layout software. It is used to design and produce documents
that can be printed.

The area outside of the dark border is referred to as the pasteboard.

Editing means making changes to the text. When you edit a document, you
revise the text.

A text block contains text you type, paste, or import. You cannot see the borders
of a text block until you select it with the pointer tool.

A Text block can be connected to other text block so that the text in one text
block can flow into another text block. Text blocks that are connected in this
way are threaded.

The process of connecting text among text blocks is called threading text.
Text that flows through one or more threaded blocks is called a story.

Any text or object that you place on the master page will appear on all the
document pages to which the master is applied.

Master Pages commonly contain repeating logos, page numbers, headers, and
footers.

A master item cannot be selected on a document page.

Chapter 2 An Introduction to Adobe Pagemaker @K
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|GLUSSARY|

Header
Footer

Symbol
Margins
Orientation
Menu
Editing

Undo
Redo

Text that is repeated at the top of each page
Text that is repeated at the bottom of each page

A sign or a special character that can be inserted in a PageMaker
document

The amount of space between the text and the edge of the page on all
four sides

The direction(along the height or along the width) in which the page is
being printed

A list of commands
Making changes to the text

Reversing the last command

Reversing the Undo command

Where? . c ‘.- 1 2 2 \\vlltt‘

= When? EVALUATION

When? i<l ’hen? T When?

Part1
Choose the correct

1. DTP stands for

answer
4. In PageMaker Window, the area

outside of the dark border is referred

(a) Desktop Publishing toas___

(b) Desktop Publication (a) page

(c) Doctor To Patient (b) pasteboard

(d) Desktop Printer (c) blackboard
2. is a DTP software. (d) dashboard

(a) Lotus 1-2-3
(b) PageMaker
(c) Maya
(d) Flash

3. Which menu
option?
(a) File menu
(b) Edit menu

(c) Layout menu

(d) Type menu

5. Shortcut to close a document in

PageMaker is

(a) Ctrl + A (b) Ctrl + B

(c) Ctrl + C (d) Ctrl + W
contains the New 6. A ___ tool is used for

magnifying the particular portion of

the area.

(a) Text tool (b) Line tool

(¢) Zoom tool (d) Hand tool

IBEID cChapter2 An Introduction to Adobe Pagemaker
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tool is used for drawing

(a) Line

(b) Ellipse

(c) Rectangle

(d) Text

option is present in
menu.

(a) File

(b) Edit

(c) Layout
(d) Window

To select an entire document using
the keyboard, press

(a) Ctrl + A
(b) Ctrl + B
(c) Ctrl + C
(d) Ctrl + D

formatting  consists

of which of the following text
properties?

(a) Bold

(b) Italic

(c) Underline

(d) All of these

Which tool lets you edit text?
(a) Text tool

(b) Type tool

(c) Crop tool

(d) Hand tool

Shortcut to print a document in

Pagemaker is
(a) Ctrl + A
(b) Ctrl + P
(c) Ctrl + C
(d) Ctrl + V

‘ ‘ XIl CompApp_English version CHAPTER 02.indd 55

13. Adobe PageMaker is a
software.

14. Bar is the topmost part of

the PageMaker window.

15. is the process of moving
up and down or left and right
through the document window.

16. tool is used to draw a

17. The Insert pages option is available

on clickingthe menu
18. Match the following.
Cut - (i) Ctrl + Z
Copy - (ii) Ctrl + V
Paste - (iii) Ctrl + X
Undo - (v) Ctrl + C
19 Choose the odd man out.
i. Adobe PageMaker, QuarkXPress,

Adobe InDesign, Audacity

ii. File, Edit, Layout, Type, Zip

iii. Pointer Tool, Line tool, Hide Tool,
Hand Tool

iv. Bold, Italic, Portrait, Underline

20. Choose the correct statement.

i. (a) Text can be selected using mouse

only.
(b) Text can be selected using mouse
or the keyboard.
ii. (a) DTP is an abbreviation for
Desktop publishing.
(b) DTP is an abbreviation for

Desktop publication.

21 Choose the correct pair
(a) Edit and Cut
(b) Edit and New
(c) Undo and Copy
(d) Undo and Redo
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Part - 11
Short Answers

1.

© BN R WD

What is desktop publishing?

Give some examples of DTP software.

Write the steps to open PageMaker.

How do you create a New document in PageMaker?
What is a Pasteboard in PageMaker?

Write about the Menu bar of PageMaker.
Differentiate Ellipse tool from Ellipse frame tool.
What is text editing?

What is text block?

10. What is threading text blocks?
11. What is threading text?

12. How do you insert a page in PageMaker?

Part - 111
Explain in Brief Answer

E S O

What is PageMaker? Explain its uses.

Mention three tools in PageMaker and write their keyboard shortcuts.

Write the use of any three tools in PageMaker along with symbols.
How do you rejoin split blocks?

How do you link frames containing text?

What is the use of Master Page?

How to you insert page numbers in Master pages?

Part - IV
Explain in detail

1. Explain the tools in PageMaker toolbox.

2. Write the steps to place the text in a frame.
3.
4

How can you convert text in a text block to a frame?

. Write the steps to draw a star using polygon tool?

BT cChapter2 An Introduction to Adobe Pagemaker

‘ ‘ XIl CompApp_English version CHAPTER 02.indd 56 @

1/5/2022 1:19:45 PM‘ ‘



Introduction to Database

@ LEARNING OBJECTIVES

Management System

To understand database concepts, components and its functions.

e To know about relational model of data

e To understand Query languages for databases.

e Enables to write SQL commands and query processing

e To enhance the programming skills and Techniques using MySQL

3.1 Introduction to Database
Management System

DBMS stands for Database Management
System, so let us break down the words what
they really mean. A database is a place where
we store, retrieve and manage data. So what's
a data then? Meaningful information like
your name, your favorite color etc to complex
data like astronomical data that scientist
handle, everything comes under database. The
management system refers to a set of programs
to manage the data, we have with various
actions like storing, retrieving, filtering etc.
Some of the popular Database Management
System is MySQL, Oracle etc. Giving protection
to data, user-friendly for users etc, are some of
the notable features of good DBMS.

3.1.1 Introduction to DBMS

Definition: “A database management system
(DBMY) is system software for creating and

‘ ‘ XIl CompApp_English version CHAPTER 03.indd 57

managing databases. The DBMS provides
users and programmers with a systematic way
to create, retrieve, update and manage data.”

What type of data is stored in a
database?

In a database, we would be grouping only
related data together and storing them
under one group name called table. This
helps in identifying which data is stored
where and under what name.

3.1.2 Evolution of DBMS

The concept of storing the data started
before 40 years in various formats. In
earlier days they have used punched card
technology to store the data. Then files
were used. The file systems were known as
predecessor of database system. Various
access methods in file system were
indexed, random and sequential access.
The file system had more limitations like
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Data Duplication - Same data is used
by multiple resources for processing,
thus created multiple copies of same data
wasting the spaces.

High Maintenance - Access control and
verifying data consistency needs high
maintenance cost.

Security - less security provided to the data.

So database systems became popular to
overcome the above limitations of file
system.

3.1.3 DBMS Concepts

There exist few standards that are
applicable to all forms of database
management Systems like Relational

Database Management System (RDBMS)
and Object Database Management System
(ODBMS). All DBMS adheres to the
following two basic concepts.

ACID Properties - The acronym
stands for Atomicity, Consistency, Isolation
and Durability. Atomicity follows the thumb
rule “All or Nothing”, while updating the
data in database for the user performing the
update operation. This update operation is
called as transaction and it either commits
(successful updating) or aborts (updating
that the
changes in data value to be constant at any

failure). Consistency ensures

given instance. This property helps in the
successful transaction. Isolation property
is needed during concurrent transaction.
When multiple users do the transactions
by accessing same object at the same time,
the transaction is known as concurrent
transaction. To prevent the conflict in
database update, the transactions are isolated
from other user and serialized. This is also
known as Degree of Consistency. Durability
is defined as the system’s ability to recover all
committed transactions during the failure
of storage or the system.

Concurrency Control and
Locking - It is the DBMSs mechanism
used for data sharing. When the same data
is shared among multiple users, proper
access control is needed and privilege of
changing the applications data item is
controlled through Locking.

3.2 DBMS Database Models

The database technology came into
existencein terms of models with relational
and object-relational behavior. The major

database models are listed below:

3.2.1 Hierarchical Database
Model

The famous Hierarchical database model
was IMS

(Information Management

> = Container
O = Object

Figure: 3.1 Hierarchical database model

Chapter 3 Introduction to Database Management System
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System), IBM’s first DBMS. In this model
each record has information in parent/
child relationship like a tree structure. The
collection of records is called as record
types, which are equivalent to tables in
relational model. The individual records
are equal to rows. See Figure 3.1

In the above model we have many
advantages like less redundant data,
efficient search, data integrity and security.
This model also has few limitations like
complex to implement and difficulty in
handling many to many relationships.

3.2.2 Network model

The first developed network data model
was IDS (Integrated Data Store) at
Honeywell. Network model is similar to
Hierarchical model except that in this
model each member can have more than
one owner. The many to many relationships
are handled in a better way. This model
identified the three database components
Network schema, Sub schema and
Language for data management. See
Figure 3.2

[ ABC college ]

N

[ College library ]

[ Department A

n:1 It has two parents

[ Student ]

Figure: 3.2 Network Model
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Network schema - schema defines all
about the structure of the database.

Sub schema - control on views of the
database for the user

Language - basic procede for accessing
the database.

The major advantage of this model
is the ability to handle more relationship
types, easy data access, data integrity
and independence. The limitation of
network model is difficulty in design and
maintenance.

3.2.3 Relational model

Oracle and DB2 are few commercial
relational models in use. Relational model
is defined with two terminologies Instance
and Schema. See Figure 3.3

Relational Database

Member Member group
id:int member_id:int
firstname:string| group_id:int
surname:string

email:string

Figure: 3.3 Relational database model

Instance - A table consisting of rows and
columns

Schema - Specifies the structure including
name and type of each column.

A relation (table) consists of unique
attributes (columns) and tuples (rows).

3.2.4 Object-oriented database
model

This model incorporates the combination

of Object Oriented Programming(OOP’s)

concepts technologies.

Practically, this model serves as the base of

and database

Relational model. Object oriented model

Chapter 3 Introduction to Database Management System
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O/.

AN

Salesperson

Has
Orders

Account Orders

v

Department

Address

.ﬂ\\.

Figure: 3.4 Object-oriented database model

uses small, reusable software known
as Objects. These are stored in object
oriented database. This model efficiently
manages large number of different data
types. Moreover complex behaviors are
handled efficiently using OOP’s concepts.

See Figure 3.4

3.3 Relational Database
Management System

Basic RDBMS concepts

Any database whose logical organization
is based on relational data model is known
as Relational Database. A DBMS that
manages the relational database is known
as Relational Data Base Management
System. RDBMS is basis for SQL and for
all modern database systems like MySQL,
oracle and Microsoft Access. The basic
RDBMS concept includes Database,
Tables, Tuple, Attribute, Schema and Key
which are discussed in RDBMS Jargons.

Chapter 3 Introduction to Database Management System
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3.4 RDBMS Jargons
3.4.1 Database

The most popular Relational Database
is MySQL. It is an open source SQL
database supporting different platforms
like Windows, Linux and MAC Operating
Systems. The other relational databases
available are Oracle, MS SQL Server and
MS Access. The features of RDBMS are

e High Availability

e High Performance
e Robust Transactions and support
e Ease of management

e Lesscost

3.4.2 Table

In relational database model, table is
defined as the collection of data organized
in terms of rows and columns. Table is the
simple representation of relations. The

true relations cannot have duplicate rows

1/5/2022 1:21:09 PM‘ ‘



@

www.tntextbooks.in

where as the table can have. The example of
Employee table is shown below in Table 3.1.

ID NAME AGE SALARY
1 Alex 26 22,000
2 Divya 25 20,000
3 Tulsi 28 30,000

3.4.3 Column

The table consists of several rows and
columns. Table can be divided into smaller
parts, in terms of columns. Each column
is known as attributes. In the Employee
table four attributes are available namely
Id, Name, Age and Salary. The attribute is
defined in a table to hold values of same
type. This is known as Attribute Domain.
In the Employee table, the Name field will
hold only characters not the numbers in
it. The vertical entity in a table is known as
Attribute or Column.

3.4.4 Row

A single entry in a table is called as Row
or Record or Tuple. Set of related data’s

are represented in a row or tuple. The
horizontal entity in a table is known as
Record or row. See Table 3.2

ID NAME AGE SALARY
1 Alex 26 22,000
3.4.5 Key

The candidate key that is chosen to
perform the identification task is called
the primary key and any others are
Alternate keys. Every tuple must have, by
definition, a unique value for its primary
key. A primary key which is a combination
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of more than one attribute is called a
composite primary key.

3.4.6 Foreign Key

A foreign key is a “copy” of a primary key
that has been exported from one relation
into another to represent the existence of a
relationship between them. A foreign key
is a copy of the whole of its parent primary
key i.e if the primary key is composite,
then so is the foreign key. Foreign key
values do not (usually) have to be unique.
Foreign keys can also be null. A composite
foreign key cannot have some attribute(s)
null and others non-null.

3.4.7 Super Key

An attribute or group of attributes, which
is sufficient to distinguish every tuple in
the relation from every other one is known
as Super Key. Each super key is called a
candidate key. A candidate key is selected
from the set of Super Key. While selecting
candidate key, redundant attributes
should not be taken. The candidate key is
also known as minimal super keys.

3.4.8 Composite Key

A key with more than one attribute to
identify rows uniquely in a table is called
Composite key. This is also known as
Compound Key.

3.5 ER Model

Generally we use an ER model to know the
concept of database design and this model

consists of a collection of entities(real
world objects)where each of these entities
will be interconnected with each other
with conditions and dependencies(i.e. one
entity is dependent on another).

Chapter 3 Introduction to Database Management System
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3.5.1 ER Modeling basic concepts

The basic concepts of ER model consists
of

1. Entity or Entity type
2. Attributes
3. Relationship

These are the general concepts which help
to create an ER diagram and produce an ER
model. With the help of these any database
design can be created and viewed to know
the concept in that database design.

3.5.2 Entity or Entity type

An Entity can be anything a real-world
object or animation which is easily
identifiable by anyone even by a common
man.

Eg:Inacompany’s database Employee, HR,
Manager are considered as entities, where
each of these entity will be having their
own attributes. An entity is represented by
a rectangular box. See Figure 3.5.

Employee Manager

Figure 3.5 Entity

Types of Entity:
1. Strong Entity
2. Weak Entity
3. Entity Instance

Strong Entity

A Strong entity is the one which doesn’t
depend on any other entity on the schema
or database and a strong entity will have
a primary key with it (i.e. a unique id
which other entities will not have in
their attributes).It is represented by one
rectangle.In the above example it is a
strong entity because it has a primary

Chapter 3 Introduction to Database Management System
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key(a unique id) as the roll no because for
every one roll no varies and it will not be
same.

Weak Entity

A weak entity is dependent on other
entities and it doesn’t have any primary
key like the Strong entity. It is represented
by double rectangle.

For Example:

Here the marks is the weak entity and
there are no unique id or primary key for
that entity. So they are dependent on the
existence of the other entity. See Table 3.3

E €& D

Marks

Figure: 3.6 Weak Entity

3.5.3 Entity Instance

Instances are the values for the entity
if we consider animals as the entity their
instances will be dog, cat, cow... Etc. So
an Entity Instance denotes the category
values for the given entity.

Entity Instances

Human Male , Female

Animals Dog, cats, lion

Jobs Engineer, Doctor, Lawyer
Actors Ajith, Vijay, Vikram
Electronics Laptop, Mobile
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3.5.4 Attributes

An attribute is the information about that
entity and it will describe, quantify, qualify,
classify, and specify an entity. An attribute
will always have a single value, that value
can be a number or character or string.
Types of attributes:

Key Attribute

Simple Attributes

Composite Attributes

Single Valued Attribute

5. Multi Valued Attribute

A

3.5.4.1 Key Attribute

Generally a key attribute describes a
unique characteristic of an entity.

3.5.4.2 Simple Attribute

Name

Employee

Figure 3.7 Simple Attribute

The simple attributes cannot be separated.
It will have a single value for that entity.
For Example: Let us consider the name as
the attribute for the entity employee and
here the value for that attribute is a single
value. See Figure 3.7

3.5.4.3 Composite Attributes

The composite attributes can be sub-
divided into simple attributes without
change in the meaning of that attribute.
For Example: In the above diagram the
employee is the entity with the composite
attribute Name which are sub-divided into
two simple attributes first and last name.
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3.5.4.4 Single Valued Attributes:

A single valued attribute contains only
one value for the attribute and they don't
have multiple number of values. For
Example:Age- It is a single value for a
person as we cannot give ‘n’ number of
ages for a single person,therefore it is a
single valued attribute. See Table 3.4

Attribute Values
Age 3
Roll no 85

In the above table are the some examples
for single valued attributes. See Figure 3.8

Date of Birth

Person

Figure 3.8 Single Valued Attributes

3.5.4.5 Multi Valued Attributes:

A multi valued attribute has more than
one value for that particular attribute.For
Example:Degree - A person can hold n
number of degrees so it is a multi-valued
attribute.

In Table 3.5 are some examples for
Multi valued attributes.

Attribute Values
Degree B.Tech, MBA
Bank_ Account SBI, HDFC

Chapter 3 Introduction to Database Management System
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3.5.5 Relationship Type

In ER Model,
between two entities. Three types of
relationships are available and the Entity-
Relationship(ER) diagram is based on the
three types listed below.

relationship  exists

One-to-One relationship: Consider
two entities A and B. one-to-one
(1:1) relationship is said to exist in a
relational database design, if 0 or 1
instance of entity A is associated with
0 or 1 instance of entity B, and 0 or 1
instance of entity B is associated with 0
or 1 instance of entity A.

One-to-Many relationship: Consider
two entities A and B. one-to-many
(1:N) relationship is said to exist in
a relational database design, for 1
instance of entity A there exists 0 or 1
or many instances of entity B, but for 1
instance of entity B there exists 0 or 1
instance of entity A.

Many-to-Many relationship:Consider
two entities A and B. many-to-many
(M:N) relationship is said to exist
in a relational database design, for 1
instance of entity A there exists 0 or 1
or many instances of entity B, and for
1 instance of entity B there exists 0 or 1
or many instance of entity A.

In reality one-to-one are in less usage,
where as one-to-many and many-to-many
are commonly used. However in relational
databases, many-to-many are converted
into one-to-many relationships.

3.5.5.1 Relationship instance

It is a finite set of liples in the RDBMS
systems relation instances never have
duplicate E.g if Works-for is the
relationship between the Employee entity

Chapter 3 Introduction to Database Management System
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and the department entity, then Ram
works for Comp.sc department, shyam
works for electrical department ..etc are
relationship instances of the relationship,
works for.

3.5.5.2 Degree of a relationship

The number of entity types involved is
known as Degree of relationship. One -
Unary, Two - Binary, Three - Ternary.E.g
An employee of an organization acts
as manager of few other employees. It
also connects one entity to itself as a
loop. so manager-of is unary. Similarly
employee works-fordepartment, connects
two entities and is binary. If a customer
purchase an item, it involves shop keeper
also and is a ternary relationship.

3.5.5.3 Cardinality

It is defined as the number of items that
must be included in a relationship.ie
number of entities in one set mapped with
the number of entities of another set via
the relationship. The three classifications in
Cardinality are one-to-one, one-to-many
and Many-to-Many. See Figure 3.9-3.11

1
driver ‘w

Figure 3.9 Cardinality

Person Vehicle

In the above example we have two entities
Person and Vehicle. If we consider a person
driving vwchicle, then we have one-to-one
relationship between Person and Vehicle.
See Figure 3.10

n
Customer

Figure 3.10 CardinalityRelation 1 to n

Order

In the above example, Customer places
the Order is a one-to-many relationship.
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Here the customer can place multiple
orders and the order is related to only one
customer. See Figure 3.11

n

Figure: 3.11 Cardinality Relation n to n

Student Course

The
relationship is Students registering the
Courses. A student can register more
than one courses and A course can be
registered by many students. Hence it is

example of  many-to-many

many-to-many.

3.6 ER-Diagram

ER Diagram presents data visually on
how they are related to each other. This

model follows separate notations for
representing data into entities, attributes
and relationship between the entities.

3.6.1 ER-Modeling Diagram
Notations
Attributes
forms the components of ER Diagram
and the defined symbols and shapes are
summarized below in Table 3.6.

Entities, and Relationship

ER Component
Entity - Strong

Entity — Weak

Relationships

between Entities
— Weak

Attributes
entity

Description (how it is represented)

Simple rectangular box

Double rectangular boxes

Rhombus symbol - Strong

Rhombus within rhombus

Ellipse Symbol connected to the

Notation

Student

Age

O

Student

Key Attribute for
Entity

Derived Attribute for
Entity

Multivalued
Attribute for Entity
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Underline the attribute name
inside Ellipse

Dotted ellipse inside main ellipse

Double Ellipse

Chapter 3

Key Attribute

_—

Introduction to Database Management System
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Enrolls

Figure: 3.12 ER-Diagram

3.6.2 Example

Fig 3.12 is an example of ER Diagram
for the scenario of School Management
System. We have many entities like
Parent, student, Admin, Teacher, class
and subjects. The attributes of few entity
is given below:

Parent — Name, Id, Fname, Lname.
Student - Id, Name, Fname, Lname.
Teacher — Name, Id, Phone#, Address.

The relationships that exist between the
entities are as follows:

Parent HAVE Student

Admin ENROLLS Student

Admin HIRES Teacher

Admin ADDS Subject

Teacher TEACHES Subject

Teacher IS ASSIGNED TO Class

Key Attributes are listed with underline.

3.7 Introduction to MYSQL

3.7.1 About MYSQL
MySQL s
database management system. Its name

an open source relational

Chapter 3 Introduction to Database Management System
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is a combination of “My” the name of the
founder Monty Widenius’s daughter and
“SQL” A clear definition of database and
SQL is mandatory to understand MySQL. In
simple, a database is defined as the structured
collection of data. Ex. Photo gallery is a
database which has collection of photos
(data). SQL - structured query language is
not a database. It is a standardized language
used to access the database and the data’s are
processed to turn into efficient information.
The SQL standard always refers to the
current version and the current version is
2003. MySQL is open source software that
allows managing relational databases. It
also provides the flexibility of changing the
source code as per the needs. It runs on
multiple platforms like Windows, Linux and
is scalable, reliable and fast.

3.7.2 Overview of Web Database

Many databases are in existence to meet
out the needs of the application. These
databases are broadly divided into Heavy
and Light databases. Heavy databases
support all the desktop applications
whereas the web applications are
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MySQL |

44.3% |

SQL server |

30.8%

SQLite |

| 21.2%

PostgreSQL |

| 21.2%

MongoDB |

Oracle |

Redis |

|:| 2.5%

| 11.2%

Cassandra

| 13.2%

| 16.8%

Figure: 3.13 Most Popular databases - Statistics

supported by Light databases. Below are
the lists of commonly used databases.

e DB2

e MySQL

e Oracle

e PostgreSQL
e SQLite

e SQL Server
e Sybase

Due to the rapid growth in the web domain,
most of the desktop applications are being
converted into web applications. These
transformations to the web results in the
availability of many web applications in
the network. Heavy databases did not
meet out the network issues efficiently.
Light databases were able to handle all
the issues raised by the network. So all
the light databases that supports the
web applications are also known as Web
Databases. See Figure 3.13

MySQL is the most commonly used
database in the world due to its ease of use.
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3.8 MySOL - Administration
3.8.1

MySQL — Administration
Responsibilities

In general there exists a role known as
Database Administrators (DBAs) who
takes care of configuration, installation,
performance, security and data backup.
DBA’s posses the skills on database
design, database queries, RDMS, SQL
and networking. The primary task is the
creation of new user and providing them
with access rights.

Creating New User Account to MySQL

In MySQL database, there exists a table
named user. The newly created account
must have an entry in this user table.
Consider the admin creates an account
with username and password. The
user account is activated with various
access rights like INSERT, SELECT and
UPDATE. Consider the user table has the
following fields host, name, password,

select_priv, insert_priv and update_priv.

Chapter 3 Introduction to Database Management System
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A new user account is added with values to
the user table using the following INSERT
query in MySQL database. The Syntax
for inserting record is INSERT INTO
table name (Parameterl,Parameter2,
Parameter3..) VALUES (Valuel, Value2,
Value3..); All the query is in SQL will
terminate with semicolon(;).

mysql> INSERT INTO user (host,
name, password, select_priv, insert_
priv, update_priv)

VALUES (‘localhost;, ‘guest,
PASSWORD(‘guest123’), Y’ Y}, Y’);
Query OK, 1 row affected (0.20 sec) -
This statement implies that the query is
executed successfully with the time in

seconds.

mysql>=FLUSH PRIVILEGES;

The above command is executed after
every This
command is similar to rebooting the

new account creation.
server so that newly created account and
the access privilege are updated in the
server. Manual server rebooting is avoided
by this command.The inserted record is
retrieved using SELECT query and the

structure is shown below Table 3.7 & 3.8:

mysql>=SELECT * FROM user WHERE
name = ‘guest’;

select_ | insert_ [update_
host name password

priv priv priv

localhost | guest |j2gd6vxdlbj3kl3g4| Y Y Y

Since MySQL is more secured, it provides
function to encrypt the password. Thus
the password ‘guestl123’ is encrypted
and stored as ‘j2gd6vxd1bj3k13g4’ using
PASSWORD() function. The parameters

Chapter 3 Introduction to Database Management System
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select_priv, insert_priv and update_priv
are few privileges set for the new user. If
the flag is set as Y’ then access is granted
and if flag set as ‘N’ then access is denied.

Privileges Action Performed (If
Granted)

User can select rows from
database tables.

Select_priv

User can insert rows into
database tables.

Insert_priv

User can update rows of
database tables.

Update_priv

User can delete rows of
database tables.

Delete_priv

User can create new tables
in database.

Create_priv

Alter_priv User can make changes to
the database structure.
3.8.2 Administrative MySQL

Command

The Database (DBA)
frequently uses few commands to control
the entire database. These commands

Administrator

are known as Administrative MySQL
Commands. The following are few such
important commands used frequently
while working with MySQL.

1. USE Database - This command is
used to select the database in MySQL
for working. If there exists a database
named test, it is used as working
database using the below Syntax.
Syntax:

mysql > use test;
Database changed
mysql>
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databases available in the database Field T — T T T
ie e u e efault Extra

server. See Table 3.9 biE d

Team_id int(5) yes null

Syntax:

Team_name varchar vyes null
mysql > show databases; (10)

Team_size  int(5) yes null

Database 5. SHOW INDEX FROM tablename -
S The query shows all the indexes for
mysql the given table.
employee Syntax:
students mysql > show indexes from sports;
parents
6. SHOW TABLE STATUS LIKE
3. SHOW Tables - Lists all the tables tablename\G - This command
available in the current database we provides with detailed report on the
are working in. See Table 3.10 performance of the table.
Syntax:
3.8.3 MySQL Installation
® mysql > show tables; Download and install ®

XAMPP Server Software

DO o memet Refer

Tables_in_test Figure 3.14 to 3.23.
school
s Warna = | Dz matie | et
& oo 115 ekt ST
Salary f::n,:m,_v_ B :r.tmmwmﬂmmr.c..c TR L TR
Pk 8] S -4 YZHNFIBM P
employee ] Sanan d 44 SEVIEATEM A
s T TWIPEF] LAD HEW LI TIAIAM e
. b Espenalinment TVRZTATI4R w0
libr ary o e Engieeivg sec 107 DI1ZTFM e
o amu okt cosload 10AAZNEIHA D0
S OI'tS 1020133 1AFM r
p e WAL e
AR we
pr e “
4. SHOW COLUMNS e e
swiolume E | = T i
: i 0421320 55T Aeisiors 2010 lead frm_Leads ZEIC0SI0 2000050 104/2003057 M s
FROM tablename - Lists all the ﬁiﬁ‘.alii W] sion, Mision, FEQLF 00D S of achiricalDepatia 1] LT AL
attributes, attribute type, Is Null i . Ao——— B
. . . = g 01 477 27 FH RN AR
value permitted, key information, /A .
. . FEINCT el 5 {
default value and other information e ———r—— | o
. =3 Ttenby fs e 1000 WERATAATA 4
for the given table. The show =zswcmmeJ-«aEﬁ“".ﬁ“"””””l TN 4
. . i St CompuberSciznsa eka - 2M_Conbined_ "SR T[] TUERIEA A
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1 |

below in Table 3.11.

Figure: 3.14 XAMPP Server executable file
Syntax:
Click the Welcome Page Next Button
mysql > show columns from sports;
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=10l x]

& Setup

Setup - ZAMPP

Welcome to the XAMPP Setup Wizard.

0 bitnami

< Back Mext = Cancel

Figure: 3.15 XAMPP Server Welcome Wizard

Select the Required component along with MYSQL component and click next button
_(of x|

Select the components you wank ko install; clear the components you do not wank ko install, Click
Mext when you are ready to continue.

- Server

i Apache

MySoL

FileZilla FTP Server

] Mercury Mail Serwer

i Tomcat

= Program Languages

PHP

Perl

=k Program Languages
phpMyAdrin

B Setup

Select Components

Click. on a component ta get a detailed description

wehalizer
Fake Sendrmail

KOMPP Installer
< Back [

Mext = [ Cancel |

Figure: 3.16 XAMPP Server Component Wizard
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Choose The Installation Folder and click Next

Installation folder

Please, choose a folder to install XAMPP

Select a Folder |C:'|,xampp rs I

=aMPR Installer
= Back I Mext =

Cancel l

Figure: 3.17 XAMPP Server install path

Click Next Button in Setup ready page

®

Ready to Install

Setup is now ready to begin instaling ¥AMPP an yaur computer,

KAMPE Installer
< Back Mext =

Cancel

Figure: 3.18 XAMPP Server setup completion
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Installation get started
B Setup [ |4

Welcome to XAMPP! m

XAMPP is an easy to install Apache distribution
containing MysQL, PHP and Perl

Installing
Unpacking Files

[ [

REMPE Installer
= Back I Next = Cancel

Figure: 3.19 XAMPP Server setup Progress window

After installing Click finish button and open the XAMMP Control panel

& Setup =P
@ Completing the XAMPP Setup Wizard @
T
Setup has finished installing XAMPP on waur computer.
[¥ Do you want to start the Control Panel now?

0 bitnami

= Back Finish Carcel

Figure: 3.20 XAMPP Server setup completion

In the Control Panel start the Apache and MySQL Services one by one
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B2 XAMPP Control Panel ¥3.2.2 [ Compiled: Nov 12th 2015 ]
IH | XAMPP Control Panel v3.2.2 :
— Modules T
Service Module  PID(s) Port(s) Actions _ D netstat_|
XI Apache Start I A dmiiry I Config I Logs I B shell |
XI My SGEL Start I .0y | Config I Logs I | Explorer I
xl FileZilla Start I Admiin | Config I Logs I B Services I
| Mercury stet | somin | confia | Logs | o v |
“"?I Tomcat Start | Admin | Contig | Logs | 2 out I
94958 AWM [Tomcat]  Tomcat Service detected with wrong path ~|
S4955 AN [Tomeat]  Change ZAMPP Tomcat and Control Panel settings or
4258 Al [Tormmcat] Uninstall/disable the other service manually first
94955 A [Tomeat]  Found Path: "CAProgram FilesApache Software FoundationtTorncat 7.0vinkTomcat
A9 58 AN [Tormcat] Expected Path: cixamppsormcatibinttomcat? exe YRS Tomcat?
9:49:58 Ahd [main] Starting Check-Timer
©49.58 Ak [main] Caontrol Fanel Ready
< | | »
| 2

Figure: 3.21 XAMPP Server Control panel

The two services get started one by one

@ 23 XAMPP Control Panel v3.2.2 [ Compiled: Nov 12th 2015 | I -10] x| @
HI XAMPP Control Panel v3.2.2 . Config |
— Modules o
Service Module  PID(s) Portis)  Actions ﬂl
ﬂ Apache gg;g 80,443 Stop | Admin | Config | Logs | B shell |
ﬂ MySQL 5308 3306 semin | config | Logs | Explorer |
ﬂ FileZilla Start I Aolmif I Config | Logs I E:' Services |
_I Mercury Start ] Acimin I Config | Logs I & Help |
| Tomeat stat | sdnin | config | Loss | Hout |
S49:55 AN [Tomcat]  Expected Path: ciwamppMomcatibinitomecat?, exe /RS Tomcat? :_]
9:49:58 AM [main] Starting Check-Timer
9:49:58 Ah [main] Control Panel Ready
Sa028 AN [Apache]  Attempting to start Apache app..
80028 AN [Apache]  Status change detected: running
SLa0 48 AN [mysgl]  Attempting to start MySCL app...
95048 A [mysgl] Status change detected: running
=
4| | 3
| 4

Figure: 3.22 XAMPP Server Services start option
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Open the URL http://localhost/phpmyadmin URL in a browser to access MySQL database.

b Feshast £ 122000 [phaMytcmin % 4 |= & =
L C 1 @ locahostphpryadminener_detabasas pho v OB ?
Appe W Eockenarks [ Satpesmalriversk, M Gmal corsoseondric [l Movidad ennarce da Ciber bookmaks
ﬁ*ﬁjv 5 € Databases | S0OL % Status == User accounts =l Cxport [ Import  J° Settings | Heplication ¢ Variables = Charsets ¥ More
Recent Favortas
e Databases
+I-_ information_schema
e syl i Create database
T— parformance_schems
T_- phprmyadmin Database nar |atin1_swedish_ti Creats
L test
Lalabase - Callatinn Actlnn
nformation_schems utfe genersl ci =7 Casos privileges
sl IatIni sweddsh ef = Check prvileges
performanca_schama  wifs general ci =3 Check privileges
phproysdmin wifa_ban g5 Chack prvileges
1e=t 1atind_ssecisiel 25 Ganck privileges
Total; & latinl siedish ci
t Checkoall  With salectad |55 Drop

o, Mole: Enabling the ¢alabase statistics here mighl cause heavy 1rafic belween 1he web seraar and 1he MySOL sermr

« Enable statistics

‘m Cionzole

vl @ O € O k™ R

. a5taM
&[5 O <l 10 gy ™

Figure: 3.23 PHP Myadmin Mysql Database server User interface

3.9 MYSQL Administration
open source software
tools

Types of software tools

Many open source tools are available in the
market to design the database in a better
and efficient manner. PhpMyAdmin is
most popular for Web Administration.
The popular Desktop Application tools
are MySQL Workbench and HeidiSQL.

PHPMYADMIN (Web Admin)

This administrative tool of MySQL is a
web application written in PHP. They are
used predominantly in web hosting. The
main feature is providing web interface,
importing data from CSV and exporting
data to various formats. It generates live
charts for monitoring MySQL server
activities like connections, processes and
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memory usage. It also helps in making the
complex queries easier.

MySQL Workbench (Desktop
Application)

It is a database tool used by developers and
DBAs mainly for visualization. This tool
helps in data modeling, development of SQL,
server configuration and backup for MySQL
in a better way. Its basic release version is 5.0
and is now in 8.0 supporting all Operating
Systems. The SQL editor of this tool is very
flexible and comfortable in dealing multiple
results set.

HeidiSQL (Desktop Application)

This open source tool helps in the
administration of better database systems.
It supports GUI (Graphical User Interface)
features for monitoring server host, server
Tables,

connection, Databases, Views,

Triggers and Events.
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3.10 Designing Databases

The process of creating, implementing
and maintaining the enterprise data in a
system is known as Designing of databases.
Better understanding of the application is
necessary before designing the database.
The performance and success of an
application depends on good database
design. MySQL provides performance
dashboard, reports and statistics regarding
the design of database.

Create Conceptual Design

It is the primary phase in database design,
where detailed discussion about the
creation of databases, tables, columns
and data types is discussed based on the
requirement of the application. As an end
result the model is framed to attain the
expectation of the application’s end user.

e Create Database
The three major parts that forms a database

are Tables, Queries and Views.

Tables - similar to an excel sheet,
containing multiple rows and columns.
Where each row is a record and each
column is an attribute.

Queries - It is a question with multiple
conditions posted to the database. The
records in the database that satisfies the
passed conditions are retrieved.

Views — A set of stored queries.

Example: create a database to store the
personaldetails.

mysql> create database personaldetails;
Query OKk, 1 row affected
mysql> USE personaldetails;

Database changed.
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The created database is listed using SHOW
command. See Table 3.12

mysql> show databases;

Database
employee

personaldetails

sports

e Create Table

In an application, each page reveals
some functionality. Each such functions
are designed to a table. For example, in
an online shopping site like Amazon,
multiple pages are maintained like
customer profile, products, orders in
cart and payment page. All these can be
created as tables like Customer, Products,

Order and Payment respectively.

e Create Columns

Each table will have many columns related
to the functionality of the table. This
column determines what values are stored
in the table. For example, the Customer
table contains the columns like firstname,
lastname, phone, email, age, address
and pincode. These columns hold the
Customer information in the table. Each
column is assigned with appropriate value
type. The efficiency and performance of
the table purely depends on the data types
assigned to the columns.

e Insert Rows

Once the database is created, tables and
the columns with the appropriate value
type are defined. Then records are inserted
to the table.

Chapter 3 Introduction to Database Management System
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INSERTINTO TABLE_NAME (columnl,
column2, column3, ... columnN)

VALUES
...valueN);

(valuel, value2, value3,

3.11 SOL

SQL- Structured Query Language is a
standard language used for accessing and

manipulating databases. It is declared as
standard by American National Standards
(ANSI) and International
Organization for Standardization (ISO) in
1986 and 1987 respectively.

Institute

About SQL

e Though SQL is standard language,
different versions are maintained to
meet out the requirements. Few major
functions performed using SQL are
listed below:

e Executes queries against a database.
Retrieves data from database.

Inserts and updates records in a
database

e Delete records from database.

e Creates new databases and new tables
in a database.

Types of SQL Commands

Different SQL commands are available to
performvariousfunctions. SQLcommands
are classified into five major categories
depending on their functionality. See
Table 3.13

Data Definition Language (DDL)

The DDL commands are used to define
database schema (Structure). Also to create
and modify the structure of the database
object in the database. CREATE, ALTER,
DROP,RENAME and TRUNCATE
commands belongs to this category.
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Commands  Description

CREATE Used to create database or
tables

ALTER Modifies the existing
structure of database or table

DROP Deletes a database or table.

RENAME used to rename an existing
object in the database

TRUNCATE Used to delete all table
records

Data Manipulation Language (DML)

These SQL commands deals with the
manipulation of data present in the
database. Most of SQL commands come
under DML. INSERT, UPDATE, and
DELETE commands belong to this
category. See Table 3.14

Commands  Description
Adds new rows into
INSERT database table.
UPDATE modifies f.:x13t1ng data with
new data in a table.
DELETE Deletes the records from
the table.

Data Query Language (DQL)
SELECT is the only SQL command used

to fetch or retrieve the data from database
tables that come under DQL. See Table 3.15

Commands

Description

Retrieve data from the

SIELECT table.
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Transaction Control Language (TCL)

These SQL
transactions in SQL databases. It also

commands manage the
helps to save the change into database
permanently. = COMMIT, ROLLBACK,
SET TRANSACTION and SAVEPOINT
commands belongs to this category. See
Table 3.16

Commands Description

COMMIT Permanently saves into
database.

ROLLBACK Restore database to
original form since the
last COMMIT.

SET Sets the transaction

TRANSACTION  properties such as read-
write or read only access.

SAVE POINT  Used to temporarily save
a transaction so that we
can rollback to that point
whenever required.

Data Control Language (DCL)

The SQL
security on database objects like table, view,
stored procedure etc. GRANT and REVOKE

commands belongs to this category. See
Table 3.17

Commands Description

commands that implement

Grant used to give permission to
specific users on specific
database objects like table,

view etc.

Revoke used to take out permission
from specific users on specific
database objects like table,

view etc.
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3.12 Basic SQL Commands

Create/Drop /Selecting Database

Create Database - used to create new
SQL Database. The Syntax and example to
create studentDB is given below.

Syntax: CREATE database databasename;

Example: mysql>create database

studentDB;

The database created now can be viewed
using the following Syntax:

mysql>Show databases;

As a result, the newly created studentDB
will be listed.

Drop Database - used to remove any of
the existing SQL Database. The Syntax
and example to delete student DB is given
below.

Syntax: DROP database databasename;

Example: mysql>DROP database

studentDB;

The deleted database will not be
viewed,when we list all databases using
the Syntax, Show databases;

Select Database - Many databases are
available in the repository, from which
the suitable database is selected using the
below command.

Syntax: USE databasename;
Example: mysql>USE studentDB;

Once the database is selected, multiple
operations are performed as per the needs
of the application.

Chapter 3 Introduction to Database Management System
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e Insert Record

Database will have multiple tables.
Tables are created using the create
command with various fields added
to it as per their need. Any table is
complete only with the record available
in it. So new row are added to the table
using the Insert command. The Syntax
and example for inserting new record
into the table is given below:

Syntax 1:
INSERT INTO
column2, column3)

VALUES (valuel, value2, value3);

tablename (columnl,

Syntax 2:
INSERT INTO tablename
(valuel, value2, value3);

VALUES

Consider we have a table named Biodata,
which has three
firstname, lastname and age. Now the new

columns namely
record is added to the table using either
Syntax1 or Syntax2 as shown below.

mysql>INSERT INTO Biodata (firstname,
lastname, age)

VALUES (Krishna, Sam, 10);

(or)

mysqI>INSERT INTO Biodata VALUES
(Krishna, Sam, 10);

e Select Record

From the multiple records available in the
table, the enquired data are retrieved from
the table-using the SELECT command
with some conditions specified in it. We
can retrieve all the fields of a record or
specify the necessary fields in a table. The
records of any table are retrieved using the
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SELECT Syntax given below in Table 3.18
and 3.19

Syntax1: SELECT * from tablename;
Example: mysql>SELECT * from Biodata;

Firstname Lastname Age
Krishna S 10
Sugal S 14
Arun ] 15
Mani K 18

Syntax2: SELECT columnl, column2

from tablename;

Example: mysqI>SELECT firstname, age
from Biodata;

Firstname Age
Krishna 10
Sugal 14
Arun 15
Mani 18
Deleting Record

The existing record in a table is removed
from the table using DELETE command.
Entire record or specified columns in the
table can be deleted. If we want to perform
delete operation on specific columns,
then the condition is given using WHERE
clause. If the condition is not specified,
then the entire data will be deleted. See
Table 3.20 and 3.21

DELETE
WHERE columnname="value”;

Syntax1: from tablename

Example: mysql>DELETE from Biodata
WHERE firstname="Mani’;
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firstname lastname age
Krishna S 10
Sugal S 14
Arun ] 15

Syntax2: DELETE from tablename;
Example: mysql>DELETE from Biodata ;

firstname lastname age
Modifying Record

SQL provides us with modifying and
updating the existing records in a table
using UPDATE command. The age of
Krishna in Biodata table is changed using
the below Syntax.

Syntax1: UPDATE tablename
SET columnl="new value”
Where column2="value2”;

Example: mysql>UPDATE Biodata SET
age=13 WHERE firstname="Krishna”;

WHERE Clause

In SQL command WHERE clause is used
to specify the selection criteria Based on
that data’s are retrieved or modified as
per the query. In the WHERE conditions,
operations like =, !=, >, >=, <, <=are used
to frame the query statement. WHERE
clause is used in SELECT and UPDATE
query statement for the condition. The
number of records updated in a table
depends on the WHERE condition.
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Using Operators

While forming the SQL query we use major
operators like Arithmetic, Comparison
and Logical in the WHERE clause. The
purpose of each operator is listed below
in Table 3.22.

Operator Type Operator

Arithmetic Operator +, - %1, %

Comparison Operator =, =, <, >, <>, >=,
<=,

Logical Operator AND, ANY,
BETWEEN,
EXISTS, IN,
LIKE, NOT, OR,
UNIQUE

Sorting Records

The Query results are listed in Ascending
or Descending order using the command
ORDER BY clause. In some databases the
results are sorted by default in Ascending
order and is given in Syntax1. The results
are displayed in descending order as per
Syntax2. See Table 3.23 and 3.24

Syntax1: select * from tablename ORDER
BY columnname;

Example: select * from Biodata ORDER
BY firstname;

firstname lastname age
Arun ] 15
Krishna S 13
Sugal S 14

Chapter 3 Introduction to Database Management System
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Syntax2: select * from tablename ORDER
BY columnname DESC;

Example: select * from Biodata ORDER
BY firstname DESC;

firstname lastname age
Sugal S 14
Krishna S 13
Arun ] 15

Grouping Records, Having Clause

In SQL we can have identical data in a group.
Consider a table named Exams with fields
Rollno, Subject and Marks. In the below
table multiple rows of records are available
for different subjects. Using the GROUP
BY command, the rollno’s are grouped and
marks are added up against the Rollno with
SUM( marks). See Table 3.25 and 3.26.

Rollno Subject Marks
201901 Tamil 81
201904 English 75
201901 English 96
201903 Tamil 92
201902 Tamil 78
201904 Tamil 83
201903 English 81
201905 Tamil 89
201902 English 80
201905 English 90
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Example: Select Rollno, SUM(Marks)
from Exams GROUP BY Rollno;

Rollno Marks

201901 177

201902 158

201903 173

201904 158

201905 179
Joining Tables

When we have to select data from more
than 2 tables SQL JOIN clause is used.
Consider two tables Exams and Profile.
The Exams table has the fields Rollno,
Subject and Marks. The data of Profile
table is shown below in Table 3.27 & 3.28.

Rollno Name Hobby
201901 Krishna Gardening
201902 Sugal Photography
201903 Charles Reading
201904 Venilla Singing
201905 Pragathi Painting

Example: SELECT Profile.Name, Profile.
Hobby, SUM(Exams.Marks)As Total

FROM Profile, Exams
WHERE Profile.Rollno = Exams.Rollno
GROUP BY Profile.Name, Profile. Hobbys;
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Name Hobby Total
Krishna Gardening 177

Sugal Photography 158
Charles Reading 173
Venilla Singing 158
Pragathi Painting 179

In the Query Statement, the marks are added and listed under the column name Total for each
of the Rollno from both the tables.

12
(GLossARY]

Backup It is a program or process of copying table contents into a file for future
reference. It’s a challenging task for DBA's

Primary Key This key of relational table identifies each record in the table in a unique
way.
Relationship There exists a relationship between two tables when the foreign key of

one table references primary key of other table.

Cardinality It is defined as the number of different values in any given table column

Open Source Open source - refers to the design that is publicly accessible by people for
modification and sharing

SQL It (Structured query Language) is a programming language designed
mainly for managing data in RDBMS

Record Record is referred in a table, which are composed of fields.

Query In SQL, all commands are named as query. The query statement is
executed against the databases.

Join Retrieves data from two or more tables, by referencing columns in the
tables that hold identical values
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S Write

v EVALUATION

‘L. When?

Part -1
Choose the correct answer

1. Which language is used to request

information from a Database?
a) Relational
b) Structural

¢) Query
d) Compiler

. The ---------- diagram gives a logical

structure of the database graphically?
a) Entity-Relationship

b) Entity

c) Architectural Representation

d) Database

. An entity set that does not have

enough attributes to form primary
key is known as

a) Strong entity set
b) Weak entity set
c) Identity set

d) Owner set

R Command is used to delete

a database.

a) Delete database database_name
b) Delete database_name

c¢) drop database database_name

d) drop database_name

. MySQL belongs to which category of

DBMS?
a) Object Oriented
b) Hierarchical
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. Which is

10.The

¢) Relational
d) Network

. MySQL is freely available and is

open source.

a) True
b) False

(P represents a “tuple” in a

relational database?
a) Table

b) Row

¢) Column

d) Object

. Communication is established with

MySQL using

a) SQL

b) Network calls

¢) Java

d) APT’s

the MySQL instance
responsible for data processing?

a) MySQL Client

b) MySQL Server

¢) SQL

d) Server Daemon Program

structure representing the
organizational view of entire
database is known as -------- in
MySQL database.
a) Schema b) View
¢) Instance  d) Table
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Part - 11
Short Answers

1.

Define Data Model and list the types
of data model used.

List of file

processing system.

few disadvantages

. Define Single and multi valued

attributes.

List any two DDL and DML
commands with its Syntax.

. What are the ACID properties?

Which command is used to make
permanent changes done by a

transaction?

What is view in SQL?

. Write the difference between SQL

and MySQL.

What is Relationship and List its
types.

10.State few advantages of Relational

databases.
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Part - 111
Explain in Brief Answer

1.
2.

Explain on Evolution of DBMS.

What is relationship in databases?
List its types.

Discuss on Cardinality in DBMS.

. List any 5 privileges available in

MySQL for the User.

. Write few commands used by DBA

to control the entire database.

Part - IV
Explain in detail

1.

. Write a note

Discuss on various database models
available in DBMS.

. List the basic concepts of ER Model

with suitable example.

Discuss in detail on various types of
attributes in DBMS.

on open
software tools available in MySQL

source

Administration.

Explain the DDL command of their
functions in SQL.
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Introduction to

Hypertext Pre-Processor

e To understand the importance of Web Application

e To know the Server side Scripting Language

e To know the features of PHP (Hyper Text Pre-processor)

e To know the Basics of Web development process

e To understand Webserver Installation and Configurations

4.1 Introduction to Hypertext
Pre-Processor (PHP)

Dheghid
o
ﬁgsuw;
entertainment industry.

Two decades back, a famous quote

Internet and Web based
applications
are performing

online

very important role
in business and

“If your business establishment is not on
the Internet (online based), then your
business will be out of business context.”

Founder of Microsoft- Bill Gates

The Web based Internet application
ensures the success of critical business in real
world competitions. The legacy programing
languages didn’t meet out the expectations
of latest Internet concepts and executions.

In earlier 1990’s British scientist
Tim Berners-Lee introduced the concept

Chapter 4 Infroduction to PHP
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of Internetand World Wide Web (WWW).
These concepts required a new set of
programming languages over the network
communication. These
languages are recently called as Web

programming

scripting languages.

The Web scripting languages has
many policies which is easy to handle
and solve the critical business problems
around the world. In Later 1990’s many
Web scripting languages were introduced
to support the Internet online business.

ﬁ"\ PHP is one of the most widely used
B and recognizable technologies in use
~- on the internet. Originally PHP stood
for "Personal Home Page", though

more recently it has been changed to stand for
"PHP: Hypertext Preprocessor'. However, no

matter what it is called, PHP is a fundamental
part of any dynamic web page.

PHP (Hypertext Pre-processor)
is a one of the important server side Web
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and general purpose scripting language
invented by Rasmus Lerdorf in 1994. It is
very simple and lightweight open source
server side scripting language. It can easily
embed with HTML and other client side
scripting languages like CSS (Cascading
Style Sheets) and Java script. It also creates
dynamic and interactive Webpages in the
real time Web development projects.

It is a competitor and alternative for
other server side scripting languages like
Microsoft ASP (Active Server Page) and
JSP (Java Server page). Recent statistics of
server side scripting language usage depict
that 78.9 % of Website are developed by
PHP scripting language.

PHP
ASP.NET
Java
Static files
Ruby
Scala
Python
JavaScript
ColdFusion
Perl
Erlang

78.9%

Figure 4.1 Server side Scripting Language
Comparison

4.2 Various Server-side
Programming Languages
Global Usage Statistics

PHP scripting language can be executed
via an interpreter which is installed in the
Webservers or CGI (Common Gateway
Interface). Most of the Webservers such
as Apache Tomcat, Microsoft IIS (Internet
Information server) supports the PHP
interpreter module. Refer Figure 4.1

PHP is an open source community
It has
versions to ensure quality and ease of

development initiation. many
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Web development activities. The current
version of PHP, 7.3 is released by the
official team on 30 November 2017.

4.3 Client Server
Architecture

In the evolution of network architecture,
various critical networks related problems
are getting resolved by client server
architecture model. The
architecture introduces application sharing

client server
mechanism between two different hardware
systemsover the network (Internet/intranet).
In 1990 Internet was emerging in the
computer network field. The main objective
of Internet implies that an application is
shared by more than one hardware either it
could be a server or client machine.

The server is a high performance
hardware machine which can run more than
one application concurrently. The client is a
separate hardware machine which is connected
with server in the network (Internet/intranet).
It could send the request and receive the
response from the server hardware. The Server
and client are also called as service provider
and service requester respectively.

Database Server

Database Server

Figure 4.2 Client Server Architecture Model
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Client Server Architecture Model

Client server architecture shown above in
Figure 4.2 is classified into three types, as
follows

e Single Tier Architecture
e Two Tier Architecture
e N/Multi/Three tire architecture

Single Tier Architecture

This architecture is used for the server,
accessed by client. The client application
runs inside the server machine itself. This
acts as a single layer interaction as in
Figure 4.3.

1-Tier Architecture

Client computers

File server

Figure 4.3 Single Tier Architecture

Two Tier Architecture

This architecture is used for the server,
accessed by client as two layer interactions.
Such as Client layer in tire one and server
layer in tire Two. Refer Figure 4.4

2-Tier Architecture

Database Tier I

Database Server

Figure 4.4 Two- Tier Architecture

Chapter 4 Introduction to PHP
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MultiZ/Three Tier Architecture:

This architecture is used for the server,
accessed by client through more than one
layer interaction. The programmer could
decide the count of business logic layers
according to the software requirement
that is the reason this model is also known
as Multi three Tire Architecture as shown
in Figure 4.5.

3-Tier Architecture

L\
1

Application Server

Database Tier Database
Server

Figure 4.5 Multi/Three- Tier Architecture

Client Tier

Business Logic
Tier

Most of the server side scripting
languages are working on any one the client
server architecture model. Webserver
is software which is running in server
hardware. It takes the responsibilities for
compilation and execution of server side
scripting languages.

4.4 Server side scripting
language

Web scripting languages are classified
into two types, client side and server side
scripting language. PHP is completely
different from Client side scripting
language like Java script. The PHP code
entirely executes on Webserver which is
installed in the remote machine and it is
generating HTML code which is sent to
the user. The user receives the HTML code

1/5/2022 1:55:07 PM‘ ‘
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and sees the Website contents via Internet
browser in their computer or laptop. PHP
also supports OOPs (Object Oriented
Programing) concepts. It is applicable to
implement all OOPs features such as class,
object and inheritance etc. The action is
shown in Figure 4.6.

HTTP request (

——
—

HTTP response

Web broswer

PHP

Executive PHP code

Web Server

Figure 4.6 Website Request and Response from
Web server to Browser

4,5 Web Server Installation
& Configuration Files

Web server software that
runs on server hardware,
governs the server side
scripting
into an intermediate
byte-code that is then
interpreted by the runtime engine.

compilation

Web server software is available

as open source or licensed version in the
Apache 45.2%
Nginx 40.0%
Microsoft-11S 9.3%
LiteSpeed 3.5%
Google Servers | 0.9%
Node.js ]0.5%
Tomcat ] 0.4%
Apache Traffic Server ]0.4%
IdeaWebServer ]0.3%
Tengine | 0.1%
Cowboy | 0.1%

Lighttpd | 0.1%

Figure 4.7 Webserver global usage
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market. Recent statistics of Web server
usage depict that more than 130% Websites
are running under the open source Web
servers such as Tomcat Apache, Nginx etc.
Refer Figure 4.7.

The following are the steps to install
and configure Apache Httpd Webserver
and PHP module
machine.

in windows server

Step 1:
Go to Apache foundation Website
and download the Httpd Webserver
Software.
https://httpd.apache.org/download.cgi

Step2:
After downloading .MSI file from
Apache foundation Website, user
launches the .MSI file and clicks
next and next button to finish the
installation on server machine. The
software takes default port number
130 or 130130. Once the user
finished, the Web server software is
installed and configured on server
hardware machine as a service.

Step 3:
To test the installation of Apache
Httpd Webserver, enter the following
URL from your Web browser which
is installed in your client machine.

https://localhost:130/ or https://
localhost:130130

The output page that says “Its works”

Step 4:
Administrator user can start, stop and
restart the Web server service at any
time via windows Control panel. Once
the services stops, the client machine
will not receive the response message
from server machine.

Chapter 4 Infroduction to PHP
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Step 5:
Webserver’s configuration setting file
“httpd.conf” is located in the conf
directory under the apache installation
directory. Edit this file and enable the
PHP module to run PHP scripting
language.

4.6 Web Development
Concept

Web development concept describesin detail
about Website development and hosting
through network (Internet/Intranet). The
process of development also includes Web
content generation, Web page designing,
Website security and so on.

4.6.1 How PHP Script Work

Website or Web page is developed by the
programmer using PHP script. Finally the
entire Website codes are moved to Web
server path in a remote server machine.

From client side, the end user opens
a browser, types the URL of the Website
or Webpage and initiates the request to
remote server machine over the network.

After receiving the request from
client machine the Web server tries to
compile and interpret the PHP code which
is available in remote machine. Next a
response will be generated and sent back
to the client machine over the network
from Webserver.

Finally the
installed in the client machine receives
the response and displays the output to
user, as shown in Figure 4.8

browser which is

4.6.2 PHP Syntax

PHP uses three diffrents types of Syntax.
They are as follows

1. Default Syntax

2. Short open Tags

3. HTML Script embed Tags

Server |

Client browser

1
request

Responge
4

X T

2
e
-«
Apache 3

Apache/IIS l T

MySQL/Microsoft SQL
Server/Oracle

= File System

3 = Database

Figure 4.8 Client to server Request

Chapter 4 Introduction to PHP

‘ ‘ X1l CompApp_English version CHAPTER 04.indd 88

1/5/2022 1:55:07 PM‘ ‘



www.tntextbooks.in

Default Syntax:

The default Syntax begins with “<?php”
and closes with “?>”. Also refer Figure 4.9

Opening PHP tag String

' '

] I I
<7 phpecho | “Hello world...” |;,?>

f f

Ouput . End of statement
one or more string

Closing PHP tag

Figure 4.9 PHP Syntax

Short open Tags

The Short open Tags begins with “<?” and
closes with “?>”. But admin user has to
enable Short style tags settings in php.ini file
on the server. Refer the syntax in Figure 4.10

Opening PHP tag String Closing PHP tag
1

<? I @ ” I. )
¢ 1echo | “Hello world... Hits

1 t

Ouput . End of statement
one or more string

Figure 4.10 PHP Short Syntax

HTML Script embed Tags:
HTML Script embed Tags looks just like
HTML script tag. The syntax is shown in
Figure 4.11.
<script language="php">
echo "This is HTML script tags.";
</script>

Figure 4.11 HTML Syntax

The above syntax is created and saved
in a file with extension of .php. This .php
file is ready to execute from Webserver and
generates response to client machine.

4.6.3 Embed PHP in HTML

PHP script can be written in side the
HTML code and save the file with
extension of .php. The embedded PHP file
get executed in the Webserver, the browser
receives only the HTML and other client
side files. None of the raw PHP code is
visible in browser which means that PHP
interpreter produces raw HTML files
to browsers in the client machine. Refer
Figure 4.12 for Web response

Ecommerce.Php

echo '<p>Order processed.</p>";
>

</body>

</html>

Client Browser Screen |View Source Code From Browser

<html> m Online - Crde- Results X + EJ iew-sourcedocalhost/ecomme 1 On
<head> — C @ localhost/ecommerce.php C @ view-sourcelocalhost/ec
<html>
<title>Online - Order Results</title> . prudl
Item Detalls <title:Online - Order Results< /ti
</head> z;"h;ad>
body>
Order Results <h;>1tem Details</hi>
<body> <h2>drder Results</h2>
<p>Order processed.</p> </body>
g Order processed. L
<h1>Item Details</h1> Proces </html
<h2>0rder Results</h2>
<?php

Figure 4.12 HTML Web Response
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4.6.4 Variable in PHP

PHP has variables like other programing

languages such as C, C++ and Python
etc. Variables are the storage location,
which can store the values for the later
manipulations in the program.

The variable in PHP begins with a
dollar ($) symbol and the assignment activity

<« »

implemented using “=" operator, finally
the statement ends with semi colon “;” The

semicolon indicates the end of statement.

The main advantage of the PHP
variable declaration is, it does not requires
to specify the data type keyword separately
such as int, char, float, double or string etc.

Basic Rules for Variable Declaration

e Variable name must always begin with
a $ symbol.

e Variable name can never start with a
number.

e Variable names are case-sensitive.

Example:
$a=5; $b=10;
$a_1="Computer Application”
$c=%a+$b;

echo $c¢;

4.6.5 PHP Data Type

PHP scripting language supports 13
primitive data types. Data Types play
importantrolein all programing languages
to classify the data according to the logics.
PHP supports the following data types.

1. String 5. Array
2. Integer 6. Object
3. Float 7. NULL
4. Boolean 8. Resource

Chapter 4 Introduction to PHP
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String:
String is a collection of characters within
the double or single quotes like

“Computer Application” or
‘Computer Application. Space is also
considered as a character.

Example:

<?php

$x = “Computer Application!”;
$y = ‘Computer Application’s
echo $x;

echo “<br>”;

echo $y;

>

Integer:

Integer is a data type which contains non
decimal numbers.

Example:
<?php

$x = 59135;
var_dump($x);
o>

Float:

Float is a data type which contains decimal
numbers.

Example:
<?php

$x = 19.15;
var_dump($x);
o>

Boolean:

Boolean is a data type which denotes the
possible two states, TRUE or FALSE
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Example:
<?php

$x = true;
$y = false;
echo $x;

echo $y;

>

Array:

Array is a data type which has multiple
values in single variable. You will learn

about arrays in the next chapter.

Example:

<?php

$cars = array(“Computer”,”Laptop”,”Mobile”);
var_dump($cars);

7>

OUTPUT:

array(3) { [0]=> string(5) “Computer “ [1]=>
string(3) “Laptop “ [2]=> string(6) “Mobile

“}

Var_dump:
The var_dump() system define
function, returns structured information

(type and value) about variables in PHP.

Object:

In PHP object is a data type which contains
information about data and function

inside the class.

‘ ‘ XIl CompApp_English version CHAPTER 04.indd 91

<?php
class School {
function marks() {
$this->sec = “A”;
}
}

/] create an object
$school_obj = new School ();
/] show object properties
echo $school_obj ->sec;

o>

NULL:

Null is a special data type which contains
no value:

<?php

$x = “COMPUTER APPLICATION!”;
$x = null;

var_dump($x);

>

OUTPUT:

NULL

Resources

Resource is a specific variable, it has
a reference to an external resource.
These variables hold specific handlers to
handle files and database connections in
respective PHP program.

<?php

// Open a file for reading
$handle = fopen(“note.txt”, “r”);
var_dump($handle);

echo “<br>7;

/] Connect to MySQL database server with
default setting

$link = mysql_connect(“localhost”, “root’,
‘(”);

var_dump($link);

=
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4.6.6.0Operators in PHP

Operator is a symbol which is used to perform mathematical and logical operations in the
programing languages. Different types of operator in PHP are:

1. Arithmetic operators,
Assignment operators,
Comparison operators,
Increment/Decrement operators,
Logical operators, and

o U oR W N

String operators.

Arithmetic operators

The arithmetic operators in PHP perform general arithmetical operations, such as
addition, subtraction, multiplication and division etc. Refer Table 4.1.

Symbol Operator Name Purpose
+ Addition This operator performs the process of adding numbers
- Subtraction This operator performs the process of subtracting numbers
* Multiplication This operator performs the process of multiplying numbers
® / Division This operator performs the process of dividing numbers ®
% Modulus This operator performs the process of finding remainder in
division operation of two numbers

Assignment Operators:

Assignment operators are performed with numeric values to store a value to a variable.
The default assignment operator is “=". This operator sets the left side operant value of
expression to right side variable. Refer Table 4.2.

Assignment Similar to Description

X=y X=y This operator sets the left side operant value of
expression to right side variable

X+=Yy X=X+Yy Addition
X-=y X=X-Y Subtraction
X*=y X=X*y Multiplication
x/=y x=x/y Division

X %=y x=x%Yy Modulus

I’®»  chapter4 [Introduction to PHP
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Comparison Operators:

Comparison operators perform an action to compare two values. These values may contain
integer or string data types (Number or Strings). Refer Table 4.3.

Symbol Operator Name Symbol Operator Name

== Equal > Greater than

==t Identical < Less than

I= Not equal >= Greater than or equal to
<> Not equal <= Less than or equal to
- Not identical

Increment and Decrement Operators:

Increment and decrement operators are used to perform the task of increasing or
decreasing variable’s value. This operator is mostly used during iterations in the program
logics. Refer Table 4.4.

®
®

Operator Name Description

++8$x Pre-increment Increments $x value by one, then returns $x
$x++ Post-increment Returns $x, then increments $x by one

--$x Pre-decrement Decrements $x by one, then returns $x

$x-- Post-decrement ~ Returns $x, then decrements $x by one

Logical Operators:

Logical Operators are used to combine conditional statements. Refer Table 4.5.

Symbol Operator Name  Example Result

&& And X && By True if both $x and $y are true

| Or $x || $y True if either $x or $y is true

! Not 1$x True if $x is not true

Xor Xor $x xor $y True if either $x or $y is true, but not both

Chapter 4 Introductionto PHP @K
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String Operators:

Two operators are used to perform string related operations such as Concatenation and
Concatenation assignment (Appends). Refer Table 4.6.

Operator Name Example Result

Concatenation $textl . § text2 Concatenation of $txtl and $txt2
= Concatenation $textl .= $ text2 Appends $txt2 to $txtl

assignment

POINTS TO REMEMBER I

e PHP is an Open Source

PHP is a Case Sensitive

PHP is a Simplicity Program language

PHP is a Efficiency Program language

PHP is a Platform Independent Program language
PHP is a Security Program language

PHP is a Flexibility Program language

PHP is a Real-Time Access Monitoring Program language

=
|GI.USSARY|

PHP PHP abbreviated as “HYPER TEXT PREPROCESSOR”. It is a server-side
scripting language

URL Uniform Resource Locator, the address of a specific Web page or file on the
Internet.
HTTP HTTP means HyperText Transfer Protocol. HTTP is the underlying protocol

used by the World Wide Web and this protocol defines how messages are
formatted and transmitted, and what actions Web servers and browsers
should take in response to various commands

YD cChapter 4 Introduction to PHP
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processes or devices.

Webserver A Web server is a Software that uses HTTP (Hypertext Transfer Protocol) to
serve the files that form Web pages to users

Web Browser A Web browser (commonly referred to as a browser) is a software application
for accessing information on the World Wide Web. Each individual Web
page, image, and video is identified by a distinct URL, enabling browsers to
retrieve and display them on the user’s device.

SERVER A server is a computer or a device that provides functionality for other
programs or devices, called “clients”. This architecture is called the client
server model, and a single overall computation is distributed across multiple

Where?

. TWhich? £ write

Write é Wh % ; \\']}cn? EVALUATION

When? 4 = When? [T When?

Part -1
Choose the correct answer

@ 1. What does PHP stand for?

a) Personal Home Page

b) Hypertext Preprocessor 4

c) Pretext Hypertext Processor

d) Pre-processor Home Page

2. What does PHP files have a default
file extension?

a) .html
b) .xml

c) .php

d) .ph

3. A PHP script should start with ___
and end with ___:

‘ ‘ Xl CompApp_English version CHAPTER 04.indd 95 @

a) <php>
b) < ? php ?>
c)<??>
d) < ?php ? >

. Which of the following must be

installed on your computer so as to
run PHP script?

a) Adobe
b) windows
c) Apache
d) I1S

We can use ___ to comment a single
line?

i) /? i) // iii) # iv) /**/
a) Only (ii)

b) (i), (iii) and (iv)

¢) (ii), (iii) and (iv)

d) Both (ii) and (iv)

Chapter 4 Introduction to PHP
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6. Which of the following PHP

statement will store 41 in variable
num?

(i) num = 41 (ii) num = 41

(iil) echcho num (iv) echo 41
a) Both (i) and (ii)

b) All of the above.

c) Only (ii)

d) Only (i)

. What will be the output of the

following PHP code?
< ¢php
$num = 1;
$numl = 2;
print $num . “+”. $numl ;
>
a)3

b) 1+2
c)1.+.2

d) Error

. Which of the following PHP

statements will output Hello World
on the screen?

a) echo (“Hello World”);
b) print (“Hello World™);
¢) printf (“Hello World”);
d) sprintf (“Hello World”);

. Which statement will output $x on

the screen?

a) echo “\$x7;
b) echo “$$x7;
c) echo “/$x”;

d) echo “$x;

Chapter 4 Introduction to PHP
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10. Which of the below symbols is a

newline character?
a) \r

b) \n

c)/n

d)/r

Part - I1
Short Answers

1.

5
6
7.
8
9

What are the common usages of
PHP?

What is Webserver?

. What are the types scripting

language?

. Difference between Client and

Server?

. Give few examples of Web Browser?

. What is URL?

Is PHP a case sensitive language?

. How to declare variables in PHP?

Define Client Server Architecture.

10. Define Webserver.

Part - II1
Explain in Brief Answer

1.

Write the features of server side
scripting language.

. Write is the purpose of Web servers?

3. Differentiate Server side and Client

Side Scripting language.

. In how many ways you can embed

PHP code in an HTML page?

. Write short notes on PHP operator.
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Part - IV
Explain in detail

Explain client side and server side scripting language.

Explain the process of Webserver installation.

Discuss in detail about PHP data types.

o1k B

Explain operators in PHP with example.

| _sTuoenT actviry

Discuss in detail about Website development activities.

Find out the following web technology details from famous website using free web

tools : http://similarweb.com or http://pub-db.com

1. Programing details
2. Webserver details
3. Hosting Country details
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PHP Function and Array

@ LEARNING OBJECTIVES

e To understand the importance of Functions in PHP

To know the types of functions in PHP

°
e To know the basics of array
e To know the types of Arrays in PHP

PHP Function and Array

In PHP server side scripting language
Functions and array concepts are very
important to solve the many complex
problems in real world.

m: PHP has over 700 functions built in
B that perform different tasks. Built in

—~
functions are functions that exist in

PHP installation package.

Functions in PHP

In most of the programming language,
a block of segment in a program that
perform specific operations like (Insert,
Execute, Delete, Calculate, etc.). This are
known as Functions. A Function is a type
of sub routine or procedure in a program.
A Function will be executed by a call to
the Function and the Function returns
any data type values or NULL value to
called Function in the part of respective
program.

Chapter 5 PHP Function and Array
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Functions can be divided in to
three types:
e User defined Function,
e Pre-defined or System or built-in
Function, and
e Parameterized Function.

User Defined Function

User Defined Function (UDF) in PHP gives
a privilege to user to write their own specific
operationinside of existing program module.

Two important steps the Programmer has to
create for users define Functions are:

Function Declaration

A user-defined Function declaration begins
with the keyword “function”. User can write
any custom logic inside the function block.

SYNTAX:
function functionName()

{

Custom Logic code to be executed;
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Function Calling:

Once a function is defined it is execulied by a function call. The programmer has to give
a functions Call inside the respective program.

SYNTAX:

functionName();

Example:
<?php
function insertMsg() {
echo “Student Details Inserted Successtully!”;
}
insertMsg(); // call the function
>

Pre-defined or system or built in function PHP has a wide collection of built-in functions
that can be called directly from with in a script, to perform a specific task. These built
in function are what make PHP a very efficient and productive. Scripting language no
installation is required to use these functions. The PHP built in function may be classified
into various caligories like;

PHP string function = — Functions that help us to manipulate strings
® PHP array function — Functions that allow you to access and ®

manipulate arrays.

PHP math function — Functions that help to perform mathematical
operations

PHP MySQLi function — Functions that allows you to access MySQL
database servers.

PHP file system — Functions that allow you to access and

function manipulate the file system

5.1 Parameterized Function

Values can be passed from one function to another function thru parameters.
The parameter is also called as arguments, it is like variables.

The arguments are mentioned after the function name and inside of the parenthesis.
There is no limit for sending arguments, just separate them with a comma notation.

Example 1:
The following example has a function with one Argument ($sfname):
<?php

function School_Name($sname) {

Chapter 5 PHP Function and Array @@L
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echo $sname.”’in Tamilnadu.<br>";
}
School_Name (“Government Higher Secondary School Madurai”);
School_Name (“Government Higher Secondary School Trichy”);
School_Name (“Government Higher Secondary School Chennai”);
School_Name (“Government Higher Secondary School Kanchipuram”);
School_Name (“Government Higher Secondary School Tirunelveli”);
>

Example 2:
The following example has a function with two arguments ($sname and $Strength):

<?php
function School _Name($sname,$Strength) {

echo $sname.”in Tamilnadu and Student Strength is”.$Strength;
}
School_Name (“Government Higher Secondary School Madurai”’200);
School_Name (“Government Higher Secondary School Trichy’,300);
School_Name (“Government Higher Secondary School Chennai”,250);
School_Name (“Government Higher Secondary School Kanchipuram”,100);
School_Name (“Government Higher Secondary School Tirunelveli’,200);
>

Example 3:
For a function to return a value, use the return statement
<?php
function sum($x, $y) { ,
$z = $x + $y; (ﬁm’ One of the most useful aspects
return $z; - of using arrays in PHP is when
} combined with the foreach statement.
This allows you to quickly loop though
echo “5 + 10 = . sum(5, 10) . “<br>"; an array with very little code.

echo “7 + 13 = “ . sum(7, 13) . “<br>";
echo “2 +4 =“.sum(2, 4);
>

5.2 Array in PHP

Array is a concept that stores more than one value of same data type (homogeneous) in

single array variable. They are 3 types of array concepts in PHP.

e Indexed Arrays,
e Associative Array and
e Multi-Dimensional Array.

Chapter 5 PHP Function and Array
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5.2.1 Indexed Arrays

An array is defined using the keyword “array”. Each element of line array is assigned on
index values which commences from O and ends with n-1. The user can access the array
element using the assname followed by index value.

Array defines with the keyword array()

$Array_Variable=array(“valuel”’value2”value2”);

S SN

Value Value Value
at O™ at 1st at 2nd
position | | position | | position

Figure 5.1 Indexed Arrays
Example:

<?php
$teacher_name=array(“Iniyan”, “Kavin”, “Nilani”);

« <

echo “The students name are “. $teacher_name[0] .  “. $$teacher_name[1] .

<« <«

and

“’)_

$teacher_name[2] . “7;
>

® 5.2.2 Associative Arrays ®

Associative arrays are a key-value pair data structure. Instead of storing data in a linear
array, with associative arrays you can store your data in a collection and assign it a unique
key which you may use for referencing your data.

SYNTAX:
Array Syntax:

An Array is defined ().

Associative Arrays Syntax
array(key=>value,key=>value,key=>value,etc.);

key = Specifies the key (numeric or string)

value = Specifies the value

Example:

<?php
$Marks=array(“Student1”=>“35"“Student2”=>“17",“Student3”=>“43");
echo “Studentl mark is” . $Marks[‘Student1’] . “ is eligible for qualification”;

echo “Student2 mark is” . $Marks[‘Student2’] . “ is not eligible for qualification”;
>

Chapter 5 PHP Function and Array @1

‘ ‘ X1l CompApp_English version CHAPTER 05.indd 101 @ 1/5/2022 1:56:55 PM‘ ‘



B [ ® H .  EEEm

- www.thtextbooks.in

5.2.3 Multidimensional Arrays

A multidimensional array is an array containing one or more arrays.PHP understands
multidimensional arrays that are two, three, four, five, or more levels deep. However,
arrays more than three levels deep are hard to manage for most people.

Example:

<?php

/I A two-dimensional array
$student=array

(

array(“Iniyan”100,96),
array(“Kavin”,60,59),
array(“Nilani”1313,139)
);

echo $$student[0][0].”: Tamil Mark: “$student [0][1].” English mark: “.$student [0]
[2]7<br>";
echo $$student[1][0].”: Tamil Mark: “.$student [1][1].” English mark: “.$student [1]
[2]7<br>";

echo $$student[2][0].”: Tamil Mark: “.$student [2][1].” English mark: “.$student [2]
@ [2]”<br>7; @

>

POINTS TO REMEMBER

e In PHP Functions Reduce duplication of code

In PHP Functions Decompose complex problems into simpler pieces

In PHP Functions Improve clarity of the code

In PHP Functions Reuse code

In PHP Functions hide Information

In PHP arrays use Foreach looping concept

12
(GLossarY)

Functions A function is that they are reusable; if you have a task that needs to be
performed a number of times, a function is an ideal solution.

User defined Function Besides the built-in PHP functions, we can create our own functions.
A function is a block of statements that can be used repeatedly in a
program.

IET) cChapter5 PHP Function and Array
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System Define A function is already created by system it is a reusable piece or block of

Functions code that performs a specific action. Functions can either return values
when called or can simply perform an operation without returning any
value.

Parameterized PHP Parameterized functions are the functions with parameters or

Function arguments.

Array An array is a special variable, which can hold more than one value at a

time of same type. It’s a collection of homogeneous data

Associative Array Associative arrays are arrays that use named keys that you assign to
them.

Indexed Arrays The index value is assigned to each array element.

Multi-Dimensional A multidimensional array is an array containing one or more arrays.

Array

4 .o ? (3G = 5
Where? rite

Write % "it' = v EVALUATION

When?

Part -1
Choose the correct answer

1. Which one of the following is the right way of defining a function in
@ PHP? @®
a) function { function body }
b) data type functionName(parameters) { function body }
c)functionName(parameters) { function body }
d) function functionName(parameters) { function body }

2. A function in PHP starts with __.

a) function b) __ def c) def d) function
3. PHP’s indexed array begin with position
a) 1 b) 2 c)0 d) -1
4. Identify the parameter in the function.
< ?php
function abc ($x)
{$y=10;}
abc (5);
o>
a) $x b) $y ¢) 10 d)5
5. stores more than one value of same data type in single array variable.
a) Array b) Function c¢) Indexed array d) Multidimensional array

Chapter 5 PHP Function and Array @ ENEN
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____ pair
data structure.

a) Single value
b) Key value
¢) Double value

d) String value

. In parameterized, the parameters

are like
a) Variables
b) Constants
c) String

d) Null value

. In PHP arrays are of ____ types

a) l
b) 2
c)3
d) 4

. $ stud = array (“Roll” = “125017,

“Name” = “Hari”); Identify the type
of array.

a) Indexed array

b) Associative array

c) Vector array

d) Multidimensional array

_ levels deep

are hard to manage.
a)l b) 2
)3 d) Multiple

Part - I1
Short Answers

1. Define Function in PHP.

| _sTuoenT actvity

@R W

© ® N o

Define User defined Function.
What is parameterized Function.
Name any two predefined functions.

Write the Syntax to define Function
in PHP.

Define Array in PHP.
What is function call?.
List out the types of array in PHP.

Define associative array.

10. What are indexed arrays?

Part - II1
Explain in Brief Answer

1.

Write the features of built-in
Functions.

. Write the purpose of parameterized

Function.

Differentiate user defined and
system defined Functions.

. Write Short notes on Array.

5. Write short note on predefined or

built-in functions.

Part - IV
Explain in detail

1. Explain Function concepts in PHP.

. Discuss in detail about User define

Functions with a suitable example.

3. Explain the Multidimensional Array.

. Explain Array concepts and their

types.
Explain Indexed array and Associate
array in PHP.

e Create store the student details arrays and display the values.

e List out real world Built-in string function usages in PHP

Chapter 5 PHP Function and Array
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switch ( It is important to use Hreak;
{ at the end of each case statement.
Otherwise the following statements
Case will all be executed!

break;

0 6 Statement following the keyword
: will only be executed if

no other cases have been matched.

CHAPTER -ase

break;

PHP Conditional Statements

@ LEARNING OBJECTIVES

e To understand the importance of Conditional Statements
e To know different types of Conditional Statements in PHP

e To know the Basic fundamental logic creation using Conditional Statements

PHP Conditional Statements:
Like other Programming languages, PHP also allows to write code that perform different
actions based on the results of a logical or a test Condition. Thus you can create test
@ conditions in the form of expressions that evaluates to either true or false and based on @
these results you can perform certain actions. The following statements in PHP help us to
make decisions:
e if Statement
e if...else Statement
o if..elseif....else Statement

e switch Statement

If statement in PHP:

If statement executes a statement or a group of statements if a specific condition is satisfied
as per the users expectation. This is the simplest PHP’s conditional statement and can be
written in the following form.

Syntax:

if (condition)

{

Statement(s);

}
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$Pass_Mark=35;
$Student_Mark=70;

if ($Student_Mark>= $Pass_Mark){
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(@,’\ Conditional statements Very
- often when we write code,
you want to perform different actions
for different decisions in different
business logic.

echo “The Student is Eligible for the

Promotion”;

}e>

If else statement in PHP:

The if statement evaluates a condition and executes a set of code if the condition is true

and another set of code if the condition is false.

Syntax:

if (condition)

{
Statement(s) if condition is true;
}
® else
{
Statement(s) if condition is false;
}
Example:
<?php
$Pass_Mark=35;
$Student_Mark=70;
if ($Student_Mark>= $Pass_Mark){
echo “The Student is eligible for the promotion”;
}
else {
echo “The Student is not eligible for the promotion”;
}e>
I cChapter 6 PHP Conditional Statements
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If elseif else statement in PHP:

If-elseif-else statement is a combination of if-else statement. Here multiple conditions can
be checked and action is based on the result of the condition.

Syntax:

if (Condition 1)
{

Statement(s) if condition 1 is true;

}
elseif(Condition 2)

{

Statement(s) if condition 2 is true;

}

else

{

Statement(s) if both conditions are false;

}

° i g °
Example: - »

I The if.. elseif.. else is also
<?php known as if.. else ledder as if
$Pass. Mark=35; lets us chain together multiple if... else
statements allowing the programmer
to define actions for more than just
$Student_Mark=70; two possible outcomes.

if ($Student_Mark>= $first_class){

$first_class=60;

echo “The Student is eligible for the promotion with First Class”;

}

elseif ($Student_Mark>= $Pass_Mark){

echo “The Student is eligible for the promotion”;

}

else {

echo “The Student is not eligible for the promotion”;

}e>

Chapter 6 PHP Conditional Statements 107
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Switch Case:

The switch case is an alternative to the if.. elseif..else statement which executes a block of

code corresponding to the match.

Syntax:

switch (n) {
case labell:
code to be executed if n=labell;
break;
case label2:
code to be executed if n=label2;
break;
case label3:

code to be executed if n=label3;
break;

default:

code to be executed if n is different from all labels;

}

Example:
<?php
$favcolor = “red”;
switch ($favcolor) {
case “red”:
echo “Your favorite color is red!”;
break;
case “blue”:
echo “Your favorite color is blue!”;
break;
case “green’:

echo “Your favorite color is green!”;

break;
default:
echo “Your favorite color is neither red, blue, nor green!”;
}
>

Chapter 6 PHP Conditional Statements
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POINTS TO REMEMBER

e The if statement contains boolean expression inside brackets followed by a
single or multi line code block.

e if-else Statement also provides for a second part to the if statement, that is else.
The else statement must follow if or else if statement.

=
|GLOSSARY|

Conditional It performs different actions for different decisions in programing language
Statements

IF else Statement ~ The If Statement is a way to make decisions based upon the result of a
condition.

Switch Statement  Switch statement work the same as if else if statement as they can check for
multiple values at a time

Where? ©%° ‘oWhich?¢ & Write

Write 575, 2 What 2 = wher EVALUATION

When? E When? T When?

Part-1
Choose the correct answer

1. What will be the output of the 2. What will be the output of the
following PHP code? following PHP code ?
<?php <?php
$x; $x =05
if ($x) if ($x++)
print “hi”; print “hi”;
else else
print “how are u”; print “how are u”;
> >
a) how are u a) hi
b) hi b) no output
C) error c) error
d) no output d) how are u

Chapter 6 PHP Conditional Statements @@L
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3. What will be the output of the 6. What will be the output of the

following PHP code ?

following PHP code ?

<?php <?php
$X; $a — « »;
if ($x ==0) i ($0)

1 a

print “hi” ;

else print “all”;
print “how are u”; else
print “hello” o )
> print "'some’;
a) how are uhello >
b) hihello 2l
) hi b) some
d) no output &) error

. Statement which is used to make

choice between two options and only
option is to be performed is written as

a. if statement

d) no output

. What will be the output of the

b. if else statement following PHP code ? ®
c. then else statement <tphp
d. else one statement $x =10;

. What will be the output of the Sy = 20;

following PHP code ?

if ($x > $y + $y !=3)

<?php

$a = print “hi” ;

lf ($a) else

print “all”;

i print “how are u”;
else >

print “some”;

a) how are u

o>
a) all b) hi
b) some C) error
c) error

d) no output

d) no output

IEET) cChapter 6 PHP Conditional Statements
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8. What will be the output of the

following PHP code ?

<?php
$x =10;
$y = 20;

if ($x > $y && 1|[1)
print “hi” ;
else
print “how are u”;
>

a) how are u

b) hi

c) error

d) no output

. What will be the output of the

following PHP code ?
<?php
if (-100)
print “hi”;
else
print “how are u”;

>
a) how are u b) hi
c) error d) no output

Part - 11
Short Answers

1. Define Conditional Statements in

PHP

2. Define if statement in PHP.
3. What is if else statement in PHP?

4. List out Conditional Statements in

PHP.

| _sTuoenT actvity

5. Write the Syntax of the If else
statement in PHP.

6. Define if...elseif....else Statement in
PHP.

7. Write the usage of Switch Statement
in PHP.

8. Write the Syntax of Switch statement.

9. Compare if and if else statement.

Part - 111
Explain in Brief Answer
1. Write the features Conditional
Statements in PHP.
2. Write is the purpose of if elseif else
stament.
3. Differentiate Switch and if else
statement.
4. Write Short notes on Switch
statement.
5. Differentiate if statement and if
elseif stament. @

Part - IV
Explain in detail
1. Explain the Function of Conditional
Statements in PHP.

2. Discuss in detail about Switch
statement with an example.

3. Explain the working of Conditional
Statements in PHP?

4. Explain the if elseif else statement.
With suitable example.

5. Explain if else statement in PHP.
With an example.

e Create simple decision making scenario using if else statement in student

management application

e Explain real world usages in using Conditional Statements
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Looping Structure

@ LEARNING OBJECTIVES

e To understand the importance of Looping Structure
e To know different types of Looping Structure in PHP

e To know the Basic fundamental logic creation using Looping Structure

Looping Structure:

Loop structures in PHP is an iterative control structures that involves executive the same

® block of code a specified num ber of times. Loops that iterate for fixed no of times is also ®
called as Bounded loops. PHP supports four types of loops. Refer Figure 7.1 for flow chart
of for Loop Structure.

e for Loop e While Loop
e foreach Loop e Do While Loop
For Loop:

The for loop is used when you know how many times you want to execute a statement or
block of statements.

Syntax:

for (init counter; test counter; increment counter) {
code to be executed;

Parameters:
e init counter: Initialize the loop initial counter value

e Test counter: Evaluated for every iteration of the loop. If it evaluates to TRUE, the loop
continues. If it evaluates to FALSE, the loop ends.

e Increment counter: Increases the loop counter value.

IEET)D chapter 7 Looping Structure
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Loop-
continuation-
condition?,
True False
Statement(s) System, out. println
(loop body) ("Welcoe to atnyla”);

False ¢
—[ Action after each iteration ] —[ i++ ]

@) @)

True

Figure 7.1 Flowchart of For loop Structure and Flow chart
Example:
<?php
for ($i = 0; $i<= 10; $i++) {
echo “The number is: $i<br>";

}

[
Foreach Loop:

foreach loop is exclusively available in PHP and is mainly used for looping through the
values of an array. The loop iteration deepens on each KEY Value pair in the Array. For
each, loop iteration the value of the current array element is assigned to $value variable

and the array pointer is advanced by one, until it reaches the end of the array element.
Refer Figure 7.2.

Syntax: E _=.
foreach ($array as $value) { ﬁ ._ :
code to be executed; :E s
}

seq = [18, 20, 32] &

foreach x of seq - Netowe The foreach construct
print x - provides an easy way to
end iterate over arrays. foreach works only
on arrays and objects, and will issue
18 20 32 an error when you try to use it on a
Yl\-/’/ variable with a different data type or

an uninitialized variable.

print

Figure 7.2 Foreach loop Structure and Flow

Chapter 7 Looping Structure
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Example: ,

<?php (ﬁ,'\ PHP Loop Often when you

$Student_name = array(“Magilan”, “Iniyan”, o write code, you want the

“Nilani”, “Sibi”, “Shini”); same block of code to run over and

over again in a row. Instead of adding

foreach ($Student_name as $value) { several almost equal code-lines in a
echo “$value <br>"; script, we can use loops to perform a

} task.

o>

While Loop:

The while loop executes a block of code as long as the condition specified in the while
statement evaluates to true. Refer Figure 7.3

Initialization; <—
—> while(condition) <—
{ True(3) False(3) }@

Statement-1;
Statement-2;

® ) ®

Statement-n;

Updation; <—n

Figure 7.3 While loop Structure and Flow

Syntax:

while (condition is true) {
code to be executed;

Example:

<?php

$Student_count = 10;

$student_number=1;

while($student_number<= $Student_count) {
echo “The student number is: $student number<br>";
$student_number++;

}

>

I  chapter 7 Looping Structure
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Do While Loop:

The do.. while loop is always very similer to the while loop but executes the block of code
at least once before evaluating the condition. Here the condition is evaluated only at the
time of exit of each iteration. Refer Figure 7.4.

This
h Start loop
appen “Do-While”
at least )
once\_ ¢‘ /—Ioops run the
~ 4o looping code
> something first...
..and then
check for the
condition
Yes is No
condition Stop loop

true?

Figure 7.4 DoWhile loop Structure and Flow Chart

Syntax:

® do { @
code to be executed;
} while (condition is true);

Example:

<?php
$Student_count = 10;

$student_number=1;

do
{

echo “The student number is: $student number<br>";
$student_number++;

}

while($student_number<= $Student_count)

>

Chapter 7 Looping Structure  @EETN
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e PHP while loops execute a block of code while the specified condition is true.

e The for loop is used when you know in advance how many times the script

should run.

e The foreach loop works only on arrays, and is used to loop through each key/

value pair in an array.

e do...while - loops through a block of code once, and then repeats the loop as

long as the specified condition is true

12
(GLossARY]

Looping In programming it is often necessary to repeat the same block of code a
Structure given number of times, or until a certain condition is met. This can be
accomplished using looping statements

for Loop For loops execute a block of code a specified number of times.

foreach Loop The foreach construct provides an easy way to iterate over arrays

While Loop PHP while loops execute a block of code while the specified condition is
true.

SWhich? & Write

- . EVALUATION

What?

<
4 E When? = When?

Part -1

Choose the correct answer

1. The loop exclusively used for

arraysis
a) While

b) Do While
¢) For

d) for each

2. Loops that iterate for fixed number
of times is called

a) Unbounded loops
b) Bounded loops

c) While loops
d) For loops

IEED) chapter 7 Looping Structure
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3. Which loop evaluates condition

expression as Boolean, if it is true,
it executes statements and when it is
false it will terminate?

a) For loop b) For each loop

¢) While loop d) All of them

. for ($ x=0; $ x<5; x++)

echo “Hai”

The above loop executes how many
no of times?

a)5
b) 4
c)3
d)2
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5. What will be displayed in a browser 8. Consider the following code
when the following PHP code is <? php
executed: $count=12;
<?php do{

printf(“%d squared=%d<br/>”,
$count, pow($count,2));

for ($counter = 20; $counter < 10;

$counter++){ :
echo “Welcome to Tamilnadu lwh11e($c0unt<4);
>
}
echo “Counter is: $counter”: What will be the output of the code.
2> a) 12 squared 141

b) 12 squared=141
c) “12 squared=141”
d) Execution error

9. What will be the output of the
following PHP code ?

a) Welcome to Tamilnadu

b) Counter is: 20

¢) Welcome to Tamilnadu Counter
is: 22

d) Welcome to Tamilnadu Welcome

to Tamilnadu Counter is: 22 <tphp
for ($x = 1; $x < 10;++$x)
6. What will be displayed in a browser {

when the following PHP code is print “\%;

® executed: } ®

<?php o5

for ($counter = 10; $counter < 10; ) wonnennnnn
a

$counter = $counter + 5){

b) 2656 5 56 56 X6
echo “Hello”;

54 % 5 34 > 4% %
c)

}
?> d) Infinite loop

el sl Belo ko Hele 10. What will be the output of the

b) Hello Hello Hello following PHP code ?

¢) Hello <?php

d) None of the above for ($x = -1; $x < 10;--$x)
7. PHP supports which types of { '

looping techniques; print $x;

a) for loop }

b) while loop >

c) foreach loop a) 123456713910412

d) all the above b) 123456713910

c) 1234567139104
d) Infinite loop

Chapter 7 Looping Structure 117
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Part - 11
Short Answers

1.

v s Y e

N

Define Looping Structure in PHP.
Define for loop in PHP.

What is For each loop in PHP?
List out Looping Structure in PHP.
Write Syntax of For loop in PHP.

Write Syntax of For each loop in
PHP.

Write Syntax of while loop in PHP.

8. Write Syntax of Do while loop in

9.

PHP.

Compare For loop and for each loop.

10. Explain the use of for each loop in

PHP

Part - II1
Explain in Brief Answer

1.

Write the features Looping Structure.

| _sTuoenT actviiy ¢

2. Write the purpose of Looping
Structure in PHP
3. Differentiate For each and While
loop.
4. Write short notes on Do while Loop.
5. Differentiate While and Do while
loops.
Part - IV
Explain in detail
1. Explain Looping Structure in PHP.
2. Discuss in detail about For each
loop.
3. Explain the process Do while loop.
4. Explain concepts of for loop with
example.
5. Explain working of loops in array.

e Create simple array element and display the values using foreach

e Explain real world usages in using Looping Structure

Chapter 7 Looping Structure

‘ ‘ XIl CompApp_English version CHAPTER 07.indd 118

1/5/2022 1:58:47 PM‘ ‘



Forms and Files

@ LEARNING OBJECTIVES

—
=
=
e
—_—
—
-
—
—
—
—
—

e To understand the importance of HTML Form in Web Application
e To know the File handling technique in PHP

e To know the Basics of Web based file management system

8.1 HTML Forms

Main objective of PHP and HTML form
controls are to collect data from users. In
the web development, user access website
or web pages from remote client machine
and feed the data to server. These data are
collected via HTML form controls like
textbox, dropdown box and radio button
etc., and sent to server using server side
programming like PHP.

Basic HTML Form Controls

The following control are available in
HTML forms:

e Radio box

e File Select

e Text inputs

e Buttons
e Checkbox

Text inputs contain textbox and text area
controls. Buttons may contain Submit
button, Reset button and Cancel Button.
Checkbox is a important feature which

e Form Tag

Pizza Shop 2.0

Name |

Pizza Topping

O Supreme

©) Vegetarian
O Hawaiian

Pizza Sauce

Optional Extras

| Tomato v |

O eExtra Cheese [ Gluten Free Base

Delivery Instructions:

[ Send my order |

Figure 8.1 Example of HTML form Page
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selects more than one value from the HTML form. Radio box is similar to checkbox but one
value can be chosen at a time. File select is the best feature to select one file from the local
machine to server machine at a time. Form tag is used to mention a method (POST or GET)
and control the entire form controls in the HTML document. Refer Figure 8.1 and 8.2

8.1.1 PHP Basic Form Handling

When the user keys in the input data in HTML controls and clicks the submit button the
request will be generated and reaches a PHP file which is mentioned in the FORM tag
under the Action attribute. All the input values are synchronized and sent to the server
via POST method or GET method. Method is an attribute of form tag in HTML. Once the
data reaches the server, two PHP variables such as $ POST and $ GET collects the data
and prepares the response accordingly.

Post Method: The input data sent to the server with POST method is stored in the request
body of the client’s HTTP request.

Get Method: The input data sent to the server with POST method via URL address is
known as query string. All input data are visible by user after they click the submit button.

Example:

Test.html:
<html>
<body>

<form action="welcome.php” method="post”>

Name: <input type="text” name="name”><br>
E-mail: <input type="text” name="email”><br>
<input type="submit”>

</form>

</body>

</html>

Welcome.php:

<html>

<body>

Welcome <?php echo $_POST[“name”]; ?><br>

Your email address is: <?php echo $_POST[“email”]; ?>
</body>

</html>

IEFI)  chapter8 Forms and Files
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Output

Name: [sethuraman

E-mail: [srssethuraman@gamail.com|

Output
Welcome sethuraman

Your email address is: srssethuraman@gamail.com

Figure 8.2 Login module

e In the above example the HTML File
contains two Text Box (Name and
Email), One Button and one form tag.
The remote server PHP file (welcome.
php) is mentioned in form tag under
the Action Attribute.

e In “Welcome.Php” file, PHP variables
such as $ POST and $_GET collects
the data and prepares the response
accordingly.

e Eventually the user will receive the
output response in the client machine’s
browser screen.

8.1.2 Basic PHP Form Validation

checking the input data
submitted by the user
machine.

from client

There are two types of

Validation rules for HTML input field

Name (Text Input)
Email (Text Input)
Website (Text Input)
Radio

Check Box

Drop Down menu

‘ ‘ XII CompApp_English version CHAPTER 08.indd 121

validation available in PHP. They are as
follows,

Client-Side Validation: The input
data validations are performed on the
client machine’s web browsers using client
side scripts like Java script or adding
“required” attribute in HTML input tags.

Server Side Validation: After
the submission of data, validations are
performed on the server side using the
programming like PHP, ASP or JSP etc.
available in the server machine.

4

~

A HTML form will take input from
the site visitor and then will post
it to a back-end application such
as CGI, ASP Script or PHP script etc. The
back-end application will perform required
processing on the passed data based on

defined business logic inside the application.

Must contain letters and white-spaces
Must contain @ and .strings

Must contain a valid URL

Must be selectable minimum one value
Must be checkable minimum one value

Must be selectable minimum one value

Chapter 8 Forms and Files
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Client Side Validation:

Before sending the data to server side program (PHP) the programmer can write few
validations from browser in the client machine. For this validation, we have to add
additional “required” attribute in HTML input tag. Refer Figure 8.3.

Example:
<input> required Attribute in HTML Username: | )[ submit
<form action="welcome.php”>
: » » Please fill in this field.
Username: <input type="text

» b2 .
name= name requ1red>

. » s o» Figure 8.3 Client Validation
<input type="submit”> e

</form>

8.2 Files

File handling is an important activity of all web application development process. Files are

processed for different tasks using the following events:

PHP Open a File,

PHP Read a File,

PHP Close a File,

PHP Write a File, @&
PHP Appending a File and

PHP uploading a File.

PHP Open a File

fopen() is a system function available in PHP. This function helps to open a file in the
server. It contains two parameters one for the file and the other one specifies in which
mode the file should be opened (Read/Write).

Syntax:
$file_Object= fopen(“FileName”, “Read/WriteMode”) or die(“Error Message!”);

Example:

<?php
$myfile = fopen(“Student.txt”, “r”) or die(“Unable to open file!”);

>

PHP Read a File:

The fread() function reads from an open file. The file object comes from fopen function.

Syntax:
fread($file_Object,filesize(“FileName”));

IBEF?)  chapter8 Forms and Files
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Example:

<?php
fread($myfile,filesize(“Student.txt”));
>

PHP Close a File:

The fclose() function is used to close an
opened file. The file object comes from
fopen function.

Syntax:

fclose($file_Object);

Example:

<?php

$mytfile = fopen(“student.txt”, “r”);
// some code to be executed....

POINTS TO REMEMBER

fclose($myfile);
>

PHP write a File:

The fwrite() function is used to write to a
file.

Syntax:
fwrite($myfile, $txt);

e Form Attribute action Backend script ready to process your passed data.

e Method to be used to upload data. The most frequently used are GET and POST

methods.

e Target Specity the target window or frame where the result of the script will be
displayed. It takes values like _blank, _self, _parent etc.

e You can use the enctype attribute to specify how the browser encodes the data

before it sends it to the server.

2
|GLOSSARY|

Hypertext Markup Language is the standard markup language for creating

Validation of HTML form data is important to protect your form from

File handling is an important part of any web application. You often need

A PHP script can be used with a HTML form to allow users to upload files

HTML
web pages and web applications.
FORM Validation
hackers and spammers!
Files handling
to open and process a file for different tasks.
File upload
to the server.
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“Which? & write

. EVALUATION

Y What?
When?

Part -1
Choose the correct answer

1.

When you use the $_GET variable to
collect data, the data is visible to..

a) none

b) only user

Cc) everyone

d) selected few

_____ method stores the input data
in the request body of the clients
HTTP request.

a) POST
b) GET
¢) form
d) HTML

. In which input field only one option

Can be selected??
a) Text box

b) Check box

¢) radio button

d) Drop Down Menu

In HTML form <input type="text”>
is used to

a) process text
b) input text

¢) Validate text
d) Output text

. Which attribute of form tag helps in

client side validation?
a) Submit

b) Check

¢) Validate

d) Required

Chapter 8 Forms and Files
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6. The no. of parameters used by
fclose() function.

a) l b) 2
)3 d) 4
7. PHP is a ____ programming
language.
a) Client side b) Server side

c) Object side d) file side

8. What does fopen() function do in
PHP?

a) It used to open files in PHP
b) It used to open Remote Server
c) It used to open folders in PHP ®
d) It used to open Remote Computer
9. How PHP files can be accessed?
a) Through Web Browser
b) Through HTML files
c) Through Web Server
d) All of Above

10.Identify which is not a server side
application language
a) PHP
b) HTML
c) ASP
d) JSP

Part - II
Short Answers

1. Define HTML form controls.

2. Define for Form Handling method
in PHP.
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5
6
7.
8
9

List out HTML control to support
PHP language.

. Write Syntax of Text box in HTML.
. Define File handling in PHP.

What is a HTML form?

. Write any Two rules for input HTML.
. Differentiate check box and .

Part - IV
Explain in detail

10. Write syntax of File open function.

Part - 111

Explain in Brief Answer

4. Write short notes on File handling.

5. Write short notes on File handling
functions.

1. Explain Form Handling methods.
2. Discuss in detail about HTML form

3. Explain the process File handling.

4. Explain

concepts of HTTP

Uploading process.

5. Explain in detail of File handling

functions .

1. Write the features Form Handling.

2. Write the purpose Get method and

Post method.

3. Differentiate Get and Post Method.

| _sTuoen actvity

e Create simple student Login Form to validate username and password using java
script (client side validation)

e Create simple student registration form to inert studnets details like Student
Name, username and password etc. using java script (client side validation)
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CHAPTER

Connecting PHP and MYSQL :|..

@ LEARNING OBJECTIVES

e To understand the importance of Database Connectivity
e To know the PHP MySQL functions

e To know the features of MySQL Connection Process

e To know the Basics of Web Databases

Connecting PHP and MySQL language connectivity, which covers
® Data is important in computer and Database =~ connection  establishment, ®
Internet related applications. Numerous Database ~ Selection,  SQL  statement

growths of data need a secure and execution, and Connection termination.
convenient environment to store and . .
manipulate autonomously. All these 9.1 MySQL Function in PHP
features are available in Relational In PHP Scripting language many functions
Database Management System (RDMS) are available for MySQL Database
such as MySQL, Oracle, IBM DB2, connectivity and executing SQL queries.
and Microsoft SQLSERVER etc. These MySQLi is extension in PHP
databases are connected with Programing scripting language which gives access to
language and perform major operations the MYSQL database. MySQLi extension
like INSERT, SELECT, UPDATE and was introduced version 5.0.0,
DELETE using Structured query language
(SQL). The combination of
PHP and MySQL has become
very popular server side web
scripting language in Internet.
Refer Figure 9.1.

This  chapter  covers
MySQL d PHP ipti

¥5Q an SCHIping Figure 9.1 Browser Button
126

‘ ‘ XII CompApp_English version CHAPTER 09.indd 126 @ 1/5/2022 2:02:55PM‘ ‘



B [ [ [ ® . EEES

] www.thtextbooks.in

The MySQLi extension contains the following important functions which are related to
MySQL database connectivity and management.

e Mysqli_connect() Function
e Mysqli_close() Function

e Mysqli_query()Function

9.1.1 Database Connections:

Before accessing MySQL Database, connect to Database Server machine via PHP scripting
language using Mysqli_connect() Function.

Syntax:

mysqli_connect(“Server Name “User Name”,Password”,; DB Name”);

This function requires four parameters to connect to database server. Database Server
name, Database username, password and Database Name.

9.1.2 Managing Database Connections

The below code describes managing database connection methods and features.

<?php
$servername = “localhost™;
$username = “username’;

$password = “password”;
$DB_name = “School_DB”;

$conn = mysqli_connect($servername, $username, $password,$DB_name);

if ('$conn) {

die(“Connection failed: “ . mysqli_connect_error());

Chapter 9 Connecting PHP and MYSQL 127
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echo “Connected successfully”;

>

In the above code snippet, four variables are used to connect to the Database server. They

are
e $servername  -> Database Server Server IP address
e $username -> Database Server User Name

e $password ->  Database Server Password

e $DB Name -> Database Name

The mysqli_connect function uses these variables to connect Database server to PHP.
If connection gets fail, output will be printed with MySQL error code. Otherwise connection
is success.

9.1.3 Performing Queries

The main goal of MySQL and PHP connectivity is to retrieve and manipulate the data
from MySQL database server. The SQL query statements help in PHP MySQL extension
to achieve the objective of MySQL and PHP connection. “mysqli_query” is a function,
that helps to execute the SQL query statements in PHP scripting language.

Syntax:

mysqli_query(“Connection Object”y’SQL Query”)

Example:

$con=mysqli_connect(“localhost”ymy_user”, my_password”,Student_DB “);
$sql="SELECT student_name,student_age FROM student”;mysqli_query($con,$sql);

9.1.4 Closing Connection:

mysqli_close() Function is used to close an existing opened database connection between
PHP scripting and MySQL Database Server.

Syntax:

mysqli_close(“Connection Object”);

Example:

<?php

Chapter 9 Connecting PHP and MYSQL
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$con=mysqli_connect(“localhost”$user”,$password”” SCHOOL_DB”);
mysqli_close($con);

>

Example of PHP and MySQL Program:

<?php

$servername = “localhost”;

$username = “username”;

$password = “password”;
$dbname = “school_DB”;

$connection = mysqli_connect(‘$servername |, ‘$username, ‘$password, $dbname’);

if (mysqli_connect_errno())

{

echo “Failed to connect to MySQL: “ . mysqli_connect_error();
}
sql_stmt = “SELECT * FROM my_contacts”; //SQL select query

$result = mysqli_query($connection,$sql_stmt);//execute SQL statement$rows =
mysqli_num_rows($result);// get number of rows returned

@® if ($rows) { ®
while ($row = mysqli_fetch_array($result)) {

echo ‘ID: ‘. $row[‘id’] . ‘<br>’;
echo ‘Full Names: . $row[‘full_names’] . ‘<br>’;
echo ‘Gender: ‘. $row[‘gender’] . ‘<br>’;
echo ‘Contact No: ‘. $row[‘contact_no’] . ‘<br>’;
echo ‘Email: . $row|[‘email’] . ‘<br>’;
echo ‘City: “. $row([city’] . ‘<br>’;
echo ‘Country: *. $row[‘country’] . ‘<br><br>’;
}
}

mysqli_close($connection); //close the database connection
>

In the above code the SQL query retrieves two records from student table in school
database. These records are populated into client browser using PHP scripting language.

Chapter 9 Connecting PHP and MYSOL QXTI
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W‘Facebook technology stack consist of application written in many language, including
~ WOW? " PHP and many others. Facebook still uses PHP but it has built a compiler for it so it
can be turned into native code. Facebook has many things built in PHP. Actually it’s
not the real PHP, Facebook has written alternative version of PHP that is, HipHop’s HPHP
which help to convert PHP code into C++.

W‘PHP has also attracted the development of many software frameworks that provide
7 WNW? building blocks and a design structure to promote rapid application development
(RAD). Some of these include PRADO, CakePHP, Symfony, Codelgniter, Laravel, Yii
Framework, Phalcon and Zend Framework, offering features similar to other web frameworks.

~

POINTS TO REMEMBER

e PHP is Open source & Community support scripting language
e PHP is a server-side scripting language designed for Web development.
e Seventy Percentage of Website has been built by PHP and MySQL

e Major of the webservers can support PHP scripting language

e PHP can embed easily with HTML and client side scripting language
® e PHP has built-in function which can be easily connected to MySQL database ®
e PHP scripting language has been supported by many Software frameworks

2
|GLUSSARY|

SQL SQL is a domain-specific language used in programming and designed for
managing data held in a relational database management system

Queries A query is a request for data or information from a database table or
combination of tables.

MySQL MySQL is an open-source relational database management system

SERVER A server is a computer or a device that provides functionality for other
programs or devices, called “clients”. This architecture is called the client—
server model, and a single overall computation is distributed across multiple
processes or devices.

Database A database is an organized collection of data, generally stored and accessed
electronically from a computer system.

IEE) cChapter9 Connecting PHP and MYSQL
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Wi 2o v - = 00 EVALUATION

WG » = When? T When?

Part -1
Choose the correct answer

1. Which is the correct function to execute the SQL queries in PHP ?

a) mysqli_query(“Connection Object”’SQL Query”)
b) query(“Connection Object”’SQL Query”)

c) mysql_query(“Connection Object”,’SQL Query”)
d) mysql_query(“SQL Query”)

2. Which is the correct function Closing Connection in PHP ?

a) mysqli_close(“Connection Object”);
b) close(“Connection Object”);
c) mysql_close(“Connection Object”);

d) mysqli_close(“Database Object”);

3. Which is the correct function to establish Connection in PHP ?

a) mysqli_connect(“Server Name “User Name”; Password”, DB Name”);

b) connect(“Server Name “User Name”, Password”,’ DB Name”);

® c) mysql_connect(“Server Name “User Name”, Password”, DB Name”); ®

d) mysqli_connect (“Database Object”);
4. Which is the not a correct MySQL Function in PHP ?
a) Mysqli_connect() Function
b) Mysqli_close() Function
c) mysqli_select_data() Function

d) mysqli_affected_rows() Function

5. How many parameter are required for MYSQLi connect function in PHP ?

a)2 b)3 ¢4 d) 5

6. How many parameter are required for MYSQLi query function in PHP ?

)2 b3 o4 d)5

7. How many parameter are required for MYSQLi Close function in PHP ?

a)l b)2 ¢)3 d) 5
8. Which version of PHP supports MySQLi fuctions ?
a) Version 2.0
b) Version 3.0
¢) Version 4.0
d) Version 5.0
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Part - 11
Short Answers

1.

o S e Bl

What are the MySQLi function available PHP?
What is MySQLi function?

What are the types MySQLi function available PHP?
Difference between Connection and Close function?
Give few examples of MySQLi Queries.

What is Connection string?

Part - 111
Explain in Brief Answer

1.
2.
3.

Write the Syntax for MySQLi Queries.
Write is the purpose of MySQLi function available.
Write MySQL Connection Syntax with example.

Part - IV
Explain in detail

1.

D
® 3.

Discuss in detail about MySQL functions with example .
Explain in details types of MySQL connection method in PHP.
Explain MySQLi Queries with examples.

| _sTuoenT actviry ¢

e Create simple student Login Form to validate username and password using

PHP and MySQL (Server side validation)

e Createsimple student registration form to inert studnets detailslike Student Name,

username and password etc. using PHP and MySQL (Server side validation).
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Introduction to Computer Networks

@ LEARNING OBJECTIVES

e

e To know about history of computer networking & the Internet

Demerits of Internet

10.1 Introduction

A set of computers connected together for
the purpose of sharing resources is called
as computer networks. At present, Internet
is the most common resource shared
everywhere. Some of the shared resources
shown in Figure 10.1 are file server, web
camera, speakers, printer, scanner, fax
machine etc., Accessing services such as
WWW (World Wide Web), Digital audio,
Digital video which are shared to use
applications, software, and storage servers.

y,ﬁ:‘_-g - .
y =

Figure 10.1 Devices in Network
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Discuss about the explosion on the Internet

To learn about the growth of computer networking

Uses of computer networks at home, business, mobile, social media

Computer networking is a technique
of digital telecommunications network one
that permits nodes to share its resources.
This computer networking exchanges the
data with each other through wired or
wireless connections between different
terminals called nodes. The data from these
wires is transferred over any cable media
such as fiber optic cable wire or a wireless
media such as WiFi.

A Computer which is connected
to a network is called as node. The data
originates and terminates at these particular
nodes is called as a source and destination.
In networking, nodes are identified by its
IP addresses i.e.,(network address) and can
include hosts such as mobile phones , tabs ,
personal computers, huge servers and other
networking device. Connecting more than
one device is called as network.
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10.2 History of Computer Networking and the Internet

The history of computer networks and its development were briefly explained in the table

given below:

S.No Period

1 Late
1950

@

2 1960

3 1963

4 1965

BEEDD  chapter10

Method

SAGE (Semi -
Automatic Ground

Environment)

SABRE(Semi
Automatic Business

Research
Environment)

Packet switching

Intergalactic
Computer network

Telephone switch

Introduction to Computer Networks
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History

It was used at U.S Military Radar system.

At Commercial Airline Reservation system online
connected with two main frame computers.

Packet switching was developed by Paul Baran and
Donald Devices to transfer the information between
computers and network.

NPL network (National Physical Laboratory ) at united
kingdom local area network (LAN) using line speed of
768kbit/s was implemented by Davies pioneered

Intergalactic Computer network was send by J.C.RLicklider
to his office colleagues discussing about this concept, a
computer network engaged to access communication with
users of computers.

At first widely used Telephone switch was introduced
by Western Electric which implemented true computer
control.
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5 1966 WAN (Wide Area An experimental paper on WAN (Wide Area Network) has
Network ) been published by Thomas Marill and Lawrence G.Roberts
published in the area of time sharing.

6 1969- ARPANET First In 1969, four nodes of ARPANET were connected
1970 (Hierarchical routing between four universities namely the university of
after 1970’s Internet ~ California at Los Angeles, at Santa Barbara, the Stanford
today) Research Institute and the university of Utah using the 50

Kbit/s circuits.

Packet —switched networks was the theoretical work to
model was performed by Leonard Kleinrock , ARPANET
was which underpinned the development of it and his
theoretical work on hierarchical routing in late 1970 s
with his student Farouk Kamoun remains critical to the
operation of the Internet today.

7 1972 X.25 Using X.25 as commercial services were deployed then was
TCP/IP using an infrastructure for expanding TCP/IP networks.
8 1973 Hosts In1973, a French network named CYCLADES was the first

for making hosts which is responsible for reliable delivery
of data, later it became centralized service of network in

@ itself. @

9 1973- Ethernet A memo at Xerox PARC was written by Robert Metcalfe
1979 describing Ethernet in 1973, in an Aloha based networking

system which was developed in 1960s by Norman
Abramson and colleagues at the University of Hawaii.
At July 1976 the paper published “Ethernet: Distributed
Packet Switching for Local Computer Networks” by
Robert Metcalfe and David Boggs, then collaborated on
many patents received in 1977 and 1978. Robert Metcalfe
pursued making on open standard at 1979.

10 1976 ARCNET ARCNET was created by John Murphy of Data point
corporation in which token-passing network was used first
to share the storage device in 1976.

11 1995 NEW FIBRE OPTIC The speed capacity of transmission for Ethernet was
CABLES slightly elevated from 10 Mbit/s to 100Mbit/sat 1995.After
19913, Ethernet supported transmission speed capacity
towards gigabit. Frequently, highest speeds up to 100 Gbit/s
were appended (still 2016). Ethernet has ability to grow
easily (such as quick compatible to support new fiber optic
cable speed)

Chapter 10 Introduction to Computer Networks (135 |
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Age of commence begins

1948

Memex conceived
1945

1945

1995
Mosaic created
1993
WWW created
1989
Internet named and goes TCP/IP
1984
TCP/IP Created
1972
TCP/IP Created
1972
ARPANET
1969
Hypertent invented
1965
Packet switching invented
1964
First vast computer network envisioned
1962
Silicon chip
1958
A mathematical theory of communication

1995

Figure 10.2 Evolution of Internet

INTERNET Stands for

e INTERnational NETwork (Technology,
telecom, intelligence)

e Internet is a network of networks-A
global network.

e Internet stands for Interesting Notions
Transmitted Electronically Round
Newly Engineered Technology.

Now a days the Internet plays a vital
role. It provides all the information and
services to us. Earlier days if we want
anything, we have to go to market and
purchase in person. Nowadays we order
anything and everything (food, clothes,
stationeries, vegetables...etc.) through
online(Internet). Online service providers
are Flipkart, Amazon, snap deal etc to buy
products via Internet and have the product
at door steps. Online payments help in

Chapter 10 Introduction to Computer Networks
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sending and receiving money via payment
gateway using this Internet. Refer Figure
10.2 for the Evolution of Internet

e-Governance has made our
work easy by providing all government
information online easily. As Internet
provides its service 24x7 - 365 days, people
around the world can access the government

websites at their own pace.

Merchandising via Internet helps
us get good branded products at offer
rates through free delivery service.

Powerful search engine can take us
to imaginary concept to our hand with
all as a text, audio, video, with briefly and
by without moving to library, or taking
advice from expert. Current affairs can
be updated immediately without any
delay. For example on olden days Internet
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Explorer, Yahoo, bing were powerful
search engine. Later, Google stepped
in with user friendly gmail, youtube,
googledrive, google maps, etc. and are
useful applications. Students, researchers
can get their relevant study and research
materials easily via Internet.

Disadvantages of Internet

e Simply wasting the precious time
on Internet by surfing, searching
unwanted things.

e Lotofunnecessary wronginformations
are sometimes posted by some people
on their web pages, blog etc.

e Different types of thefts related to
money and other valuables can take
place through Internet as hackers and
viruses are always active around.

10.2.1 The Internet Explosion

Internet  is  simply
defined as the World
Wide Web connection
of individual networks

operated by academic
persons,
people, government, and private parties.

industry

In few years, the Internet built itself
as a highly powerful platform that changed
our way we do business and the way we
communicate. Internet promotes as the
universal source of information of billions
of people, at work, at home, at school.

As Internet is growing, markable
evolution has come mobile technology and
social web. These two innovations have
changed the life style of people. We may find
many communities in social web. Facebook
was created in 2004 but today has more
than 2,230 million active users. Mobile

‘ ‘ XII CompApp_English version CHAPTER 10.indd 137

technology has increased the use of Internet
all over the world.

The Internet allows all to be
democratic in mass media. Anyone can
have a webpage in Internet with very
low investment. Similarly any business
can reach a very large market directly,
economically and fast, no matter of
location or size of their business. Almost
anyone that who can read and write can
have aaccess and a presence in World Wide
Web with very low investment. People
everywhere can express and publish their
ideas and opinions via blogging.

10.2.2 Growth of Computer
Networking

The Internet is a global network of
computers linked by high-speed data lines
and wireless systems. It is estimated that
the Internet links 50 million users in more
than 80 countries world wide. This may
increase to around 300 million in next five
years.

Lot of difficulties were faced by
the service providers (including Google)
in expanding their residential fiber optic
cables Internet service due to increased
competition and installation cost from
other broadband providers. Even though
4G LTE mobile network was not reached
to many parts of world, the industry of
telecommunication has been working
hard on the development of their next
generation “5G” cellular communication
Technology. This 5G intense to boost
up the speed the mobile connections
dramatically,. When 4G was initially
being developed, companies did not
wait to advertise about the 5G efforts.

Chapter 10 Introduction to Computer Networks
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Figure 10.3 shows Generation of Mobile
Networks

1G ZG
S

More thap
1 Gb/s

24 Kb/s | 64 Kb/s | 2Mb/s | 100 Mb/s

Figure 10.3 Generation of Mobile Networks

Artificial intelligence will help
to maintain, manage, and protect the
network problems. Now the networks
are monitored by algorithm that enables
for anomalous build-ups of traffic and
activity which may be the result of nasty
activities such as (DDos) Distributed
Denial-of-Service attacks and attempted
hacks. This Artificial Network powering
algorithms will become most intelligent;
it might find faster and reliable methods
of anticipating threats and cleaning
networks. Artificial intelligence will be
able to predict traffic as it collects and
analyzes data in real time.

10.3 Uses of the Computer
Networks

The computer networks play a major role
in providing information to large , small
organization as well as common man.
Now a days almost all the companies,
bank and stores have implemented the
computerized transactions. It may be in
same campus, building, city, or at different
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places (or) cities. For all these purpose the
computer networks are used.

The common uses of computer network
are

e Communication
e Resource sharing
e Data (or) software sharing

e Money saving

Communication

Using computer networks, we can interact
with the different people with each other
all over the world. It provides a powerful
communication among widely separated
employees, team, section. They can easily
communicate at very low cost via mobile,
social media, telephone, e-mail, chatting,
video telephone, video conferencing,
SMS, MMS, groupware etc...

Resource sharing

Resource sharing means when one device
is accessed by many systems. It allows
all kind of programs, equipment’s and
available data to be accessed by anyone
via network irrespective of the physical
location of the resource. Simply resource
sharing is sharing such as printers,
scanner, PDA, fax machine, and modems.
For example, many computers can access
one printer if it is in network.

Software (or) Data sharing

Using computer network, any application
or other software can be stored at a central
computer or server. The software can be
shared among other computers of the
network. It provides high reliability and
backup can also be stored at one location
for easy availability in case of crash.
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Money saving

Computer networking is also money
savingasitreduces paper work, manpower,
resources sharing, software sharing and
also time saving.

10.3.1 Networks in Business

In twenty first century, communication
is very important factor for successful
business operations. There by with the
growth of computer network and speedy
Internet services, business also developed
drastically.

With the development of cloud computing,
global access and security issues were
restricted. Internet conversation made
conversation faster, quick decision making
and money saving e-banking paved way
for easy transactions. Business large or
small scale B2C, B2B, B2G,C2B, C2C,
C2G, G2B,G2C, G2G or commercial that
transfer information across the Internet
can be done. Cheap marketing and easy
selection of products through Internet
with customers satisfaction can also be
done. Company renewals, license, other
certificates, bill receipts,
invoice, stock maintenance, can be done

payments,
without any geographical boundaries
via Internet and computer networks.
Government subsidies were available for
their business to promote their business
by digitization.

Direct human interactions are

reduced because of Internet. Buyer
directly purchases any product from
cost, middle
person brokerage charges are reduced.
The network connectivity in business is

shown in Figure 10.5

manufacturer with less
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10.3.2 Networks at Home

Now a day, network has become
common as it facilitates communication
among devices with in the close vicinity
of a home. Devices in this network can
be smart devices, mobile computers,
network printers which are capable of
interacting and thereby increase the
quality of life inside home in a variety
of ways like automation of repetitive
tasks, increased personal productivity,
enhanced home security and easier
access to entertainment. Networks at
home were connected in two ways they

are:

e Wired network

e Wireless network

A Wired network system is connected with
a network cable . For example speakers,
CCTYV, printers, outdoors, and scanners
etc., with cables.

A Wireless network is connecting
devices like tablets(tab), indoor cameras
and E-readers, etc., without cables (WiFi).

Wired network

Figure 10.4 Wired and Wireless Network

Networkathomehelpsustoperform
e-banking,
e-health, telemedicine, call centers, video
conferencing, digitalization of memories,
etc. Refer Figure 10.4

e-learning, e-governance,

Chapter 10 Introduction to Computer Networks
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10.3.3 Mobile Networks

Mobile network is the network connecting
devices without cable (wireless). Mobile
computers, such as laptop, tablet, and
hand held computers, were fastest growing
segments. At land areas network was
distributed as cells, each will be served by
single — location transceiver, but generally
three cell sites or a base transceiver station.
This base station provides the cell with
network coverage and other features that
can be utilized for transmission of voice,
data and other content as well. Joining
together all radio coverage is called as wide
geographical area. This portable transceivers
used to communicate with one another with
fixed transceivers and moving via more than
one cell during transmission. For example
mobiles, tablets, pagers, laptops, engaged
with mobile broadband just like modems
etc. Refer Figure 10.6

Features of Mobile Networks

e Less consumption of power is used by
mobile devices compared to a single
transmitter or satellite since the cell
towers are closer.

e Huge capacity than a large transmitter,
at single frequency can be used for
different or many links as long as they
are in different in cells.

e Asmobile phones are now heavily used
for data communication, the mobile
network traffic is fully busy.

Mobile phone converts voice, text,
multi-media message or data calls into
Radio-frequencies (RF). Mobile phone
base stations transmit and receive these
RF signals and connects callers to other
phones and other network.

Private cellular networks can be
used at various locations like research,
large organizations and small industries.

After the reach of mobile and
access to Internet work progress faster.
People can be in touch with others even
while traveling. Important informations
can be received any time without much
problems. Searching important topics,
checking mail, watching progress of
company can be done easily sitting at one
place. Adequate computer knowledge is
sufficient to access Internet via mobile
network.

Branch office

Branch office

Figure 10.5 Networks in Business
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10.3.4 Social Application

To get connected to with people around
the world through social network media,
applications like Whatsapp, Facebook,
Twitter, Blogs, Pinterest, Classmate and so
on are in full fledge use.

Through the social media we share our
thoughts, ideas, files and also chats. Refer
Figure 10.7 given below.

Figure 10.7 Social Media Outline

These several
attributes in common:

e Membership. Social nets generally

social networks share

requires user to register names and
avoid duplicate and
maintain secrecy. So many public

a_Ju=

o
I

accounts to

~ Cable

&

o o

\

\/

Small office

0000000000000
Cellular

networks offer free registration
and some meagre charges for their
services. Private networks (such as
BANK ACCOUNT HOLDERS groups)
restrict registration to people who

meet certain eligibility criteria.

e Content contribution. These networks

allow members to easily share
comments, movies, music, short films

and/or photos with others.

e Frequent return visits. Healthy social
net have a group of members who
check in regularly to contribute their
share and also for new updates

e Human relationship building. The
common goal of most social networks
is to allow interaction among people,
which create stronger connection with
people of different communities.

Benefits of Social Networks

Besides being a fun place to meet and
relax with people, social networking
leads to some extremely useful benefits to
individuals and communities:

Internet service
provider

Dial-up
telephone

Figure 10.6 Mobile Networks
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Group information sharing over long
distances. Although friends and family
members can keep in contact via mobile
phone calls or by text messages, social
nets provide a much richer environment
for staying connected. We can also share
photo albums, videos and convey daily
wishes through the social network.
Group discussions and Group chats go
on in various groups through which
people are kept in touch with each other.

Broadcast announcements. Quick,
easy way to spread informations of
emergencies and natural calamities.
Venues and local shops can advertise
upcoming events on social networks.

Business people can market their
products through these networks.

Fostering diversity of thought. Some
critics of social networks say that online
communities attract people by similar
interests and backgrounds. Indeed, when
the people with different opinions do get
together on online, many discussions
to degenerate into personal
attacks and so-called “flame wars.” The

seem

arguments goes online, healthy debate
takes place and some of them become
viral also.

Such arguments and talks bring out a

relaxation for busy people from their regular
work schedules. It also enriches with current
affairs and keep in touch with people.

e A set of computers connected together for the purpose of sharing resources is called as
computer network. Internet is the most common resource shared on today.

Computer networking is a technique of digital telecommunication network that permits nodes

to share its resources with one another. Computer networking exchanges the data as a main

element. These link were transferred over cable media like optic cables or wire or wireless

media such as Bluetooth and WIFI

Packet switching is a method of grouping data that is transmitted over a digital network into

packets.

In 1966 WAN (WIDE AREA NETWORK)was introduced for time sharing.

Artificial intelligence helps to predict traffic as it collects and analyzes data in real time.

The common uses of computer networks were

o Communication
o Resource Sharing
o Data (or) software sharing

©  Money savings

Networks at home were connected by two ways they are

o Wired network

o  Wireless network

e When group of people of different opinion come together online, many discussions arise

which lead to personal attacks called “flame wars.”

Chapter 10 Introduction to Computer Networks
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|GLOSSARY|

WWW

SAGE

SABRE

Packet Switching

Telephone Switches

WAN
Arpanet
Hosts

NEW FIBER OPTIC cable

e-Governance

e-Banking

Hackers

Viruses

Globalized

Blogging
Cloud Storage

Cloud Computing

e-Readers

Flame wars

World wide web
Semi — Automatic Ground Environment
Semi Automatic Business Research Environment

It used to transfer the information between computers and
network

First widely used to which implemented true computer control.
Wide Area Network
Advanced Research Projects Agency Network

the service provider that leases this infrastructure, which is
known as hosting.

Here speed capacity of transmission has increased 10 Mbit/s
to 100 Mbit/s now on this fibre optic cable has speed upto 100
Gbit/s

This is an application of ICT for access the government services,
communication transactions, of various standards system
between government to citizen, government to business.

It was a safe, fast, easy and efficient electronic service that
enables you access to bank account and to carry out online
banking services, 24 hours a day, and 7 days a week.

Hackers were skilled computer experts, some who with their
technical knowledge access our accounts.

Malware treats or computer warms that replicates it
By its own is called as virus

Developed to make international influence or operation
possible.

Add new material to or regularly update a blog.

Just a storage of data on online, access in different area no
geographical limits was in need

It is based on Internet computing, to share resources, software
and information.

E-Readers is similarly called as e-book reader these were
designed for the purpose of reading via mobile electronics
device to read digital e-books and periodically

Flame wars are nothing that lengthy exchange of angry or
abusive messages between users of an online forum or other
discussion area.
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b Whichﬁ & Write

What?
When? & When?

Part -1
Choose the correct answer

1. A set of computers connecting

together is called as ----------
a) Network
¢) Hub

b) Server
d) Node

. Computer network devices that

originates route and terminate the
data were called as

a) Hub

b) Resource
¢) Node

d) Cable

. Match the period and mehods

available on history of computer
networking in the Internet

1) 1950 - X.25 TCP/IP
2) 1966 - SAGE

3) 1976 - WAN

4) 1972 - ARCNET
a)4,3,2,1 b) 3,4,2,1
c)1,2,3,4 d)2,3,4,1

. Western Electric introduced the first

widely used ----------------- that
implemented true computer control.

a) Packet switch
b) Arpanet
¢) Host

d) Telephone switch

Chapter 10 Introduction to Computer Networks
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5. Wi-Fi is short name for

a) Wireless Fidelity

b) Wired fidelity

¢) Wired fiber optic
d) Wireless fiber optic

. Inwhichone ofthe following periods,

the speed capacity supported towards
gigabit on computer network?

a) SABRE

b) SAGE

c) NEW FIBRE OPTICS
d) ARCNET

. Which among them was challenging

to the business people on computer
networking

a) Hacking
b) Viruses
c) Botha &b

d) none of this above

L e helps to predict, manage,

and protect the computer network at
problems.

a) Artificial intelligence
b) Broadband provider
c¢) Cloud computing

d) Transceivers
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less power

comparing with single transmitter
or satellite with cell towers closer.

a) Mobile devices
b) Transistors
c) WIFI

d) Communication

10.People now a days getting relaxed

11.

via

a) Business

b) Corporate company

c) News papers

d) Social media

Which one of the following is not
the social media

a) Gmail

b) Facebook

c) twitter

d) Linkedin

12.Facebook was created in
———————————— year
a) 2002 b) 2004
c) 2013 d) 2010

13.In mobile network, land areas for

network coverage was distributed as
a) Firmware b) cells

c) Range d) Service

14.Which one of the following are

harmful to computer?
a) Bloggers
b) Browser
¢) Hackers

d) twitter

‘ ‘ XIl CompApp_English version CHAPTER 10.indd 145

15. Which innovation made the people

to use Internet?

a) Social web

b) Mobile technology
c) Mobile App

d) Both a & b.

Part - I1
Short Answers

1.

2

Define Computer Network.

Define Internet.

. What are the common wuses of

computer network?

. List out some features of mobile

network.

Difference between wired and

wireless networks.

Part - 111
Explain in Brief Answer

1.

2

Define ARPANET.
Write the disadvantages of Internet.

What s
Intelligence?

meant by artificial

. List out some benefits of social

networks.

. How computer networks are money

saving?

Part - IV
Explain in detail

1.

Define
and

computer
Explain different
developments on computer network
and Internet.

networking
Internet.

Chapter 10 Introduction to Computer Networks
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2. Explain the growth of the computer networking.

3. Mention some uses of network at business, home, mobile, social application.

| _sTupenT activiies

List out the wireless network ?
1. Find out how your family members and other public use the network ?

2. Instead of landline (wired network) what were the types of wireless network you
know?

3. Some example devices with wireless networks

How social media has its memory management ?
1. Do you have a account on social media (or) create an account

2. Analyse how the social media applications transfer a huge data

IR Chapter 10 Introduction to Computer Networks
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Network Examples and Protocols

@ LEARNING OBJECTIVES

e To know network examples like Intranet, Intranet, Extranet

e Different types of mobile networks
e Know about wlans :802.11
e To Know about RFID

e Discuss briefly about the network protocols

11.1 Introduction

Internet Protocol (IP) is the principle of
communication protocol amoung the
Internet protocols forlayering on datagram
across boundaries of other networks. Its
main function is to allow Internet working

and boost up the Internet.

Internet protocol (IP) will discharge
packets from the source host and it will
deliver to the destination host via IP

address in the packet header.

Network protocols is the usual
procedures, rules, formal standards and
policies comprised of formats which
allows communication between more
than one device which is connected to the
network. Network protocols have to do
end-to-end process of secure on time and

manage data or network communication.
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All requirements which combine
process, on network protocols so as to
carry out the communication between
routers, servers, computers, laptop, and
other authorized networked device. Here
on network protocols might be installed
and rooters in both sender and receiver
to ensure data or network communication
and apply to software and hardware nodes
which communicate on a network.

The broad types of networking

protocols, including:

e Network communication protocols is
the basic data communication protocol
which consist of HTTP and TCP/IP.

e Network security protocol is which
implement security over network
communication and include HTTP,
SFTP and SSL.

e Network management protocol will
Provide network governance and

147
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Figure: 11.1 INTERNET

maintenance and include ICMP and
SNMP.

11.1.1 Internet/Intranet/

Extranet
INTERNET: The Internet, “the Net,” is a
worldwide system of computer networks-
A network of networks where the users
at any one computer can, if they have
permission, get information from any
other computer. The Internet is a network
of global connections - comprising private,
public, business, academic and government
networks - linked by guided, wireless and
fiber-optic technologies. It was perceived
by the Advanced Research Projects Agency
(ARPA) of the U.S. government in 1969 and
was first recognized as the ARPANet. The
unique aim was to generate a network that
would permit users of a research computer
from one university to “talk to” research
computers on other universities. The
jargons Internet and World Wide Web are
frequently used interchangeably, but they
are not precisely the same. The Internet
denotes to the global communication
system, including infrastructure and
hardware, whereas the web is one of the
services interconnected over the Internet.

See Figure 11.1
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INTRANET: It is a

network within an enterprise to share

private

company data and computing resources
between the employees. It may consist
of many interlinked local area networks.
It includes connections through one or
more gateway (connects two networks
using different protocols together known
as protocol convertor) computers to

outside Internet. See Figure 11.2

Figure 11.2 Intranet

EXTRANET: It is a private network that
uses Internet technology and the public
telecommunication system to securely
with

suppliers, vendors, partners, customers,

share business’s information

or other businesses. See Figure 11.3 and
11.4
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Firewall

Figure 11.3 Extranet

w‘lnternet of Things refers to the digital
?

. interconnection of everyday objects Q o = :
(home applicances, wearable devices or ﬁ IlNTERNET . fad m iI'-.
automobiles) with the Internet. The ‘thing’ in IoT 0
refers to objects that have been assigned an IP 8_' ’“THINGS ' _ 2
address and have the ability to collect and transfer =0s anms G m
data over a network without manual assistance or s A -
intervention. b= g o
Comparison
Type Definition Example

Internet A global network, public TCP/IP network used ~ Sending email to a friend
by over a billion people all over the world

Intranet A TCP/IP network with access restricted to Accessing your record in the
members of an organization employee personnel file

Extranet A TCP/IP network with restricted access to Checking availability of inventory
members from an outside supplier

Chapter 11 Network Examples and Protocols QT
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Network Diagram

Internet

Extranet

Internet
server

Extranet
server

Intranet
server

Application

il server

Intranet

Figure 11.4 Internet, Intranet and Extranet

@® Application of Internet. Application of Intranet

e Download programs and e Sharing of company
files policies/rules and

e Social media regulations

e E-Mail °

e E-Banking °

e Audio and Video Office Orders
Conferencing ® Access product and

e E-Commerce customer data

e File Sharing ®

e E- Governance common interest

e Information browsing e Launching of personal/

e Search the web addresses
for access through search Submission of reports
engine e Corporate telephone

e Chatting and etc directories.

Access employee database
Distribution of circulars/

Sharing of information of

departmental home pages

Application of Extranet

Customer communications
Online education/ training
Account status enquiry
Inventory enquiry

Online discussion

Supply - chain managements
Order status enquiry
Warranty registration

Claims

Distributor promotions

11.1.2 Mobile Networks

A mobile network or cellular network as it
is made up of a large number of signal areas
called cells. These cells join to form a large
coverage area. Users can cross into different
cells without losing their connection.

Chapter 11 Network Examples and Protocols
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Within each cell there is a base station,
which sends and receives the mobile signals.
A mobile device will connect to the nearest
or least base station. The base stations are
connected to digital exchange where the
communication is sent to other telephone
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or data networks. Cells will often be smaller
in size in large towns, as the number of users
in the area is more. Communication over
mobile network is made up of voice, data,
images and text messages. See Figure 11.5

Macrocells
\“|||
&|||
\“lll
Rural
&|||
- \“lll
Microcells
ﬂlll “'I' ﬂlll
ﬂlll ﬂ||| ﬂIII \k\”
Urban

Figure 11.5 Mobile Network

Mobile networking assign to the technology
supports voice/data, network connectivity
using via radio transmission solution. The
common application of mobile networks
is mobile phones, tablets, etc.. In the past,
wireless communications largely used
circuit switching to carry only voice over a
network, but now currently both data and
voice are being transmitted over both circuit
via switched networks and packet-switched

networks.

The generation of mobile networks
are as follows.

e First Generation(1G) 1981- NMT
launch
e Second Generation(2G) 1991-GSM

Launch

e Second to Third Generation Bridge
(2.5)2000 — GPRS launch

‘ ‘ XII CompApp_English version CHAPTER 11.indd 151

e Third Generation( 3G) 2003- UK 3G
launch

e Fourth Generation (4 G) 2007
e Fifth Generation (5G) 2019+

First Generation (1G) 1981
- NMT launch

During the initial periods the mobile
systems based on
transmission. NMT stands for Nordic
Mobile Telephone communication. They
had a very low traffic density of one
call per radio channel, and a very poor

voice quality, and they used unsure and

were analog

unencrypted transmission, which leads to
the spoofing of its identities.

Second Generation (2G) 1991 -
GSM launch

Later the second generation of mobile
systemswere placedondigital transmission
with GSM. GSM stands for (Global
System for Mobile communication)
was most popular standard which is used
in second generation, using 900MHz
and 1800MHz for the frequency bands.
GSM  mobile grown digital
transmission using SIM. SIM stands for
(Subscriber Identity Module) technology
to authenticate a user for identification

systems

and billing purposes, and to encrypt the
data to prevent listen without permission
(eavesdropping). The transmission used as
TDMA. TMDA stands for (Time Division
Multiple Access) and CDMA stands for
(Code Division Multiple Access ) method
to increase the amount of information
transported on the network. Mobility is
supported at layer 2, which stops seamless
roaming across assorted access networks
and routing domains. This means that

Chapter 11 Network Examples and Protocols

1/5/2022 2:07:47 PM‘ ‘



@

www.tntextbooks.in

each operator must cover the entire area
or have agreements in place to permit
roaming.

Second to Third Generations Bridge
(2.5G) 2000 - GPRS launch

GPRS was introduced here, this is the
excess period of mobile networking
development, between 2G and 3G.
GPRS stands for(General Packet Radio
Service).GPRS is a data service which
enables mobile devices to send and
receive messages, picture messages and
e-mails. It allows most popular operating
speeds of up to 115kbit/s, latterly
maximum of 384kbit/s by usingEDGE.
EDGE stands for EDGE (Enhanced
Data rates for Global Evolution). GSM
data transmission rates typically reached

9.6kbit/s.

Third Generation(3G)2003 - First
UK 3G launch

This generation of mobile system merges
different mobile technology standards,
and uses higher frequency bands for
transmission and Code Division Multiple
Access to deliver data rates of up to
2Mbit/s supporting multimedia services

ﬁl‘Li—Fi is a wireless technology
~ WOW?  \vhich uses light-emitting diodes

(LEDs) for data transmission
whereas Wi-Fi uses radio frequencies for
data transmission. Li-Fi is the short form
of Light Fidelity.

—~-

The term Li-Fi was first used by
Harald Haas, Professor in Edinburgh
University. The computer scientists
achieved speeds of 224 gbps in the lab
and research is going on. The biggest
revolution in the Internet world is going
to happen

Chapter 11 Network Examples and Protocols
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(MMS: voice, video and data). European
standard is UMTS (Universal Mobile
Mobile
phones systems continue to use digital

Telecommunication Systems).

transmission with SIM authentication for
billing systems and for data incorruption.
Data transmission used a WCDMA.
WCDMA stands for (Wideband Code
Division Multiple Access). A technique
to obtain data rates between 384kbit/s
and 2048kbit/s. Few 3G suppliers use
ATM (Asynchronous Transfer Mode)
for ‘over the air’ network with in MPLS
(Multiprotocol Label Switching) or IP for
their backbone network.

Mobility still supported at layer
2, and hence like 2G it still prohibits
seamless roaming beyond heterogeneous
access networks and routing domains.
The transmission were band frequencies
between 1900 and 2200 MHz. All UMTS
license holders at the UK holds a 20
year license with the condition that 80%
population coverage 1is achieved by
31 December 2007. The present third
generation licensed operators in the UK
can be seen below as at August 2004.

Fourth Generation(4G) 2007

4G is at the research stage. 4G was based on
an adhoc networking model where there was
no need for a fixed infrastructure operation.
Adhoc networking requires global mobility
features (e.g. Mobile IP) and connectivity
to a global IPv6 network to support an IP
address for each mobile device. Logically
roaming in assorted IP networks (for
example: 802.11 WLAN, GPRS and UMTY)
were possible with higher data rates, from
2Mbit/s to 10-100Mbit/s, offering reduced
delays and new services. Mobile devices will
not expect on a fixed infrastructure, they
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will require enhanced intelligence to self
configure in adhoc networks and having a
routing capabilities to route over a packet-
switched network.

Fifth Generation (5G) 2019+

5G is the stage succeeds the 4G (LTE/
WiMAx), 3G(umts) and 2G(GSM)
syetems. 5G targets to perform the high
data rate, reduced latency, energy saving,
cost reduction, higher system, capacity,
and massive device connectivity. The two
phases of 5G, First one will be Release-15
complete by March 2019,Second one
Release-16 is expected to complete
at March2020, for submission to the
ITU(International Telecommunication
Union) as a candidate IMT-2020
technology. The ITUIMT - 2020 provides
speed up to 20 gigabits per second it has
been demonstrated with millimeter waves
of 15 gigahertz and higher frequency. 3
GPP standard includes any network using
New Radio software. 5G New Radio can
access at lower frequencies from 600 MHz
to 6 GHz. Speed in the lower frequencies
are only modest higher than 4G systems,
estimated at 15% to 50% faster.

11.1.3 WLANS 802.11

Wi-Fi stands for Wireless Fidelity. It
is a wireless network technology that
permits computers and alternative devices
to be connected to every alternative into a
local area network and to the net without
wires and cables. Wi-Fi is additionally
stated as wireless local area networkthat
stands for wireless local area network,
and 802.11, is the technical code for the
protocol. See Figure 11.6
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Figure 11.6 Wi-Fi

ADVANTAGES: Benefits of Wi-Fi are

e It provides mobility. Example: I get
Internet connection wireless through
my laptop computer at home and at
work, because of Wi-Fi, hotspots both
at home and at work can be used.

It provides connection to Internet.
Flexibility of LAN.

Ensures connectivity.

It allows remote places to benefit from
connectivity.

e Low cost, high benifts.

11.1.4 RFID
e RFID - Radio Frequency Identification.

RFID is a technology designed to
locate objects (Credit cards, Passports or
even livestock) using radio signals.

RFID used radio waves to read
and capture information stored on a tag
attached to an object. Tag can be read
from several feet away and does not need
to be in direct-line-of-sight of the reader
to be tracked. RFID has been made up
of two parts a reader and a tag or a label.
RFID tags are installed with a transmitter
and receiver.

RFID component on the tags has
two parts: a microchip which stores and
processes the information, and the antenna

Chapter 11 Network Examples and Protocols
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to receive and transmit a signal. The Tag
replies the information from its memory
bank. The reader will transmit to read the
result to RFID computer program.

Two types of RFID tags were Active
RFID and Passive RFID systems.

1. In a passive RFID tag, the power is
supplied by the reader when radio
waves from the reader are encountered
by a passive RFID tag, the coiled
antenna forms a magnetic field.

2. Battery powered RFID tagisinstalled
with small battery that powers the
broadcast of information

Main Components of a RFID System

e A RFID tag: It has silicon microchip
attached to a small antenna and mounted

on a substrate. See Figure 11.7
Chip

Antenna
coil

Figure 11.7 RFID Tag

e Areader:Ithasascannerwith antennas
to transmit and receive signals, used
for communication. See Figure 11.8

Figure 11.8 An RFID Reader

Chapter 11 Network Examples and Protocols
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e A Controller: It is the host computer
with a Microprocessor which receives
the reader input and process the data.

Two types of RFID Systems:

1. Active RFID system: The tag has its
own power source. These systems
are used for larger distances and to
track high value goods like vehicles.

2. Passive RFID system: The tag gets
power from a reader antenna to
the tag antenna. They are used for
shorter range transmission.

11.2 Reference Model

11.2.1 OSI Model

Open System
Interconnection  (OSI)
model was found in

the year 1934, general

framework that enables
network protocols along
with software and systems to be developed
based on general set of guidelines. It
describes the standards for the inter-
computer communication. See Figure 11.9

There are many prompts used to remember
the OSI layer order:

e Everyone Needs Data Processing.

® Everyone Should Try New Diet Pepsi.

OSI Layers:

1. Physical Layer: This is the 1* layer,
it defines the electrical and physical
specifications for devices.

2. Data Link Layer: It is the 2" layer and
it guarantees that the data transmitted

1/5/2022 2:07:47 PM‘ ‘



www.tntextbooks.in

Layer 7
Application HTTP, SMTP, IMAP, SNMP, POP3, FTP
Layer 6 ASCIl Characters, MPEG, SSL, TSL,
Presentation Compression (Encryption & Decryption) (I Lape tate
l.aye.r s NetBIOS, SAP, Handshaking connection
Session
Layer 4
Transport TCP, UDP Segment
Layer 3
Ntk IPv4, IPv6, ICMP, |PSec, MPLS, ARP Packet
Layer 2 Ethernet, 802.1x, PPP, ATM, Fiber i
Data Link Channel, MPLS, FDDI, MAC Addresses
Layer1 Cables, Connectors, Hubs (DLS, RS232, Bits
Physical 10BaseT, 100BaseTX, ISDN, T1)

Figure 11.9 OSI LAYERS

are free of errors. This layer has simple
protocols like “802.3 for Ethernet” and
“802.11 for Wi-Fi”

. Network Layer: It is the 3 layer

determining the path of the data
packets. This layer is responsible
for routing of data packets using IP
Addressing.

. Transport Layer: It is the 4™ layer that

guarantees the transportation/sending
of data successfully. It includes the
error checking operation.

. Session Layer: It is the 5" layer,

identifies the established system
session between different network
entities. It controls dialogues between
computers .For instance, while
accessing a system remotely, session
is created between your computer and
the remote system.

. Presentation Layer: It is the 6™ layer

that does the translation of data to
the next layer (Prepare the data to the
Application Layer). Encryption and
decryption protocols occur in this layer
such as, Secure Socket Layer (SSL).

Application Layer: It is the 7™ layer,
which acts as the user interface
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platform comprising of software
within the system.

11.2.2. TCP/IP

Transmission Control Protocol/Internet
Protocol, TCP/IP is a set of protocols
which governs communications among all
computers on the Internet. TCP/IP protocol
tells how information should be packaged,
sent, and received, as well as how to get to
its destination. See Figure 11.10

TCP WORKING: TCP/IP is a
combination of two protocols: Transmission
Control Protocol (TCP) and Internet
Protocol (IP). The Internet Protocol typically
specifies the logistics of the packets that
are sent out over networks; it specifies the
packets which have to go, where to go and
how to get there. The Transmission Control
Protocol is accountable for guaranteeing the
trustworthy transmission of data. It checks
if any packet is not transmitted and submits
it again.

Frequent TCP/IP Protocols

e HTTP - Itis used between a web client
and a web server and it guarantees
non-secure data transmissions.

Chapter 11 Network Examples and Protocols
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< 32 bits >
0 4 8 16 19 31
Version Length | Type of service Total length
g Identification Flags Fragment offset
2 Time to live | Protocol Header checksum
e Source address
o
- Destination address
Options
Data
Source port Destination port
Sequence number
Acknowledgement number
S| offset | Revserved I UEEES Window
= CEUAPRSE
Checksum Urgent pointer
TCP options

Figure 11.10 TCP/IP Layer

e HTTPS - It is used between a web
client and a web server ensures secure
data transmissions.

e FTP - It is used between computers
for sending and receiving file.

Domain Names and TCP/IP Addresses

The address for any website is not as easy
as to remember, domain name are used
instead. For example, 216.58.216.164
is one of the IP address for Google and
google.com is the domain name.

The Different Layers of TCP/IP

There are four total layers of TCP/IP
protocol, each of which is listed below
with a brief description.

e Network Access Layer - concerned
with building packets.

e Internet Layer - describes how packets
are to be delivered.

e Transport Layer - ensure the proper
transmission of data.

e Application Layer - application network
processes. These processes include File
Transfer Protocol (FTP), Hypertext
Transfer Protocol (HTTP), and Simple
Mail Transfer Protocol (SMTP).

Chapter 11 Network Examples and Protocols
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11.2.3 Other Network Protocols

Networkprotocolsotherthan OSIand TCP/
IP were simply known as other network
protocols which implements security over
the network communication that include
HTTPs, SSL, and SFTP. Other networks
similarly classified in network layer are IP,
ARP, ICMP,IGMP, at transport layer are
TCP,UDP at Application Layer are HTTP,
FTP, Telenet, SMTP, and DNS.

HTTPS positions for Hypertext
Transfer Protocol Secure. It’s a protocol
where encoded data transfer on a secure
connection. This HTTPS make data more
safe and provides data security over the
network mainly on public networks like
Wi-Fi. See Figure 11.11

For example, let us take a bank website,
when we go to login page, we may watch an
HTTPS in address bar with some specific
design. HTTPS mainly deals with financial
transactions or transfer users personal
data highly sensitivily. Banking websites
are common examples for HTTPS. Data
exchanged between the user and the website
is not stolen, read or altered by a third party.
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Application Layer

Transport Layer

Internet Layer

Network Access Layer

Application Layer

Presentation Layer

Session Layer
Transport Layer

Network Layer

Data Link Layer

Physical Layer

Figure 11.11 Network Layers

In laymans terms, HTTPS
gurantees that users watch websites that
they want to watch. Data exchanged
between the user and the website is not
read, stolen or tampered by a third party.
Butit can’t encrypt everything - it has some
limitations too. For example, HTTPS can’t
encrypt host addresses and port numbers.

TCP/IP procedures are based on a layered
framework. TCP/IP has four layers. See
Figure 11.12

Network Interface Layer

It is the bottommost level layer. It is
comparable to that of the Open System

Interconnection Physical and Data Link
layers. Different TCP/IP protocols are
being used at this layer, Ethernet and
Token Ring for local area networks and
protocols such as X.25, Frame Relay, and
ATM for wide area networks. It is assumed
to be an unreliable layer.

Network Layer

It is the layer where data is addressed,
packaged, and routed among networks.
The important Internet protocols that
operate at the Network layer are:

TCP/IP Layers TCP/IP Prototocols
Application Layer HTTP Telnet SMTP DMS
Transport Layer TCP ubP
Network Layer IP ARP ICMP IGMP

Network Interface

Ethernet
Layer

Other link-layer

Token rin
9 protaocols

Figure 11.12 TCP/IP Protocols
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e Internet Protocol (IP): Routable
protocol which uses IP addresses
to deliver packets. It is an

unreliable  protocol, does not
guarantee delivery of information.
Address
(ARP):
MAC

addresses.

Resolution Protocol
IP addresses to
(Medium Access Control)

(A MAC address
hardware identification number that

Resolves
is a

uniquely identifies each device on
a network.)i.e., to map IP network
addresses to the hardware addresses.
Internet Control Message Protocol
(ICMP): Used by network devices to
send error messages and operational
information. Example: A host or router
might not be reached or a request
service is not presented.

e Internet Group Management Protocol
(IGMP): 1t is a communication protocol
used by hosts and routers to send Multicast
(group Communication) messages to
multiple IP addresses at once.

Transport Layer

The sessions are recognized and data
packets are swapped between hosts in this

layer. Two main protocols established at
this layer are:

e Transmission Control Protocol

(TCP): Provides reliable connection

oriented transmission between
two hosts. It ensures delivery
of packets between the hosts.

User Datagram Protocol (UDP):
Provides connectionless, unreliable,
one-to-one or one-to-many delivery.

Application Layer

The Application layer of the TCP/IP model
is similar to the Session, Presentation, and
Application layers of the OSI Reference
Model. The most popular Application
layer protocols are:

Hypertext Transfer Protocol
(HTTP): The core protocol of the World
Wide Web. File Transfer Protocol (FTP):
enables a client to send and receive
complete files from a server. Telnet:
connect to another computer on the
Internet. Simple Mail Transfer Protocol
(SMTP): Provide e-mail services. Domain
Name System (DNS): Refer to other host
computers by using names rather than
numbers.

POINTS TO REMEMBER

e The Internet is a network of global connections - comprising private, public,
business, academic and government networks - linked by guided, wireless and

fiber-optic technologies.

e ARPANET was Advanced Research Projects Agency (ARPA) of the U.S.
government in 1969 and was first recognized

e INTRANET: It is a private network within an enterprise to share company data
and computing resources between the employees.

e EXTRANET: It is a private network that uses Internet technology and the
public telecommunication system to securely share business’s information with

suppliers, vendors, partners, customers, or other businesses.

Chapter 11 Network Examples and Protocols
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e Communication over mobile network is be made up of voice, data, images and
text messages.

e RFID -(Radio Frequency Identification) uses RF wireless technology to
identify.

e Open System Interconnection (OSI) model was found in the year 1934, over
all basis that permits network protocols along with software and schemes to be
developed based on Universal guidelines.

e Transmission Control Protocol/Internet Protocol, TCP/IP is a set of protocols
permitting communications among all computers on the Internet.

e HTTP - A protocol used between a web client and a web server protects non-
secure data transmissions. The core protocol of the World Wide Web.

e HTTPS - A protocol used between a web client and a web server permits secure
data transmissions.

e FTP - Used between computers for sending and receiving data. Enables a client
to send and receive complete files from a server.

e Internet Protocol (IP): routable protocol which uses IP addresses to deliver
packets. It is an unreliable protocol, does not guarantee delivery of information.

e Address Resolution Protocol (ARP): Resolves IP addresses to MAC (Medium
Access Control) addresses.( A MAC address is a hardware identification number

@ that uniquely identifies each device on a network.) )

e Internet Control Message Protocol (ICMP): Used by network devices to send
error messages and operational information.

e Transmission Control Protocol (TCP): Provides reliable connection oriented
transmission between two hosts. It guarantees delivery of packets between the
hosts.

e Simple Mail Transfer Protocol (SMTP): Provides e-mail services.

e Domain Name System (DNS): A method of refering to other host computers
by using names rather than numbers.

11
(cLossarY)

Internet Several networks, small and big all over the world, are connected together to
form a Global network called the Internet.

Intranet It is a website used by organizations to provide a place where employees can
access company related information.

Extranet It is a private network using Internet technology to share part of business
information with supplier’s partners and customers.

APRANet Advanced Research Projects Agency Network

TCP/IP Transmission Control Protocol / Internet Protocol

Chapter 11 Network Examples and Protocols @I
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Wi-Fi Wireless Fidelity.

RFID Radio Frequency Identification.
OSI Open System Interconnection
HTTP Hypertext Transfer Protocol
HTTPS Hypertext Transfer Protocol Secure
FTP File Transfer Protocol

SMTP Simple Mail Transfer Protocol
UDP User Datagram Protocol

SMTP Simple Mail Transfer Protocol
DNS Domain Name System

Th ara? s DY, . < .
Where? > ¢ [SRVAY NG —~ \\‘Tltt‘

Write & 5 - ft . = When? EVALUATION

When?

Part -1
Choose the correct answer
® ¢) iii, iv; 1, ii d) iv, iii, ii, i ®
1. Which one of the following will be
easy way to use Internet technology

and the public telecommunication

a) i, ii, iii, iv b) ii, iii, iv, i

3. Communication over ------------
—————— is be made up of voice, data,

. , images and text messages.
system to securely share business’s

information with suppliers, vendors, a) Social media

partners and customers. b) mobile network
a) Extranet b) Intranet c) whatsapp
c) arpanet  d) arcnet d) software
2. Match the following and choose the 4. Wi-Fi stands for---------------------
correct answer a) Wireless Fidelity
i. HTTP -The core protocol of the b) wired fidelity
World Wide Web.

c) wired optic fibre
ii. FTP- enables a client to send d) wireless optic fibre

and receive complete files from a 5. A TCP/IP network with access

SErver. restricted to members of an
iii. SMTP - Provide e-mail services. organization
iv. DNS- Refer to other host a) LAN b) MAN

computers by using names rather ) WAN d) Intranet

than numbers.

IEIT) Chapter 11 Network Examples and Protocols
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. RFID stands for --------------

a) Radio Free identification
b) real Frequency identity
c¢) Radio Frequency indicators

d) Radio Frequency Identification.

. It guarantees the sending of data is

successful and which checks error on
operation at OSI layer is--------------

2. What is the uses of mobile networks?
3. List out the benefits of WiFi
4. How many types of RFID system

available and what are they?
Expand HTTP, HTTPS, FTP.

Part - II1
Explain in Brief Answer

. 1. Compare Internet, Intranet and
a) Application layer
RE— Extranet
) Network layer 2. List out the components of a RFID
c) Transport Layer enabled system.
d) Physical layer 3. Write short notes on HTTP, HTTPS,
. Which one of the following will FTP.
secure data on transmissions 4. What are the layers available in TCP/
a) HTTPS b) HTTP IP Reference Model?
c) FTP d) SMTP 5. Expand ARP,ICMP, SMTP and DNS.
e provides e-mail service
Part - IV
a) DNS b) TCP o .
Explain in detail
@ c) FTP d) SMTP ®
1. Explain about Internet, Intranet and
o refer to other host
) Extranet.
computers by using names rather . .
2. Discuss about OSI model with its
than numbers.
) DNS b) TCP layers.
a :
¢) FTP d) SMTP 3. Ditference between TCP/IP and OSI
Reference Model.
Part - II 4. Explain about the development,

Short Answers

merits and demerits in Mobile
networks.

1. Define Intranet

| _STUDENT acTivities

List out some web address with http and https

1. Find some of the http web addresses

2. Give some example for https

3. Can you know difference between http and https.
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DNS (Domain Name System)

@ LEARNING OBJECTIVES

e To understand the need of Domain Name System for proper functioning of

Internet

e To know the importance of IP addresses

e To know the parts of URL and its types

e To know the components of Domain name system and its functions

e To know how the DNS is working

12.1 Introduction

In earlier days, websites were accessed
through their IP addresses. It was difficult
for an individual to remember all the IP
address to access the websites. So, the
domain names were created and mapped
with IP addresses. Like phone book,
where all the contact numbers are stored
under respective names and are accessed
by the contact names. Domain Name
System (DNS) maintains all the directory
of domain names/host names and help us
to access the websites using the domain/
host names.

12.2 Overview of DNS

For the communication to takes place,
the information should pass through

‘ ‘ X1l CompApp_English version CHAPTER 12.indd 162

seven layers. Application layer is one
among the seven layers. There are several
applications in the application layer and
DNS (Domain Name System) is one
among them. Internet is based on IP
addresses, not domain names. But it is
easy to use domain names to refer them
rather than the long numbers (IP address).
To enable the use of domain names in a
network, the Domain Name System (DNS)
is used. Domain names to IP address
mapping must be consistent across the
network to ensure interoperability. DNS
provides the domain name to IP address
mapping through Name servers. To know
more about DNS working we must first
know about IP address, URL and DNS
components. So, let us see about each in
detail. Refer Figure 12.1
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The host computer

@

www.tnschools. gov in

35 173.69.207

DNS server

Figure 12.1 Domain Name System

While typing a web address, e.g.,
www.tnschools.gov.in, DNS
it into a machine friendly IP address
(for example 35.173.69.207 is the IP for
and directs

translates

www.tnschools.in) your

Internet connection to the correct website.

W‘American computer scientist
~ WMOW?  paul V. Mockapetris together

with Jon Postel, invented the
Internet Domain Name System (DNS)
Jon Postel was an administrator of the
Internet Assigned Numbers Authority
(IANA) until his death and he was
known as “God of the Internet”.

Jon Postel

Paul V. Mockapetris

12.3 IP Address

Internet Protocol (IP) address is simply
the logical address in the network layer.
Like how the door number/flat number
is used to differentiate

individual house from
others in the
apartment, IP address

same

is also used to find the

‘ ‘ XIl CompApp_English version CHAPTER 12.indd 163

host system in the whole network. Due
to increase in the number of system in a
network there is a need of more addresses
which lead to two addressing methods i.e.,
IPv4 and IPveé.

12.3.1 [IPv4 Address

IPv4 address is a 32-bit unique address
given to a computer system. No two systems
can have same IP address. If the network has
p connections then ‘p’ addresses should be
there. An address space is the total number
of addresses that can be made by that
protocol. It is determined by the number
of bits that the protocol use. If the protocol
uses n bits then the address space of that
protocol would be 2" addresses. So, the
number of addresses that can be formed in
IPv4 is 2*2. There are two ways to represent
the IP address

e Binary notation

e Dotted-decimal notation

In binary notation the address is expressed
as 32-bit binary values.

For E.g. 00111001 10001001

00111000 00000111

In dotted-decimal notation the address
is written in decimal format separated by
dots(.). Refer Figure 12.2

For e.g. 128.143.137.144

Chapter 12 DNS (Domain Name System)
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10000000 10001111 10001001 10010000
1st Byte 2" Byte 3" Byte 4™ Byte
=128 = 143 =137 = 144

~ N\ S

128.143.137.144
Figure 12.2 IPv4 Address

12.3.2 1Pv6 Address

IPv6 address is a 128-bit unique address given to a computer system. The number of addresses
that can be formed in IPv6 is 2'*%. In IPv6 address, the 128 bits are divided into eight 16-bits
blocks. Each block is then changed into 4-digit Hexadecimal numbers separated by colon
symbols. E.g. 2001:0000:32313:DFE1:0063:0000:0000:FEFB. Refer Figure 12.3

128 Bits

A
>

Network prefix (64 bits) Host number (64 bits)
XXXX i XXXX i XXXX § XXXX fi[ XXXX §XXXX i XXXX i XXXX |

@ X - Hexadecimal number (0,1,2,3,4,5,6,7,8,9,A,B,C,D,E,F @
XXXX - 0000 to FFFF

Figure 12.3 IPv6 Address

12.4 Uniform Resource Locator (URL)

URL (Uniform Resource Locator) is the address of a document on the Internet. URL is
made up four parts—protocols, hostname, folder name and file name. Each part has its
own specific functions. Depending on the applications, additional information can be
added to the URL but the common and fundamental URL consists of these four parts.
Refer Figurel2.4

http://cms.tn.gov.in/sites/default/files/press_release/pr070119a.jpg
Y
file

| Protocol | domain name/ hi il h
host name (this will have

an extension
such as .htm,

.Jpg, .gif, .css)

Figure 12.4 URL Parts

T chapter 12 DNS (Domain Name System)
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Figure 12.4 shows the basic URL
where http is a protocol, www.cms.tn.gov.in
is a hostname / domain name, sites/
default/files/press_release are the folders
and pr070119a.jpg is the file name. These
are all the basic information which can be
obtained from a URL.

URL Type

Depending on the location of the
document the URL is divided into 2 types

e Absolute URL
e Relative URL

12.4.1 Absolute URL

Absolute URL is the complete address
of a document on the Internet. Absolute
URL contains all the information that are
required to find the files on the Internet.
These are similar to postal address if any
of the information is missing then the
post will not be delivered to the right
person. Similarly, if any of the four parts is
missing then the browser would not able
to link to the specific file. So, all the four
parts is very important in absolute URL.

12.4.2 Relative URL

Relative URL is the partial address of a
document on the Internet. Relative URL
contains only file name or file name with
folder name. We can use this type of URL
when the file is on the same server related
to original document.

12.5 DNS Components

There are three important components in
the Domain Name System. They are

e Namespace
e Name server

e Zone
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12.5.1 Name Space

The domain names must be very unique
and appropriate. The names should be
selected from a names pace. The name
space can be organized in two ways

e Flat name space

e Hierarchical name space

Flat name space is where the name
is assigned to the IP address. They do not
have any specific structure. In this flat
name space, some meaningful names are
given to IP address for accessing. The major
disadvantage of flat name space is that they
cannot be used in large system. Because they
need to be accessed and controlled centrally
to avoid ambiguity and redundancy. But it
is difficult in flat name system. To avoid this
major disadvantage hierarchical name space
is used in large.

Hierarchical name space is where
the name is made up of several parts.
The first part may represent the nature
of organization, the second part may
represent the name of organization, and
third part may represent the department
of the organization and so on. In this way
the power to control the name space can
be decentralized.

Domain Name Space

Domain name space was designed to
achieve hierarchical name space. In this,
the names are represented as a tree like
structure with root element on the top
and this tree can have a maximum of 128
levels starting from root element taking
the level 0 to level 127.

Chapter 12 DNS (Domain Name System)
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arpa com edu ceoe

Root (Level 0)

org ad [ X X} W

Figure 12.5 Domain Name Space

Figure 12.5 represent the domain
name space where the root element is
present at the top most level i.e., level
0. The root element always represents
the NULL string (empty string). The
next level to the root element is node
(children of root element). Each node
in the tree has a label and a domain
name.

Root

®.

edu.

<.

\fhda.edu.

Label

It is a string which can have maximum of
63 characters. Each node in that level should
have different labels thereby assuring the
individuality of the domain name.

In other words, Labels are the
names given to domains. Domain is a sub
tree in domain name space tree structure.
The domain can be further divided into
sub domains.

Domain name

Domain name

atc

Domain name

@D

Challenger

1 atc.fhda.edu.
challenger.atc.fhda.edu.

Domain name

Figure 12.6 Domain Name and Label
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Figure 12.6 explain the domain
name and label clearly. challenger.atc.
thda.edu. is the domain name which
is obtained by reading the labels from
bottom to top, separating each label by
dot (.) Refer Figure 12.7

Domain name

It is the sequence of labels. In domain
name the sequence of labels are separated
by dot (.). The domain name is always read
from the lower level to higher level i.e.,
from the leaf node to root node. Since the
root node always represent NULL string,
all the domain name end with dot.

Basic rules of Domain names

e Domain can consists of Alphabets a
through z, and the digits 0 through 9.
e Hyphens are allowed, but hyphens
can not be used as first character of a
domain name.
Spaces are not allowed
Special symbols (suchas !, $, &, and
S0 on) are not permitted.

e Domain names have the minimum
length of 2, and the maximum length
of 63 characters. The entire name may
be at most 253 characters long.

e Domain names are not case-sensitive.
(It may be upper, lower or mixing of
both case letters)

Generic Top-Level Domain names:

Top level domain is the last part of a domain
name. Generic top level domains are used
for generic purpose and maintained by
IANA. Refer Table 12.1

Domain Name Meaning

com Commercial Organisation

edu Educational Institutions

gov Government (US)

mil Military groups

org Non profit Organization

net Networking organization

info Information service
providers

Root level

Top level
domains

Second level
domains

Sub domains

Figure 12.7 Domain representation of www.tnscert.org
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Country top-level domain names
Country domain uses 2-character country
abbreviation according to country. For e.g.,
google.in — for INDIA, google.us for US.
Refer Table 12.2

Domain Name Meaning

in India

us United States
fr France

uk United Kingdom
ca Canada

au Australia

Ik Srilanka

bd Bangladesh
cn China

pk Pakistan

ip Japan

sg Singapore

ﬁ]‘Domain names may also be used
~ WNOW? in other than English languages

in UNICODE format. Tamil
language is also used in three country
Top Level Domain names which are.
@npsHlwm, fiusiyd and .Qeomiens

Shdun India
AruesLiy T Singapore
Beorhiend Srilanka

12.5.2 Name Server

The information which needs to be stored
in Domain name space is quite large.
Single system would be inefficient and
insufficient to store such a huge amount

Chapter 12 DNS (Domain Name System)
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as responding to requests from all over the
world. It also becomes unreliable because
in case of any failure the data becomes
inaccessible.

The solution to this problem is to
distribute the information among many
computers. The best way to do that is to
divide the entire space into many domains
and sub domains. DNS also allows domains
to be further divided into sub domains.
By this, the solution to the problem is
obtained and hierarchy of servers is also
maintained. Name servers store the data
and provide it to clients when queried by
them. Name Servers are programs that
run on a physical system and store all the
zone data.

w‘lnverse domain performs the
~ WNOW? - opposite task of normal DNS

query. It converts the IP address
to domain name.

Name Server is a main part in the
Domain Name System (DNS). It translate
the domain names to IP addresses. Name
server contains the DNS database which
consists of domain names and their
corresponding IP addresses. There is a
need to store large number of domain
names for the world wide usage, so plenty
of servers are used in the hierarchical
manner. Name servers do the important
task of searching the domain names. While
you searching a website, Local Name
server (provided by ISP) ask the different
name servers until one of them find out
your answer. At last it returns IP address
for that domain name. Your computer can
now connect to the requested webpage
stored on the webserver. Refer Figure 12.8
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Web Server

IG
'5

Host

1 (;)
_Ak/y ‘G’ II

Local DNS

a
name server \ I

Root DNS
name server

)
A////' 9

Top level
name
server

®

Authoritative
DNS server

Figure 12.8 working structure of Name server

Types of Name Servers

There are three types of Name Servers which
control the entire Domain Name System:

1. Root Name Server - top level server
which contains entire DNS tree,
maintained by ICANN. There are 13
servers.

2. Primary/Master =~ Name  Server-
contains a zone resource records.
These records are updatable by domain

name holders such as organizations.

3. Secondary/Slave Name Server -

contains a copy of primary server files.
This server has no authority to update,
but reduce the workload of master
server by sharing the queries.

ﬁ]‘ICANN, Internet Corporation for
~ WWOW?  Assigned Name and Numbers is the
Non-profit Organization
which assigns names and
numbers for all Internet
resources like domain
names and IP addresses.

~

L

ICANN

‘ ‘ XII CompApp_English version CHAPTER 12.indd 169

12.5.3 Zone

The entire name space is divided into many
different zones. It is the area up to which
the server has access. Zone is defined as
a group of contiguous domains and sub
domains. If the zone has a single domain,
then zone and domain are the same.

Every zone has the server which
contains a database called zone file. Using
the zone file, the DNS server replies to the
queries about hosts in its zone. There are
two copies of zone files available, Master
file and slave file. Refer Figure 12.9

()
€T

LETSRECAP ©® A zone is a subset of the
Domain namespace generally
stored in a file.

® A domain is a single node of
the Domain Namespace.

® Domain Name space is an entire collection
Domains, Sub domains and Zones

e Name server manages the database of
domain names and corresponding IP
addresses.

® A server can contain more than one zone
files (Zones). A zone can contain more
than one sub domains

Chapter 12 DNS (Domain Name System)
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Root

A}
A}
1
“€——Domain
5
A}

<« Zone and
.
A}

domain

~ea
.....................

Figure 12.9 Zone and Domains

12.5.4 Resolver

Domain Name System is a client/ server
application. A host system need to map
domain name to IP address or vice versa
according to the call and that work is done
by resolver. Resolver either asks server to
provide information about IP address. If it
doesn’t find any information, then it sends
the request to other servers and so on.
Once the resolver receives the mapping, it
checks whether it is an error or resolution
(mapping) and provides result according to
that.

DN

QUERY @

Where is
www.tnscert.org

Type
(CResover) . tnscert.org

ﬁ]‘The resolver is a program which
- '¥Nows

is responsible for initiating the
translation of a domain name
into an IP address. Since a resolver is
stored in the host, There is no need
of any protocol to form a connection
between the resolver and the user
program.

~

12.5.5 How DNS works?

When the user enters the URL (consists
of protocol, domain name, folder name,
file name) in the browser, the system first
checks its DNS cache for the corresponding
IP address. If the IP address is found in
the cache then the information is retrieved
from cache. If not, then the system needs to
perform DNS query i.e., the system needs
to query the resolver about the IP address
from Internet Service Provider (ISP). Each
resolver has its own cache and if it is found
in that then that information is retrieved. If
not, then the query is passed to next domain

Local Server

[
'
'
'
'
'
. - '
'
'
'
'
'

Root Server

Org Server

www.tnscert.org
is at 198.71.57.84

tnscert.org Server

Figure 12.10 workflow of basic DNS
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wj‘Web Server
~ 'KNOW?

- Web server is a program running on dedicated machine which handle the queries of
www enduser. Server is used to host the websites and to deliver the contents of websites using
HTTP. While typing the URL in browser, the browser send the URL to DNS. After getting an
IP address from DNS, It sends the request to the web server with IP address . Now the content
of websites appear on browser.

server i.e., TLD (Top Level Domain) which reviews the request and direct the query to name
servers associated with that specific domain. Until the query is solved it is passed to next level
domains. At last the mapping and the record are returned to the resolver who checks whether
the returned value is a record or an error. Then the resolver returns the record back to the
computer browser which is then viewed by the user. Refer Figure 12.10

»

“IANA is an affiliated authority of ICANN. IANA does the
“WNOW?  overall management of the DNS Root, IP addressing, and ;ﬂ”ﬂ
other Internet protocol resource handling. TANA takes care of  ieretassizned numbers authoriy
a number of key aspects of the DNS, including the root zone, and the
domains .int and .arpa.

https://www.iana.org/

The WHOIS is a service of ICANN. It is a free, publicly available @

=¥ |[CANN WHOIS
directory containing the details of registered domain names and their ~ ***

owners (registrants). https://whois.icann.org/en

POINTS TO REMEMBER

e Domain Name System (DNS) maintains all the directory of domain names and
help us to access the websites using the domain names. It translates the domain
name into IP address.

e IP address is a logical address used to uniquely identify a computer over the
network. There are two types: IPv4 and IPvé6.

e IPv4 addressisa 32 bit unique address given to a computer or a device. There are
two ways to represent the IP address: Binary notation, Dotted-decimal notation.

Chapter 12 DNS (Domain Name System) 171
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e IPv6 address is a 128 bit unique address given to a computer or a device. It
follows Hexadecimal number notation.

e URL (Uniform Resource Locator) is the address of a document on the
Internet. URL is divided into two types: Absolute URL and Relative URL

e URL is made up of four parts- protocols, hostname, folder name and file
name. Absolute URL contains all the four necessary and fundamental parts
of URL.

e Relative URL contains only folder name and the file name or just the file
name.

e There are 3 important components in the Domain Name System. They are
Namespace, Name server and Zone.

e Label is a string which can have maximum of 63 characters. Each node in
that level should have unique label.

e Domain name space is a tree like structure with root element on the top. It
can have a maximum of 128 levels starting from root element taking the level
0 to level 127.

e Domain name is the sequence of labels separated by dot (.). The domain
name is always read from the leaf node to root node. The root node always
represent NULL string. So All the domain name ends with dot.

e In the domain name space (DNS) tree structure domain is a sub structure
tree. The domain can be further divided into sub domains. I

e Name Servers are programs that run on a physical system and store all the
zone data. It provides to clients when queried by them.

e Zone is the contiguous part up to which the server has access. The domain
assigned for the server does not divide into further sub domains then zone is
same as domain.

e Resolver, a client/ server application, initiates the process of resolving the
domain names.

172 Chapter 12 DNS (Domain Name System)
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|GLUSSARY|

DNS

IP address
URL

Domain Name
space

Domain Name

Name server

ICANN

TIANA

Zone

The resolver

TLD
IPv4 /IPv6

Domain Name System an Internet service that translates domain name into IP
address.

used to uniquely identify a computer over the network.

Uniform Resource Locator, the address of a specific web page or file on the
Internet.

A naming system on which domain names are in a hierarchical and logical tree
structure.

a symbolic name associated with an IP address

Contains the DNS database which consists of domain names and their
corresponding IP addresses.

Internet Corporation for Assigned Name and Numbers, Non-profit organization
which regulates an Internet.

Internet Assigned Numbers Authority (IANA) is an affiliated authority of
ICANN.

A group of contiguous domains and sub domains in the Domain Name Space.

a program which is responsible for initiating the translation of a domain name
into an IP address

Top Level Domain, domains below the root domain

Internet Protocol version 4/6

. SWhich?

Part -1

T, When?

S Write

= When? EVALUATION

Choose the correct answer

1. Which of the following is used to maintain all the directory of domain names?

a) Domai

n name system b) Domain name space

c) Name space d) IP address

2. Which of the following notation is used to denote IPv4 addresses?

a) Binary

b) Dotted-decimal

¢) Hexadecimal d)aandb

Chapter 12 DNS (Domain Name System) 173
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3. How many bits are used in the IPv6

addresses?
a) 32

b) 64

c) 128

d) 16

4. Expansion of URL is

a) Uniform Resource Location
b) Universal Resource Location
¢) Uniform Resource Locator

d) Universal Resource Locator

5. How many types are available in

Relative URL?
a) 2 b) 3 a4 d)5

6. Maximum characters used in the

label of a node?

a)255 b) 128 c)63 d) 32

7. In domain name, sequence of labels

are separated by
a);

b) .(dot)

c):

d) NULL

8. Pick the odd one out from the

following.
a) node b) label

¢) domain d) server

9. Which of the following initiates

the mapping of domain name to IP
address?

a) Zone
b) Domain
¢) Resolver

d) Name servers

10. Which is the contiguous area up to
which the server has access?

Chapter 12 DNS (Domain Name System)
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a) Zone
b) Domain
c)Resolver

d) Name servers

11. ISP stands for

a) International Service provider
b) Internet Service Provider
¢) Internet service Protocol

d) Index service provider

12.TLD stands for
a) Top Level Data
b) Top Logical Domain
¢) Term Level Data
d) Top Level Domain

13. Which of the following statements
are true?

i) Domains name is a part of URL.
ii) URL made up of four parts

iii) The relative URL is a part of Absolute
URL

iv)URL doesn’t contain any protocol
a)i&ii b) ii
<) i, ii & iii d) i, ii & iv

14.

Assertion (A) : The number of
addresses used in IPv6 addressing
method is 128 .

Reason (R) : IPv6 address is a 128 bit
unique address.

a) A is true and R is false.
b) A is false and R is true.

¢) Both A and R are correct and R is
the correct explanation of A.

d) Both A and R are correct and R is
not the correct explanation of A.
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15. Match the following

a.

b.

C.

d.

domain - 1. progress
that initiates
translation

zone - 2. contains database
of domain names

name server - 3.single node

resolver - 4. contiguous nodes
a. 1432
b.3421
c. 3214
d. 3412

Part - 11
Short Answers

1.

R I I N

List any four domain names.
What is an IP address?

What are the types of IP address?
What is an URL?

List out four URLs you know.
What are the types of URL?
What is a domain?

What is a zone?

What is a resolver?

| _sTuoenT activities

. Find out IP address of your system

10. What are the categories available in

domain name space?

11. Write any four generic Top Level

Domain.

Part - II1
Explain in Brief Answer

1.
2.
3.

5.
6.

Write a note on DNS.
Differentiate IPv4 and IPvé6.

Differentiate Domain name and
URL

. What are the differences between

Absolute URL and Relative URL?
Write a note on domain name.

Differentiate web address and URL

Part - IV
Explain in detail

1.

. What is

Explain briefly the components of
DNS.

. Classify and Explain the IP address.

Explain about the name server?

domain name space?
Explain.

Explain how the DNS is working.

i. Click start menu and type command or cmd to open command prompt

ii. A command prompt window will be displayed. Type ipconfig and press enter.
iii. The IP number is listed under IPv4 Address and IPv6 Address.
iv. Find out the MAC address of the network card in the list.

v. Find out and analyze what the other information displayed on the screen.
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2. Find out IP address for the websites using command prompt
i. Click start menu and type command or cmd to open command prompt.
ii. A command prompt window will be displayed. Type tracert and press enter.
iii. From the displayed window, You'll see the IPv4 and IPv6 address.

iv. Find out IP address for another website.

3. List out websites to find out IP address of other websites
For example:

https://ipinfo.info/html/ip_checker.php
4. Use nslookup in command line and analyse what purpose it is used.

5. Buy your own domain name or create free sub-domain and connect free hosting
servers.

For example:

www.goDaddy.com, www.webs.com

176 Chapter 12 DNS (Domain Name System)

‘ ‘ XIl CompApp_English version CHAPTER 12.indd 176 @ 1/5/2022 2:08:50PM‘ ‘



@ LEARNING OBJECTIVES

CHAPTER

Network Cabling

e To know the necessity of cabling in computer networking.

e To know the different types of cables used in networking.

e To know the components involved in making of Ethernet cable.

To know the various types of Registered Jacks and its functions

To know the wiring and colour coding techniques used in Ethernet cabling.

e To practice in making an Ethernet cable with desired length.

13.1 Introduction

Once the basics of computer was invented by
Charles Babbage, people started inventing
much newer technology compatible with
the computer. In the 19" Century the US
military base had much technology to serve
weapons and people but they did not have
any technology to send a report from one
place to another. Then slowly the word
network grew bigger and bigger. Then
the Advanced Research Projects Agency
Network (ARPANET) was invented and
the TCP/IP was adopted with ARPANET.
Then the researchers began to research the
“network of networks”.

First the network was within one
computer to another computer, then it
moved to one place to another place, then
one city to another, then slowly it grew up

‘ ‘ XII CompApp_English version CHAPTER 13.indd 177

and became one as Internet. The essential
service of Internet is WWW (World Wide
Web) which was invented by Tim Berners

Lee. Internet can be accessed easiliy from
anywhere but the setting up of the network
is a big nightmare. Still network cables are
being used worldwide to produce a faster
Internet to the people. The network cables
are used to transfer the data from one device
to another device.

Figure 13.1 Network cables
Source: Data center knowledge

177
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In the figure 13.1 huge and huge cables 2. Twisted Pair Cables: It is type of
are used during network cabling. This cable with two or more insulated
Causes lot of confusion which cable to be wires twisted together. It started with
connected and therefore alternatives to a speed of 10 mbps (1I0BASE-T cable
replace this are in process. is used). Then the cable was improved
and the speed was higher and went to

13.2 Types of Network 100 mbps and the cable was renamed
Cables as 100BASE-TX. Then finally the

cable was improved to 10 gbps and
named as 10GBASE-T. This twisted
cable has 8 wires which are twisted to

There are many types of cables available
in the networking. Here we are going to
discuss about six different types of cables.
1. Coaxial Cables: This cable was
invented at late 1880’s, which is used

ignore electromagnetic interference.
The eight wires cannot be placed in a
single unit as there can be difficulty

to connect the television sets to . . . .
in space, so it is twisted to make it one

home antennas. This cable is used to i )
wire. There are two types of twisted

pair cables, Unshielded Twisted Pair
(UTP) and Shielded Twisted pair
(STP). The UTP is used nowadays as
modern cables for Internet and they
are lower in cost and installation and

transfer the information in 10 mbps.
The cable is divided into thinnet and
thicknet cables. These cables have
a copper wire inside and insulation
is covered on the top of the copper
® wire to provide protection to the

maintenance is easy compared to the
cable. These cables are very difficult Y P

) .. coaxial cables. STP is similar to UTP,
to install and maintain, because they

are too big to carry and replace. The
coaxial cable got its name by the word
“coax”. Nowadays coaxial cables are

but it is covered by an additional jacket
to protect the wires from External
interference. See Figure 13.3

o

also used for dish TV where the setup ”’m%

box and the television is connected P

using the coaxial cable only. Some o

of the cable names are Media Bridge

50-feet Coaxial cable, Amazon basics £

CL2-Rated Coaxial cables, etc. See Figure13.3 Twisted pair cables
Figure 13.2

3. Fiber Optics: This cable is different
from the other two cables. The other
two cables had an insulating material
outside and the conducting material
like copper inside. But in this cable it
is strands of glass and pulse of light

A . . .
Figure13.2 Coaxial cables for connecting is used to .Send the '1nf01.*mat10n.
television sets They are mainly used in Wide Area

Network (WAN). The WAN is a

178 Chapter 13 Network Cabling
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network that extends to very large
distance to connect the computers.
One example of WAN is Internet.
These cables are placed in deep
underground to avoid any damage to
the cables. The optic cable uses light
to transmit the information from one
place to another. There are two types
of fiber optic cables available, One is
single-mode (100BaseBx) another
one is Multimode (100BaseSX).
Single-mode cables are used for
long distance transmission and at
a high cost whereas the multimode
cables are used for short distance
transmission at a very low cost. The
optic cables are easy to maintain and
install. See Figure 13.4

Figure 13.4 Fiber optic cable with 4 cores

combined with one cable.

4. USB Cables: The Universal Serial

Bus are used to connect keyboard,
mouse and other peripheral devices.
But there are some special network
devices used to connect the Internet
through the USB called dongles. The
dongle is a small peripheral device

which has a compatible of mobile
broadband with a slim slot in it
and connects the Internet and acts
as a modem to the computer. See
Figure 13.5

4

~The latest version of USB is USB

OW? 3 0 which has the data transfer rate

4.85 Gbps. But USB 2.0 has just
480 Mbps.

Micro USB is a miniaturized version
of the USB used for connecting mobile
devices such as smart phones, GPS
devices and digital cameras.

X

USE Type A Mini US _
USB Type B Micro USB

. Serial and Parallel cables: Earlier in

1980s to 1990s the Ethernet and the
USB were not developed. Then the
Serial and Parallel interface cables
were used to connect the Internet
to the system. They were sometime
used for PC to PC networking.
Before the USB emerged, the system
will have both serial port and parallel
port. The serial port will send 1 bit
at one time whereas the parallel
port will send 8 bit at one time. The
parallel cables are used to connect to

Figure 13.5 The USB Cables and USB dongle connected to a laptop.

‘ ‘ XII CompApp_English version CHAPTER 13.indd 179

Chapter 13 Network Cabling

179

1/5/2022 2:10:31 PM‘ ‘



@

www.tntextbooks.in

the printer and other disk drivers.
RS232 is one type of serial cable,
also known as Null modem cable.

See Figure 13.6

Figure 13.6 The serial cable at the left and
parallel cable at the right.

6. Ethernet Cables: Ethernet cable is
the most common type of network
cable mainly used for connecting
the computers or devices at home
or office. This cable connects wired
devices within the local area network
(LAN) for sharing the resources and
accessing Internet.

The Crossover Ethernet cable is an
example of the Null modem Cables.
This cable is used to join two PCs or
two network devices of the same type.
This cable is the sophisticated Ethernet
cable used to connect the Internet to
the system. This cable works at a speed
of 10 gbps and more. The Ethernet
crossover cable is identical on both
the ends. Nowadays Routers are being
connected through the crossover cables
to provide wireless network from the

local network. See Figure 13.7

Figure 13.7 The Ethernet cables.

Chapter 13 Network Cabling
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ﬁ]‘]ust like the crossover cable,
T WNOW?  RS-232 cable is also used for

interconnecting two computers
without modem. So it is also a null
modem cable. A cable interconnecting
two devices directly is known as a null
modem cable.

=

13.3 Ethernet Cabling
Components

Computer Networking is a group of
interconnected other
devices for sharing the data and resources
among them. Computers can be connected
on the network with the help of wired
media (Unshielded Twisted pair, shielded
Twisted pair, Co-axial cables and Optical

computers or

fibre) or wireless media (Infra Red,
Bluetooth, WiFi)

Wireless networks enable more
devices including mobile sharing the
resources and Internet connections
remotely. But Compared to wireless
networks, wired networks maintain a
faster Internet speed and more secure.
Wired networks for larger area are more
expensive. Wired networks are still used
widely in the offices where need increased
speed and secure connections are very

essential.

The computers with  wired
connections must be configured with

Ethernet cards. These cards enable the

1/5/2022 2:10:31 PM‘ ‘



@

www.tntextbooks.in

computers to have a connection with
other devices by using Ethernet cables.
The switches and routers may be used
to increase the number of systems to be
interconnected.

The Ethernet cable is the basic
component of the Local Area Network
(LAN); here only one popular Ethernet
wire is used - RJ45 Ethernet cable.
We shall be discussing the different
components used inside the Ethernet
cable. The components of the Ethernet
cable are RJ45 connector, patch cable
(UTP cable), plastic covering. The RJ45
connector is made up of plastic cubes
connected at the both the ends. With
this connector we will connect one end
at the computer and other end at the
LAN port. The patch cables has eight
small wires inside. The plastic covering
is used to provide protection to the
wires when it bends or get twisted while
connecting to the system or to the LAN
port.

Ethernet cabling is the process
of connecting the computers with other
devices using Ethernet cables. The four
main components used in the Ethernet
cabling components are

1. Patch Cable (Twisted pair)

2. RJ45 Connector

3. Ethernet Ports

4. Crimping Tool
13.3.1 Patch Cable (Twisted

Pair)

These Cables are generally made up of 8
wires in different colors. Four of them are

solid colours, and the others are striped.
The eight colors are white green, green,

‘ ‘ XIl CompApp_English version CHAPTER 13.indd 181

white orange, blue, white blue, orange,
white brown and brown. The following
figure 13.8 shows the patch cable.

>

-

Figure 13.8 Patch cable (Twisted pair)

Ethernet cables are
normally manufactured in several
industrial standards such as Cat

3, Cat 5, Cat 6, Cat 6e and cat 7.
“Cat” simply stands for “Category,” and the
following number indicates the version.
Latest version denotes faster and higher
frequencies, measured in Mhz. Increasing
the size of the cable also lead to slower
transmission speed.

The cables together with male
(RJ45) on
commonly referred as Ethernet cables. It
is also called as RJ45 cables, since Ethernet
cable uses RJ45 connectors

connectors each end are

Ethernet cable is
specially designed for makinga connection

A crossover

between two computers. Generally, the
Ethernet cables are designed to make a
connection between a computer and a
router or switch.

Chapter 13 Network Cabling
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13.3.2 RJ45 Connector

The RJ45 connector is a small plastic cup
which will be used to connect the wire
inside the connector and ready to connect
the Internet. The RJ45 connector looks
similar like a telephone jack but it looks
a slightly wider. The Ethernet cables are
sometime called as RJ45 cables. In RJ45
the “RJ” stands for the Registered Jack
and the “45” simply refers to the number
of interface standard in the cable. See
Figure 13.9

Figure 13.9 RJ45 Connector

Each RJ45 connector has eight pins
and connected to each end of the Ethernet
cable. since it has 8-position, 8-contact
(8P8C) modular plug, It is also known as
8P8C connector. These plugs (connector)
are then inserted into Ethernet port of the
network card.

Wiring schemes and colour codes of
the connector

The RJ45 connector has eight small jack
inside to connect eight small wires of the
patch cable. The eight cables are in eight
different colors. Let’s discuss that eight
colors and where does that eight colors
connect to the RJ45 connector.

Wiring schemes specifies how the
wires to be connected with RJ45 connector.
There are two wiring schemes available

Chapter 13 Network Cabling
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to terminate the twisted-pair cable on
each end, which are T-568A and T-568B.
The Table 13.1 describes the pinouts and
colour coding of these schemes.

Pin T-568A Pin T-568B

1 white / green 1
stripe (Tx+)

white / orange
stripe (Tx+)

2 green (Tx-) 2 orange (Tx-)

3 white/orange 3 White/ green
stripe (Rx+) stripe (Rx+)

4  blue 4 blue

5 white / blue 5 white / blue
stripe stripce

6 orange (Rx-) 6 green (Rx-)

white / brown
stripe

7  white / brown 7
stripe

8 brown 8 brown

Although four pairs of wires are
available in the cable, Ethernet uses only
two pairs: Orange and Green. The other
two colors (blue and brown) can be used
ISDN or phone connections.

As we have already discussed
about the pin details in the Ethernet
connector. Now let’s see the pin details
of the Ethernet ports, the pin 1 shows the
transmission positive the pin 2 shows the
transmission negative the pin 3 shows
the receiver positive. The pin 4 shows the
reserved position it is nothing but tells the
connection for some other use. The pin
5, 7, 8 are also used in reserved position.
The pin 6 shows the receiver negative. The
two main signals of the pins: the one is the
TX which is transmission of data and RX
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Figure 13.10 The Ethernet wiring schemes (T568A & T568B)

which is Receiver of data. See Figure 13.10

& Figure 13.11

1. In the Figure 13.10 the position of pin

no. 1 describes the transmit data or
bidirectional, the bidirectional means
it can be sent to both connection
with the TX (positive). The TX+ has
positive terminal and the color is used
in this position is white green.

. In the position of pin no. 2 describes

the transmit data or bidirectional
with the TX (negative). The TX- has

Pin 4: Pin 5:
Reserved Reserved
Pin 3: Pin 6:
Receive + Receive —
Pin 2: Pin 7:
Transmit — Reserved
Pin 1: Pin 8:
Transmit + Reserved

negative terminal and the color is
used in this position is Green.

. In the position of pin no.3 describes

the receive data or bidirectional
with the RX (positive). The RX is
compatible to receive the data which
has positive terminal and the color is
used in this position is white orange.

. In this position of pin no. 4 describes

thatitisnot connected or bidirectional.
It means there will be no transmitting
or receiving will exist. But it can be
used later for some other connection.
The color used in this pin is blue.

(I

]

Pin 1 Pin 8

Position 1 at RJ45 jack

Position 1 at RJ45 plug

Figure 13.11 The Ethernet port pin details
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5. In this position of pin no. 5 describes
that it is not connected or bidirectional
and the color is white blue.

6. In this position of pin no. 6 describes
the receive data or bidirectional
with the RX (Negative) which has a
negative terminal and the color used
in this position is orange.

7. In this position of pin no. 7 describes
that it is not connected or bidirectional
and the color is white brown.

8. In this position of pin no. 8
describes that it is not connected or
bidirectional and the color is brown.

13.3.3 Ethernet card and Port

Ethernet card is a Network Interface
Card (NIC) that allows computers to
connect and transmit data to the devices
on the network. It may be an expansion
card or built-in type. Expansion card is a
separate circuit board also called as PCI
Ethernet card which is inserted into PCI
slot on motherboard of a computer. Now
a days most of the computers come with
built-in Ethernet cards which resides on
motherboard. Wireless Ethernet cards are
also available, which uses radio waves to
transmit data. See Figure 13.12

Ethernet port is an opening which is a
part of an Ethernet card. It accepts RJ45

PCI Ethernet port

connector with Ethernet cable. It is also
called as RJ45 jack. It is found on personal
computers, laptops, routers, switches, hubs
and modems. We can see an Ethernet port
on the back side of a computer or a laptop.
It connects Ethernet cable with Ethernet
card mounted on motherboard.

These days, most of the computers
and laptops have a built-in Ethernet port
for connecting the device to a wired
network. Some of them not having an
Ethernet port use an Ethernet dongles
to form a network with other devices.
Devices or computers which use wifi only
for networking eliminates both the cable
and its port. See Figure 13.13

Ethernet port (RJ45 Jack)

Ethernet cable - RJ-45 Connector (8P8C plug)

(Twisted pair cable)

Figure 13.13 Ethernet cable with Port

Once you inject the plug into the
port the two led lights will glow in the
computer, one is green and another one
is orange. The orange light will start
blinking which indicates that the Internet
is connected.

Motherboard

Ethernet port

Built-in Ethernet card

Figure 13.12 Ethernet Network Interface Cards
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Ethernet Technology  RJ45, 802.3
(according to IEEE)

RJ45 Connector RJ45 plug, Ethernet

(male) connector, 8P8C
connector

RJ45 socket (female)  Rj45 jack, Ethernet
Port

RJ45 Cable Ethernet cable,

13.3.4 Crimping Tool
Crimping is the process
of joining two or more
pieces of metal or wire by
deforming one or both of
them to hold each other.
Joining RJ45 connector

together with twisted pair cable at each end
is an essential process in Ethernet cabling
which lead the cable to function properly.

The crimping tool is a physical tool
which is used to connect the patch wire
and the Ethernet connector. The crimping
tool looks like a small cutting handle with
two mould of Ethernet port. The tool will
puncture the connector and inserts the
wire set in the connector. See Figure 13.14

Figure 13.14 Crimping Tool for RJ-11 (6 pin) and
RJ-45 (13 pin)
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Crimping process for making
Ethernet cables

1.

2.

Cut the cable with desired length

Strip the insulation sheath about 1
inch from both end of the cable and
expose the Twisted pair wires

After stripping the wire, untwist the
smaller wires and arrange them into
the proper wiring scheme, T568B
preferred generally.

. Bring the wires tighter together and

cut them down so that they all have
the same length ( % inch).

Insert all the 8 coloured wires into the
eight grooves in the connector. The
wires should be inserted until the plastic
sheath is also inside the connector.

. Use the crimping tool to lock the

RJ45 connector on the cable. It
should be strong enough to handle
manual traction. Now it is ready for
data transmission.

Use a cable tester to verify the proper

connectivity of the cable. See Figure
13.15

Figure 13.15 Crimping process using crimping

tool

Chapter 13 Network Cabling

1/5/2022 2:10:32 PM‘ ‘



______ NEEN .

www.tntextbooks.in

,@,’ HISTORY OF ETHERNET

Bob Metcalfe invented Ethernet in 1973 while at Xerox PARC (Palo Alto Research Center
in California, USA) and the company patented it in 1975. It was used for interconnecting
advanced computer workstations, making it possible to send data to one another and to
high-speed laser printers. Metcalfe and others then finalized an open Ethernet standard in
1980, and by 1985 it had become an IEEE standard. An industry was born, and Ethernet was
ready for its meteoric rise.

There have been a number of networking standards published in the 802 branch of the
IEEE, including the 802.3 Ethernet and 802.5 Token Ring standards. The IEEE standard was
first published in 1985 with the title IEEE 802.3 Carrier Sense Multiple Access with Collision
Detection (CSMA/CD) Access Method and Physical Layer Specifications . The IEEE standard
does not use “Ethernet” in the title, even though Xerox relinquished their trademark on the
Ethernet name. That’s because open standards committees are quite sensitive about using
commercial names that might imply endorsement of a particular company. As a result, the
IEEE calls this technology 802.3 CSMA/CD or just 802.3. However, most people still use the

Source : www.wikipedia.org

Ethernet name when referring to the network system described in the 802.3 standard.

13.4 Types of Jacks

Registered Jacks: A Registered Jack
commonly known as R] is a network

interface used for network cabling, wiring
and jack construction. The
function of the registered jack is to
connect different data equipment and

primary

telecommunication devices. The commonly
known registered jacks are RJ-11, RJ-45,
RJ-21, and RJ-28. The registered jack refers
to the male physical connector (Plug), a
female physical connector (Jack) and it’s
wiring. We will see some of the variety of
registered jack below with some definitions.
See Figure 13.16

1. RJ-11:1Itis the most popular modern
form of registered jack. It is found
in home and office. This registered
jack is mainly used in telephone
and landlines. When we look at the
pin details of the RJ-11, there are
6 pin where the two pins give the
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transmission configuration, the two
pins give the receiver configuration
and the other two pins will be
kept for reserved. The two pin will
have the positive terminal and the
negative terminal.

(Phone)
RJ11

Figure 13.16 comparison of RJ-45 with RJ-11

2. RJ-14 and RJ-61: The RJ-14 is the

same as RJ-11 which will be used
for telephone lines which has 6 pins
whereas the RJ-61 will have 8 pins.
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This RJ-61 will use the twisted pair
cable with a modular 8 connection.
See Figure 13.17

Figure 13.17 RJ-14 Ethernet Connector

3. RJ-21: The RJ-21 connector has 50
pins with 25 pins at one end and 25
pins at the other end. It is also called
as champ connector or Amphenol
connector. The Amphenol is a

connector  manufacturer.  The

RJ-21 interface is typically used

for data communication trucking

applications. See Figure 13.18

Figure 13.18 The RJ-21 Ethernet port wire with
many other ports on the other end.

13.5 Ethernet Cable Color
Coding Techniques

There are three types of wiring techniques
to construct the Ethernet cable. It is also
known as color coding techniques. They
are

e Straight-Through Wiring
e Cross-over Wiring
e Roll-over Wiring
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13.5.1 Straight-Through Wiring

In general, the Ethernet cables used
for Ethernet connections are “straight-
through cables” These cable wires are
in the same sequence at both ends of
the cable, which means that pin 1 of the
plug on one end is connected to pin 1
of the plug on the other end (for both
standard - T568A & T568B). the straight
through wiring cables are mostly used for
connecting PC / NIC card to a hub. This
is a simple physical connection used in
printers, computers and other network
interfaces. See Figure 13.19

1 11
2 ] 2
K} . A A A, A A A A
4 | — 4
S/ & & & & A& 5
L ——
AN AN AR AN AN A A ey
8 I— 8

Figure 13.19 Straight through wiring connection

13.5.2 Cross-over Wiring

If you require a cable to connect two
computers or Ethernet devices directly
together without a hub, then you will need
to use a Crossover cable instead. Then the
pairs(Tx and Rx lines) will be crossed
which means pin 1 & 2 of the plug on one
end are connected with pin 3 & 6 of the
plug on other end, and vice versa (3 & 6 to
pin 1 & 2).

The easiest way to make a crossover
cable is to make one end to T568A colour
coding and the other end to T568B.
Another way to make the cable is to
remember the colour coding used in this
type. Here Green set of wires at one end
are connected with the Orange set of wires

Chapter 13 Network Cabling
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at another end and vice versa. Specifically,
connect the solid Green (G) with the solid
Orange, and connect the green/white with
the orange/white. See Figure 13.20

PC Cross over PC
Tx+1 1 Tx+
Tx—2 2 Tx—
Rx+3 3 Rx+

4 4
5 5
Rx—6 6 Rx—

T 7
8 I 8

Figure 13.20 Cross over wiring

13.5.3 Roll-over Wiring

Rollover cable is a type of null-modem
cable that is often used to connect a device
console port to make programming changes
to the device. The roll over wiring have
opposite pin arrangements, all the cables
are rolled over to different arrangements.
In the rollover cable, The coloured wires are
reversed on other end i.e. The pins on one
end are connected with other end in reverse
order (i.e.pin1t08,2t07,3t06,4t05,5to
4,6t03,7t02,8to1).

Rollover cable is also known as
Yost cable or Console cable. It is typically

flat (and light blue color) to distinguish it
from other types of network cabling.

Figure 13.21 Roll over Wiring

These three arrangements are used to
perform an interface change. But, all the
three arrangements transmits the data at
the same speed only. See Figure 13.21

(@?‘How to determine the type
—  of Ethernet cables?

Straight-through: The coloured wires

are in the same sequence at both ends
of the cable.

Cross-over: The first coloured wire
at one end of the cable is the third
coloured wire at the other end of the
cable.

Roll-over: The coloured wires are in
the opposite sequence at either end of
the cable.

POINTS TO REMEMBER

e By using World Wide Web, now
people can access the network from
different parts of the world.

e The Network cables are used to
transfer the data and information to
another computer.

e Coaxial cablesare used for connecting
the television with setup box.

Chapter 13 Networking Cabling
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e Twisted cable has 13 wires which are

twisted to ignore electromagnetic
interference

e Two types of twisted pair cables are

Unshielded Twisted Pair (UTP) and
Shielded Twisted pair (STP).

e The optic cable uses light to transmit

the information from one place to
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another. They are mainly used in
Wide Area Network (WAN).

There are two types of fibre optic
cables are available are Single-
mode (100BaseBx) and Multimode
(100BaseSX).

Single-mode cables are used for long
distance transmission and at a high
cost whereas the multimode cables are
used for short distance transmission
at a very low cost.

USB cablesareused connectkeyboard,
mouse and other peripheral devices

The serial port will send 1 bit at one
time whereas the parallel port will
send 13 bit at one time.

The parallel cables are used to connect
to the printer and other disk drivers.

Cross over cable is used to join two
network devices of the same type
like example two PCs or two network
devices. The Null modem Cables are
the example of the crossover cables.

The Ethernet cable is the basic
component of the Local Area Network
(LAN)

The RJ45 Ethernet connector is
a small plastic cup which will be
used to connect the wire inside the
connector and ready to use to connect
the Internet.

The RJ45 connector has eight small
pins inside to connect eight small
wires in the patch cable. The eight
cables has eight different colours

The Ethernet port is the jack where
the Ethernet cable is to be connected.
This port will be there in both the
computers and the LAN port.

The crimping tool is a physical tool
whichisusedto connectthe patch wire
and the Ethernet connector(RJ45).

A Registered Jack (R]) is a network
interface used for
different  data
telecommunication devices.

connecting
equipment and

RJ11 jack is mainly used in telephone
and landlines

There are three wiring techniques
available in Ethernet cables: Straight
through Wiring, Cross over Wiring
and Roll over Wiring.

|GLOSSARY|

ARPANET

WWW

10BASE-T /
100BASE-TX /

100BASE-FX/
100BASE-BX/
100BASE-SX

‘ ‘ XII CompApp_English version CHAPTER 13.indd 189

Advanced Research Project Agency Network, predecessor to the modern

Internet

World Wide Web, Definition comes from the World Wide Web Consortium
(W3QC): “The World Wide Web is the universe of network-accessible
information, an embodiment of human knowledge”

10 Mbps / 100 Mbps

Mbps stands for Mega bits per second

T stands for Twisted pair

X stands for number of paired copper wires

E B, S - Fibre optic cables

Chapter 13 Networking Cabling
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Null modem
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LAN
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Wide Area Network,
WAN is the network that spans large geographical area

Universal Serial Bus, connects all the peripheral devices with the computers

A communication method directly connects two computers without modem
or any equipment.

Local Area Network in which the devices used in home or office
interconnected for sharing the resources.

Transmit / Receive signals used in connectors

The dongle is a small peripheral device with a sim slot in it and connects the
Internet and acts as an Ethernet port to the computer.

Where? ©° : D1 1 2 & Write

= When? EVALUATION

‘. When?

Part - I 4. Expansion of UTP is
® Choose the correct answer a) Uninterrupted Twisted Pair ®
1. ARPANET stands for b) Uninterrupted Twisted Protocol
a) American Research Project ¢) Unshielded Twisted Pair
Agency Network d) Universal Twisted Protocol

b) Advanced R

esearch Project Area 5. Which medium is used in the optical

Network fibre cables to transmit data?
¢) Advanced Research Project a) Microwave b)infra red
Agency Network o)light d)sound
d) American Research Programs 6. Which of the following is a small
And Network peripheral device with a sim slot to
2. WWW was invented by connect the computers to Internet?
a) Tim Berners Lee a) USB
b) Charles Babbage b) Dongles
c) Blaise Pascal ¢) Memory card
d) John Napier d) Mobiles
3. Which cable is used in cable TV to 7. Which connector is used in the
connect with setup box? Ethernet cables?
a) UTP cable b) Fibre optics a) RJ11 b) RJ21
c¢) Coaxial cable d)USB cable ¢) RJ61 d) RJ45

IETI) chapter 13 Networking Cab
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Which of the following connector is
called as champ connector?

a) RJ11
b) RJ21
c) RJ61
d) RJ45
How many pins are used in RJ45
cables?

a)8
b) 6
¢) 50
d) 25

Which wiring standard is used for
connecting two computers directly?

a) straight Through wiring
b) Cross Over wiring

c) Rollover wiring

d) None

pick the odd one out from the

following cables
a) roll over

b) cross over

¢) null modem

d) straight through

Match the following

1. Ethernet - Port

2. RJ45 connector - Ethernet
3. RJ45 jack - Plug

4. RJ45 cable - 802.3
a.l,2,4,3 b.4,1,3,2
c.4,3,1,2 d4,2,1,3
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Part - 11
Short Answers

1.
2
3.

Write a note on twisted pair cable.
What are the uses of USB cables?

Write a note on the types of RJ45
connector.

. What is an Ethernet port?

5. What is the use of Crimping tool?

What are the types of twisted pair
cables?

What is meant by champ connector?

Part - II1
Explain in Brief Answer

1.
DA
3.

Write a note on crossover cables.
Write a short note on RJ45 connector.

What are the differences between
serial and parallel ports?

. What is meant by null modem cable?

5. What are the components involved

in Ethernet cabling?

What are the types of Fibre optic
cables?

Part - IV
Explain in detail

1.

What is meant by Registered Jack?
Explain briefly the types of Jacks.

. Explain wiring techniques used in

Ethernet cabling.

Explain about RJ45 connector.

. Explain the components used in

Ethernet cabling.
Explain the types of network cables

Chapter 13 Networking Cabling
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| _sTupenT activities

1. Make your own Crossover cable.
A Purchase the following
i. a patch cable(UTP cat 5e / 6) with desired length

ii. RJ45 connector(8P8C modular plug) of both wiring schemes(T568A and
T568B)

iii. Crimping Tool
B. Construct the cable using the method described in the text book, with the help
of crimping tool

2. Connect two computers using Crossover cable for sharing resources

T chapter 13 Networking Cabling

‘ ‘ X1l CompApp_English version CHAPTER 13.indd 192 @ 1/5/2022 2:10:33PM‘ ‘



@ LEARNING OBJECTIVES

To know the

e Need of Open Source Software.
e NS2 and its Use

14.1 Introduction

Free software and compilers were provided
with early computer hardware. With these
human understandable code the user can
modify, add new code and identify the
errors.

Can anyone change the codes in
open source software?

Open source software has been
developed by a variety of programmers.
However, to add a new change to the
software,the modified code will be submitted
to a group of dedicated programmers. These
programmers then test the modified codes
and if it satisfies the appropriate rules, it will
then be distributed to all.

Why it is called open source?

Open Source simply refers to making the
source code of the software freely available
for users or other developers to use and
make changes into the original repository
or fork the project into and build a new

‘ ‘ X1l CompApp_English version CHAPTER 14.indd 193
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Open Source Concepts

e OpenNMS and Group which created

OpenNMS

e OpenSource Hardware

one. Open source software is usually created
and updated by many programmers around
the world and made freely accessible.
Proprietary software is owned by an
organization or individual. The makers
of proprietary software have not allowed
the users or other developers to view or
edit the source code. But the advantage
of the proprietary software is that it gives
more control, support, training, security
and stability for user making the software
reliable to the users

In a network it is not easy to find
problems. Especially when there are more
systems are connected, the complexity
is more, so we need Network Software
to Control, Analyse the Server, System,
protocol, Network, Traffic flow and
reports about ups and downs of network
parts. Notification help the user and
administrator easily find working status
of network systems and hardware, alert
message, give details of faults, where and
when it happens.
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NRCFOSS

National Resource Centre for Free and
Open Source Software is an Institution
of Government of India. It helps in
development of FOSS (Free Open Source
Software) in India.

Organizations related to Open
Source

e Apache Software Foundation
e The Document Foundation

e The Eclipse Foundation

e Free Software Foundation

e Linux Foundation

e OpenCourseWare Consortium

e Open Source Initiative

BOSS

BOSS (Bharat Operating System Solutions)
Operating System Developed in India
by C-DAC (Centre for Development of
Advanced Computing) helps to prompt
the use of open source software in India.
It supports many Indian Languges.

Types of open source license
e Apache License 2.0

e BSD 3-Clause
license

e BSD 2-Clause
“FreeBSD” license

e GNU General Public License (GPL)

“New” or “Revised”

“Simplified”  or

e GNU Library or “Lesser” General
Public License (LGPL)

e MIT license
e Modzilla Public License 2.0

Chapter 14 Open Source Concepis
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e Common Development and

Distribution License

e Eclipse Public License

When you change the source
code, OSS requires the inclusion of what
you altered as well as your methods. The
software created after code modifications
may or may not be made available for
free.

Open-Source Software vs.
Free Software

Although the terms are often used
interchangeably, OSS is slightly different
from free software. Both deal with the
ability to download and modify software
without restriction or charge. However,
free software is a concept developed in
the 1980s by an MIT computer science
researcher, Richard Stallman who defined
four conditions - as outlined by the
nonprofit Software
These “four freedoms” emphasize the
ability of users to use and enjoy software

Free Foundation.

as they see fit.

In contrast, the OSS criteria, which
the Open Source Initiative developed
a decade later, place more emphasis on
the modification of software, and the
consequences of altering source code,
licensing, and distribution.

Obviously, the two overlap; some
would say the differences between OSS
and free software are more philosophical
than practical. However, neither should
be confused with freeware. Freeware
usually refers to proprietary software that
users can download at no cost, but whose

source code cannot be changed.
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Open-Source Software and

Copyright
Developers
OSS  projects  are  collaboration Owner Owner Owner
opportunities that improve skills and \ ¢ /
build connections in the field. Domains 0SS
that developers can contribute to the open Project

source community include:

e Communication tools.

e Distributed revision control systems.
e Bug trackers and task lists.

e Testing and debugging tools.

Copyright

Vendor Vendor Vendor

Oowner ¢ /
Contributor Contributor
v 0

SS

N 0SS e Project

Project

® Copyright ®

How Open Source work

©)
Improved Source
Code

User/Developer

@)

ZR Compiled Program
Developer O
Improved Source
Code

Source code

Vastly Improved
Source Code

User/Developer

User/Developers Worldwide

@)
Improved Source
Code
User/Developer

Chapter 14 Open Source Concepts  @CITN
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Benefits of Open Source

software and tools

e There are many open source softwares.
so, we can select and use any software
that suits our needs.

e The complete options of the software
can be used without any cost and
restrictions.

e We can share our ideas with the team,
write the required code and share it
with many.

e As we can identify the programming
techniques of group members, we
can learn many ideas and make our
program writing skills more efficient.

e Thecodinginopensourcesoftwaresare
being groomed by many enthusiastical
members of the group. So if we report
problems that we have in the program
they are quickly mended by the group’s
effort.

e As we can make changes to the open
source softwares, we can add the most
required features in the software

e Many open source software are very
user friendly.

Like benefits Open source Software
also have Some Problems Like Difficult
to work for beginners, Exchange of files
to other softwares, Some times Lack of
Responsibility,

service and problems

related to hardware compatibility.

Example of open source
Application software

NS2, OPEN NMS, Ubuntu,  MySQL,
PDF Creator, Open Office, 7zip
GNUCASH, GIMP, BLENDER,

AUDACITY, VLC, MOZILA FIREFOX,
MAGENTO, ANDROID, PHP

Chapter 14 Open Source Concepis
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14.2 Network simulation
tool — NS,

network, network

a method where a

In  computer
simulation is
software program models the activities
of a mnetwork by calculating the
communication between the different
network objects such as(routers, nodes,
switches, points, links etc.).

A network simulator is a software

access

program that replicates the functioning
of a computer network. In simulators,
the computer typically
demonstrated with devices, traffic
etc. and the performance is evaluated.
Normally, users can then adapt the
simulator to accomplish their precise

network is

analysis needs. The network parameters
that define the state of the network
(node placement, existing links) and
the events (data transmissions, link
failures, etc.). A significant output
of simulation is the trace files. Trace
files can document every incident that
happened in the simulation and are used
for examination.

NS2 is the abbreviation of
NETWORK SIMULATOR version 2. It
was considered explicitly for exploration
in network communication and event-
driven

open-source simulator in

computer.

OTCL and c++ are used to create
and run NS2. NS2 works on Windows
and Linux platforms, that supports wired
or wireless network and also use the
command line interface as a user interface,
API is a pure event base software tool
with super simulation design, it has more
models which help the user to get desired
output easily.
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14.3 Open NMS

Open NMS (Network Management System)
is a free and open-source initiative grade
network monitoring and management
platform. It is established and maintained
by a community of users ,developers and by
the Open NMS Group, it offering services,
training and support. The goal is for Open
NMS to be actually distributed, scalable
management application platform for all
features of the FCAPS (Fault, configuration,
accounting, performance, security) network
management model. Presently the emphasis
is on Fault and Performance Management.

It was intended to cope tens of
thousands of devices from a single server
as well as achieve unlimited devices using a
cluster of servers. OpenNMS comprises of a
discovery engine to routinely configure and
manage network devices without operator
intervention. It is written in Java and is issued
under the GNU (General Public License.)

OpenNMS is the Worlds first
software for Network monitor and
management with opensource options.
There are two types of Open NMS -
Meridian and Horizon. When we need
stability and long term support choose
Meridian which is best for Enterprises

as well as businesses. Horizon used

where innovation occurs frequently. It is
Best for IT-ecosystem, new technologie
monitoring. OpenNMS was Released in
1999 by Steve Giles, Brian Weaver, and
Luke Rindfuss.

In 2004 OpenNMS Group was
created by Balog, Matt Brozowski, and
David Hustace. It is written in Java and
can run on all type of platform. It gives
us Event management & Notification,
Discovery &  Provisioning, service
monitoring and Data Collection. It has
won lot of awards for best open source

software.

OpenNMS has three main functional
areas:

e Service monitoring - where a number
of monitor modules can govern if
network-based services (ICMP, HTTP,
DNS, etc.) are accessible.

e Data Gathering - using SNMP and
TMX.

e Event management and notifications
- which comprises of alarm reduction
and a robust announcement system
with accelerations and duty schedules.

In this period of increased
competition and cyber crimes, the
computers used by indivudals or

business organisations may have

Open Source Hardware
® Remix

® Remake

® Remanufacture

e Redistribute

® Resell

e Study and Learn

spy hardwares of rivals. Open
source hardware
helps in such threats. In this
technique we get the components

of the hardware and its circuit

technology

diagram, so that we can remove
suspicious spyware if found.
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POINTS TO REMEMBER I

e Open Source denotes to some program whose source code is made available for
usage or reform as users or other developers see appropriate

e In simulators, the computer network is typically demonstrated with devices,
traffic etc. and the performance are evaluated.

e A significant output of simulation is the trace files. Trace files can document
every incident that happened in the simulation and are used for examination.

e NS2has C++ and Object-oriented Tool Command Language (OTcl) of languages
2.

e It link together for C++ and the OTcl using TclCL.

e Open NMS (Network Management System) is a free and open-source initiative
grade network monitoring and network management platform.

e Network monitoring software notifications help the user/administrator for
fixed errors.

=
@® |GLUSSARY| ®

NS2 Network Simulation 2

OpenNMS First Open Source Network Management Software

Trace File A document file, consists of every incident happens in a simulation
OTCL Object-oriented Tool Command Language

FCAPS Fault, configuration, accounting, performance, security
GNU General Public License

SSENet Scalable Simulation Framework Net Models

API APPLICATION PROGRAM INTERFACE

SOURCE CODE Set of Instructions that decide, how the software should work
BOSS Bharat Operating System Solutions

C-DAC Centre for Development of Advanced Computing

IETI) chapter 14 Open Source Software
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Part -1 5.

Choose the correct answer

1. If the source code of a software is

freely accessible by the public, then 6.

it is known as
a) freeware

b) Firmware

c) Open source

d) Public source

2. Which of the following is a software
program  that replicates the
functioning of a computer network?

a) Network software
@ b) Network simulation

c) Network testing

d) Network calculator

3. Which of the following can
document every incident that
happened in the simulation and are
used for examination?

a) Net Exam
b) Network hardware

¢) Trace file
d) Net document

4. Which is an example of network
simulator?

a) simulator
b) TCL
c) Ns2
d) C++

‘ ‘ XII CompApp_English version CHAPTER 14.ndd 199 @

Fill in the blanks : NS2 comprises of

_____ key languages?

a) 13 b) 3 c)2 d) 4
Choose the Correct Pair from the
following to build NS2

a) UNIX & TCL
b) UNIX & a. C++
¢) C++ & OTcl

d) C++ & NS2

Which of the following is not a
network simulation software?

a) Ns2
b) OPNET
c) SSFNet
d) C++

. Which of the following is a open

source network monitoring
software?

a) C++

b) OPNET

c) Open NMS

d) OMNet++

Open NMS was released in

.....................

a) 1999 b) 2000

¢) 2003 d) 2004
10.OpenNMS Group was created

by..oii

a) Balog

b) Matt Brozowski
¢) David Hustace
d) All of them.

Chapter 14 Open Source Software
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Part - II
Short Answers
Explain the History of open source software

What is meant by network simulator?
What is trace file?

Write short notes on NS2.

Explain NRCFOSS.

Write short note on Open NMS?

S

Part - II1
Explain in Brief Answer
What are the uses of Open source Network Software?

Explain Free software.
List out the Popular open source software.
Write note on open source hardware.

What are the main functional areas of Open NMS?

v P e s

Explain Types of Organisations related to Open Source.

® Part -1V ®

Explain in detail
1. Differentiate Proprietary and open source software.

2. List out the Benefits of Open Source Software

3. Explain various Open Source License.

| _sTuoenT activities

1 Mention Open source software and free software names that not explain in this
chapter.

2. Mention Software that are accounts related.
3. Mention Open Source Developing and maintaining companies

IEII) chapter 14 Open Source Software
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@ LEARNING OBJECTIVES

e To learn the concept of E-Commerce.

15.1 Introduction to
E-Commerce

“The wise possess all”.
Anyone who is quick
to identify and adopt
innovation  will  be

successful. Commerce

always  profits from

innovations. Successful ~ businesses
quickly identify developing opportunities
in emerging new technology, and expand

their commercial capabilities.

The customer goes to the market,
checking out a wvariety of products,
choosing required stuff, purchasing them
and then paying the specific amount is
traditional commerce. However, recent
ways of buying or selling goods and
services have come up with technology
innovations.

‘ ‘ X1l CompApp_English version CHAPTER 15.indd 201

CHAPTER

E-Commerce

To know the brief history of E-Commerce.
To analyze different types of E-Commerce business models and revenue models.
To distinguish between E-Commerce and Traditional commerce.

To understand the advantages and disadvantages of E-Commerce.

In near future commercial activities
such as buying or selling of goods between
merchant and consumer will be forgotten.

Figure 15.1 Conventional commodities exchanging
System

As growth in technology and vast
usage of internet, our style of living has
changed and this has also modified the
working of commercial trade. Refer Figure
15.1
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In 1996, IBM coined the term
E-Business. Just, as business is broader
than commerce, E-Commerce is a subset
of E-Business. E-Commerce is commercial
transaction through Internet, but E-Business
entirely depends on the Internet for its every
intra-company and inter-company activities
such as procurement of raw materials,
marketing, finance, manufacturing, selling
and negotiation.

While,
with  monetary

E-Commerce is limited

transactions  using

Internet  E-Business is  grounded
on technologies Network
Infrastructures (like Internet, Intranet,
Extranet), Multimedia content &
network publishing infrastructures (like
HTML, Online Marketing), Messaging &
information distribution infrastructures
(like EDI, e-mail, http, Computerized
Management Systems)
and other Common business service

infrastructures (like electronic payments

such as

Inventory

gateways, globalized Supply Chain
Management (SCM), Online Transaction

Processing). See Figure 15.2

& publishings
Messaging &
Information
Distribution

Common Business
Service Infrastructure

Multimedia content

Figure 15.2 E-Business building block

Chapter 15 E-COMMERCE
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A company is set to have E-Business if and
only if

e It has the ability to conduct business
electronically over Internet.

o It payment
through Internet.

manages transaction
e It hasa platform for selling products &
services via Internet.

E-Commerce

E-Commerce is currently one of the most
important aspects of the Internet era. Just
likethewordse-mail, e-bookwith the prefix
‘@ (¢ stands for electronic) Commerce
and Internet makes E-Commerce. It also
allows the consumers to exchange goods
and services with no barrier of time
or distance. Electronic commerce has
expanded rapidly over the past few years

and is predicted to accelerate.

E-Commerce can be described as the
process of buying or selling products,
services or information via computer
networks.

It could be a consumer based retail
site or auction site or trade between large
business organizations. The commodity
could be a laptop or a wrist watch or it
could be an operating system or a simple
browser plugin.

The Physical products which can
be seen are touched. They are distinct
from intangible goods which have value
but are not physical entities.

Tangibles products may be like
printed books, CD’s and DVD’, lamp
etc., Intangible products may be like
digital files, downloaded video games,
music files are movies which can not be
physically touch. Refer Figure 15.3
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Figure 15.3 Tangible and intangible goods.

e Goods - e.g. mobile phones, digital
cameras, clothes, accessories, antivirus.

e Information - e.g. subscription to
some newspapers, scientific journals,
television channels.

e Services - e.g. matrimonial services,
placement services.

e Tangible form - e.g. a digital camera
purchased by a consumer from an
online shopping website which might
be delivered at the requested address.

e Electronic form - e.g. a music album or
a software downloaded from a site which
might be delivered in electronic form.

15.2 The Evolution of
Electronic Commmerce

E-Commerce is not a completely new type
of commerce. The dawn of E-Commerce
started few decades ago and continues to
grow exponentially. It first emerged on
private networks in 1970s. Electronic Data
Interchanges and teleshopping together
paved the way for the E-Commerce.

4

- 'vows
proposed a technique

home infotainment device called Teleputer, which was a
fusion of Television, Computer and Telecom networking

technologies.
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In 1979, Michael Aldrich, an English entrepreneur,
that enables
transaction processing between consumers and businesses,
or between businesses. It was later proficiently called
as E-Commerce. In 1980 he invented a multi-purpose

H .  EEEw
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Thehistoryof modern E-Commerce
is closely twisted together with the
history of the Internet. E-Commerce
became really possible when the Internet
was opened to commercial use. Online
shopping started to grow when National
Science Foundation opened the Internet to
the public in 1991. Since then businesses
have reached websites.

With the progress of the Internet
technology and vastly developed global
Internet community, large number of
Dotcoms, FinTech and Internet Startups
have appeared and a strong foundation of
electronic commerce continues to build.

The Internet has provided new
potential not only for
large organizations, but also provided
a sustainable entry point for Small and
(SMEs) of
E-Commerce is

commercial

Medium-sized Enterprises
E-Commerce. Today,
no longer an exclusive domain of large

organizations or private networks.

Even though E-Commerce has
been existing since few decades, it has
recently sustained significant growth. It is
because the Internet has transformed from
an auxiliary communication medium of
academics and large organizations to an
entrenched communication medium that
extends nearly to all parts of mainstream

online

Chapter 15 E-COMMERCE
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society. Integrated with commercialization
of the Internet, personal computers and
electronic payment systems together
made E-Commerce flourish.

The growth of E-Commerce is also
related to the socio-technological changes.
The more, the medium becomes deep-
rooted, the more, are the users drawn
towards it. Increase of users, increases the
markets. As the markets expand, more
business organizations are attracted. The
more businesses accumulate it create
competition. The competition leads to

English inventor Michael Aldrich
connected a TV set to a computer
with a phone line and created 1979
“teleshopping” - meaning shopping
at a distance

The ‘Electronic mail’ is launched by
Compuserve - users could purchase

innovation; innovation in turn drives the
development of technology; technology
facilitates E-Commerce’s growth. See
Figure 15.4

W‘In August 11, 1994 by noon of
” WMOW?  the day, Phil Brandenberger of

Philadelphia (U.S.A), bought a
music CD (Sting’s “Ten Summoners’
Tales”) from Kohn of Nashua (U.S.A)
and paid $12.48 plus shipping charges
using his credit card through online. This
is marked as the first true E-Commerce
transaction.

~

Electronic date interchange allows

1960s companies to carry out electronic
transactions-a precursor to online

shopping
1981 The first business-to-business

transaction from Thompson holidays

The National Science Foundation
o allows the internet to be used for
commerical purposes

items directly from 110 online Ll
merchants
Online retailer NetMarket makes the
‘first secure retail transacton on th
web’ - a copy of Sting’s album Ten Aug 1994

Summoner’s Tales

Amazon sold its first item - a science Jul 1995

textbook

The first online-only shop, Zappo'’s,
opens 1999

Groupon is launched

With mobile commerce, it is expected to
hike 265% up and will be $ 850 billion

American Dollar

Joe McCambley ran the first ever

online banner ad. It went like on

HotWired.com and promoted 7 art
museums.

Oct 1994

eBay sold its first item - a broken

Sep 1995 laser pointer

Social commerce (people using
social media in their buying
decisions) is born thanks to

networks like Facebook

2005

India’s Total E-Commerce sale is

2009 3.9 billion Americal Dollar

Figure 15.4 Timeline describing various events in E-Commerce

Chapter 15 E-COMMERCE
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15.3 The Development and
Growth of Electronic
Commerce

Economists describe four distinct waves
(or phases) that occurred in the Industrial

different
successful.

Revolution. In each wave,
strategies
Electronic commerce and the information

revolution brought about by the Internet

business were

likely go through such series of waves.
Refer Figure 15.5

e The First Wave of Electronic
Commerce: 1995 -2003

The Dotcom companies of first wave are
mostly American companies. Thereby
their websites were only in English.
The Dotcom bubble had attracted huge
investments to first wave companies.

As the Internet was mere read-only
web (web 1.0) and network technology
was in its beginning stage, the bandwidth
and network security was very low. Only
EDI and unstructured E-mail remained as
a mode of information exchange between
businesses. But the first wave companies
enjoyed the first-move advantage and
customers were left with no option.

e The Second Wave of Electronic
Commerce: 2004 - 2009

The second wave is the rebirth of
E-Commerce after the dotcom burst. The
second wave is considered as the global
wave, with sellers doing business in many
countries and in many languages. Language
translation and currency conversion were
focused in the second wave websites. The
second wave companies used their own
internal funds and gradually expanded
their E-Commerce opportunities. As a
result E-Commerce growth was slow and
steady. The rapid development of network
technologies and interactive web (web
2.0, a period of social media) offered the
consumers more choices of buying. The
increased web users nourished E-Commerce
companies (mostly B2C companies) during
the second wave.

e The Third Wave of Electronic

Commerce: 2010 - Present

The third wave is brought on by the
mobile technologies. It connects users for
real-time and on-demand transactions
via mobile technologies. The term Web
3.0, summarize the various characteristics
which

of the future Internet include

—

2 5

O =

g =

o E

S o]

« O

5 9 WEB 2.0

Qo

£ WEB 1.0

=z Read-Write-Execute

Web, Smart Search,
c Read-Write Web, Social Commerce, Auctons, Vlsrétréri?:w;gg,
o Blogs, Wiki, Instant Mesenger, 2D portals, Augmented Realfty.
= Read-only Web, Text, Widgets, Pull web Gesture Technology,
€ Catalogs, Forms, Search, Avatar representations,
Pictures, Flash Wearable Techanology,
o ’ Smart Personal Assistant,
— 3D Portals, Push web
1995 2004 2010

Figure: 15.5 Evolution of Electronic Commerce
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Artificial Intelligence, Semantic Web,
Generic Database etc.

w‘Dotcom Bubble
- nows

~

The Dotcom Bubble was a historic
excessive growth (excessive assumption)
of economy that occurred roughly
between 1995 and 2000. It was also a
period of extreme growth in the usage
and adaptation of the Internet as well.

In the late 1995, there was a
tremendous development in US equity
investmentsin Internet-based companies.
During the dotcom bubble, the value of
equity markets grew exponentially with
the NASDAQ composite index of US
stock market rising from under 1000
points to more than 5000 points.

NASDAQ Composite Index

(1990-Present)
8000

7000

B fes mecnes /
5000 & L 2 W
4000 L /l'

2000 wrational | W) oot com /

exuberance
speech

2000

Dot-com bull

1000 |market begins

Dotcom Burst

The Nasdaq-Composite stock market
index, fell from 5046.86 to 1114.11. This s
infamously, known as the Dotcom Crash
or Dotcom Burst. This began on March
11, 2000 and lasted until October 9, 2002.
During the crash, thousands of online
shopping companies, like as Pets.com
failed and shut down. Some companies
like Cisco, lost a large portion of their
market capitalization but survived, and
some companies, like Amazon declined
in value but recovered quickly.

Chapter 15 E-COMMERCE
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15.4 Classification of
E-Commerce Business

models
Business organizations, Consumers
and Government (also called as

Administrations) are the major parties in
the E-Commerce. Sometimes Employees
(Informal workers) also indulge in this
system. Based upon the entities involved
in transaction, E-Commerce is classified
into the following categories. The model in
which the government plays as an entity is
termed as e- Governance. See Figure 15.6

BUSINESS

CONSUMER GOVERNMENT

BUSINESS

CONSUMER

GOVERNMENT

Figure 15.6 E-Commerce business models

Business to Business (B2B)
Business to Consumer (B2C)
Business to Government (B2G)
Consumer to Business (C2B)
Consumer to Consumer (C2C)
Consumer to Government (C2G)
Government to Business (G2B)

Government to Consumer (G2C)

© ® N QG R W N

Government to Government (G2G)

e Business to Business (B2B)
In B2B
transactions take place between different
through the
Internet. For example, a cycle company

E-Commerce, commercial

business organizations,

may buy tyres from another company for
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their cycles. When compared to other models, the value per transaction in B2B transaction
is high, because of bulk purchase. The company also might get the advantage of discounts
on bulk purchases. See Figure 15.7

Out-sourcing and Off-shoring are generally associated with B2B E-Commerce.

e Ifa company’s work is hired to another company, it would be termed as out-sourcing.

e If the work is outsourced to a company, which is outside its own country;, it is called as

off-shoring.

Figure 15.7 Business to Business

e Business to Consumer (B2C)

In B2C E-Commerce, commercial transactions take place between business firms and
their consumers. It is the direct trade between companies and end-consumers via the

® Internet. B2C companies sell goods, information or services to customers through online ®
in a more personalized dynamic environment and is considered as real competitor for a

traditional storekeeper. An example of B2C transaction is a book company selling books to
customers. This mode is intended to benefit the consumer and can say B2C E-Commerce
works as ’retail store’ over Internet. See Figure 15.8

Figure 15.8 Business to Consumer

e Business to Government (B2G)

B2G is a business model that refers to business organizations sells products, services or
information to Governments or to its administrations. In other words, when a company
get paid for its goods, services by the Government through Internet it is called as B2G
model. e.g. The Government or its administration buys laptops for students. See Figure
15.9
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Figure 15.9 Business to Government

e Consumer to Business (C2B)

C2B can be described as a form of E-Commerce where, the transaction is originated by
the consumers. The consumers will fix a requirement or specific price for a service or
a commodity. C2B model, is also called as reverse auction model. Here, customer bid
his price for a service or a product. Then E-Commerce business entity will match the
requirement of the consumer to the best possible extent.

For instance, in a travel website (eg.yatra.com) a consumer may specify his dates of travel,
his source and destination, number of tickets required and range of hotel etc. The website
then finds out the various options for him which best meets his requirements. These
websites generate revenue through affiliate links, sponsored advertisement or even a small
commission in every booking. e.g. Name-your-price websites. See Figure 15.10

Figure 15.10 Consumer to Business

e Consumer to Consumer (C2C)

C2C in E-Commerce provides opportunity for trading of products or services among
consumers who are connected through the Internet. In brief when something is bought
and sold between two consumers using Internet it is called C2C E-Commerce. Here
the websites act as a platform to facilitate the transaction. The electronic tools and
Internet infrastructure are employed to support transactions between individuals.
Typically, this type of E-Commerce works as Consumer to Business to Consumer
(C2B2C). It means that a consumer would contact a business in search of a suitable
customer. Most of the auction websites and matrimonial websites are working on this
methodology.

For example, a consumer who wants to sell his property can post an advertisement
on the website (eg:timesclassifieds.com). Another person who is interested in buying
a property can browse the property, advertisement posted on this site. Thus, the two
consumers can get in touch with each other for sale/purchase of property through another
business’ website. See Figure 15.11
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Figure 15.11 Consumer to Consumer

e Consumer to Government (C2G)

Citizens as Consumers and Government engage in C2G E-Commerce. Here an individual
consumer interacts with the Government. C2G models usually include income tax or
house tax payments, fees for issue of certificates or other documents. People paying for
renewal of license online may also fall under this category. See Figure 15.12

Figure 15.12 Consumer to Government

e Government to Business (G2B)

G2B is closely related to B2G. G2B in E-Commerce refers to a business model where
Government providing services or information to business organization. It may be a
@ formal offer such as a takeover bid for a road project. See Figure 15.13 @&

Figure 15.13 Government to Business

G2Bisa part of e-governance. The Government provides information about business rules,
requirement and permission needed for starting a new business, and other specifications
in its portal. The objective of G2B is to reduce burdens on business, provide one-stop
access to information thereby boost the economy. e.g. ebiz.gov.in See Figure 15.14

i it i A2 iy e b b P o | | e . + - o EEN
o R " = :

Figure 15.14 ebiz.gov.in
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e Government to Consumer (G2C)

G2C in E-Commerce is very similar to C2G. Here the Government provides platform for
its citizens to avail its services and information through the Internet. The services may be
issue of certificates through online.e.g. https://csc.gov.in/governmenttocitizen. See Figure
15.15

Figure 15.15 Government to Consumer

e Government to Government (G2G)

G2Gistheonline (usuallynon-commercial) interactionbetween Governmentorganizations
or departments. G2G’s principle objective is to implement e-governance rather than
commerce. G2G model in e-governance involves distributing data or information between
its agencies/departments. G2G systems can be classified into two types

e Internal facing or local level - joining up a single Government’s bureaucracy.
e.g. https://www.nic.in/

e External facing or international level - joining up multiple Governments’
bureaucracy.

See Figure 15.16

Figure 15.16 Government to Government

15.5 E-Commerce Revenue Models

Apart from regular selling of commodities, today there are many other ways by which
companies can make money from the Internet. The other forms of E-Commerce activities
are:

1. Affiliate site is a form of third party marketing in which the site owner gets paid
based on the performance. The affiliate site may be a price comparison service or
shopping directories or review sites or blogs that contain a link to a normal retailing
site and are paid when a customer makes a purchase through it. The affiliate site
usually attracts visitors by offering more information and tutorials on some specific
product or a topic. See Figure 15.17 to Figure 15.23

IFZT)  chapter15 E-COMMERCE

‘ ‘ X1l CompApp_English version CHAPTER 15.indd 210 @ 1/5/2022 2:13:38 PM‘ ‘



B [ ® H .  EEEm

www.thtextbooks.in -

. = -
FIIEIS “E Finde dein Produkt... in Computer >~
. Mein Merkzettel

v
Preisvergleich Apple MacBook Air 13 " 2017 (142 Angehote*)
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Apple Machook Air 13 1.8 GHz D
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aptop MacBook Air 13

Apple MacBook Air MQD32 13.3 * Core iS ]
Intel Core i5-5350U 1
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Clothing Trading EU Jurongeast bueromarkt-zg.de mactrade.de

Figure 15.17 Affiliate site (price comparation website)

® 2. Auction site is a kind of website, that auctions items on the Internet and levies some
commission from the sales. e.g. https://www.ebay.com/

Find a Vehicle~ Auctions = Locations Support=

Browse Stock

Frert End (869)
Hail 3

Featured ltems b

Wehicle Types » Minor Dents(Scratch... (200
Narmal Wesr (7)
Recovered Thefis (5]
Rur and Drive (344)

Mare...

Makes 4

MORE THAN Automobile ¥]

300 VEHICLES - _ B ——

All Makes T

EX Rental Cal“S - 1 Mode | All Mode's |
younger than 3 years e [ ]

Figure 15.18 E-Auction website
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3. Banner advertisement site displays advertisements of other companies in its websites

and thereby earns revenue.

Is African Mango Really A Scam?
Thers: has been 4 lot of hype about African Mango going around
v these days. It is sadd that African Mango is a “breakthrough diet
g supplement.” African Mango has been featured by a few
ThE New television celebrties, and also featured on many news sites
| 5
secret in
Weight Loss

Natusal African

boasting being able to lose 28 Ibs a month with no change in diet

Or Exencioe.

You are telling me [ can lose 28 [bs a monith with
African Mango?!?

After hearing such bold statements like that, and seeing
promotions (Fke the video below) that looked unbelievable. |
was very skeptical as I'm sure you are too. 5o | decded to test it
out for myself, | had been scammed by weight loss products

| | before and | wanted to see if this one delivered the results, [ was
| | sick of being overweight!

<= banners

Advertisements

R PURE
B NICOTINE
WITHNOD
CHEMICALS

banners

Figure 15.19 Banner advertisement site

4. Bulk-buying sites collect a number of users together where every one wants to buy
similar items - the site negotiates a discount with the supplier and takes commission.

e.g. https://www.alibaba.com/

Alibaba com

Global irscs 41arts hare What are yuu looking fo

boys pants elastic band wedding vell By underviear hook oop underwens

AUTOMOBILES & MOTORCYCLES

Other Auto
Clectronics

Tire Inflators

- P

Motorized
Diversified Tricycles
Procurement

Solutions

THINEstoNe connectar

() searcn

waterpronl Zipper heated vest

Car Seat Covers

Clectric Subwoofers Passenger Car
Motorcycles Wheels
1 T
3g -
r .=
utv tyre refrigerator muck baat anchor cleat auto switch ham carbon brush engine assembly wheel hub 1achomerer .
)
ECOMMERCE BUYERS' ZONE BRAND ZONE

Search easier with product links
Paste procuct link or upioad a photo

Advanced Product
N Search Tool

Popular Brands -
New to Alibaba.com b ¥

Figure 15.20 Bulk-buying sites
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5. Digital publishing sites effectively host the e-books or magazines on the web. They make
profits in a number of ways such as advertising, selling etc., https://wordpress.org/

W Publisher

Welcome to the official website of Author

This WordFress theme is ideal solution for Book authors and Digital product publishers to represent their
creative work such as ebooks, Books, DVDs, Audio CDs and other creative works such as Paintings etc:

——-—.——'_'
!* ?“f:‘*.“; 4
eTCE TN
NATURAL

| HISTORY

PR AN
B O il T e s

AAPReicd

Latest News Author Info
= Autamatic Lipdates. Tohn Macnroe
g4 3061 Yims cain ke Shia avetian 1

» Use Shortcodes with this theme 1o describe yourscifaushock
ot

« Widgetized Hame pege

stithon your Bablion, interests eic.

Figure 15.21 Digital Publishing website

6. Licensing sites allow other websites to make use of their software. For example, the

C A Notsecure

28 Nov 2018 12,55

©

WWWLIGNOWU,ECIN

A A-| A=

Select Lanquags | ¥ Scieen Reader Access

search engines which allow a visitor of the site to search within the website more easily.

= ®

aoe
ignou -
ngFECFLF_s Indira Gandhi National Open University Custom Search
UNIVERSITY

Figure 15.22 Google Search in IGNOU website

7. Name-your-price sites are just like normal retail sites. In contrast, the buyer negotiates
with the retailer for a particular product or service. https://in.hotels.com/

win fFgints on LATAM Abfines.

priceling’

FLIGHTS

MOTEL * FLIGHT CARS - — — —
s o uTH o
e AMERICA
1B checkin - Crecean & 1oem
=p

!k

Figure 15.23 Name-your-price sites

8. Online Shopping mall site allows multi E-Commerce traders to assemble together
on a single website. Often these sellers would be related to each other, for example
they may all sell luxury goods. This site would take a percentage of their profit.
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E-Commerce

15.6 Comparison between Traditional Commerce and

E-Commerce isn’t just commerce anymore. Even though they share the
primary principle of buying and selling goods and services, there is a
difference between traditional commerce and E-Commerce.

Figure 15.24 Traditional vs E-Commerce

Traditional Commerce

Traditional commerce is buying or selling of
products and services physically.

Customer can face to face identify, authenticate

and talk to the merchant.

Physical stores are not feasible to be open at all

times.

Products can be inspected physically before
purchase.

Scope of business is limited to particular area.

Resource focus Supply side.
Business Relationship is Linear.
Marketing is one way marketing.

Payment is made by cash, cheque, cards etc.

Most goods are delivered instantly.

E-Commerce

E-Commerce carries out commercial
transactions electronically on the Internet.

Neither customer nor merchant see the other.

It is always available on all time and all days
of the year.

Products can’t be inspected physically before
purchase.

Scope of business is global. Vendors can
expand their business Worldwide.

Resource focus Demand side.
Business Relationship is End-to-end.
One-to-one marketing.

Payment system is mostly through credit
card, debit card or fund transfer.

It takes time to transport goods.
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15.7 Advantages and

Disadvantages of
E-Commerce

The pros and cons of E-Commerce affect

three major

stakeholders: consumers

business organisations, and society.

The following are the advantages

and disadvantages of E-Commerce for a

consumer.

Advantages

E-Commerce system is operated on
all days and all the day 24 x 7. Neither
consumer nor suppliers need physical
store to be opened to do business
electronically. People can interact
with businesses at the time of their

convenience.

Speed is a
E-Commerce.

major advantage in
Advanced Electronic
communications systems allow
messages to reach across the world
instantaneously. There is no need to wait
days for a catalogue to arrive by post.
Communication delay is not a part of

the Internet or E-Commerce world.

The Internet is too easy to ‘shop around’
for products and services that may be
more cheaper and effective than left to
buy only in a Brick and Mortar shop.
It provides an opportunity to buy at
reduced costs. Itis possible to, explore the
Internet, identify original manufacturers,
thereby bypass wholesalers and achieve
a cheaper price.

The whole world becomes a shop for
today’s customers. They can have wide
choice by comparing and evaluating

‘ ‘ XIl CompApp_English version CHAPTER 15.indd 215

the same product at different websites
before making a purchase decision.

Customers can shop from home or
anywhereattheir convenience. Theydon't
need a long wait to talk to a salesman.
They can read the details regarding
model numbers, prices, features etc. of
the product from the website and buy
at their own convenience. Payments can
also be made through online.

Disadvantages

e E-Commerce is often used to buy goods

that are not available locally but from
businesses all over the world. Physical
goods need to be transported, which
takes time and costs money. In traditional
commerce, when we walk out of a shop
with an item, it’s ours, we have it. We
know what it is, where it is and how it
looks. But in E-Commerce we should
wait to get the product in hand. Some
E-Commerce companies handle this by
engaging their customer updating status
of their shipments.

Unlike returning goods to a traditional
shop returning goods through online is
believed to be an area of difficulty. The
doubts about the period of returning
will the returned goods reach source
in time, refunds, exchange and postage
make one tiresome.

Privacy  issues are serious in

E-Commerce. In E-Commerce
generating consumer information is
inevitable. Not all the companies use the
personal information they obtained to
improve services to consumers. Many

companies misuse the information and
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make money out of it. It is true that
privacy concerns are a critical reason
why people get cold feet about online
shopping.

Physical product disputes are a
major disadvantage in E-Commerce.
E-Commerce purchases are often made
on trust. This is because, we do not have
physical access to the product. Though
Internet is an effective channel for visual
and auditory information it does not
allow full scope for our senses. We can
see pictures of the perfumes, but can not
smell their fragrance, we can see pictures
of a cloth, but not its quality. If we want
to inspect something, we choose what
we look at and how we look at it. But
in online shopping, we would see only
the pictures the seller had chosen for us.
People are often much more comfortable
in buying the generic goods (that they
have seen or experienced before and in

which there is little ambiguity) rather
than unique or complex things via the
Internet.

We couldn’t think of ordering a single
ice cream or a coffee from a shop
in Paris. Though specialized and
refrigerated transport can be used,
goods bought and sold via the Internet
need to survive the trip from the
supplier to the consumer. This makes
the customers turn back towards
traditional supply chain arrangements
for perishable and non-durable goods.

Delivery ambiguity. Since supplying
businesses can be conducted across the
world, it can be uncertain whether they
are indeed genuine businesses or just
going to take our money. It is pretty hard
to knock on their door to complain or
seek legal recourse. Further, even if the
item is sent, it is easy to start bothering
whether or not it will ever arrive on time.

» Disruptive innovations in E-commerce

~

The innovations which replace
the existing technologies are
calledasdisruptiveinnovations.
Disruptive innovation creates a new
market. Not all innovations are near
disruptive. The first automobiles in
the late nineteenth century were a
great innovation. But it didn’t affect
existing animal-based road transport
market until 1908 when Henry Ford

Chapter 15 E-COMMERCE
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introduced affordable motor cars. The
term disruptive innovation was first
coined by Clayton M in his book “The
Innovator’s Dilemma”

Example: Film cameras market
is disrupted by digital camera
innovations, floppy disk  market

is interrupted by CD and USB
innovations. E-Commerce itself is a
disruptive innovation.
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Steps to Start an E- Business

The following are the initial steps involved in the process to start an online business
and start selling items instantly:

e Business structure and Registration

Operating an E-Commerce or E-Business does not exclude from requiring certain
business licenses and permits. The company must be registered before starting

the trade. Registration includes business name, trade name, type of company.
(e.g., Private Ltd, Public Ltd, Partnership or Sole Proprietor, LLP - limited liability
partnership etc.) The company must be registered to get the bank account opened
in the company name and obtaining GST registration documents easily. Any one is
allowed to enroll in an online platform and start selling immediately, but there will
be no limited liability protection provided to litigation. Thus, if one need to sustain
and grow it is best to start with an LLP or a company. http://www.mca.gov.in/

i » FACILIATOR » EDLCK

Ministry of Carporate Affairs @ EMPOWERING BUSINESS, PROTECTING INVESTORS

@ . Government of India
e o

m ABOUT MCA ACTS B RULES MY WORKSPACE MCA SERVICES DATA & REPORTS CONTACTS HELP & FAQS
i

FREQUENTLY UISED MNEWS & IMPORTANT UPDATES

EBODK
COMPANIES ACT, 2013

COMPANIES STRUCK OFF

SEARCH
COMPANIES ACT, 2013 s ADT-3 and MR-1 have Been revised on MCAZL Company Forms ek

Home page of Ministry of Corporate Affairs to register a Business organization online

Chapter 15 E-COMMERCE 217

‘ ‘ Xl CompApp_English version CHAPTER 15.indd 217 @

1/5/2022 2:13:39 PM‘ ‘



I [ [

@

H .  EEEw

www.tntextbooks.in

e Tax Registration

Taxation is unavoidable in any
country. A company must have
registered with tax department
of the concerned nation. In India
registration with GST and other
tax norms is a necessary to begin
selling online, it does not matter
whether we are starting our own
online business website or selling
on a others’ portal. https://services.
gst.gov.in,  https://ctd.tn.gov.in/
home

e Business Bank Account

Bank account facilitate payment
systems. Once the company or LLP
is registered successfully, the next
step is to apply for a bank account
in the name of the online venture.
GST certificate is necessary to open
a bank account for a business firm.

e Payment Gateway

The next important step is to
implement a payment gateways
with
website to allow customers make
their payments through credit card,
debit card, Internet banking, etc.
With digital payment gateway, the

integrated E-Commerce

customers can make the payment
online which automatically gets

transferred to Dbusiness’s bank
account.

e Shipment Solution

Once the above steps are

accomplished and start receiving
the order, the next step is to set up

Chapter 15 E-COMMERCE
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the logistics section. Logistics is
a major part of the E-Commerce.
Third party logistics companies
may help us to deliver sold products
to the customers at their mentioned
destination.

e Identifying suppliers

Global market space comes along
with competition in selling products
online. so finding the best quality
and best prices for the products we
sell is very important. We should
shop around until we find a supplier
we find a suitable supplier.

e Marketing

Marketing plays a significant role
in any business. Using Internet and
social media effectively will take
out product worldwide. Marketing
could be started as early as it could
be. Catchy captions and logos attract
more new customers. It’s a good idea
to set up social media profiles and
writing content for blogs from very
first day because we do not want to
wait when it is ready to serve.

e Right technologies

Updating our technical knowledge
will give hand in E-Commerce.
Technology makes so much of our
work easier. So before we start our
E-Commerce business, we should
be familiar with some of the basic
entities like customer relationship
management, project
management, email and marketing
etc. The deeper we learn, the greater

accounting,

we grow..
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POINTS TO REMEMBER

e E-Commerce can be described as the process of buying or selling products, services or
information via Internet.

e FinTech Financial technology is a collective term for technologically advanced financial
innovations. In simple words Fintech is a new finance industry that uses technology to
improve financial activity.

e The dotcom bubble was a rapid rise in U.S. equity market of Internet-based companies
during 1990s.

e Web 1.0 (Web of Content) is the early web that contained text, images and hyperlinks
and allowed users only to search for information and read it. There was a very little in
the way of user interaction or content generation.

e Web 2.0 (Web of Communication) is a read-write web that allowed users to interact
with each other.

e Web 3.0 (Web of Context) is termed as the semantic web or executable web with
dynamic applications, interactive services, and “machine-to-machine” interaction.

=
|GI.USSARY|

Affiliate Business who promotes the products of another business for a commission.

Blog An online platform for writing articles about a topic.

Brick and mortar The term that refers to a business that has a physical store; opposite of
online store.

Dotcom Common name for Internet based companies.

Mobile commerce Businesses that are conducted through the Internet using mobile phones
or other wireless hand-held devices.

Nascent stage Initial stage of growth.

Off-shoring Company’s work is given to overseas (another country) company
Out-sourcing Hiring third party service providers to handle business on behalf.

Social media In terms of E-Commerce, a platform for advertising products to targeted

consumers e.g. Facebook, twitter.

Tangible form Physical goods we receive.
Teleputer Fusion of television, computer and telecom networking technologies.
Wordpress A free, open source online blogging platform.
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Part I
Objective Questions

1. A company has E-Business if

a) it has many branches across the
world.

b) it conduct business electronically
over the Internet.

c) it sells commodities to a foreign
country.

d) it has many employees.

. Which of the following is not a tangible
good?

a) Mobile

b) Mobile Apps

¢) Medicine

d) Flower bouquet

. SME stands for

a) Small and medium sized enterprises
b) Simple and medium enterprises

¢) Sound messaging enterprises

d) Short messaging enterprises

. The dotcom phenomenon deals with

a) Textile industries
b) Mobile phone companies
c) Internet based companies

d) All the above

. Which of the following is not correctly

matched

a) The First Wave of Electronic
Commerce: 1985 -1990

b) The Second Wave of Electronic
Commerce: 2004 - 2009

@

¢) The Third Wave of Electronic
Commerce: 2010 - Present

d) Dotcom burst: 2000 — 2002

. Assertion (A): The websites of first

wave dotcom companies were only in

English

Reason (R): The dotcom companies

of first wave are mostly American

companies.

a) Both (A) and (R) are correct and
(R) is the correct explanation of (A)

b) Both (A) and (R) are correct, but (R)
is not the correct explanation of (A)

¢) (A) is true and (R) is false

d) (A) is false and (R) is true

. Off-shoring means

a) Work outsourced to a branch of its
own company

b) Work outsourced to new employees

c) Work outsourced to a third party
locally

d) Work outsourced to a third party
outside its own country

. G2G systems are classified into

a) Internal facing and external facing
b) Internet facing and Extranet facing
c) Internal flag and external flag

d) Internet flag and Extranet flag

host the e-books on their
websites.

a) Bulk-buying sites
b) Community sites
c) Digital publishing sites

d) Licensing sites

Chapter 15 E-COMMERCE
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10. Which of the following is not a characteristics of E-Commerce

a) Products cannot be inspected physically before purchase.
b) Goods are delivered instantly.

¢) Resource focus supply side

d) Scope of business is global.

Part - II
Short Answers

1.

GoR W

Define E-Commerce.

Distinguish between E-Business and E-Commerce

Differentiate tangible goods and electronic goods with example of your own.
What is dotcom bubble and dotcom burst?

Write a short note on out-sourcing.

Part - 111
Explain in Brief Answer

vk e N

Describe how E-Commerce is related to socio-technological changes.
Write a short note on the third wave of E-Commerce.

Explain B2B module in E-Commerce.

Write a note on name-your-price websites.

Write a note on physical product dispute of E-Commerce.

Part - IV
Explain in detail

o1k B

Write about the development and growth of Electronic Commerce.

List all the E-Commerce business models and explain any four briefly.
Explain any five E-Commerce revenue models.

How would you differentiate a traditional commerce and E-Commerce?

What are the advantages and disadvantages of E-Commerce to a consumer?

| _sTupenT activities

e Draw a timeline describing various developments in E-Commerce.

e List the business around your society and sort it according to business modules.

e Interview a consumer who recently bought a product online and write his experience.
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Electronic Payment Systems

e To understand what is Electronic payment systems

e To know the various types of E-payment methods

e Tolearn the basics of
o Card Based Payment Systems

Electronic Account Transfer

o
o Electronic Cash Payment Systems
o

Mobile Payment and Internet Payment Systems

16.1 Introduction to
Electronic Payment
systems

Everyday people buy or sell goods and
services for money. Money becomes the
major medium of exchange. Later some
payment systems were developed out of a
need to facilitate the growth of commerce
and economic development.

The media used for transferring
the value of money is very diversified,
ranging from the use of simple payment
instruments (e.g. cash) to the use of
complex systems (e.g. cryptocurrency).
Physical money (cash), is the traditional
and most widely used payment instrument
that consumers use, in their daily lives to
buy goods and services.

Chapter 16 Electronic Payment Systems
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As the volume and variety of
transactions expands, the volume of money
also expand. Using cash for each of large
transactionsis neither feasible nor practically
possible.
problems arise in cases where large amounts

Security and transportation

of cash transactions are involved.

Banks would support in such cases
by offering other payment methods. The
cashless society has been discussed for long
time. The demise of cash and cheques could

not be sudden. Though old habits hardly die,
people do not hesitate adapting new things.

Definition

An Electronic payment system is a
financial arrangement that consists of
an intermediator to facilitate transfer of
money-substitute between a payer and
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a receiver. Sometimes it is also called
liquidation, clearing system or clearing
service. It ensures the transfer of value
from one subject of the economy to
another and plays an important role in

modern monetary systems.

Modern payment systems may
be physical or electronic and each has
its own procedures and protocols that
guide the
payment mechanisms and legal systems.

financial institution with
Standardization has allowed some of these
systems to grow globally.

The term electronic payment refers to a
payment made from one bank account
to another bank account using electronic
methods forgoing the direct intervention
of bank employees.

Payment system is an essential
part of a company’s financial operations.
But it becomes complex, when many
different payment systems are used.
Further
continuous

challenges come from the

introduction of newer
payment systems such as paytm, UPI,
bitcoin and various mobile payment
options. As a result there are more than
750 payment systems throughout the

world. See Figure 16.1

Consumers

Payment
method

= ~ I+ Banik Direct Link
| » fusbomatic Clearing
Housa [ACH}

* Payroll
» Credit Card

Figure 16.1 Electronic Payment Systems
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16.2 Classification of
Electronic Payment
methods

Many electronic payment methods have
been developed with the advancements
in the Internet technologies. Based on the
value of money transactions, processing
time, processing requirements, security
issues and usability, electronic Payment
systems are generally classified into two
types. They are

e Micro electronic Payment Systems

e Macro electronic Payment Systems

16.2.1 Micro electronic Payment
Systems

It is an on-line payment system
designed to allow efficient and frequent
payments of small amounts. In order
to keep transaction costs very low, the
communication  and

costs are minimized here. Unlike macro

computational

electronic payments, which use expensive
public key cryptography, micro electronic
payment are relaxed by using light weight
cryptographic primitives and off-line
payment verifications.

As the security of micro electronic
payment systems is comparatively low it
can be tampered but, the cost of fraud is
much higher than the possible value to
be gained by fraud itself. So the security
in micro electronic payment methods is
considered to be adequate. The majority
of micro electronic payment systems are
designed to pay for simple goods on the
Internet. e.g., subscriptions of online
games, read journals, listen to a song or
watch a movie online etc.

Chapter 16 Electronic Payment Systems
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In general, the parties involved in
the micro on-line payments are Customer,
Service Provider and Payment processor.
The Microelectronic paymenttransactions
can be explained in the following way.

Step 1 Customer proves his authentication
and the payment processor issues
micro payments.

Step 2: Customer pays the micro payments
to the online service provider
and gets the requested goods or
services from them.

Step 3: Service provider deposit micro
payments
customer to the payment processor
and gets the money.

received from the

16.2.2 Macro electronic payment
systems

Macro electronic payment systems
support payments of higher value. The
security requirements are more rigorous
in macro payment systems because of huge
money transactions. Banks will impose a
minimum transaction overhead on macro
payment systems. These transactional over
heads for the usage of computationally
cryptographic
prevent these payment systems to be used
for the payment of small amounts. Some
of the popular macro on-line payment

systems are mentioned below

expensive operations

e Card based payment systems
e Electronic account transfer
e Electronic cash payment systems

e Mobile payment systems and internet
payment systems

Chapter 16 Electronic Payment Systems
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16.3 Card Based Payments
Systems

Payment cards are plastic cards that
enable cashless payments. They are simple
embossed plastic card that authenticates
the card holder on behalf of card issuing
company, which allows the user to make
use of various financial services. More
than 90% of online payments are card
based payments, at the same time other
e-payment methods are also gaining
importance now-a-days.

Based on the transaction settlement
method there are three widely used card
based payment systems. They are

1. Credit card based payment systems
(pay later)

2. Debit card based payment systems
(pay now)

3. Stored value card based payment
systems (pay before)

16.3.1 Credit Card

Credit card is an electronic payment system
normally used for retail transactions.
A credit card enables the bearer to buy
goods or services from a vendor, based
on the cardholder’s promise to the card
issuer to payback the value later with an
agreed interest. Every credit card account
has a purchase limit set by the issuing
bank or the firm. A credit card is different
from a debit card where the credit card
issuer lends money to customer instead
of deducting it from customer’s bank
account instantly.

The term credit card was first
mentioned in 1887 in the sci-fi novel
“Looking Backward” by Edward Bellamy.
The modern credit cards concept was
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born in the U.S.A, in the 1920s, when °
private companies began to issue cards to
enable their customers to purchase goods °
on credit within their own premises.

@]‘In February 1950, Frank
~ WWOW?  McNamara and Ralph Schneider
created The Diners Club card
which was made of paper-cardboard.
Initially The card was accepted in only 27
restaurants and was used only by friends
and acquaintances of the two founders
(approximately 200 people). Later it was
enhanced and accepted worldwide. From
1955, the card was made of plastic. The
Diners Club still exists today under the

name Diners Club International.

Har ﬁa .aﬁa?z‘,, Y
Cluly
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Advantages of credit card

e Most credit cards are accepted
worldwide.

e It is not necessary to pay physical
money at the time of purchase. The
customer gets an extra period to pay
the purchase.

e Depending on the card, there is no
need to pay annuity.
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Allows purchases over the Internet in
installments.

Some issuers allows “round up” the
purchase price and pay the difference
in cash to make the transactions easy.

Key players in
operations of credit card

1. Bearer: The holder of the credit
card account who is responsible
for payment of invoices in full
(transactor) or a portion of the
balance (revolver) the rest accrues
interest and carried forward.

2. Merchant: Storekeeper or vendor

who sell or providing service,
receiving payment made by its
customers through the credit card.

3. Acquirer: Merchants bank that is

responsible for receiving payment on
behalf of merchant send authorization
requests to the issuing bank through
the appropriate channels.

4. Credit Card Network: It acts as the

intermediate between the banks.
The Company responsible for
communicating the transaction
between the acquirer and the credit
card issuer. These entities operate
the networks that process credit
card payments worldwide and
levy interchange fees. E.g. Visa,
MasterCard, Rupay

5. Issuer: Bearer’s bank, that issue the

credit card, set limit of purchases,
decides the approval of transactions,
issue invoices for payment, charges
the holders in case of default and
offer card-linked products such
as insurance, additional cards and
rewards plan. See Figure 16.2

Chapter 16 Electronic Payment Systems
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CARDHOLDER MERCHANT ACQUIRER CREDIT CARD NETWORK ISSUING BANK
- /] D i »
y//1\\
The cardholder The merchant The acquirer The credit card
pays the merchant send the credit forwards the network requests
for a purchase card details to credit card details payment authorization
with a credit card. the acquirer. to the credit card from the issuing bank.
network.

Figure 16.2 Key players of Credit card transaction

Anatomy of a credit card

All Payment cards (including debit
card) are usually plastic cards of size
85.60 mm width x 53.98 mm height,
rounded corners with a radius of
2.88 mm to 3.48 mm and thickness of
0.76 mm. These standards dimensions are
maintained universally in accordance with
ISO/IEC 7810#ID-1. See Figure 16.3

1. Publisher: Emblem of the issuing
bank (along with the sub category or
scheme if any)

2. Credit card number: The modern
credit card number has 16-digit
unique identification number.

e The first digit of the credit

card number is Major Industry
Identifier (MII). It identifies the

1 Credit Card
Dl ——

4

2 234 5678 9102 3456

3 NAME \um\\(::umn/t;:“ LOGO

issuer category. e.g. 1 — Airlines,
4 - Banks

e The next 5 digits uniquely identifies
the issuing organization.

e The first 6 digits together called
as Issuer Identifier number (IIN)
or Bank Identification number
(BIN)

e The next 9 digits are the account
number.

e The last digit is a check digit
(based to the Luhn algorithm).

3. Name of the cardholder: It is
visibly embossed on the front side
(additionally stored on the magnetic
stripe) some cards like gift cards do
not hold any name.

1234 456

0C T

Figure 16.3 Credit Card
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EMV chip: It is integrated chip in
addition to magnetic stripe to store
cardholder’s EMV
stands for Europay, MasterCard, Visa.

information.

These three names correspond to the
names of the companies which are
responsible to develop this technology.
It is categorized into Chip-and-
Signature and Chip-and-PIN.

RFID symbol: It is four curved lines
radiating rightwards similar to a
tilted Wi-Fi symbol. It indicates that
it is a contactless smartcard.
Expiration month and year: It is
visible on the front side (also stored
on the magnetic stripe or chip). The
card is valid until the last day of the
month printed on it.

Card brand logo: It is the name of
the credit card network company.
Visa and MasterCard are leading
credit card network companies.
Rupay is Indian domestic open loop
card launched in 2012.

. Magnetic stripe: It is an iron based

magnetic ~ material  containing
encrypted data about the card holder
and account number.

Hologram: Hologram is a security
feature that prevents duplication. It
is a 3-dimentional image formed by

interference of light beams.

10. Signature: It is cardholder’s signature

11.

at the back of the card, used as an
attempt to identify cardholder’s
identity. It also holds the last 4 digits
of card number.

CVC/CVV: Card Verification code/
value is a 3 digit code usually printed
to the left of signature pane validates
the card. CVC2 is used in contact
less transactions.

‘ ‘ XII CompApp_English version CHAPTER 16.indd 227

Apart from the these mentioned
each credit card may also holds issuer’s
disclaimer, address and phone number.

16.3.2 Debit Card

Debit Card is an electronic payment card
where the transaction amount is deducted
directly from the card holder’s bank account
upon debit
cards function as ATM cards and act as a

authorization.  Generally,
substitute for cash The way of using debit
cards and credit cards is generally the same
but unlike credit cards, payments using a
debit card are immediately transferred from
the cardholder’s designated bank account,
instead of them paying the money back at a
later with added interest. In modern era the
use of debit cards has become so widespread.

The debit card and credit card are
identical in their physical properties. It
is difficult to differentiate two by their
appearance unless they have the term
credit or debit imprinted.

Currently there are three ways of
processing debit card transactions:
1. EFTPOS (also known as online debit
or PIN debit)
2. Offline debit
signature debit)

(also known as

3. Electronic Purse Card System

16.3.3 Stored value cards

Stored value card is a type of debit card that
is pre-loaded with certain amount(value),
with which a payment is made. It is a card
that has default monetary value onto it.
The card may be disposed when the value
is used, or recharged to use it again. The
major advantage of stored value card is that
customers don't need to have a bank account
to get prepaid cards. See Figure 16.4

Chapter 16 Electronic Payment Systems
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Figure 16.4 Stored value card

Like a credit card or debit card it
is a plastic and has a magnetic strip on
its back. The magnetic strip stores the
monetary value of the card. Stored value
cards may not have the card holder’s name
always. It is also indistinguishable from a
regular credit or debit card in appearance.
What look like a credit card or debit card
act like a credit or debit card. It is used to
make purchases offline and online in the
same way as in credit card or debit card.

There are two varieties for stored
value card.

1. Closed loop (single purpose)

In closed loop cards, money is
metaphorically stored on the card
in the form of binary-coded data.
Closed loop cards are issued by
a specific merchant or merchant
group and can only be used to make
purchases from specific place. e.g.
chennai metro rail travel card.

2. Open loop (multipurpose)

Open loop cards can be used to make
debit transaction at variety of retailers.
It is also called as prepaid-debit cards.

Chapter 16 Electronic Payment Systems
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It can be used anywhere the branded
cards are accepted. e.g. Visa gift cards.

4
w‘ln some countries it is legal for
T WNW?  anyone to enter or leave the

country with money that is stored
on cards, unlike carrying cash in high
amounts which is believed a form of
money laundering.

16.3.4 Smart card

The modern version of card based
payment is smart cards. Smart cards
along with the regular features of any
card based payment system holds a EMV
chip. This chip is similar to well-known
sim card in appearance but differ in its
functionalities. The advantage of Smart
cards is that it can provide identification,
authentication, datastorage and application
processing. Smart cards can be classified
into Contact smart cards and Contactless
smart cards. See Figure 16.5

Figure 16.5 Contact Smart card & POS

1. Contact smart cards

Contact smart cards have a contact
area of approximately 1 square
centimeter, comprising several gold-
plated contact pads. These pads
provide electrical connectivity only
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when inserted into a reader, which
is also used as a communications
medium between the smart card
and a host. e.g. a point of sale
terminal(POS).

2. Contactless smart cards

Contactless smart card is empowered
by RF induction technology. Unlike
contact smart cards, these cards
require only near proximity to an
antenna to communicate. Smart
cards, whether they are contact or
contactless cards do not have an
internal power source. Instead, they
use an inductor to capture some of
the interrupting
signal, rectify it and power the card’s

processes. See Figure 16.6

radio-frequency

16.4 Electronic Account
Transfer

Apart from card based payment systems
there are many alternative electronic
payment systems. With the advent of
computers, network technologies and
electronic large
number of alternative electronic payment
systems have emerged. These include

communications a

ECS (Electronic Clearing Services), EFT
(Electronic funds transfers), Real Time
Gross Settlement system (RTGS) etc.
These Electronic Payment systems are
used in lieu of tendering cash in domestic
and international transactions.

16. 4.1 Electronic Clearing
Services (ECS)

Electronic Clearing Service can be
defined as repeated transfer of funds
from one bank account to multiple bank
accounts or vice versa using computer and
Internet technology. The payer instructs
the bank to debit from his bank account
and credit it to one or more payee bank
account provided amounts and dates
of the payments earlier. This system
provides the convenience of paperless

payments.

Advantages of this system are bulk
payments, guaranteed payments and
no need to remember payment dates. It
can be used by institutions for making
payments such as disbursing of salary,
pension or dividend interest among
shareholders. Similarly, individual bank
customers also can make small value
repetitive payments such as paying EMI

b ] ~

r

-

Figure 16.6 Contactless smart card
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Sample R-ECS file

Figure 16.7 ECS

of a loan, electricity bills, telephone
bills, insurance premium, as well as SIP

investments. See Figure 16.7

ECS can be used for both credit
and debit purposes i.e. for making bulk
payments or bulk collection of amounts.

e ECS credit: ECS credit is used for
making bulk payment of amounts. In
this mode, a single account is debited
and multiple accounts are credited.
This type of transactions are Push
transactions.Example: if a company
has to pay salary to its 100 employees
it can use ECS credit system than
crediting every employees’ account
separately.

e ECS debit: ECS debit is an inverse
of ECS credit. It is used for bulk
collection of amounts. In this mode,
multiple accounts are debited and then
a single account is credited. This type
of transactions are Pull transactions.
Example: The insurance premium of
bulk number of customers is debited
from customer’s bank account on their
prior consent and paid to insurance
company.

Chapter 16 Electronic Payment Systems
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W‘EFT is known by a number of

names across countries. In India,
it is called as N-EFT (National
Electronic Fund Transfer), in the
United States, they may be referred to
s “electronic cheques” or “e-cheques”.
National Electronic Funds Transfer
(NEFT) is an electronic funds transfer
system initiated by the Reserve Bank
of India (RBI) in November 2005. It is
established and maintained by Institute
for Development and Research in
Banking Technology (IDRBT). NEFT
enables a bank customer to transfer funds
between any two NEFT-enabled bank
accounts on a one-to-one basis. It is done
via electronic messages. Unlike RTGS,
fund transfers through the NEFT do not
occur in real-time basis.

‘NEFT’

16.4.2 Electronic Funds Transfer
Electronic Funds Transfer (EFT) is the
“electronic transfer” of money over an
online network. The amount sent from
the sender’s bank branch is credited to the

-

Pz R
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receiver’s bank branch on the same day
in batches. Unlike traditional processes,
EFT saves the effort of sending a demand
draft through post and the inherent delay
in reaching the money to the receiver.
Banks may charge commission for using
this service. EFT is a widely used method
for moving funds from one account to
another in B2B business models.

16.4.3 Real Time Gross
Settlement:

Real Time Gross Settlement

(RTGS) is a payment system particularly

used for the settlement of transactions

system

between financial institutions, especially
banks. As RTGS
transactions are processed at the real-
time. RTGS payments are also called
as push payments that are initiated
(“triggered”) by the payer. RTGS payments

name indicates,

are generally large-value payments, i.e.
high-volume transactions.

W‘The development and maintenance
T MWW of NEFT or RTGS systems
worldwide is driven primarily by
the central bank of a country. (RBI
in India)

~—

Real-time gross settlement transactions
are:

e Unconditional - the beneficiary will
receive funds regardless of whether he
tulfills his obligations to the buyer or
whether he would deliver the goods
or perform a service of a quality
consistent with the order.

e Irrevocable - a correctly processed
transaction cannot be reversed and
its money cannot get refunded (the
so-called settlement finality).
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16.4.4 Electronic wallets

Electronic wallets (e-wallets) or electronic
purses allow users to make electronic
transactions quickly and securely over
the Internet through smartphones or
computers. The electronic wallet functions
almost the same as a physical wallet in term
that it holds our money. Electronic wallets
were first recognized as a method for storing
money in electronic form, and became
popular because it provides a convenient
way for online shopping.

With  the
advanced Internet, the use of electronic

development  of

wallets turned out as an efficient
transaction tool. This is evidenced by
the many E-Commerce websites that
use electronic wallets as a transaction
tool. There are several electronic wallet
services that are now widely used. e.g.

:PayPal, SBI Buddy. See Figure 16.8

Receive Payment, Send Payment

request on the go

Figure 16.8 e-wallets

16.5 Mobile Banking and
Internet Banking

As smartphones have already usurped
the place of digital camera and voice
recorders, soon it will double up as virtual

Chapter 16 Electronic Payment Systems
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debit cards. It enables to send or receive
money instantly without any plastic cards.

16.5.1 Mobile Banking

Mobile banking is another form of net
banking. The term mobilebanking (also called
m-banking) refers to the services provided by
the bank to the customer to conduct banking
transactions with the aid of mobile phones.
These transactions include balance checking,
account transfers, payments, purchases, etc.
Transactions can be done at anytime and
anywhere. See Figure 16.9

W‘Some of the latest mobile banking

? applications even have a cash
withdrawal menu. The menu will
create a specific code that can be used
instead of an ATM card to operate an
ATM. However, this can only be done at a
special ATM (ATM with no card service).

—~—

The WAP protocol installed on a
mobile phone qualifies the device through

%)

=

State Bank freedoM

Your Mobile, Your Bank.

2
Enquiry
- g3

Bill Pay

e

Logout ;I

il

an appropriate application for mobile
session establishment with the bank’s
website. In this way, the user has the option
of permanent control over the account and
remote management of his own finances.

Mobile Banking operations can be
implemented in the following ways:
e contacting the call center.
e automatic IVR telephone service.
e using a mobile phone via SMS.
e WAP technology.

e Using smartphone applications.

16.5.2

Internet banking is a collective term

Internet banking

for E-banking, online banking, virtual
banking (operates only on the Internet
with no physical branches), direct banks,
web banking and remote banking.

Internet banking allows customers
ofafinancial institution to conduct various
financial transactions on a secure website

Back State Bank Mobile Banking

Funds Transfer
Payee Type :

B

Amount To Be Transferred :|
Debit from Account :

Figure 16.9 mobile banking through smartphone application
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operated by the banking institutions.
This is a very fast and convenient way of
performing any banking transactions. It
enables customers of a bank to conduct
a wide range of financial transactions
through its website. In fact, it is like
a branch exclusively operating of an
individual customer. The online banking
system will typically connect to the core
banking system operated by customers
themselves (Self-service banking).

Advantages:

e The advantages of Internet banking
are that the payments are made at the
convenience of the account holder and
are secured by user name and password.
i.e. with Internet access it can be used
from anywhere in the world and at any

time.

transaction statements, recent

transactions, bill payment, blocking a
card in case of theft or loss, information
about like

other bank products

payment cards, deposits, loans etc.

W‘Out of 7.7 billion world population
T WO roughly 3.2 billion have the

Internet access. There by more
than 50% of world population are
accessed to Internet banking.

—~-

The following are the steps to transfer
fund using net banking.

Step 1: Login to net banking account using

® ° éEY stan.dard browser (e.g. Goo.gle unique user name and password ®
rome) is adequate. Internet banking provided by the bank earlier.

does not need installing any additional Step 2: Add the beneficiary as a payee
software. to enable transfer of fund. The

e Apart from regular transactions, following details like Account
Internet banking portal provides Number, Name, IFSC about the
complete control over all banking beneficiary are to be filled in the
demands such as available balance, ‘Add New Payee’ section.
st 22 v

Sudected Aczoust Humbar El
Salect a schedule opfion

Schodula Da *

Wy suthonse sn NEFTAHET fransaes

Favouries ~Salect

25 Hov-2014 (0600 PMIST]

Limt

100049

 reachately tut tha KEFTICERIT wall 5o g o the et moadabin NEFTAGRET batch

Flasse note, a8 per HEI instnsctions credit will

taccept the Tasmy gt Coniony

4 the Beneficiary name particalars will not be used thesalor,

Lameel

Figure 16.10 Home page of SBI Internet banking
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Step 3: Once the beneficiary is added,
choose RTGS / NEFT / IMPS as
mode of Fund Transfer.

Step 4: Select the account to transfer money
from, select the payee, enter the
amount to be transfered and add
remarks (optional).

Step 5: Click on submit.

Step 6: Enter the OTP received to
mobile number linked to the
corresponding account to

complete the transaction.

Modern Electronic funds transfers are
secured by a personal identification number
(PIN), one-time password (OTP) etc. An
automated clearing house (ACH) processes
the payment then. See Figure 16.10

W‘Indian Financial System Code
~ WOW?(TFSC)isan 11 digit alpha-numeric

code issued by Reserve Bank of
India to uniquely identify individual
bank’s branch in India. It is used for
domestic e-payments. SWIFT code is
used for international bank transactions.

~a

16.6 Unified Payments
Interface

Unified Payments Interface (UPI) is a
real-time payment system developed
by National Payments Corporation of
India (NCPI) to facilitate
transactions. It is simple, secure and
instant payment facility. This interface is
regulated by the Reserve Bank of India
and used for transferring funds instantly
between two bank accounts through

inter-bank

mobile (platform) devices. http://www.
npci.org.in/

Chapter 16 Electronic Payment Systems
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Unlike traditional e-wallets, which
take a specified amount of money from
user and store it in its own account, UPI
withdraws and deposits funds directly
from the bank account whenever a
transaction is requested. It also provides
the “peer to peer” collect request which can
be scheduled and paid as per requirement

and convenience.

UPI is developed on the basis of
Immediate Payment Service (IMPS). To
initiate a transaction, UPI applications
use two types of address - global and local.

e Global address includes bank account
numbers and IFSC.

e Local address is a virtual payment
address.

Virtual payment address (VPA) also
called as UPI-ID, is a unique ID similar to
email id (e.g. name@bankname) enable us
to send and receive money from multiple
banks and prepaid payment issuers. Bank
or the financial institution allows the
customer to generate VPA using phone
number associated with Aadhaar number
and bank account number. VPA replaces
bank account details thereby completely
hides critical information.

The
Personal

MPIN (Mobile
Identification

banking
number) is
required to confirm each payment. UPI
allows operating multiple bank accounts
in a single mobile application. Some
UPI application also allows customers to
initiate the transaction using only Aadhaar
number in absence VPA.
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~UPI is also available as an

Unstructured Supplementary

Service Data (USSD) service.
Users who don’t have Internet can dial
*99# and get UPI services within India.
The financial services like transferring
fund, payment request and non-financial
services like changing MPIN and balance
check are currently available through the
USSD.

- 'KNOW?

—~

&

Pay Online

R

Scan & Pay

G

Money Transfers

Advantages

e Immediate money transfers through
mobile device round the clock 24 x 7.

e Can use single mobile application for
accessing multiple bank accounts.

Click Authentication for
transferring of fund.

e Single

e It is not required to enter the details
such as Card no, Account number,
IFSC etc. for every transaction.

e Electronic payments will become
much easier without requiring a digital
wallet or credit or debit card.

16.7 Cash on delivery

Cash on delivery (COD) also called as
collection on delivery, describes a mode

of payment in which the payment is made
only on receipt of goods rather in advance.
Originally, the term applies only to cash

‘ ‘ XIl CompApp_English version CHAPTER 16.indd 235

payment, but since other forms of payment
have become more common, the word
“cash” has sometimes been replaced by the
word “collect” to transactions with checks,
credit cards or debit cards.

COD is often used as an additional
payment option in E-Commerce. It offers
the recipient the advantage of paying only
when commodity is handed over that is
likely similar to traditional system. If the
goods are not paid, they are returned to
the retailer.

ﬁ]‘Bharat Interface for Money
T WNWE (BHIM)

Individual banks and financial
institutions build and maintain their
own mobile application for UPI
transaction. Bharat Interface for
Money (BHIM) is an exclusive mobile
app for UPI developed by National
Payments Corporation of India (NPCI)
and launched on 30 December 2016.
It is intended to facilitate e-payments
directly through banks and drive
towards cashless transactions.

Select Your Bank

Stabe Bank of India

Welcome to

BHiMpy

NEXT
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POINTS TO REMEMBER

® Payments are the financial instruments used globally to transfer value in the form of money or
its substitutes and are constantly changing due to new technology and Government regulations.

® Payment system can also be divided into two types, namely the cash payment system and the
non-cash payment system based on the instruments used. In the cash payment system, the
instruments used are in the form of currency (paper money and coins) while in the non-cash
payment system the instruments used are card-based payment, Cheques or electronic money.
A Credit card plays a major role in electronic payment system worldwide.
ECS is treated as a electronic cheques by the bank. The advantages and disadvantages of the
physical cheque is also extended to ECS. In electronic clearing services, bank process the
instructions from the customer to debit his account and pay another automatically without
much human interference.

e (POS) Point of Sale Terminal- It enables customers to make payment for purchase of goods
and services by means of credit and debit cards. To facilitate customer convenience some

banks also cash withdrawal using debit cards at POS terminals.

&
(GLossARY]

BIN Bank Identification Number. The first six-digits of credit card number to
@ uniquely identify financial institutions. ®

Brick and mortar The term that refers to a business that has a physical store; opposite of online
store.

(CVC2/CVV2) Card Verification Code and Card Verification Value : A three digit code
printed on the cardholder signature panel allows e-payments when the card
is not physically accessible.

Credit card Company responsible for communicating the transaction between the

network / acquirer and the credit card issuer. E.g. MasterCard, Visa, Rupay

processor

Double spend A type of fraud where same cryptocurrency is spent in more than one
transactions.

E-wallets Electronic purses allow users to make electronic transactions quickly and
securely

Gift cards A magnetic stripe or chip card that holds the value of money to offer as a gift

by a E-business

Internet banking Is the activity of buying or selling of commodities through online services or
over the Internet

PIN Personal Identification Number. A static number that is assigned to
consumers to secure card based payments.

Point of sale Merchant’s electronic device that enables the e-payments. It reads the card

(POS) information from EMV or magnetic strip

XD chapter 16 Electronic Payment Systems
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Write

. EVALUATION

When?

Part -1
Choose the correct answer

1.

Based on the monetary value e
payment system can be classified into

a) Mirco and Macro
b) Micro and Nano
¢) Maximum and Minimum

d) Maximum and Macro

. Which of the following is not a

category of micropayment?

a) Buying a movie ticket

b) Subscription to e journals
¢) Buying a laptop

d) Paying for smartphone app

. Assertion (A): Micro electronic

payment systems support higher

value payments.

Reason (R): Expensivecryptographic

operations are included in macro

payments

a) Both (A) and (R) are correct and
(R) is the correct explanation of
(A)

b) Both (A) and (R) are correct, but
(R) is not the correct explanation
of (A)

c) (A) is true and (R) is false

d) (A) is false and (R) is true

Which of the following is correctly

matched

a) Credit Cards - pay before

b) Debit Cards - pay now

c) Stored Value Card - pay later

d) Smart card - pay anytime

‘ ‘ XII CompApp_English version CHAPTER 16.indd 237
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5. ECS stands for
a) Electronic Clearing Services
b) Electronic Cloning Services
¢) Electronic Clearing Station
d) Electronic Cloning Station

6. Which of the following is a online
payment system for small payments.
a) Card based payment
b) Micro electronic payment
¢) Macro electronic payment
d) Credit card payment

7. Which of the following is true about
Virtual payment address (VPA)

a) Customers can use their e-mail
id as VPA

b) VPA does not includes numbers

c) VPA is a unique ID

d) Multiple bank accounts cannot
have single VPA

8. Pick the odd one in the credit card
transaction
a) card holder
b) merchant
c) marketing manager
d) acquirer
9. Which of the following is true about
debit card
i. debit cards cannot be used in ATMs
ii. debit cards cannot be used in
online transactions
iii. debit cards do not need bank
accounts
iv. debit cards and credit cards are
identical in physical properties

Chapter 16 Electronic Payment Systems
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a) i, ii, iii b) ii, iii, iv

¢) iii alone d) iv alone

10. Match the following

List A List B
Al) First Digit B1) Account
number

A2) 9" to 15™ Digit

B2) MII Code

A3) First 6 Digits

B3) BIN Code

A4) Last Digit

B4) Check digit

a) B4 B3 B2 Bl

b) B2 B1 B3 B4

c) B2 B3 B4 B1

d) B2 B4 B3 Bl
Part - I1

Short Answers

1.
® 2

Define electronic payment system

. Distinguish micro electronic payment

and macro electronic payment

. List the types of micro electronic

payments based on its algorithm

| _sTuoenT acrivitzes

Presentation about various payment systems

Chapter 16 Electronic Payment Systems
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4.
5.

Explain the concept of e-wallet

What is a credit card network?

Part - 111
Explain in Brief Answer

1.

5.

Define micro electronic payment
and its role in E-Commerce.

. Compare and contrast the credit

card and debit card.
Explain briefly Anatomy of a credit
card.

. Briefly explain the stored value card

and its types.
What is electronic fund transfer?

Part - IV
Explain in detail

1.

Create a slide describing a payment method.

What is credit card? Explain the
key players of a credit card payment
system and bring out the merits of it.

. Briefly explain Electronic Account

transfer and its types.
Write a note on

a. Internet banking

b. Mobile banking
Write about smard card and type.
Explain in detail : Unified payments
interface

Choose any presentation tool (e.g. Open office impress)

List the futures of the particular payment method.
List the advantages and disadvantages of the same.

Repeat the steps for other payment methods.
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E-Commerce Security Systems

@ LEARNING OBJECTIVES

e To know basics of E-Commerce Security Systems

e To understand various types of E-Commerce threats

e To learn about dimensions of E-Commerce security

e To know about security technologies in E-Commerce transaction

17.1 E-Commerce Security

With the rapid development of the

Internet, online transactions have
increasingly become a new business
E-Commerce

based on network resources have been

model. transactions
accepted by the public. While enjoying
the convenience brought by online
transactions, the security of transactions
has attracted much attention. The
inherent openness and resource sharing
of the network have seriously threatened
the security of online transactions. To an
E-Business security threats not only result

in loss of revenue but also in reputation.

Definition

Security has become a critical factor and
core issue in the emerging E-business.
Solving  the
transactions is the basis for ensuring the
smooth development of E-business.

security problems in
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E-Commerce security is a set of protocols
that safely guide E-Commerce transactions

through the Internet.

17.2 Types of E-Commerce
Threats

Since E-Commerce is based on information
technology and computer networks, it
inevitably faces a series of security issues
compared with traditional businesses.
E-Commerce security threats can be
accidental (caused by a human error) or
intentional.

Foreign or domestic, internal or
external, group or individual, business
rivals or disgruntled employees, terrorists
or hackers anyone with the capability,
technology, opportunity, and intent to
do harm can be a potential threat to
E-Commerce. Though every business has
pitfalls E-Commerce business would face
the following specific threats.
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4
wj‘Viruses cause harm to the
- 'KNOW? the

computers thereby harms

efficient and smooth functioning
of E-Commerce. Some viruses destroy all
the information stored in a computer and
cause huge loss of revenue and time. The
emergence of computer viruses and their
variants has rapidly increased over the
past decade. The Internet has turned to be
the best medium for the spread of viruses.
Many new viruses directly use the Internet
as their mode of transmission causing
huge economic losses to E-businesses.

1. Information leakage: The leakage
of trade secrets in E-Commerce
mainly includes two aspects: (a) the
content of the transaction between
the vendor and customer is stolen by
the third party; (b) the documents
provided by the merchant to the
customer or vice versa are illegally
used by the other. This intercepting
and stealing of online documents is

called information leakage.

wj‘PhiShing is also a E-Commerce
- TKNow?

threat in which a target is contacted

by e-mail, telephone or text

message by someone who pretend himself
as a genuine authority. They try to trap
individuals to provide sensitive data such
as, banking and credit card details, OTP,
PIN or passwords. Once they succeed, the
results would lead to devastating acts such
as identity theft and financial loss.

Chapter 17 E-Commerce Security Systems
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2. Tampering: E-Commerce has the
problem of the authenticity and
integrity of business information.
When hackers grasp the data
transmitted on the network, it can be
falsified in the middle through various
technical means, and then sent to the
destination, thereby destroying the
authenticity and integrity of the data.

3. Payment frauds: Payment frauds have
subsets like Friendly fraud (when
customer demands false reclaim or
refund), Clean fraud (when a stolen
credit card is used to make a purchase)
Triangulation fraud (fake online shops
offering cheapest price and collect
credit card data) etc.

4. Malicious code threats: Within an
E-Commerce site, there are multiple
vulnerable areas that can serve as an
intrusion point for a hacker to gain
payment and user information. Using
malware, Cross Site Scripting or SQL
Injection, an attacker will extract the
credit card information and sell the
acquired data on black markets. Fraud
isthen committed to extract the greatest
value possible through E-Commerce
transactions or ATM withdrawals, etc.

5. Distributed Denial of Service
(DDoS) Attacks: It is a process of
taking down an E-Commerce site by
sending continious overwhelming
request to its server. This attack
will be conducted from numerous
unidentified computers using botnet.
This attack will slow down and make
the server inoperative. DDoS attacks
is also called as network flooding.

6. Cyber Squatting: Cybersquatting is the
illegal practice of registering an Internet

1/5/2022 2:16:17 PM‘ ‘
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domain name that might be wanted
by another person in an intention to
sell it later for a profit. It involves the
registering of popular trademarks and
trade names as domain names before
the particular company do. Cyber
squatters also involve in trading on
the reputation and goodwill of such
third parties by inducing a customer to
believe that it is an official web page.

W‘In September 2015, the domain
- "KNOW?

google.com was bought for 12
American dollars by a former

Google employee which he later sold it
for 6006.13 American dollars.

7. Typopiracy: Typopiracy is a variant of
Cyber Squatting. Some fake websites
try to take advantage of users’ common
typographicalerrorsin typingawebsite
address and direct users to a different
website. Such people try to take
advantage of some popular websites
to generate accidental traffic for
their websites. e.g. www.goggle.com,
www.faceblook.com

W‘Hacking refers to unauthorized
- "KNow:

intrusion into a computer or a
network. That is to say breaking

security to gain access to a website
illegally and
information. They would then misuse
such information to their advantage or
modify and even destroy its contents to
harm the competitors.

intercept  confidential

17.3 Dimensions of

E-Commerce security

As the security issue is the most worrying
issue for E-Business, ensuring the security
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of E-Commerce activities has become

the core research field of E-Commerce.

The following are some of the security

elements involved in E-Commerce.

—~

Authenticity: conforming genuineness
of data shared.

Availability: prevention against data
delay or removal.

Completeness: unification of all

business information.

Confidentiality: ~ protecting  data

against unauthorized disclosure.

Effectiveness: effective handling of
hardware, software and data.

Integrity: prevention of the data being
unaltered or modified.

Non-repudiation: prevention against
violation agreement after the deal.

Privacy: prevention of customers’
personal data being used by others.

Reliability: ~ providing a  reliable
identification of the individuals or

businesses.

Review ability: capability of monitoring
activities to audit and track the
operations.

14
~Ransomware: Ransomware is

a type of malware that usually
encrypt all the files in a target’s
computer and threatens to publish
the critical data unless a ransom
(money) is paid.

~_____ ¥ WARNING!!

|
é Another

Widespread
Ransomware
Attack...
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17.4 Security technologies
in E-Commerce
transaction

Since a large amount of confidential
information are involved in E-Commerce
activities it must be transmitted through
safe and secured network. Sophisticated
security technologies are required to
ensure the security of E-Commerce
transactions. At present, the security
technologies in E-Commerce transactions
are roughly classified into

e Encryption technology
e Authentication technology

e Authentication protocols

17.4.1 Encryption technology

Encryption technology is an effective
information security protection. It is
defined as converting a Plaintext into
meaningless Ciphertext using encryption
algorithmthusensuringthe confidentiality
of the data. The encryption or decryption
process uses a key to encrypt or decrypt
the data. At present, two encryption
technologies are widely used. They are
symmetric key encryption system and an
asymmetric key encryption system.

Symmetric key encryption

The Data Encryption Standard (DES) is a
Symmetric key data encryption method.
It was introduced in America in the year

1976, by Federal Information Processing
Standard (FIPS).

DES is the typical block
algorithm that takes a string of bits of
cleartext (plaintext) with a fixed length
and, through a series of complicated
operations, transforms it into another
encrypted text of the same length.
DES also uses a key to customize the
transformation, so that, in theory, the
algorithm can only be deciphered by
people who know the exact key that
has been used for encryption. The DES
key is apparently 64 bits, but in fact the
algorithm uses only 56. The other eight
bits are only used to verify the parity
and then it is discarded.

Today, it is considered that DES
is not safe for many applications, mainly
because of its relatively smaller key size
(56-bit).

Asymmetric or Public key encryption

Asymmetric encryption also called as
RSA (Rivest-Shamir-Adleman) algorithm.

) 32:’:—:43—1516
Encryption + ﬁ

Plain text

SSN:
BcoYzwoga
XBzdWogZG
9sb3lgc2101G]
FtZXQNCg...

Decryption

Cipher text

Bc9Yzwoga
oooooooooooo XBzdWogZG
9sb3lge2101G]

SSN:
783-43-1616
oooooooooooo

SSN:

FtZXQNCG...

Algorithm Cipher text

Algorithm Plain text

Figure 17.1 Data Encryption and Decryption process
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It uses public-key authentication and
digital signatures. Until 1970s, there were
only symmetric cryptosystems in which
transmitter and receiver must have the
same key. This raises the problem of key
exchange and key management. Unlike a
symmetric encryption, the communicating
parties need not know other’s private-
Each
user generates their own key pair, which

key in asymmetric encryption.

consists of a private key and a public key. A
public-key encryption method is a method
of converting a plaintext with a public key

Symmetric Key Encryption

Same key is used for both encryption and
decryption

into a ciphertext from which the plaintext
can be retrieved with a private key.

17.4.2 Authentication
Technology

The main role of security certification is

to ensure Authentication, Integrity and

Non-repudiation. This can be achieved

through digital signatures and digital

certificates.

Asymmetric Key Encryption

Different keys are used for encryption and
decryption

Speed of encryption or decryption is very
fast

Speed of encryption or decryption is
comparatively slow

Plain text and cipher text are of same size

The size of cipher text is always greater than
plain text.

Algorithms like DES, AES, RC4 uses
symmetric key encryption

Algorithms like RSA, ECC, DSA use
asymmetric key encryption

Provides confidentiality

Provides confidentiality, authenticity and
non-repudiation

The number of key used grows
exponentially with the number of users

The number of key used grows linearly with
the number of users

@ Plaintext U Ciphertext U Plaintext
3 4 =

Sender Encrypt Decrypt

Sama key is used to encrypt
and decrypt message

N
)

Shared Secret Key

@ Semler

Recipient

Plalnleﬂ

B R
. U Ciphertext : @ Plaintext :Q

Encrypt Decrypt Recipient

Diffarent keys ara used to
encrypt and decrypt message

) &
Recipient’s Recipient’s
Public Private
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ﬁ]‘ln 1976, Whitfield Diffie and Martin e. Hellman, devised an algorithm called public key
~ WMOW? encryption. The algorithm can be understood using color game. This how could “A” and
“B” get a secret key without letting “C” finding it out. The trick is based on 2 facts

~

e It is easy to mix 2 colors together to get 3 color

e Given a mixed color it’s hard to reverse it c B
_ Agreed colour -
in order to find the exact original colors < ¥ >

+

1. First A and B agree publicly on a starting
color (yellow)

Secret colour
IN0J0J 18199S

2. Now A select a random colour (red)
mix it with yellow and send new color
(yellow+red=orange) to B.

>

3. Similarly B selects a random colour
(blue) mix it with yellow and send new
colour (yellow+blue=green) to A.

Secret colour

II +I /I+ ’
II +
IN0J02 1919395

4. Hacker “C” may have two new colours
(orange) and (green) but not the A’s (red) or B’s (blue) private colours.

5. After interchanging colors, A adds his own private (red) to B’s mixture (green) and
arrive at a third secret colour(black).

6. Also B adds his own private (blue) to A’s mixture (orange) and arrive at a same third
secret color (black).

7. Cis unable to have the exact color (black), since C needs one of the private color to do so.

Digital certificates because he trusts that CA has done their
A digital certificate (also known as part verifying the sender’s identity.

public key certificate) is an electronic 20
document used to prove the ownership of Genaral | Detats | Certiication Path |

a public key. This certificate includes the
information about the sender’s identity,
digital signature and a public key.

e
L.:-ﬁ Certilicate Information

This certificate is intended to:

=Ensures the identity of & remote computer il
*Proyes your idantity to 3 remaote computer
A digital certificate function is e
similar to the function of identification *Abows Gt o b fgned with the e tine =l
cards such as passports and driving
licenses. Digital certificates are issued BRI TR
by recognized Certification Authorities T —

(CA). When someone requests a digital
certificate, the authority verifies the
identity of the requester, and if the
requester fulfills all requirements, the
authority issues it. When the sender uses o]
a certificate to sign a document digitally,

Valid from: 05/01/2001 be 05j02/2001
?? Yioud Pave & private fey that corresponds o ths certificats,

receiver can trust the digital signature Figure 17.2 Digital Certificates

IEXID) cChapter17 E-Commerce Security Systems
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Common digital certificate systems are
X.509 and PGP.

e Pretty Good Privacy (PGP): Phil
Zimmermann developed PGP in
1991. It is a decentralized encryption
program that provides cryptographic
privacy and authentication for data
communication. PGP
uses a serial combination of hashing,
data compression,
cryptography and
cryptography and works on the concept

encryption

symmetric-key
asymmetric-key

of “web of trust”.

e The X.509 system is a centralized
system in which the authenticity of
the key is guaranteed by the hierarchy
of certification authorities formally
certifying the key relationship with the
identity of its owner. Due to its clear

responsibility, it is easier to implant in

the law, X.509 is currently world wid
accepted certification technology.

@]‘The digital certificate are being
i issued by a licensed Certifying

Authority (CA). NIC, Safescript,
TCS, MTNL, e-Mudhra are some of the
authorized Certifying Authorities under
Government of India.

~—

Digital signature

(S

A digital signature is a mechanism that
is used to verify that a particular digital
document, message or transaction is
authentic.

It provides the receiver th

(S

guarantee that the message was actually
generated by the sender. It also confirms

Digital signature Digital certificate ®

A digital signature is a mechanism that is used to
verify that a particular digital document, message or

transaction is authentic.

A digital certificate is a computer file which officially
approves the relation between the holder of the

certificate and a particular public key.

Digital signatures are used to verify the

trustworthiness of the data being sent

Digital certificates are used to verify the

trustworthiness of the sender.

Digital signature is to ensure that a data remain
secure from the point it was issuedand it was not
modified by a third party.

Digital certificate binds a digital signature to an
entity

It provides authentication, non-repudiation and

integrity

It provides authentication and security.

A digital signature is created using a Digital
Signature Standard (DSS). It uses a SHA-1 or
SHA-2 algorithm for encrypting and decrypting the

message.

A digital certificate works on the principles of public
key cryptography standards (PKCS). It creates
certificate in the X.509 or PGP format.

The document is encrypted at the sending end and
decrypted at the receiving end using asymmetric

keys.

A digital certificate consist of certificate's owner
name and public key, expiration date, a Certificate
Authority 's name , a Certificate Authority's digital

signature
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that the information originated from
the signer and has not been altered by a
cracker in the middle. Digital signatures
can provide the added assurances of
evidence to the origin, identity and status,
as well as acknowledging the consent of
the sender.

Digital signatures use a standard,
worldwide accepted format, called Public
Key Infrastructure (PKI), to provide the
highest levels of security and universal
acceptance. In many countries, digital
signatures have the same legal significance as
the traditional forms of signed documents.
Digital signatures are widely used for
avoiding forging or tampering of important
documents such as financial documents or
credit card data.

@]‘A security token is a hardware
- 'Kiows

o component that are wused to

identify and authenticate users.

17.4.3 Authentication protocols

At present, there are two kinds of security
authentication protocols widely used in
E-Commerce, namely Secure Electronic
Transaction (SET) and Secure Sockets
Layer (SSL).

Secure Electronic Transaction

(SET)
is a security protocol for electronic

Secure Electronic Transaction

Chapter 17 E-Commerce Security Systems
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payments with credit cards, in particular
via the Internet. SET was developed in
1996 by VISA and MasterCard, with the
participation of GTE, IBM, Microsoft and
Netscape.

The implementation of SET is
based on the use of digital signatures and
the encryption of transmitted data with
asymmetric and symmetric encryption
algorithms. SET also use dual signatures
to ensure the privacy.

The SET purchase involves three
major participants: the customer, the
seller and the payment gateway. Here the
customer shares the order information
with the seller but not with the payment
gateway. Also the customer shares the
payment information only with the
payment gateway but not with the seller.
So, with the SET, the credit card number
may not be known to the seller and will
not be stored in seller’s files also could not
be recovered by a hacker.

The SET protocol guarantees the
security of online shopping using credit
cards on the open network. It has the
advantages of ensuring the integrity of
transaction data and the non-repudiation
of transactions. Therefore, it has become
the internationally recognized standard
for credit card online transaction.

SET
following key features:

system incorporates the

e Using public key encryption and
private key encryption ensure data
confidentiality.

e Use information digest technology to
ensure the integrity of information.

e Dual signature technology to ensure
the identity of both parties in the
transaction.
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& < (& A Notsecure example.com

& = (O @ Secure https//www.example.com

Figure 17.3 Difference between http and https

Secure Sockets Layers

The most Cryptographic
protocol is Secure Sockets Layers (SSL).

common

SSL is a hybrid encryption protocol for
securing transactions over the Internet.
The SSL standard was developed
by Netscape in collaboration with
MasterCard, Bank of America, MCI and
Silicon Graphics. It is based on a public
key cryptography process to ensure
the security of data transmission over
the internet. Its principle is to establish
a secure channel
(encrypted) between a client and a server
after an authentication step.

communication

The SSL system acts as an additional
layer, to ensure the security of data,
located between the application layer and
the transport layer in TCP. For example, a
user using an internet browser to connect
to an SSL secured E-Commerce site will
send encrypted data without any more
necessary manipulations. Secure Sockets
Layers (SSL) was renamed as Transport
Layer Security (TLS) in 2001. But still it
is popularly known under the name SSL.
TLS differs from SSL in the generation of
symmetric keys.

‘ ‘ X1l CompApp_English version CHAPTER 17.indd 247

Today, all browsers in the market
support SSL, and most of the secure
communications are proceeded through this
protocol. SSL works completely hidden for
the user, who does not have to intervene in
the protocol. The only thing the user has to
do is make sure the URL starts with https://
instead of http:// where the “s” obviously
means secured. It is also preceded by a
green padlock.

3D Secure

“3-D Secure is a secure payment protocol
on the Internet. It was developed by Visa to
increase the level of transaction security,
and it has been adapted by MasterCard. It
gives a better authentication of the holder
of the payment card, during purchases
made on websites. The basic concept
of this (XML-based) protocol is to link
the financial authorization process with
an online authentication system. This
authentication model comprise 3 domains
(hence the name 3D) which are:

1. The Acquirer Domain
2. The Issuer Domain

3. The interoperability Domain

Chapter 17 E-Commerce Security Systems

247

1/5/2022 2:16:18 PM‘ ‘



___IEEEN ® N = HEEN

www.tntextbooks.in

Q

| casE iTunY]

The operating principle of SSL using public key encryption could be easily understood
with the following scenario “kumar orders a mobile phone from an online store (abc.

com).”

1.

POINTS TO REMEMBER

Kumar connects to abc.com website through a secure connection, from his
computer browser.

The abc.com website sends Kumar an digital certificate and a public key (P).
This digital certificate issued by a certification authority (CA) proves the
identity of abc.com.

Kumar’s browser checks the certificate. It (browser) then agrees with the remote
server on a symmetric cryptographic system to use. Then it randomly choose
a key for this algorithm (session key K).

. Kumar’s browser sends P (K) to abc.com. Using its secret key S, the abc.com

server calculates S (P (K)) = K. Thus, Kumar’s browser and abc.com server are
in possession of the same key.

Kumar enters his credit card number and other data. They constitute the
“information”. The browser sends these “information” to abc.com, encrypted
using the key K. It also sends a summary of this “information”, using a
mathematical function called hash function.

With the K key, the abc.com server can dencrypt the “information” It also
calculates the summary of information, and compares with the summary sent
by Kumar’s browser. If they coincide, it is assumed that the data has been
correctly transmitted.

Phishing: Phishingisacquiring critical datalikelogin credentials through telephone,
sms, e-mail or any social media by the crackers disguising as authentic.

Authentication: Information of the entity sending the document is often included
in the document, but the information may be inaccurate. A digital signature can be
used to authenticate the source of a document.

Integrity: In many scenarios, the sender and receiver of the document will require
confidence that the document has not been tampered with during the transfer. If the
document was digitally signed, any modification of the document will invalidate
the signature.

Non-repudiation: Repudiation refers to any act of relinquishing responsibility
for a message. Non-repudiation ensures that the signer who digitally signed the
document cannot deny having signed it. The digitally signed documents strengthen

IEXY) cChapter17 E-Commerce Security Systems
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its recipient integrity claims. Therefore, the recipient can strongly insist on the
signature of the sender so as not to be easily denied at a later time.

e The difference between a digital signature and digital certificate is that a digital
certificate binds a digital signature to an entity; whereas a digital signature ensures
that a data remain secure from the point it was sent. In other words: digital
certificates are used to verify the trustworthiness of the sender, while digital
signatures are used to verify the trustworthiness of the data being sent.

e The certificate authority maintains a database of public keys called repository so
that it can verify the user with digital signatures. Expired certificates are usually
deleted from the database by the certificate authority.

e Brute-force attacks is the simplest attack method for breaking any encryption; that

is, trying all the possible keys one by one.

|GI.OSSARY|

3-D Secure
Ciphertext

Cracker

Cryptanalysis
Cyber Squatting

Decipher
Domain name

Encryption

Friendly Fraud

Hacking

Message digest (MD)

One-Time Password
(OTP)

PIN (Personal
Identification
Number)

Plaintext/ cleartext
Traffic

An additional security layer for online credit and debit card transactions.

It is the encrypted data usually the output of an encryption algorithm

A person who breaks computer network’s security maliciously to gain
access to critical data.

Analyzing a suspecting document for hidden data or chiphertext

Is the illegal practice of registering an Internet domain name that might
be wanted by another person in an intention to sell it later for a profit

A standard algorithm for decrypting data
The website address of an online store, e.g.www.amazon.com

A method of scrambling data using an algorithm to protect / hide from
unauthorized access.

Is an intentional falsely claim of a costumer that they really didn’t
buy(after receiving the goods)

Unauthorized intrusion into a computer or a network. That is to say
breaking security to gain access to a website illegally and intercept
confidential information

Is a representation of data in a form of single string of digits using one-
way hashing formula.

A dynamic password that is valid for one login session or transaction
provides a potential security for a e-payment transaction.

A static number that is assigned to consumers to secure card based
payments.

It is the unencrypted information also called as input chip

An indicator that marks the number of visitors for a particular site.
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2 & Write

=~ When? EVALUATION

When?

Part -1 5. PGP stands for
Choose the correct answer
1. In E-Commerce, when a stolen credit

a) Pretty Good Privacy

card is used to make a purchase it is
termed as

a) Friendly fraud

b) Clean fraud

c) Triangulation fraud

d) Cyber squatting

. Which of the following is not

a security element involved in
E-Commerce?

a) Authenticity
b) Confidentiality

b) Pretty Good Person
c) Private Good Privacy
d) Private Good Person

____ protocol is used for securing

credit cards transactions via the
Internet

a) Secure Electronic Transaction
(SET)

b) Credit Card Verification

c) Symmetric Key Encryption

d) Public Key Encryption

. Secure Electronic Transaction (SET)

c) Fishing was developed in
d) Privacy a) 1999
. Asymmetric encryption is also b) 1996
called as c) 1969
a) Secure Electronic Transaction d) 1997

b) Certification Authority
c) RSA algorithm

d) Payment Information

. The websites secured by Secure

Socket Layer protocols can be
identified using

. The security authentication a) html://
technology does not include b) http://
i) Digital Signatures ¢) htmls://
ii) Digital Time Stamps d) https://
iii) Digital Technology . 3-D Secure, a protocol was developed
iv) Digital Certificates by
a) i, ii &iv  b) ii & iii a) Visa
c)i,ii &iii  d) all the above b) Master
c) Rupay
d) PayTM

Chapter 17 E-Commerce Security Systems
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10. Which of the following is true about Ransomware

a) Ransomware is not a subset of malware
b) Ransomware deletes the file instantly
c) Typopiracy is a form of ransomware

d) Hackers demand ransom from the victim

Part - I1
Short Answers

1.

GoR W N

Write about information leakage in E-Commerce.
Write a short note on typopiracy.
Define non-repudiation.

List the different types of security technologies in E-Commerce

Write about digital signature.

Part - II1
Explain in Brief Answer

Gk e N

Write a note on certification authorities (CA)

List some E-Commerce Security Threats?

Differentiate asymmetric and symmetric algorithms.

Write a note on PGP.

Explain 3D secure payment protocols

Part - IV
Explain in detail

IR

Write about dimensions of E-Commerce Security.

Explain encryption technology.

Differenticate digital signatures and digital certificates.

Define Secure Electronic Transaction (SET) and its features.

Briefly explain SSL.

| _sTuoenT activiry ¢

Identifying the security protocols used in the particular payment gateway.

e Create a chart for a payment process.

e Repeat the process for few other payment process.

‘ ‘ XIl CompApp_English version CHAPTER 17.indd 251 @

e Describe the security technology used in that payment method.
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@ LEARNING OBJECTIVES

e Toacquire basic knowledge on EDI
e To know the brief history of EDI

e To understand the various types of
EDI

18.1 Introduction to EDI

The Electronic Data Interchange (EDI)
is the exchange of business documents

between one trade partner and another
electronically. It is transferred through a
dedicated channel or through the Internet
in a predefined format without much
human intervention.

It is used to transfer documents
such as delivery notes, invoices, purchase
orders, advance ship notice, functional
acknowledgements etc. These documents
are transferred directly from the computer
of the issuing company to that of the
receiving company, with great time saving

!‘J Purchase Order
Buyer’s

internal system

0101001019 @—
O—

e To learn the advantages of EDI
e To know about the layers of EDI
e To study about UN/EDIFACT

and avoiding many errors of traditional
“on paper” communications.

Before the popularization of
Internet-based E-Commerce, it was a
major E-Commerce model. EDI includes
data exchange between buyers and
sellers, trade partners, and also internal
data exchange within departments of a
company. There are many internationally
accepted EDI standard e.g. EDIFACT,
XML, ANSI ASC X12, etc. See Figure 18.1

EDI is “Paperless Trade” and EFT

(Electronic Transfer) is “Paperless
Payment”

Invoice

« ol
v

A _...1-'-_!']"""".'-._
001001 CLI0TIU TULT LT LA ERA

Figure: 18.1 Electronic Document Exchange
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HISTORY OF EDI

With the popularity of computers, many companies and organizations use computers to store
and process data. However, different organizations use different application systems, and
the format of the data generated is not the same. When organizations need to communicate
for their business needs they have to rekey. This was time consuming and a major obstacle
in the business operations. In order to solve this problem, some enterprises have agreed a
specific standard format, which can be regarded as the origin of the EDI application concept.

14

~Like many other early information

- technologies, EDI was also inspired
by developments in Defense
Research Organization. Ed Guilbert, is
called as the father of EDI. He manifested
shipping standardized format (much like
the 856, or ASN) during the 1948 Berlin
airlift. Guilbert with his team developed
the first standardized system for business
that later

documents would be passed from computer

documents, influenced how
to computer. This standard helped to track
“what was contained in the shipment,
“who was delivering the cargo’, while not
allowing language barriers or confusing
formats to delay the shipment.

Soon, businesses began to realize
that using EDI will smoothen the business
transactions and increase the profit. These
standardizations ordering and
shipping faster, more organized, and less

made

expensive. Earlier, EDI documents were

‘ ‘ XIl CompApp_English version CHAPTER 18.indd 253

transmitted electronically by the use of
Radio teletype, telex messages, or telephone.

1960s, shipping
railroads, airlines, and truck companies of
USA were exchanging electronic messages

In late line,

for their businesses. These messages were
in different formats, and it resulted in
problems in transfer of goods. In 1968,
these companies grouped together among
themselves and formed the Transportation
Data Coordinating Committee (TDCC)
to develop EDI standard formats.

In 1975, first EDI standards were
released by TDCC, of which Ed Guilbert
was a major contributor. In 1977, a
group of supermarket companies and
their business partners begin drafting
and using an EDI project. The TDCC is
renamed as Electronic Data Interchange
Association (EDIA) in 1978. Later in that
year, the EDIA was undertaken by the
American National Standards Institute
and becomes the ANSIX12 committee.
Since then this committee is responsible
for the publication of EDI standards.

Later in 1985, UN created the
EDIFACT to assist with the global reach
of technology in E-Commerce. EDIFACT
is the most widely used EDI.

Chapter 18 Electronic Data Interchange- EDI
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ﬁ]‘The first EDI messages was sent in
~ KNow? 1965 from the Holland-American
steamship line to Trans-Atlantic
shipping company using telex messages.
The computer had sent a full page of
information in roughly 2 minutes. These
messages were then written on the magnetic
tapes that could be loaded onto another
computer.

18.2 EDI Types
The types of EDI were constructed based

on how EDI communication connections
and the conversion were organized. Thus
based on the medium used for transmitting
EDI documents the following are the
major EDI types.

e Direct EDI

e EDIvia VAN

e EDIvia FTP/VPN, SFTP, FTPS
e Web EDI

e Mobile EDI

Direct EDI1/Point-to-Point

It is also called as Point-to-Point EDI. It
establishes a direct connection between
stakeholders and
partners individually. This type of EDI

various  business
suits to larger businesses with a lot of day
to day business transactions.

EDI via VAN

EDI via VAN (Value Added Network) is
where EDI documents are transferred
with the support of third party network
service providers. Many businesses prefer
this network model to protect them from
the updating ongoing complexities of
network technologies. See Figure 18.2

ﬁ]‘A value-added network is a
~ WOW? company, that is based on its own
network, offering EDI services to
other businesses. A value-added network
acts as an intermediary between trading
partners. The principle operations of value-
added networks are the allocation of access
rights and providing high data security.

Sending Company

EDI
Translator
2) Translate the

documents into EDI
format.

m c

00“““\:‘ e

1) Prepare the Documenis [0 be sent.
Internal Format

Provider

Receiving Company

Datain

Internal Format

EDI
Translator

EDI Network T
Service

\ n

3) Connect and transmit
your documents [0 your
business partner

Communications & e - ,_d Communications
Soﬂware irect, oini-{o- W, ommunications Soﬂware

Figure: 18.2 EDI via VAN
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EDI via FTP/VPN, SFTP, FTPS

When protocols like FTP/VPN, SFTP
and FTPS are used for exchange of EDI
based documents through the Internet or
Intranet it is called as EDI via FTP/VPN,
SETP, FTPS.

Web EDI

Web based EDI conducts EDI using an
web browser via the Internet. Here the
businesses are allowed to use any browser
to transfer data to their business partners.
Web based EDI is easy and convenient for
small and medium organizations.

Mobile EDI

When smartphones or
handheld devices are used to transfer
EDI documents it is called as mobile EDI.
Mobile EDI applications considerably

other such

increase the speed of EDI transactions.

18.3 Advantages of EDI

EDI was developed to solve the problems

inherent in paper-based transaction
processing and
electronic communication. Implementing
EDI system offers a company greater
control over its supply chain and allow it

to trade more effectively. It also increases

in other forms of

productivity and promotes operational
efficiency. The following are the other
advantages of EDI.

e Improving service to end users
e Increasing productivity

e Minimizing errors

e Slashing response times

e Automation of operations

‘ ‘ XIl CompApp_English version CHAPTER 18.indd 255

e Cutting costs

e Integrating all business and trading
partners

e Providing information on process status

e Optimizing financial ratios

18.4 EDI Layers

Electronic data interchange architecture
specifies four different layers namely

1. Semantic layer
2. Standard translation layer
3. Transport layer
4. Physical layer

These EDI layers describes how data
flows from one computer to another. See
Figure 18.3

EDI Semantic

Application level services
layer

EDIFACT business form standards
EDI Standard

translation layer

ANSI X 12 business form standards

Electronic mail X.435, MIME
EDI Transport | poins 16 point FTP. TELNET
layer
World Wide Web HTTP

Physical layer Dial-up line, internet, I-way

Figure: 18.3 EDI Layers

18.5 EDI Components

There are four major components of EDI.
They are

1. Standard document format
2. Translator and Mapper
3. Communication software

4. Communication network

Chapter 18 Electronic Data Interchange- EDI
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18.6 EDI Standards

The standard is the most critical part
of the entire EDI. Since EDI is the data
transmission and information exchange

in the form of an agreed message
format, it is important to develop a
unified EDI standard. The EDI standard
is mainly divided into the following
aspects: basic standards, code standards,
message standards, document standards,
management  standards,  application
standards, communication standards and

security standards.

The first industry-specific EDI
standard was the TDCC published by
the Transportation Data coordinating
Committee in 1975. Then other industries
started developing unique standards based
on their individual needs. E.g. WINS in
the warehousing industry.

After the
two major regional EDI standards and

development of the

a few years after trial, the two standards
began to integrate and conduct research
and development of
standards.

common EDI
United
Nations Economic Commission for
Europe (UN/ECE/WP.4) hosted the task
of the development of international EDI
standards. In 1986, UN/EDIFACT is
officially proposed. The most widely used
EDI message standards are the United
Nations EDIFACT and the ANSI X12.

Subsequently, the

18.7 UNZ/EDIFACT

United Nations / Data
Interchange for Administration, Commerce
and Transport (UN / EDIFACT) is an
international EDI - standard developed
under the supervision of the United Nations.

Electronic

Chapter 18 Electronic Data Interchange- EDI
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In 1987, the UN / EDIFACT syntax rules
were approved as ISO: 1SO9735 standard
by the International Organization for
Standardization. See Figure 18.4

EDIFACT
internationally agreed standards, catalogs

includes a set of

and guidelines for electronic exchange
of structured data between independent
computer systems.

EDIFACT

Figure: 18.4 UN/EDIFACT

It is a cross-industry, standard data
format of electronic data for commercial
and further
development of this standard goes through the
United Nations Center for Trade Facilitation
and Electronic Business (UN/CEFACT),
which is affiliated to the UN Economic
Commission for Europe (UNECE).

transactions. Maintenance

EDIFACT directories

The versions of EDIFACT are also called
as directories. These EDIFACT directories
will be revised twice a year; on 1* April
and 1** October to include new or update
existing EDIFACT messages. EDIFACT
directories have names like D.18B

(D stands for Directory, 18 is the
year and A/B indicates the month of
release)
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EDIFACT subsets designator and repetitation field. The
Due to the complexity, branch-specific requirement designator may be mandatory
subsets of EDIFACT have been developed. (M) or conditional (C). The (M) denotes
These subsets of EDIFACT include only that the segment must appear atleast

the functions relevant to specific user once. The (C) denotes that the segment
groups. may be used if needed. e.g. C10 indicates
repetitions of a segment or group between
Example: 0 and 10.
CEFIC - Chemical industry Position  Tag Name. _Req  Rept
0010 UNH Massage Header M 1
0020 BGM Beginning of Message M 1
1 1 o030 BUS Busi Functi c 1
EDIFURN - furniture industry oS B gerondl b -
0060 RFF Reference M 1
: 70 / /
EDIGAS - gas business o8 I eyt ¢ 1
0090 PAI Payment Instructions c 1
0100 FCA Financial Charges Allocation c 1
EDIFACT Structure 0120 MOR  Monetary Amount M 1
0130 CUX Currencies c 1
. . . 0140 DTM Date/Time/Period e 2
EDIFACT is a hierarchical structure 0150  RFF  Reference ¢ 1
ate,
where the top level is referred to as an e
. . e ———)
interchange, and lower levels contain

multiple messages. The messages consist
of segments, which in turn consist of

EDI Interchange
composites. The final iteration is a data d

) element. See Figure 18.5 and 18.6 Interchange is also called as envelope. )
The top level of EDIFACT structure is
Segment Tables Interchange. An interchange may contain
multiple messages. It starts with UNB and

Segment table lists the message tags. It
contains the tags, tag names, requirements

ends with UNZ

» B DOGAINVOIC » IE out B8 APERAKXMLTO.. Ta #obXML2EDIF. B8 DESADV.XMLTO.. [ APER?
4 [ Transaction-INVOIC bt | | FoT—— /Transaction-INVOIC/Loop-UNB/UNB
4 3 Loop-UNB (1:%) :

4|1 UNB INTERCHAMGE HEADER | &

. ® 5001 SYNTAX IDENTIFIER Inherited Root lUse Only Childran .

¥ S002 INTERCHAMGE SENDER 3 Ignore Inherited Adds? rl
¥ S003 INTERCHAMGE RECIPIENT Use Child of r
+ & 5004 DATE/TIME OF PREPARATION AR

7 E0020 Interchange control reference
@ Loop-UNH (1% Syntax Rules 3
# UNH MESSAGE HEADER
- H BGM BEGINNING OF MESSAGE
® DTM (1:35) DATE/TIME/PERIOD
A Loop-RFF (1:99) Segment Group 1

Seguence [d

Template Anchor XPath Name

Validate Emit |IsPresent Null |Util | Document

1 UbA:+.7 !

2 IMB+UNOA 2+ E7 1157E000003: 14487 LOEZ4900007 = 144 151214 1057+ 1512 1410570200
3 UEH+ 15094495+ THVOIC: D : 964 :UN :EAIIDDS!

4 BEM+ZI80+15094495+5+HA"

5 DTM+137:20150629:102"

B DIM+35:20150829: 102"
7
5]
El
1]

REF+CH :02041593625"

HAD+IV+B87 10624900007 - -9
HAD+EU+BY11578000003: :9°
REF+VAMLOOE100363ED]! o

=

A Component I» Run (Job EDIfactToXML) e %

Figure 18.5 Sample EDI Application
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Highest Level

4

V 48 i,

e A E Piece of data between
9 segments UNB/UNZ

.

:
:
:

Y

V 48 B,

Functional Groups Piece of data between
& segments UNG/UNE

\4
B,
Messages Piece of data between
. segments UNH/UNT

\4

V 48 B,

Segment Groups * Block of related data

\4
B
Mixture of simple and
Segments .
composite elements

\4

Composite
Elements

Group of related simple elements

.

:
:
.

Y

Simple data
Elements

Piece of single data

Lowest Level

Figure: 18.6 UN/EDIFACT Message structure
m Chapter 18 Electronic Data Interchange- EDI

‘ XIl CompApp_English version CHAPTER 18.indd 258 /# 1/5/2022 2:17:48 PM



@

www.tntextbooks.in

EDIFACT message

The basic standardization concept of
EDIFACT
message types called United Nations
Standard Message (UNSM). In so-called
subsets, the message types
specified deeper in their characteristics

is that there are uniform

can be

depending on the sector. The message
types, all of which always have exactly
one nickname consisting of six uppercase
English alphabets. The message begins
with UNH and ends with UNT

e Service messages
To confirm/rejectamessage, CONTRL
and APERAK messages are sent.

o CONTRL- Syntax Check and
Confirmation of Arrival of Message

o APERAK - Technical

messages and acknowledgment

error

e Data exchange

o CREMUL - multiple credit advice
o DELFOR- Delivery forecast

o IFTMBC - Booking confirmation

EDIFACT Segment

It is the subset of message. A segment is a
three-character alphanumeric code. These
segments are listed in segment tables.
Segments may contain one, or several
related user data elements.

EDIFACT Elements

The elements are the piece of actual data.
These data elements may be either simple
or composite.

‘ ‘ X1l CompApp_English version CHAPTER 18.indd 259

An excerpt from an EDIFACT message
might be:

DTM + 11: 200 606 200 730: 203’

This whole line is called a segment. The
meaning of each code is as follows:

e DTM is the segment identifier and
it indicates that the following data is
date / time information.

e 11 is a data element. In this example,
a qualifier describes what kind of
event is meant. The code 11 means:
time of dispatch / delivery of goods.

® 200606200730 is another element.
Here it represents the date in the
format CCYYMMDDHHMM.

e 203 is also an element. 203 is an
identifier for the date format.

In this example, 203 means that the date
is in the format CCYYMMDDHHMM
(as of D.18B, CC - century, YY - Year,
MM- Month, DD - Date, HH - Hour,
MM - Minute)

EDI Separators

EDIFACT has the following punctuation
marks that are used as standard separators.

Character Uses

Apostrophe > segment terminator

Plus sign + segment tag and data
element separator

Colon : component data

element separator

Question mark ? release character

Period - decimal point

Chapter 18 Electronic Data Interchange- EDI
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Example:

UNA:+.2¢

UNB+IATB:1+6XPPC:ZZ+LHPPC:ZZ+940101:0950+1°

UNH+1+PAORES:93:1:1IA
MSG+1:45’

[FT+3+XYZCOMPANY AVAILABILITY’

ERC+A7V:1:AMD’
[FT+3+NO MORE FLIGHTS’
oDr

TVL+240493:1000::1220+FRA+JFK+DL+400+C’

PDI++C:3+Y::3+F::1’
APD+74C:0:::6++++++6X

TVL+240493:1740::2030+JFK+MIA+DL+081+C’

PDI++C:4’
APD+EM2:0:1630::6+++++++DA’
UNT+13+1’

UNZ+1+1°

Standards and Technology, EDI is “the
computer-to-computer interchange
of strictly formatted messages that
represent documents other than

monetary instruments.”

EDI is “Paperless Trade” and EFT
(Electronic Transfer) is “Paperless
Payment”

Ed Guilbert, is called as the father of
EDI

Chapter 18 Electronic Data Interchange- EDI
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In 1985, UN created the EDIFACT
to assist with the global reach of
technology in E-Commerce.

Direct EDI is also called as Point-to-
Point EDI

Every EDI message consist of six
uppercase English Alphabets
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|GLUSSARY|

Advance ship notice A notification of pending deliveries

FTP A standard network protocol used for the transfer of computer files
between a client and server on a computer network.

Interchange The top level message of EDI hierarchical structure

Invoice A commercial document issued by a seller to a buyer containing
product name, quantity and price.

Purchase order A commercial and first official document issued by a buyer to a seller

indicating types, quantities, and agreed prices for products or services.

Segment Segments may contain one, or several related user data elements.

Separators punctuation marks that are used to separate segments or elements.

TDCC Transportation Data Communication Committee - The first industry-
specific EDI standard.

Telex A type of teleprinter

VAN Value Added Network, a third party network service provider

. 2 e o . < Tt
Where? g : g\/\]thh? < Write

Write O~ E What? When? EVALUATION

When? When? & When?

Part -1 3.

Choose the correct answer
1. EDI stands for
a) Electronic Details Information
b) Electronic Data Information
c) Electronic Data Interchange
d) Electronic Details Interchange

2. Which of the following is an
internationally recognized standard
format for trade, transportation,
insurance, banking and customs?

a) TSLFACT
b) SETFACT
¢) FTPFACT
d) EDIFACT

‘ ‘ XIl CompApp_English version CHAPTER 18.ndd 261 @

Which is the first industry-specific
EDI standard?

a) TDCC
b) VISA
c) Master
d) ANSI

. UNSM stands for?

a) Universal = Natural  Standard
message

b) Universal Notations for Simple
message

¢) United Nations Standard message

d) United Nations Service message

Chapter 18 Electronic Data Interchange- EDI
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5. Which of the following is a type of

EDI?
a) Direct EDI
b) Indirect EDI
¢) Collective EDI
d) Unique EDI
6. Who is called as the father of EDI?
a) Charles Babbage
b) Ed Guilbert
¢) Pascal
d) None of the above

7. EDI interchanges starts with
and ends with

10. Number of characters in an single

EDIFACT messages
a)5 b) 6 c) 4 d)3
Part - I1

Short Answers

1. Define EDI.

2. List few types of business documents
that are transmitted through EDI.

3. What are the 4 major components of
EDI?

4. What is meant by directories in
EDIFACT?

5. Write a note on EDIFACT subsets.

Part - 111
Explain in Brief Answer
Write a short note on EDI.

List the various layers of EDI.
Write a note on UN/EDIFACT.
Write a note on EDIFACT message.
Write about EDIFACT separators

ok e N

Part - IV

Explain in detail
1. Briefly explain various types of EDI.
2. What are the advantages of EDI?
3. Write about structure of EDIFACT.

e Prepareachart explaining various types of EDI standards. (e.g. web EDI)

a) UNA, UNZ
b) UNB, UNZ
c) UNA, UNT
d) UNB, UNT
8. EDIFACT stands for
® a) EDI for Admissible Commercial
Transport
b) EDI for Advisory Committee and
Transport
c) EDI for Administration,
Commerce and Transport
d) EDI for Admissible Commerce
and Trade
9. The versions of EDIFACT are also
called as
a) Message types b) Subsets
¢) Directories d) Folders
| _sTuoenT actviry
IEI?) Chapter 18 Electronic Data Interchange- EDI

‘ ‘ XII CompApp_English version CHAPTER 18.indd 262

1/5/2022 2:17:48 PM‘ ‘



@

www.tntextbooks.in

12th STD - Computer Applications - Practicals

PageMaker-Page Formatting

To create a new document using thedefault given options.

1. Open Pagemaker 7.0 and create a new document layout which includes the following
setup options:
e Page size - A4.
e Number of Pages - 4.
e Margins 1.25 inches- top, and .75 inches - all other sides.

® 2. Type the following text: ®
HAPPINESS

Happiness is often confused with fun, good living, and riches. Sometimes fun is
equated with happiness. Fun is what we experience while doing an activity, whereas
happiness is a residual and long-lasting feeling. The path to happiness is long and
tull of challenges. Happiness requires life-long pursuit.

3. Set the heading ‘HAPPINESS’ in 18 points, Arial font, bold and alignment centre.

4. Format the paragraph as follows:

(a) Font - Arial
(b) Font size - 12

(c) Alignment - Justified
(d) Leading - 20

5. Save the document as ‘happiness.

263
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Procedure
1. Start the PageMaker using the following commands.

Start -> All Programs -> Adobe -> PageMaker 7.0 -> Adobe PageMaker 7.0. The
Adobe PageMaker window will be opened as shown in Figure.

D)  Practicals
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2. Choose File > New in the menu bar. (or) Press Ctrl + N in the keyboard.

This opens the Document Setup dialog box.

e Click the Page Size drop down list box and select A4 size.

e In the Number of pages text box, type 4.

® e Set the values in the Margins sections as follows :
Inside - —=0.75 inches
Outside -  0.75 inches
Top - 1.25inches
Bottom - 0.75inches
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3. Click on OK. Now a new document called Untitled - 1 will appear on the screen as
shown in Figure.

4. Click on the Text tool and create a text block. Then type the following text in the text
block.

HAPPINESS

Happiness is often confused with fun, good living, and riches. Sometimes fun is
equated with happiness. Fun is what we experience while doing an activity, whereas
happiness is a residual and long-lasting feeling. The path to happiness is long and
tull of challenges. Happiness requires life-long pursuit.

B  Practicals
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5. Select the word ‘HAPPINESS’ with Text tool. Using Character Control Palette,
change the font to Arial, font size to 18, and Leading 22. Then click on Bold button.
Then press Shift + Ctrl + C for centre alignment.

Practicals 267
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6. Select the paragraph with Text tool. Using Character Control Palette, change the
font to Arial, font size to 12, and Leading 20. Then press Shift + Ctrl + J for Justify.

BE)  Practicals
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7. To save the document as ‘happiness’

(a) Press Ctrl + S (or) Choose File > Save in the menu bar. Save publication dialogue
box appears. Type ‘happiness’ in the File name text box and press Save button.

Output

HAPPINESS

Happiness is often confused with fun, good living, and riches. Sometimes fun is
equated with happiness. Fun is what we experience while doing an activity, whereas
happiness is a residual and long-lasting feeling. The path to happiness is long and

full of challenges. Happiness requires life-long pursuit.

Conclusion

The expected output is achieved.

Practicals  @ITI
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PageMaker-Creating Notice Board

To create a Student Notice Board.

Create a Student Notice Board using PageMaker.

Student Notice Board

Procedure
1. Start the PageMaker using the following commands.

Start -> All Programs -> Adobe -> PageMaker 7.0 -> Adobe PageMaker 7.0. The
Adobe PageMaker window will be opened.

2. Choose File > New in the menu bar (or) Press Ctrl + N in the keyboard.
This opens the Document Setup dialog box.

3. Click on OK button.
Now a new document called Untitled - 1 will appear on the screen.

4. Create a box with dimension 100 mm x 100 mm using the Rectangle tool. Fill it with
cyan colour and change the percentage value of tint to 25%. The resulting box is as
shown in Figure.

270 Practicals
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5. Similarly create another box with dimension 100 mm x 15 mm. Fill it with black
® colour and place it on the top portion of the cyan filled box as shown in figure. ®

Practicals 271
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6. With the text tool click and drag the mouse from the left corner to the right corner
of the black filled box and type the following words “Student Notice Board”.

The colour of the text and the colour of the box will be same black colour. As soon
as you finish typing press Ctrl + A in the keyboard which will select the entire text.

Using Character Control palette change the font size to 20 points and click on the
Bold button. Then click on the Reverse button which will change the colour of the
text to white and press Shift + Ctrl + C for centre alignment. The result is as shown
in Figure.

Output

Conclusion

The expected output is achieved.

272 Practicals
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PageMaker-Creating Visiting Card

To create a Visiting Card using PageMaker software.

Create the following Visiting Card using PageMaker.

S. Barath Kumar

Vision TECH

S, Annai Avenue, Trichy - 17
Ph : 0431 - 2780000

Procedure
1. Start the PageMaker using the following commands.

Start -> All Programs -> Adobe ->Pagemaker 7.0 -> Adobe PageMaker 7.0. The
Adobe PageMaker window will be opened as shown in Figure 1.1.
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@ 2. Choose File > New in the menu bar (or) Press Ctrl + N in the keyboard. @

This opens the Document Setup dialog box.
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3. Click on OK.

Now a new document called Untitled - 1 will appear on the screen as shown in
Figure.

@ 4. Now you can change Measuring Units from Inches to Millimeters. ®

Choose File > Preferences > general (or ) Press Ctrl + K. Now Preferences dialogue
box appears.

Change the unit of Measurements and Vertical ruler to Millimeters.
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5. Select the Rectangle Tool from the Tool box and draw a rectangle.

6. Using Control Palette, the width and height value of the rectangle has to be set to 95
mm and 55 mm respectively.
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7. Select the Text Tool in the Tool box. Then drag from the left corner of the rectangle
box to the right corner to specify the boundary of the text that is to be typed.

8. Type the Name of the person and select it using Text tool. Choose suitable Font and
Font Size from the Control Palette. Then move it a little bit towards right side.
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9. Repeat the step 7. Then type the Company name and select it using Text tool. Choose
suitable Font and Font Size from the Control Palette. Then move it a little bit towards
right side.

Select the First character using the Text tool and increase the font size.
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10. Repeat the step 7. Then type the Company Address and select it using Text tool.
Choose suitable Font and Font Size from the Control Palette. Then move it towards
right side.

Output

Conclusion

The expected output is achieved.
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PageMaker-Creating Notice Board

To create a Label using PageMaker software.

Create the following Label using PageMaker.

Procedure

1. Start the PageMaker using the following commands.
Start -> All Programs -> Adobe ->Pagemaker 7.0 -> Adobe PageMaker 7.0.

2. Choose File > New in the menu bar (or) Press Ctrl + N in the keyboard.
This opens the Document Setup dialog box.

3. Click on OK.
Now a new document called Untitled - 1 will appear on the screen.

4. Now you can change Measuring Units from Inches to Millimeters.

Choose File > Preferences > general (or ) Press Ctrl + K. Now Preferences dialogue
box appears.

Change the unit of Measurements and Vertical ruler to Millimeters.
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5. Select the Rectangle Tool from the Tool box and draw a rectangle.

6. Using Control Palette, the width and height value of the rectangle has to be set to
100 mm and 40 mm respectively.

7. Choose Element > Rounded corners from the menu bar.

8. Choose the required shape from the rounded corners dialog box. Now the rectangle
appears with the rounded corners.

9. Select the Text Tool in the Tool box and create a text block within the rectangle.
10. Type Name : and press a Tab key and then press Enter key.

Type STD : and press a Tab key and then press Enter key.

Type Section : and press a Tab key and then press Enter key.

Type School : and press a Tab key and then press Enter key.

Type Subject : and press a Tab key.

11. Select all the text using Text tool.
12.Choose Type > Indents / Tabs (or) press Ctrl + I.

13.Set a right tab at the value 90 mm and choose the dotted line style from the leader
option and then press Apply button.
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14. Now the required label is created.

Output

Conclusion

The expected output is achieved.
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MySQL - Usage of
Commands in Data Base

To execute following DDL [Data definition Language] and DML [Data manipulating
Language] MySQL queries

1. CREATE - to create a database and its objects like (table, index, views, store procedure,
function, and triggers)

ALTER - alters the structure of the existing database.
DROP - delete objects from the database.

SELECT - retrieve data from a database.

INSERT - insert data into a table.

UPDATE - updates existing data within a table.
DELETE - Delete all records from a database table.

N oo w N

Procedure
1. Open MySQL command prompt from XAMPP Control panel.
2. Tologin in to your Database using User name and password.

3. Execute and get the output of given DDL MySQL queries.

SYNTAX:

Based on the below syntax queries are built and executed.

* CREATE DATABASE testDB;

* CREATE TABLE table_name (columnldatatype,column2datatype,column3datatype, ....);
* ALTER TABLE ‘table_name' ADD COLUMN ‘column_name" ‘data_type';

* DROP DATABASE databasename;

*SELECT * FROM TABLE NAME

*INSERT INTO table_name( fieldl, field2,...fieldN ) VALUES ( valuel, value2,...valueN );
* UPDATE table_name SET field1 = new-valuel, field2 = new-value2 [WHERE Clause]
*DROP TABLE table_name ;
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PROGRAM:
CREATE DATABASE SchoolDB;

CREATE TABLE student(
studentID int,
LastName varchar(255),
FirstName varchar(255),
Address varchar(255),
City varchar(255)
);
ALTER TABLE ‘'members’ ADD COLUMN ‘credit_card_number' VARCHAR(25);
DROP DATABASE SchoolDB
SELECT * FROM student
INSERT INTO student (studentID ,LastName , FirstName,Address,City ) VALUES
(002”7, “Ram”y’Kumar”, “ROJA NAGAR”YCHENNATI);
SELECT * FROM student
UPDATE student SET LastName = ‘SRI’ WHERE studentID = 003;
SELECT * FROM student
DROP TABLE student ;

SELECT * FROM student
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Table created:

StudentID
101
202

002
003
StudentID
101
202

002

003

Table dropped.
Table not found.

Database created

studentID LastName
Table Altered

Database dropped
StudentID LastName
101 C

202 S

One row inserted.

LastName
C
S

Ram

R
LastName
C

S

Ram

SRI

FirstName

FirstName
Priya

Ramu

FirstName
Priya

Ramu

Kumar
Krishna
FirstName
Priya

Ramu

Kumar

Krishna

Address

Address
1, new street

5, North garden
St

Address
1, new street

5, North garden
St

ROJA NAGAR
Park Street
Address

1, new street

5, North garden
St

ROJA NAGAR
Park Street

City

City
Trichy
Madurai

City
Trichy
Madurai

CHENNAI
Coimbatore
City

Trichy
Madurai

CHENNAI

Coimbatore
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PHP—Basic Programing

To create and execute a basic PHP programing

Procedure

1. Start Xampp server (Apache)

2. Goto virtual path folder (C:\xampp\htdocs)
3. Create test.php file and type the program
4. Execute the program on your Web browser using by this URL link (http://localhost/
® test.php) ®
PROGRAM
<html>
<body>
<?php
echo “Welcome to Our School”;
$color = “blue”;
echo “My car is “ . $color . «<br>";
echo “My dress is “ . $COLOR . «<br>";
echo “My box is “ . $coLOR . «<br>";
/I test whether a number is greater than 30, 20 or 10 using ternary operator
functiontrinary_Test($n){
BEID)  Practicals
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$r=9%$n > 30

? “greater than 30”
:($n > 20

? “greater than 20”
:($n >10

¢ “greater than 10”
: “Input a number atleast greater than 10!”));
echo $n” : “$r’\n”;
}

trinary_Test(32);
trinary_Test(21);
trinary_Test(12);
trinary_Test(4);

7>

</body>

</html>

OUTPUT

Welcome to Our School

My car is blue
My dress is
My box is

32 : greater than 30
21 : greater than 20
12 : greater than 10

4 : Input a number atleast greater than 10!
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EXERCISE

PHP—Create & Execute Variables

To create and execute a PHP Variables Example program

Procedure

1. Start Xampp server (Apache)
Goto virtual path folder (C:\xampp\htdocs)
Create Variable.php file and type the program

Ll O

® Variable.php)

PROGRAM
<html>

<body>

<?php

$a = 25; // Numerical variable
$b = “Hello”; // String variable
$c = 5.7; // Float variable
echo ,Number is : “$a.,<br/>7;
echo ,String is : “$b.,<br/>”;
echo “Float value : “.$c¢;

$txt = “INDIA”;

echo “I love $txt!”;

$x = 2;

$y = 2;
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echo $x + $y;
function demo() {

echo «<p>Variable x inside function is: $x</p>»;

}

demo();
echo “<p>Variable x outside function is: $x</p>7;
function myTest() {

static $a = 0;

echo $a;

$a++;

myTest();

echo “<br>";

myTest();

echo “<br>”;
® myTest();

>

</body>

<html>

OUTPUT
Number is : 25

String is : Hello

Float value : 5.7

I LOVE INDIA

4

0

1

2

Variable x inside function is:

Variable x outside function is: 2
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EXERCISE

Create & Execute ECHO and PRINT
statements

To create and execute ECHO and PRINT statements in PHP program.

Procedure

1. Start Xampp server (Apache)
Goto virtual path folder (C:\xampp\htdocs)
Create echo-print.php file and type the program

Ll O

Execute the program on your Web browser using by this URL link
(http://localhost/ echo-print.php)

PROGRAM
<html>

<body>

<?php

/IUse Echo

echo “Welcome to Tamilnadu<br>";

//'Use “print’ to print on console

print “Welcome to our School!l <br>**+**x*txex,
$txtl = “Learn PHP”;

$txt2 = “Daily”;

$x = 5;

$y=4;

IEII)  Practicals

‘ ‘ XII CompApp_English version Practicalindd 290 @ 12/10/2021 4:20:34 PM‘ ‘



____IEEEN ®

www.tntextbooks.in

echo “<h2>” . $txtl . «</h2>»;
echo “Study PHP “. $txt2 . «<br>";
echo $x + $y;

$txt3 = “Hello”;

$txt4 = “Welcome”;

$x =7;

$y = 3;

print “<h2>” . $txt3 . «</h2>»;

<«

print “Hi . $txt4 . «<br>";
print $x + $y;

o>

</body>

</html>

OUTPUT
Welcome to Tamilnadu

Welcome to our School!

*hkhkkhhhkikkix

Learn PHP

Study PHP Daily
9

HELLO

Hi Welcome
10
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String Functions

To create and execute String Functions in PHP

Procedure

[e—

. Start Xampp server (Apache)

2. Goto virtual path folder (C:\xampp\htdocs)

3. Create funtion.php file and type the program

4. Execute the program on your Web browser using by this URL link

(http://localhost/ funtion.php)

<html>

<body>

<?php

/1 Displays the length of the string
echostrlen(“Hello world!”);

//Counting number of words in a String
echo str_word_count(“Good Morning All”);
/] Reversing a string

echo strrev(“welcome”);
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/] calculates position of strong

echo strpos(“Hello world!”, “world”);

/] replacing the text

echo str_replace(“Hi”, “Hello”, “Hi Everyone”);

define(“GREETING”, “Good Morning!!!”);

echo GREETING;

/I changes the color of the first character of a word

$text = ‘PHP Tutorial’;

$text = preg_replace(‘/(\b[a-z])/i; <span style="color:red;”>\1</span>’$text);
echo $text;

>
</body>
</html>
® ®
OUTPUT
12
3
emoclew
6

Hello Everyone
Good Morning!!!

PHP Tutorial
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Converting Word to Digit

Write a PHP program to convert word to digit.

Procedure

1. Start Xampp server (Apache)
Goto virtual path folder (C:\xampp\htdocs)
Create convert.php file and type the program

Ll O

Execute the program on your Web browser using by this URL link

(http://localhost/convert.php)

<html>

<body>

<?php

functionword_digit($word) {
$warr = explode(‘;;$word);
$result = “;

foreach($warr as $value){

switch(trim($value)){
case ‘zero’:

$result .= ‘0’;
break;
case ‘one’:

$result .= ‘1’;
break;

< b
case two:
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$result .

break;

case ‘three’:

$result .

break;

< bl
case ‘four’:

$result .

break;

(e bl
case ‘five’:

$result .

break;

case ‘six’:

$result .

break;

case ‘seven’:

$result .

break;

case ‘eight”:

$result .

break;

case ‘nine’:

$result .

break;

}
}

return $result;

}

@
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echoword_digit(“zero;three;five;six;eight;one”).”\n”;

echoword_digit(“seven;zero;one”).”\n”;

>
</body>
</html>

OUTPUT
035681

701
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